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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

Welcome to HP ALM Performance Center. 

ALM Performance Center is HP’s Web-enabled global performance testing 
tool, which is specially designed to simplify the testing process and increase 
test efficiency for multiple concurrent performance tests across multiple 
geographic locations.

This guide describes how to use ALM Performance Center. It provides 
descriptive and conceptual information, step-by-step guidance to help you 
work with the application, and explanations of reference-oriented material.
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How This Guide is Organized 

This guide contains the following parts:

Part Description

Part I: Performance 
Testing Basics

Provides an overview of HP ALM Performance Center 
and performance testing methodology. 

Relevant task: "How to Conduct a Performance Test" on 
page 28

Part II: Performance 
Testing Assets

Describes how to define project settings and performance 
testing assets.

Relevant task: "How to Manage Testing Assets" on 
page 34

Part III: Timeslot 
Reservation

Describes how to reserve resources for performance 
testing.

Relevant task: "How to Reserve Performance Testing 
Timeslots" on page 112

Part IV: Performance 
Test Design

Describes how to design a performance test.

Relevant task: "How to Design a Performance Test" on 
page 171

Part V: Performance 
Test Execution

Describes how to run a performance test.

Relevant task: "How to Manage a Performance Test Run" 
on page 340

Part VI: Online 
Monitoring

Describes how to set monitors for monitoring 
performance test runs.

Relevant task: "How to Set Up the Monitoring 
Environment – Workflow" on page 417

Part VII: Runtime 
Settings 
Configuration

Describes how to configure runtime settings in your 
Vuser scripts.

Relevant task: "Script Runtime Settings" on page 511
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Documentation Library

The Documentation Library is an online help system that describes how to 
use ALM. You can access the Documentation Library in the following ways:

➤ Click Documentation Library in the ALM Help menu to open the 
Documentation Library home page. The home page provides quick links 
to the main help topics.

➤ Click Help on this page in the ALM Help menu to open the 
Documentation Library to the topic that describes the current page.

Part VIII: My 
Performance Center

Describes how to create a personalized view of 
performance testing features.

Relevant task: "How to Work with My 
Performance Center" on page 565

Part IX: 
Performance Center 
Administration

Describes how to perform Performance Center 
administration.

Relevant task: "How to Work with Performance Center 
Administration" on page 622.

Part Description
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Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Application Lifecycle Management Guides

Reference Description

Using this 
Documentation 
Library 

Explains how to use the Documentation Library and how 
it is organized.

What’s New? Describes the newest features in the latest version of 
ALM. 

To access, select Help > What's New.

Product Feature 
Movies

Short movies that demonstrate the main product 
features.

To access, select Help > Product Feature Movies.

Readme Provides last-minute news and information about ALM.

Guide Description

HP ALM User Guide Explains how to use ALM to organize and execute all 
phases of the application life cycle management process. 
It describes how to specify releases, define requirements, 
plan tests, run tests, and track defects.

HP ALM 
Administrator Guide

Explains how to create and maintain projects using Site 
Administration, and how to customize projects using 
Project Customization.

HP ALM Tutorial A self-paced guide teaching you how to use ALM to 
manage the application life cycle management process.

http://www.adobe.com
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ALM Performance Center Guides

HP ALM Installation 
Guide

Describes the installation and configuration processes for 
setting up ALM Platform.

HP Business Process 
Testing User Guide

Explains how to use Business Process Testing to create 
business process tests.

Guide Description

HP ALM Performance 
Center Quick Start

A self-paced guide giving the Performance Center user a 
high level overview of creating and running performance 
tests.

HP ALM Performance 
Center Guide

Explains to the Performance Center user how to create, 
schedule, run, and monitor performance tests. Explains 
to the Performance Center administrator how to use Lab 
Management for overall lab resource management, lab 
settings management, and system configuration.

HP ALM Performance 
Center Installation 
Guide

Describes the installation processes for setting up 
Performance Center Servers, Performance Center Hosts 
and other Performance Center components.

HP ALM Performance 
Center 
Troubleshooting 
Guide

Provides information for troubleshooting problems while 
working with HP ALM Performance Center.

HP Performance 
Center of Excellence 
Best Practices

Provides best practices for successfully building and 
operating Performance Centers of Excellence.

HP Performance 
Monitoring Best 
Practices

Provides best practices for monitoring the performance 
of applications under test.

Guide Description
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ALM Best Practices

ALM API References

Guide Description

HP ALM Database 
Best Practices Guide

Provides best practices for deploying ALM on database 
servers.

HP ALM Upgrade 
Best Practices Guide

Provides methodologies for preparing and planning your 
ALM upgrade.

HP ALM Business 
Models Module Best 
Practices Guide

Provides best practices for working with the Business 
Models module.

Guide Description

HP ALM Project 
Database Reference

Provides a complete online reference for the project 
database tables and fields.

HP ALM Open Test 
Architecture API 
Reference

Provides a complete online reference for the ALM COM-
based API. You can use the ALM open test architecture to 
integrate your own configuration management, defect 
tracking, and home-grown testing tools with an ALM 
project.

HP ALM Site 
Administration API 
Reference

Provides a complete online reference for the Site 
Administration COM-based API. You can use the Site 
Administration API to enable your application to 
organize, manage, and maintain ALM users, projects, 
domains, connections, and site configuration 
parameters.

HP ALM REST API 
Reference

Provides an online reference for the ALM REST-based API. 
You can use the REST API to access and work with ALM 
data.

HP ALM Custom Test 
Type Guide

Provides a complete online guide for creating your own 
testing tool and integrating it into the ALM 
environment.
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Topic Types

The content in this guide is organized by topics. Three main topic types are 
in use: Concepts, Tasks, and Reference. The topic types are differentiated 
visually using icons.

Topic Type Description Usage

Concepts Background, descriptive, or 
conceptual information. 

Learn general information 
about what a feature does.

Tasks Instructional Tasks. Step-by-
step guidance to help you 
work with the application and 
accomplish your goals. 

Task steps can be with or 
without numbering:

➤ Numbered steps. Tasks that 
are performed by following 
each step in consecutive 
order.

➤ Non-numbered steps. A list 
of self-contained operations 
that you can perform in any 
order.

➤ Learn about the overall 
workflow of a task.

➤ Follow the steps listed in 
a numbered task to 
complete a task.

➤ Perform independent 
operations by 
completing steps in a 
non-numbered task.

Use-case Scenario Tasks. 
Examples of how to perform a 
task for a specific situation.

Learn how a task could be 
performed in a realistic 
scenario.
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Reference General Reference. Detailed 
lists and explanations of 
reference-oriented material.

Look up a specific piece of 
reference information 
relevant to a particular 
context.

User Interface Reference. 
Specialized reference topics 
that describe a particular user 
interface in detail. Selecting 
Help on this page from the 
Help menu in the product 
generally open the user 
interface topics.

Look up specific 
information about what to 
enter or how to use one or 
more specific user interface 
elements, such as a 
window, dialog box, or 
wizard.

Troubleshooting 
and Limitations

Troubleshooting and 
Limitations. Specialized 
reference topics that describe 
commonly encountered 
problems and their solutions, 
and list limitations of a feature 
or product area.

Increase your awareness of 
important issues before 
working with a feature, or 
if you encounter usability 
problems in the software. 

Topic Type Description Usage
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Additional Online Resources

The following additional online resources are available from the ALM Help 
menu:

Part Description

Troubleshooting & 
Knowledge Base

Opens the Troubleshooting page on the HP Software 
Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & 
Knowledge Base. The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support Opens the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You 
can also post to and search user discussion forums, 
submit support requests, download patches and updated 
documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an 
HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site Opens the HP Software Web site. This site provides you 
with the most up-to-date information on HP Software 
products. This includes new software releases, seminars 
and trade shows, customer support, and more. Choose 
Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Add-ins Page Opens the HP Application Lifecycle Management Add-
ins Page, which offers integration and synchronization 
solutions with HP and third-party tools.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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1
HP ALM Performance Center 
Introduction

This chapter includes:

Concepts

➤ HP ALM Performance Center Overview on page 26

Tasks

➤ How to Conduct a Performance Test on page 28
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Concepts

HP ALM Performance Center Overview 

HP ALM Performance Center is a global cross-enterprise performance testing 
tool which enables you to manage multiple, concurrent performance testing 
projects across different geographic locations without any need to travel 
between the locations. Performance Center administers all your internal 
performance testing needs. With Performance Center, you manage all 
aspects of large-scale performance testing projects, including resource 
allocation and scheduling, from a centralized location accessible through 
the Web. Performance Center helps streamline the testing process, reduce 
resource costs, and increase operating efficiency.

Performance Center generates load on your Web server or application using 
HP’s virtual user (Vuser) technology. Each Vuser follows a series of steps (for 
example, hyperlink steps, submit form steps, and so on) that you define in a 
Vuser script. You design Vuser scripts to emulate typical user activity in your 
application. 

Vusers run on dedicated host machines. Each host machine runs many 
Vusers. When run concurrently, the Vusers create the same load as tens of 
thousands of individual human users. While Vusers run, 
Performance Center collects server response time data.

Performance Center analysis tools, which you access both during and after 
the performance test, provide you with a clear and concise picture of your 
application's performance under load. 

Performance Center helps you pinpoint performance bottlenecks. It also 
allows you to determine the number of users your system can scale up to 
(this number is the “breaking point" after which your application's 
performance starts to degrade). This information gives clues as to what can 
be done to increase your application’s load capacity. 

In addition, the information provided by Performance Center helps you 
analyze how the load on your system affects the service level agreements 
(SLAs) or other performance thresholds that are important to your business.
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Performance Center had the following system advantages: 

➤ Performance Center’s step-by-step process helps guide you through the 
performance testing procedure.

➤ Performance Center enables remote testing by anybody, from anywhere, 
at any time, eliminating the need to travel.

➤ Performance Center enables multiple concurrent tests, replacing serial 
testing with parallel testing.

➤ Performance Center enables remote management from anywhere 
through a Web server.

➤ Performance Center is a complete system for managing performance tests, 
scripts, and resources. Furthermore, Performance Center centralizes the 
testing environment, with no duplication of testing labs, keeping costs 
down and minimizing time.

➤ Performance Center enables you to take advantage of the power of the 
Web for supporting services such as remote consulting, online support, 
and so on.

For details on how to conduct a performance test, see "How to Conduct a 
Performance Test" on page 28.
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Tasks

How to Conduct a Performance Test

This task describes how to conduct a performance test on your application.

Note: To view a movie that demonstrates how to conduct a performance 
test, select Help > Product Feature Movies in the ALM main window. Under 
HP ALM Performance Center 11.00 Movies, select Introduction.

To learn more about performance testing, see "HP ALM Performance Center 
Overview" on page 26.

This task includes the following steps:

➤ "Create and add test assets" on page 29

➤ "Reserve a timeslot for performance testing" on page 29

➤ "Design a performance test" on page 29

➤ "Run, monitor, and view results of the performance test" on page 29
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 1 Create and add test assets

For details, see "How to Manage Testing Assets" on page 34.

 2 Reserve a timeslot for performance testing

For details, see "How to Reserve Performance Testing Timeslots" on 
page 112.

 3 Design a performance test

For details, see "How to Design a Performance Test" on page 171.

 4 Run, monitor, and view results of the performance test

For details, see "How to Manage a Performance Test Run" on page 340
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2
Testing Assets - Introduction

This chapter includes:

Tasks

➤ How to Manage Testing Assets on page 34
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Tasks

How to Manage Testing Assets

The following steps describe how to configure project settings and add 
testing assets.

Note: This task is part of a higher-level task. For details, see "How to 
Conduct a Performance Test" on page 28.

This task includes:

➤ "Configure project settings" on page 34

➤ "Upload VuGen Scripts" on page 34

➤ "Design topologies of your applications under test" on page 34

➤ "Create monitor profiles to monitor your tests" on page 35

Configure project settings

You can configure the monitors, runtime settings, timeout, general, and 
debug information options for all your Performance Center projects. For 
details, see "Project Settings > Controller Options Page" on page 659.

Upload VuGen Scripts

After you create Vuser scripts using HP Virtual User Generator, you must 
upload them to ALM. For details, see "How to Upload VuGen Scripts" on 
page 39.

Design topologies of your applications under test

You can design topologies of your applications under test using the 
Topologies feature. For details, see "How to Design Topologies" on page 47.
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Create monitor profiles to monitor your tests

To monitor server resources, you must configure the monitor settings for a 
test. These monitor settings can then be saved as monitor profiles that can 
be used by any performance test in your project. For details on creating 
monitor profiles, see "How to Create and Configure Monitor Profiles" on 
page 75.
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3
VuGen Script Management

This chapter includes:

Concepts

➤ Vuser Scripts on page 38

Tasks

➤ How to Upload VuGen Scripts on page 39

Reference

➤ VuGen Script Management User Interface on page 41
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Concepts

Vuser Scripts 

When you run a performance test, virtual users (Vusers) access your 
application concurrently in order to put load on your server. The actual 
steps that the Vusers perform when accessing your application are 
represented in a Vuser script. Each Vuser performs the actions recorded in 
one Vuser script.

You design Vuser scripts to emulate typical end-user activities on your 
application. For example, if you are testing performance on a Web site, the 
Vuser script emulates a real user accessing URLs, clicking links, submitting 
forms, and so on. When you create a performance test, you distribute your 
Vuser scripts among your Vusers. 

For example, in the case of testing a Web site, you can specify that a portion 
of the Vusers run a Vuser script that emulates real users accessing your home 
page, a portion run a script that performs a search query, and a portion 
emulate the completion of an order form.

You obtain Vuser scripts by recording them using HP’s Virtual User 
Generator (VuGen) and uploading them to ALM. 

In addition to testing Web sites, Performance Center can be used to test 
performance of non-Web environments. For example, you can test WAP, 
Real, or Oracle NCA applications. For details of supported protocols, see the 
HP Virtual User Generator User Guide.

For details on how to upload VuGen scripts to ALM, see "How to Upload 
VuGen Scripts" on page 39.
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Tasks

How to Upload VuGen Scripts

This task describes how to upload VuGen scripts to ALM. 

Note: This task is part of a higher-level task. For details, see "How to Manage 
Testing Assets" on page 34.

This task includes the following steps:

➤ "Prerequisite" on page 39

➤ "Upload the VuGen scripts to ALM" on page 39

 1 Prerequisite

Create scripts in VuGen. For details, see the HP Virtual User Generator User 
Guide.

 2 Upload the VuGen scripts to ALM

You can upload scripts in one of the following ways:

➤ To upload scripts from the Test Plan module:

➤ Save the VuGen scripts locally. The scripts must be saved in ZIP 
format and must include all the files in the test scripts folder.

➤ On the Test Plan module toolbar, click the Upload Scripts button. 

➤ Select a destination folder, scripts to upload, and upload options.

For user interface details, see "Upload VuGen Scripts Dialog Box" on 
page 42.
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➤ Upload the scripts from VuGen to ALM.

For details about uploading VuGen scripts from VuGen to ALM, see the 
section about saving VuGen scripts to ALM in the HP Virtual User 
Generator User Guide.
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Reference

VuGen Script Management User Interface 

This section includes:

 ➤ Upload VuGen Scripts Dialog Box on page 42
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Upload VuGen Scripts Dialog Box

This dialog box enables you to upload VuGen scripts to ALM. 

 

To access 1  On the ALM sidebar, under Testing, select Test Plan.

2  On the Test Plan module toolbar, click the Upload 
Scripts  button.

Important 
information

➤ The Upload VuGen Scripts dialog box is intended for 
uploading VuGen scripts only. The VuGen scripts must 
be saved locally, must be in ZIP format, and must 
include all the files in the test scripts folder.

➤ You cannot upload QTP or ST tests using the Upload 
VuGen Scripts dialog box. To upload QTP or ST tests, 
see the relevant product’s User Guide.
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User interface elements are described below:

Relevant tasks "How to Upload VuGen Scripts" on page 39

See also "Vuser Scripts" on page 38

UI Elements Description

Uploads the selected VuGen Scripts to the specified 
destination folder.

Select Folder The destination folder for the uploaded scripts.

Note: The folder name must not contain a forward slash 
(/). For more details, see "Troubleshooting and 
Limitations" on page 44.

Select Scripts Enables you to select up to five scripts. 

Note: The scripts must be saved locally, must be in ZIP 
format, and must include all the files in the test scripts 
folder.

If Script Exist Action to take if the script already exists in the 
destination folder.

➤ Auto Rename Script. Automatically gives the script a 
different name.

➤ Overwrite Existing Script. Overwrites the existing 
script.

Upload Method The method to use for uploading the script:

➤ Upload All Files. Uploads all the files contained in the 
.zip file. With this option the upload takes a long time.

➤ Upload runtime files only. Only the runtime files—
that is the scripts, runtime settings, parameters, and so 
on—are uploaded.
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Troubleshooting and Limitations 

This section describes troubleshooting and limitations for uploading VuGen 
scripts.

➤ If the name of the folder to which you are uploading VuGen scripts 
contains a forward slash (/) you cannot upload the scripts using the 
Upload VuGen Scripts dialog box. Either rename the folder so that it does 
not contain a forward slash (/) or upload the scripts from VuGen.

Versioning > Keep 
checked out

For version enabled projects, keeps the uploaded scripts 
checked out. 

Version Control: When you upload a script, it is available 
only for your own use until you check it in. After you 
check the script in, other users can access the script as 
well.

Messages Enables you to enter messages and comments about the 
script upload.

UI Elements Description
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4
Topologies

This chapter includes:

Concepts

➤ Topologies Overview on page 46

Tasks

➤ How to Design Topologies on page 47

➤ How to Design Topologies - Use-Case Scenario on page 51

Reference

➤ Topologies User Interface on page 59
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Concepts

Topologies Overview 

ALM Performance Center can articulate the topology of your application 
under test (AUT) and use it as an interface for defining performance 
monitors by integrating with HP SiteScope. 

Using topologies, you can:

➤ Manage an inventory of application under test (AUT) hosts which are 
grouped into AUT host pools, similar to Performance Center hosts and 
host pools

➤ Visually understand the tested environment

➤ Configure monitors using best practice monitor templates

➤ Pinpoint runtime performance issues by highlighting a topology node's 
status based on the SiteScope monitor thresholds

The SiteScope user interface hosted in ALM Performance Center enables 
leveraging SiteScope functionality in a use-case oriented approach, without 
requiring additional monitor configuration on the ALM Performance Center 
side. 

During runtime, the AUT schema with comprehensive SiteScope monitor 
data is displayed in different monitor graphs in the ALM 
Performance Center run screen and measurement names can be identified 
and filtered.

For details on designing topologies, see "How to Design Topologies" on 
page 47.
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Tasks

How to Design Topologies

This section describes how to design a topology that graphically displays the 
logical components that make up your application under test (AUT) and the 
relationships between the components. This provides a useful method for 
managing your inventory of AUT hosts and enables topology-oriented 
monitoring and analysis.

Note: 

➤ This task is part of a higher-level task. For details, see "How to Manage 
Testing Assets" on page 34.

➤ Ensure that SiteScope is installed and configured to integrate with 
ALM Performance Center. For details, see the section about installing 
SiteScope in the HP ALM Performance Center Installation Guide.

➤ After you have designed a topology you can select it for a performance 
test when you design the test.

➤ Product Feature Movie. To view a movie that demonstrates how to 
design topologies, select Help > Product Feature Movies in the ALM main 
window. Under HP ALM Performance Center 11.00 Movies, select 
Topologies and SiteScope Integration.

Tip: For a use-case scenario related to this task, see "How to Design 
Topologies - Use-Case Scenario" on page 51.

To learn more about topologies, see "Topologies Overview" on page 46.
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This task includes the following steps:

➤ "Create an empty topology" on page 48

➤ "Design the topology" on page 48

➤ "Add the AUT hosts" on page 49

➤ "Configure the component properties" on page 50

➤ "Configure monitors on the components" on page 50

➤ "Results" on page 51

 1 Create an empty topology

 a On the ALM sidebar, under Lab Resources, select Topologies. 

 b To create a topology folder, click the New Folder button, and enter the 
folder name.

 c Click the New Topology button and enter the topology details. To add 
SiteScope monitors to the topology, specify the SiteScope server 
details. 

For details about the topology fields, see "Topologies Module Fields" on 
page 62.

 2 Design the topology

Note: The Topology Designer window opens automatically when you 
create a new topology. If the Topology Designer window did not open, 
right-click the topology and select Design Topology.

In the Topology Designer window:

 a From the palette on the left, select relevant nodes representing the 
components in your AUT and drag them onto the Topology canvas.

 b To connect two components, click one component (ensure that it is 
not selected) and drag the cursor to the other component.
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 3 Add the AUT hosts

Define the machines that host the relevant components of the AUT. 

On the Topology Designer toolbar, click New AUT Host to define the 
machines hosting your AUT.

Tip: If you have an Excel file listing your AUT hosts, you can import the 
list of AUT hosts into ALM. For details, see "How to Import AUT Host Data 
from Excel" on page 863.

You can view the list of AUT hosts in the AUT Hosts tab on the left.
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 4 Configure the component properties

Select a component and, in the Properties pane in the top left corner of 
the Topology Designer, enter the relevant properties for that component. 
For successful integration with SiteScope, ensure that you select the 
relevant AUT host, and that all of the relevant properties are accurate.

Tip: When you click a property, a description is displayed in the lower 
area of the Properties pane.

Repeat this procedure for each of the relevant components.

 5 Configure monitors on the components

You can configure groups of monitors for the components on AUT hosts. 
Ensure that the AUT host details are accurate for each relevant 
component. 

➤ To deploy relevant system-defined monitors on specific components 
on your canvas, select the components, right-click the selection, and 
select Deploy Monitor Templates. Monitor groups are created in 
SiteScope for each selected component, and each group is 
automatically configured with relevant system-defined monitors.

➤ To configure monitors for a component manually in SiteScope, 
right-click the component and select Configure Monitors. For more 
details about configuring monitors in SiteScope, see the HP SiteScope 
User Guide.

Note: The AUT host defined in a component’s properties is passed to 
SiteScope as a remote host and is inserted as the default monitored server 
for all monitors created for this component.
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 6 Results

After you save the topology, you can select the designed topology for your 
performance test. For details, see "Performance Test Designer > Topology 
Tab" on page 71. 

During a test run, you can view the SiteScope monitor activity on the 
relevant components in your AUT. For details, see "Topology Tab" on 
page 370.

How to Design Topologies - Use-Case Scenario 
This use-case scenario describes how to design a topology that graphically 
displays the logical components that make up your application under test 
(AUT) and the relationships between the components. 

Note: For a task related to this use-case scenario, see "How to Design 
Topologies" on page 47.

This scenario includes the following steps:

➤ "Background" on page 52

➤ "Create the topology and design the outline" on page 52

➤ "Add the AUT hosts" on page 54

➤ "Define the component properties" on page 55

➤ "Deploy the monitor templates" on page 57

➤ "Results" on page 58
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 1 Background

John is a performance engineer working with HP Web Tours. He would 
like to design a performance test for the application.

As a first step, he would like to model the application in ALM 
Performance Center so that he can keep track of the topology of his 
application under test. Using this model, he can benefit from the 
monitoring and online view features that the topology feature offers.

 2 Create the topology and design the outline

 a On the ALM sidebar, under Lab Resources, John selects Topologies to 
open the Topology module, and clicks the New Topology button to 
create new topology. He calls the topology WebTours, and enters the 
details of the SiteScope server with which the application will interact 
for monitoring purposes. 

When John clicks OK, the Topology Designer window opens, 
displaying the Topology canvas which, at this stage, is empty. 

 b John’s Web Tours application comprises the following components: 
A Web server, an application server, and a database server. The user 
accesses the application through a client workstation.

In the Topology Designer window, from the palette in the left, John 
drags the nodes representing these components onto the Topology 
canvas, and changes their captions to names that are relevant to the 
components they represent. 
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John drags the following nodes:

Palette 
Category

Component New Caption

Web Servers Microsoft IIS Web Server

Application Microsoft ASP Server Application Server

Database Microsoft SQL Server Database Server

Miscellaneous Workstation Client

Miscellaneous User User
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 c John connects the application server to the Web server by clicking the 
application server (ensuring that it is not selected) and dragging the 
cursor over to the Web server. 

Similarly, he connects the application server to the database server, the 
client workstation to the Web server, and the user to the client.

 3 Add the AUT hosts

The AUT hosts are the physical machines that host the relevant 
components of the application under test. 

On the Topology Designer toolbar, John clicks New AUT Host, and enters 
the name and details of the machine that hosts the database server: 

John then adds the AUT host that hosts both the application and Web 
servers. 
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Tips: 

➤ Alternatively, if John had an Excel file listing the AUT hosts in his 
system, he could have imported the list of AUT hosts to ALM. For 
details, see "How to Import AUT Host Data from Excel" on page 863.

➤ John can view the list of AUT hosts in the AUT Hosts tab by clicking 
AUT Hosts at the bottom of the Palette tab.

 4 Define the component properties

For successful integration with SiteScope, John needs to ensure that the 
properties for each component are defined correctly.

John selects each component and, in the Properties pane in the top right 
corner of the Topology Designer window, he provides the relevant 
properties. The properties differ from one type of component to another. 

Tip: A description for each property is displayed in the lower area of the 
Properties pane, and helps John to understand what information to 
provide for each property. 
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For example, for the database server, John selects machine33 from the 
AUT Host drop-down list, and accepts the default values for all of the 
other properties. Then he provides the relevant details for the application 
and Web servers.
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 5 Deploy the monitor templates

John selects the three servers and clicks Deploy Monitor Templates. ALM 
creates a monitor group in SiteScope for each of the selected components, 
and deploys the relevant system-defined monitor templates for each 
component. Because the AUT Host Templates property is enabled, the 
templates for the actual AUT host are deployed as well.

Tip: If John wants to view or modify these monitors, he can do so by 
clicking Configure Monitors on the toolbar, which opens HP SiteScope 
and displays the monitor trees that were created for each component.
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 6 Results

John saves the topology and closes the Topology Designer window. He 
selects this topology when designing the performance test for the 
Web Tours application. When he runs the test, he can view the SiteScope 
monitor activity on the relevant components in the application in the 
Performance Test Run page.
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Reference

Topologies User Interface 

This section includes:

 ➤ Topologies Module on page 60

 ➤ Topologies Module Fields on page 62

 ➤ New Topology Dialog Box on page 64

 ➤ Topology Details Dialog Box on page 66

 ➤ Topology Designer Window on page 68

 ➤ Performance Test Designer > Topology Tab on page 71
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Topologies Module 

This module lists the topologies that you have defined.

 

To access On the ALM sidebar, under Lab Resources, select 
Topologies.

Important 
information

After you have designed a topology for your performance 
test, you must associate it with your test. For details 
about associating a topology with a test, see 
"Performance Test Designer > Topology Tab" on page 71. 

Relevant tasks "How to Design Topologies" on page 47

See also "Topologies Overview" on page 46
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

New Topology Folder. Enables you to create a topology 
folder.

New Topology. Enables you to create a new topology.

Opens the Topology Designer window, enabling you to 
design topologies. For details, see "Topology Designer 
Window" on page 68.

Delete. Enables you to delete the selected topologies.

Cut/Paste. Enables you to cut and paste the selected 
topology from one topology folder to another.

Refresh All. Refreshed the page so that it displays the 
most up-to-date information. 

Set Filter/Sort. Enables you to filter and sort the 
topologies. Any currently applied filters or sorting orders 
are displayed below the toolbar. For more details, see the 
HP Application Lifecycle Management User Guide.

Attachments. Enables you to add attachments that 
provide additional information about the topology. For 
more details, see the HP Application Lifecycle Management 
User Guide.

<Topologies tree> Located on the left side of the window, organizes and 
displays your topologies hierarchically.

Preview tab Displays a preview of the topology selected in the 
Topology tree.

➤ Properties pane. Displays general details about a node 
selected in the topology on the left. If an AUT host is 
configured on the node, the host’s details are 
displayed as well.

➤ Overview pane. Displays a full overview of the 
topology structure.
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Topologies Module Fields 

This section describes the Topologies module fields:

Details tab Displays the details of the selected topology. For details, 
see "Topology Details Dialog Box" on page 66.

Attachments tab Lists attachments that provide additional information 
about the currently selected topology. For details, see the 
HP Application Lifecycle Management User Guide.

Dependencies tab Displays dependency relationships that exist between 
entities. For more information, see the HP Application 
Lifecycle Management User Guide.

History tab Lists changes made to the selected topology. For more 
details, see the HP Application Lifecycle Management User 
Guide.

Field (A-Z) Description

Created by The user who created the topology.

Creation Date The date and time the topology was created.

Enable Monitors Always enables SiteScope monitors, or enables them 
automatically during monitor configuration and 
performance test runs.

Modified The date and time the topology was last modified.

Modified by The user who last modified the topology.

UI Elements Description
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SiteScope Port The port defined for SiteScope during installation of 
SiteScope. 

Default value:

➤ Non-SSL: 8080

➤ SSL: 8443

For details, see the section about installing SiteScope for 
Performance Center in the HP ALM Performance Center 
Installation Guide. 

SiteScope Server The name of the SiteScope server.

SiteScope SSL Indicates whether or not SiteScope uses SSL.

Topology Name A name for the topology. 

Field (A-Z) Description
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New Topology Dialog Box

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access On the ALM sidebar, under Lab Resources, select 
Topologies. Click the New Topology  button.

Relevant tasks "How to Design Topologies" on page 47

See also "Topologies Overview" on page 46

UI Elements Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.
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Spelling Options. Enables you to configure how to check 
the spelling.

Topology Name The name of the topology.

Details Enables you to enter the details of the selected topology. 
Required fields are marked with an asterisk (*) and are 
displayed in red. 

For details, see "Topologies Module Fields" on page 62.

Attachments Lists attachments that provide additional information 
about the currently selected topology. For details, see 
HP Application Lifecycle Management User Guide.

UI Elements Description
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Topology Details Dialog Box 

This dialog box enables you to view topology details.

 

User interface elements are described below:

To access 1  On the ALM sidebar, under Lab Resources, select 
Topologies. 

2  Select a topology in the Topology tree, and click the 
Attachments  button. Then click Details.

Relevant tasks "How to Design Topologies" on page 47

See also "Topologies Overview" on page 46

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of topologies.

Spell Check. Checks the spelling for the selected word or 
text box. 
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Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Topology Name The name of the topology.

Details Displays the details of the selected topology. For more 
details, see "Topologies Module Fields" on page 62.

Attachments Lists attachments that provide additional information 
about the currently selected topology. For details, see the 
HP Application Lifecycle Management User Guide.

Dependencies Displays dependency relationships that exist between 
entities. For more information, see the HP Application 
Lifecycle Management User Guide.

History Lists changes made to the selected topology. For more 
details, see the HP Application Lifecycle Management User 
Guide.

UI Elements Description
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Topology Designer Window 

 

To access On the ALM sidebar, under Lab Resources, select 
Topologies. In the tree, select a topology, and click 

.

Important 
information

After you have designed a topology for your performance 
test, you must select it for your test. For more details, see 
"Performance Test Designer > Topology Tab" on page 71. 

Relevant tasks "How to Design Topologies" on page 47

See also "Topologies Overview" on page 46
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Enables you to close the Topology Designer window. 

Enables you to save the topology and close the Topology 
Designer.

Save Topology. Enables you to save your topology.

Rename. Enables you to rename the node selected on 
the canvas.

Delete. Enables you to delete the nodes selected on the 
canvas.

Undo/Redo. Enables you to undo or redo the previous 
action.

Zoom in/out. Enables you to zoom in and out of the 
canvas.

Fit to screen. Enables you to fit the whole topology 
design to the current screen size.

Opens the New AUT Host dialog box, enabling you to 
add a new AUT host. For details, see "New AUT Host 
Dialog Box" on page 873. 

Tip: If you have a list of AUT hosts set up in an Excel file, 
you can import this list instead of adding the hosts one 
by one. For details, see "How to Import AUT Host Data 
from Excel" on page 863.

Opens the Configure Monitors dialog box, enabling you 
to manually configure SiteScope monitors on the 
selected node. For details about creating SiteScope 
monitors, see the HP SiteScope User Guide.

Note: When configuring monitors for these components 
in SiteScope, the value for Monitor Run Settings > 
Frequency should be changed to a more suitable value, 
such as 5 - 15 seconds.
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Opens the Deploy Monitor Templates dialog box, 
enabling you to configure SiteScope monitors on the 
selected node automatically by deploying a template 
monitor set. 

Enables you to export the whole area of the topology, or 
only the visible region of the topology to an image file.

Palette tab Enables you to select components to add to the canvas.

The palette includes various types of server categories, as 
well as a Miscellaneous category. This category includes 
nodes that are not necessarily AUT-specific but that 
complete the topology design, such as a user or a client 
workstation.

AUT Hosts tab Displays all AUT hosts defined in the projects AUT host 
pool.

Topology canvas Provides a canvas where you can lay out the topology by 
dragging components/server nodes and linking them to 
each other.

Properties pane Enables you to define properties for the node selected on 
the canvas. 

The lower section of the Properties pane displays a 
description of the selected property.

Overview pane Displays an overview of the topology’s structure.

UI Elements Description



Chapter 4 • Topologies

71

Performance Test Designer > Topology Tab 

This tab enables you to select a topology for a performance test.

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Topology tab.

Important 
information

You design topologies in the Topologies module. After 
you have designed topologies, you can select one of them 
for a performance test.

Relevant tasks ➤ "How to Design a Performance Test" on page 171

➤ "How to Design Topologies" on page 47

See also "Topologies Overview" on page 46
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Opens the Topologies tree in the right pane, enabling 
you to select a topology for the test.

Enables you to remove the selected topology.

Zoom in. Enables you to zoom into the displayed 
topology.

Zoom out. Enables you to zoom out of the displayed 
topology.

Fit to panel. Enables you to fit the topology to the size of 
the Topology pane.

Topologies tree Opens when you click , enabling you 
to select a topology for the test.

Expand the Topologies tree, select a topology, and click 
 to move it to the Topology pane on the left.

To refresh the tree, click .

Topology pane Displays the selected topology.
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5
Monitor Profiles 

This chapter includes:

Concepts

➤ Monitor Profiles Overview on page 74

Tasks

➤ How to Create and Configure Monitor Profiles on page 75

Reference

➤ Monitor Profiles User Interface on page 78
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Concepts

Monitor Profiles Overview 

You monitor performance test execution using the Performance Center 
online monitors. To monitor server resources, you must configure the 
monitor settings for a performance test. You select the type of monitors to 
run, the servers whose resources you want to monitor, and add the 
measurements to monitor for each server. These monitor settings can then 
be saved as a monitor profile that can be used by any performance test in 
your project.

For details about creating monitor profiles, see "How to Create and 
Configure Monitor Profiles" on page 75.
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Tasks

How to Create and Configure Monitor Profiles

This task describes how to create and configure a monitor profile.

Note: This task is part of a higher-level task. For details, see "How to Manage 
Testing Assets" on page 34.

To learn more about monitor profiles, see "Monitor Profiles Overview" on 
page 74.

This task includes the following steps:

➤ "Prerequisites" on page 76

➤ "Create the monitor profile test resource type" on page 77

➤ "Add monitors to the monitor profile" on page 77
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 1 Prerequisites

To use the following monitors, you must first install or configure 
monitoring components on the server machine. For task details about 
configuring the monitoring components, see the specific monitoring 
sections listed below.

➤ Citrix. For task details, see "How to Set up the Citrix Monitoring 
Environment" on page 499.

➤ J2EE & .NET. For task details, see "How to Enable and Configure J2EE/
.NET Diagnostics" on page 292. 

➤ Network Delay. For task details, see "How to Set Up the Network 
Monitoring Environment" on page 450.

➤ Oracle. For task details, see "How to Set Up the Oracle Monitoring 
Environment" on page 471.

➤ PeopleSoft (Tuxedo). For task details, see "How to Set Up the 
PeopleSoft (Tuxedo) Resource Monitor" on page 481.

➤ SAPGUI. For task details, see "How to Set Up the SAPGUI Server 
Resource Monitor" on page 483.

➤ Tuxedo. For task details, see "How to Set Up the Tuxedo Monitoring 
Environment" on page 491.

➤ UNIX. For task details, see "How to Set up the UNIX Monitoring 
Environment" on page 440.



Chapter 5 • Monitor Profiles

77

 2 Create the monitor profile test resource type

You create test resources from the Test Resources module. For task details, 
see the HP Application Lifecycle Management User Guide. 

 3 Add monitors to the monitor profile

 a In the Test Resources module, select a monitor profile, select the 
Monitors Configuration tab, and then click the Add Monitor button. 
In the Add New Monitor page that opens, select the monitor that you 
want to run.

 b In the Edit Monitor page, enter the required information and select the 
counters that you want to monitor. The Edit Monitor page varies 
depending on which monitor type you select:

➤ For Windows Resources, UNIX, Apache, MS IIS, MS ASP, Citrix, SQL, 
Oracle, TUXEDO, PeopleSoft (Tuxedo), or SAPGUI monitors user 
interface details, see "Edit Monitors Dialog Box" on page 83.

➤ For SNMP monitor user interface details, see "Edit SNMP Monitors 
Dialog Box" on page 85.

➤ For SiteScope monitor user interface details, see "Edit SiteScope 
Monitors Dialog Box" on page 86.

➤ For Network Delay Time monitor user interface details, see "Edit 
Network Delay Time Monitors Dialog Box" on page 87.
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Reference

Monitor Profiles User Interface 

This section includes:

 ➤ Monitors Configuration Page on page 79

 ➤ Add New Monitors Page on page 81

 ➤ Edit Monitors Dialog Box on page 83

 ➤ Edit SNMP Monitors Dialog Box on page 85

 ➤ Edit SiteScope Monitors Dialog Box on page 86

 ➤ Edit Network Delay Time Monitors Dialog Box on page 87

 ➤ Performance Test Designer > Monitors Tab on page 90
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Monitors Configuration Page

This page enables you to add and edit monitors that are part of a monitor 
profile.
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User interface elements are described below:

To access Use one of the following:

➤ In the Test Resources module, select a monitor profile 
in the test resource tree and click the Monitors 
Configuration tab.

➤ In the Performance Test Designer, click the Monitors 
tab, and then click View Selected.

Relevant tasks ➤ "How to Create and Configure Monitor Profiles" on 
page 75

➤ "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

Add Monitor. Opens the Add New Monitor page enabling 
you to select which monitors to run in the monitor 
profile.

Edit Monitor. Enables you to edit the selected monitor.

Delete Selected Item. Deletes the selected item from the 
monitor profile.

Refresh Monitor List. Refreshes the monitors list.

Counters The counters that are being monitored. 

Monitor The name of the monitor.

Server The server whose resources are being monitored.
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Add New Monitors Page

This page enables you to select the monitor type to add to a monitor profile.

User interface elements are described below:

To access Use one of the following:

➤ In the Test Resources module, select a monitor profile 
in the test resource tree and click the Monitors 
Configuration tab. Then click the Add Monitor 
button .

➤ In the Run-Time Monitors dialog box, click the 
Add Monitor button . For more information, see 
"Monitor Profile Content Dialog Box" on page 383.

Relevant tasks ➤ "How to Create and Configure Monitor Profiles" on 
page 75

➤ "How to Manage a Performance Test Run" on page 340

UI Elements Description

Windows Resources

Unix Resources

Apache

MS IIS

MS ASP

Citrix Server

SQL Server

Oracle

TUXEDO

PeopleSoft (Tuxedo)

SAPGUI

Enables you to select the specific counters for this 
monitor type. For more information, see "Edit Monitors 
Dialog Box" on page 83.

SNMP Opens the Edit Monitors Page, which enables you to 
select the specific counters that you want to monitor for 
this monitor type. For more information, see "Edit SNMP 
Monitors Dialog Box" on page 85.
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SiteScope Opens the Edit Monitors Page, which enables you to 
select the specific counters that you want to monitor for 
this monitor type. For more information, see "Edit 
SiteScope Monitors Dialog Box" on page 86.

Network Delay Time Opens the Edit Monitors Page, which enables you to 
select the specific counters that you want to monitor for 
this monitor type. For more information, see "Edit 
Network Delay Time Monitors Dialog Box" on page 87.

UI Elements Description
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Edit Monitors Dialog Box

This dialog box enables you to define the server whose resources you want 
to monitor, and to select the counters to be monitor.

User interface elements are described below:

To access In the Test Resources module, select a monitor profile in 
the test resource tree and click the Monitors 
Configuration tab. Click the Add Monitor  button, 
and then select one of: Windows Resources, UNIX 
Resources, Apache, MS IIS, MS ASP, Citrix, SQL, Oracle, 
Tuxedo, PeopleSoft, SAPGUI.

Important 
information

This dialog box contains information relevant for the 
following monitor types: Windows Resources, UNIX 
Resources, Apache, MS IIS, MS Active Server Pages, Citrix, 
SQL, Oracle, TUXEDO, PeopleSoft (Tuxedo), SAPGUI

Relevant tasks "How to Create and Configure Monitor Profiles" on 
page 75

UI Elements (A-Z) Description

Click to display a list of available counters.

Available Counters A list of available counters for the selected monitor.

Client The PeopleSoft (Tuxedo)/SAPGUI client.

Available for: PeopleSoft, TUXEDO, SAPGUI

Password The monitored server’s password, if relevant.

Port The port number of the Apache server.

Note: To monitor an Apache server through a firewall, 
use the Web server port (by default, port 80).

Available for: Apache

SAP Server The SAP Server.

Available for: SAPGUI

Selected Counters A list of selected counters for the monitor.
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Server The name or IP address of the server whose resources you 
want to monitor.

URL (Apache only) The Server statistics information URL. To verify the 
statistics information URL, try to view it through the 
browser using the following format: 
http://<server_name/IP address>:<port_number>/
server-status?auto 
For example: http://stimpy:80/server-status?auto.

Format: Enter the server statistics information URL, 
without the server name. 

Default value: /server-status?auto

Note: The default port number and URL can vary from 
one server to another. Consult your Web server 
administrator.

Available for: Apache

User Name The monitored server’s user name, if relevant.

UI Elements (A-Z) Description
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Edit SNMP Monitors Dialog Box 

This dialog box enables you to define the SNMP server whose resources you 
want to monitor, and to select the counters to monitored.

User interface elements are described below:

To access In the Test Resources module, select a monitor profile in 
the test resource tree and click the Monitors 
Configuration tab. Click the Add Monitor  button, 
and then select SNMP.

Relevant tasks "How to Create and Configure Monitor Profiles" on 
page 75

UI Elements (A-Z) Description

Click to display a list of available counters.

<choose counters 
area>

Displays a list of available counters. 

Default: Displays all nodes of the SNMP objects in a 
tree-level hierarchy.

Concatenate SNMP 
Levels

For SNMP object nodes with ten or more levels, select to 
display the sub-levels as a single string, separated by 
periods (.). 

Server Enter the name or IP address of the server to monitor.

Note: Performance Center connects to default SNMP port 
161. To use a different port number, specify the machine 
name in the following format:

<server name>:<port number>
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Edit SiteScope Monitors Dialog Box 

This dialog box enables you to define the SiteScope server whose resources 
you want to monitor, and to select the counters to monitor.

User interface elements are described below:

To access In the Test Resources module, select a monitor profile in 
the test resource tree and click the Monitors 
Configuration tab. Click the Add Monitor  button, 
and then select SiteScope.

Relevant tasks "How to Create and Configure Monitor Profiles" on 
page 75

UI Elements (A-Z) Description

Click to display a list of available counters.

Password When Use Account is selected, enter the relevant 
password. 

Port The SiteScope port.

Default: 8888

Server The SiteScope server name.

Use Account Select when SiteScope is working in secure mode, which 
requires authentication. Enter the SiteScope account 
name, user name and password in the corresponding 
fields.

Use HTTPS Specify if you are using a secure HTTP connection.

User Name When Use Account is selected, enter the relevant user 
name.
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Edit Network Delay Time Monitors Dialog Box 

This dialog box enables you to define the Network Delay Time server whose 
resources you want to monitor, and to select the counters to monitor.

User interface elements are described below:

To access In the Test Resources module, select a monitor profile in 
the test resource tree and click the Monitors 
Configuration tab. Click the Add Monitor  button, 
then select Network Delay Time.

Relevant tasks "How to Create and Configure Monitor Profiles" on 
page 75

UI Elements (A-Z) Description

Uses the default values.

Destination Machine The name of the machine at the final destination of the 
path you want to monitor.

Note: If the destination machine is localhost, type the 
local machine’s name and not localhost.

Monitor Frequency Send next packet Xmilliseconds after receipt of previous 
packet. Select the number of milliseconds the monitor 
should wait between receiving a packet and sending out 
the next packet. If you have a long, steady load test, you 
can increase the interval by several seconds.

Default: 3000 milliseconds
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Monitor Settings ➤ Send Request Using Xprotocol. Select the relevant 
protocol. It is recommended that you keep the default 
protocol. In Windows, the default is TCP, and in 
UNIX, the default is UDP.

➤ Send request to port X. Enter the port number being 
used by the network path.

➤ Enable display of network nodes by DNS names. Select 
to view the DNS name of each node along the network 
path, in addition to its IP address. Note that selecting 
this option decreases the speed of the Network 
monitor.

Monitoring Packet 
Retries

➤ Wait Xseconds for packet to return before retrying. 
Select the maximum number of seconds that the 
monitor should wait for a packet to return before it 
retries to send the packet.

Default: 3 seconds. If your network is very large and 
loaded (an internet connection with a low capacity), 
increase the value by several seconds. If you have a 
small network (such as a LAN), decrease the value.

➤ Number of retries. Select the number of times the 
Network monitor should try resending a packet to a 
node if the packet is not initially returned. 

Default: 0

UI Elements (A-Z) Description
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Platform The platform on which the machine runs. 

Source Machine The name of the source machine from which you want 
the network path monitoring to begin.

Note: To run the Network Delay Monitor when there are 
firewalls between the Performance Center Host machine 
and the source machine, type the server name or IP 
address of the source machine according to the format:

<MI Listener machine>:<source machine local key>

Where source machine local key is the unique key that 
you chose when configuring the Performance Center 
agent on the source machine.

For example, 

12.12.12.3:vds

For more information about working with firewalls in 
Performance Center, see the section about firewalls in the 
HP ALM Performance Center Installation Guide.

UI Elements (A-Z) Description
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Performance Test Designer > Monitors Tab 

This tab enables you to select monitor profiles and monitor-over-firewall 
agents to use in your performance test.

User interface elements are described below:

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Monitors tab.

Important 
information

You must have monitor profiles defined before you can 
select them for the test.

Relevant tasks ➤ "How to Design a Performance Test" on page 171

➤ "How to Create and Configure Monitor Profiles" on 
page 75

See also "Monitor Profiles Overview" on page 74

UI Elements(A-Z) Description

Opens the Monitor Profiles tree in the right pane, 
enabling you to select a monitor profile for the test.

Opens the Monitors Over Firewall tree in the right pane, 
enabling you tot select a monitor-over-firewall agent for 
the test.
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Opens a window that displays all of the measurements of 
the selected monitor profile.

Removes the selected monitor profile or 
monitor-over-firewall agent from the test.

Associated Monitors 
grid

Displays the monitors and monitor-over-firewall agents 
selected for the test.

Monitor Profile Tree 
/ Monitors Over 
Firewall Tree

Enables you to select a monitor profile or 
monitor-over-firewall agent for the test. 

Expand the Resources tree, select a monitor profile or 
monitor-over-firewall agent, and click  to move it to 
the Associated Monitors grid on the left.

UI Elements(A-Z) Description
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6
Reserving Timeslots

This chapter includes:

Concepts

➤ Reserving Timeslots Overview on page 96

➤ Host Allocation on page 102

Tasks

➤ How to Reserve Performance Testing Timeslots on page 112

➤ How to Reserve Maintenance Timeslots  (Lab Management only) 
on page 115

Reference

➤ Reserving Timeslots User Interface on page 117
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Concepts

Reserving Timeslots Overview 

When performance testers want to run performance tests, or need to 
perform maintenance on host machines (administrators only), the resources 
needed for these tasks must be available, and must fall within the project 
and license limits. Performance Center’s timeslots feature enables you to 
reserve resources in advance to ensure that the required resources are 
available when you are ready to perform the tasks. Performance Center itself 
also reserves resources needed for data processing tasks.

This section includes:

➤ "Types of Timeslot Reservations" on page 97

➤ "Autostart Timeslots" on page 99

➤ "Prolonging Timeslot Reservations" on page 101

➤ "Modifying Timeslot Reservations" on page 101

➤ "Understanding Timeslot Failure" on page 102
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Types of Timeslot Reservations
Timeslots can be reserved ad hoc or manually. This section describes these 
two types of timeslot reservations.

Ad Hoc Timeslot Reservations 

An ad hoc timeslot reserves resources for a task at hand.

For example:

➤ Administration: If you want to perform administrative tasks on 
particular hosts, such as installing patches, when you start the task—
and provided that the hosts are available at the time—
Performance Center automatically reserves the requested hosts in an 
ad hoc maintenance timeslot during which the hosts cannot be used 
for any other purpose.

➤ Performance Testing: When you start running a performance test 
manually, before the test starts to run, you specify how much time you 
need to run the test. Performance Center checks if the required hosts 
and Vusers are currently available for that amount of time, and that 
the license and project limits are not exceeded, in which case, you can 
reserve the hosts and Vusers for that timeslot. If the hosts and Vusers 
are not available, or license/project limits have been exceeded, you 
cannot run the test at that time and need to try again at a later time.

➤ Data Processing: Tasks such as test result analysis, SLA status 
publication, and trending are performed on a data processor host. 
Performance Center estimates how long a data processor host is 
needed for the task at hand. As soon as a data processor becomes 
available for this task, an ad hoc reservation is automatically made.
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Manual Timeslot Reservations

If you know which testing resources (hosts and Vusers) you need for 
running a performance test, or the hosts on which you need to perform 
maintenance, you can manually reserve the resources in advance for a 
specified amount of time.

For performance testing timeslots, you must request at least one Controller 
and one load generator. These can be specific hosts, or alternatively, you can 
request automatch hosts. When you select automatch hosts, you allow 
Performance Center to allocate any available host whose properties match 
those of the automatch host. For more details, see the "Load Generator 
Types" on page 222.

If you have a test linked to the timeslot, the hosts and Vusers defined in the 
test are automatically requested for the timeslot, and you can request 
additional resources.

A timeslot can be reserved successfully only if all of the requested Vusers are 
available, and all of the hosts can be allocated. 

Tip: All users in your project can use the timeslot that you have reserved.

It is important to note that many conditions and changes in the system can 
affect host allocation, and can cause a shuffling around of the hosts.

For more details about host allocation and examples of resource shuffling, 
see "Host Allocation" on page 102.
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Autostart Timeslots
Some performance tests might require a lot of time and many resources. 
Performance Center’s Autostart feature enables you to reserve these 
resources when resources are more readily available, and/or when you might 
not be available to run the test manually. This allows for maximum resource 
usage because your resources can then be used around the clock.

For example, suppose a project has a total of eight hosts for allocation and 
the employees assigned to the project work a standard 09:00-17:00 day. The 
hours between 09:00 and 17:00 are peak hours for host usage, during which 
time all the hosts are usually reserved for testing, data processing, and 
maintenance tasks. Because of this, there may be periods during the day that 
employees cannot perform tasks because there are no available hosts. In 
contrast, the non-standard work hours pass with very little host resource 
usage.

To extend host resource usage, employees might come in early or stay late to 
run tests, but this only extends the peak usage by one or two hours at the 
beginning and end of the day. 

Reserving timeslots during non-standard work hours and setting the tests to 
run during these timeslots allows for maximum resource usage.
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Best Practices for Reserving Autostart Timeslots

This section describes some best practices to follow when reserving an 
Autostart timeslot:

➤ When reserving an Autostart timeslot, always ensure that the Scheduler is 
set to stop as soon as all the Vusers have stopped running. This allows 
more time for post-run actions during the duration of the timeslot. For 
details on setting test options, see "Test Options Dialog Box" on page 219. 

➤ Where possible, run the test manually to get an indication as to how long 
it takes for the test to run. This information can assist you when selecting 
the timeslot duration.

➤ 15 minutes before the end of a timeslot, Performance Center 
automatically stops the test run. Five minutes before the end of the 
timeslot, even if all the Vusers have not yet finished running, 
Performance Center aborts the run. To ensure that the test ends properly 
as designed, make sure that you reserve more time than defined for the 
test schedule.

➤ If you want to perform auto-collate and analyze operations at the end of 
the run, you should take the time required for these operations into 
account when reserving the timeslot. 

Note: To prevent loss of run data, we recommend, whenever possible, to 
collate the results immediately after the run finishes. If your timeslot ends 
before result collation is completed, collation continues as it does not 
require reserved resources.

➤ If you want to analyze the test results straight after the run, take into 
account that the analysis process can take a long time, so be sure to 
reserve enough time for this operation.
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Prolonging Timeslot Reservations 
When a test is running and your testing timeslot is coming to a close, you 
can prolong the timeslot for a number of minutes, provided the resources 
you need are available. If any of the resources you are using are already 
reserved for a timeslot immediately following your timeslot, you cannot 
prolong the timeslot. 

For certain tasks the system prolongs timeslots automatically. For example, 
when you are running a test, if the Vusers are in the process of stopping 
gradually, the system will prolong the timeslot automatically for 15 
minutes, provided the resources are still available.

If a timeslot cannot be prolonged, the task at hand stops without 
completing properly.

Modifying Timeslot Reservations 
When you modify an open timeslot, depending on the modification, the 
timeslot might split into two separate timeslots.

A timeslot splits when: 

➤ You stop a run and select to keep the reserved resources for the remaining 
time.

➤ The run ends more than 30 minutes before the timeslot ends (not 
relevant for "NEW" ad-hoc timeslots).

➤ You modify an open timeslot that is not active.

Note: Active performance testing timeslots—that is, if the test is running—
can be modified from within a running performance test only. Changes that 
can be made include: prolonging a timeslot, adding Vusers, adding hosts.
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Understanding Timeslot Failure 
Timeslots can be reserved successfully only when all the requested resources 
are available for the requested duration of time.

Many factors render a valid timeslot invalid. Such factors include:

➤ Changes to the Performance Center licenses (This does not affect 
maintenance timeslots)

➤ Resources can become unavailable

➤ A test linked to a timeslot can become invalid

In some cases, such as issues with hosts, the system can perform a reshuffle 
of hosts to try to rectify the situation and revalidate the timeslot. For more 
information, see "Host Allocation" on page 102. Other factors, such as test 
invalidation, can be corrected manually. 

Tip: You can configure the system to alert you by email when a timeslot 
becomes invalid. The alert provides as much detail as possible as to the 
cause of the failure. For details on configuring timeslot alerts, see "Timeslot 
Settings Page" on page 656.

Host Allocation 

When reserving a timeslot, the system calculates the availability of all the 
requested hosts and Vusers. A timeslot can be reserved successfully only if all 
of the requested Vusers are available, and all of the requested hosts can be 
allocated.

You manually request resources for the timeslot. For performance testing 
timeslots, you must request at least one Controller and one load generator. 
If you have linked a test to the timeslot, the hosts and Vusers defined in the 
test are automatically requested for the timeslot.
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Hosts are allocated as follows:

➤ A specific host defined in the system can be allocated for performance 
testing as long as it is available and operational. A specific host can be 
allocated for maintenance even if it is non-operational.

➤ An automatch host is matched up with a specific host that has the same 
properties. A host is allocated after the following criteria have been 
checked:

➤ The system creates a list of all the hosts in the project’s host pool that 
are operational and available, and that match the properties of the 
automatch host. 

➤ From this list of candidate hosts, the system allocates the host that best 
fits the requested properties, taking into account the host priority, the 
number of pools the host belongs to, the purposes assigned to the 
host, and the host’s attributes. The system tries to allocate hosts in 
such a way that other hosts with similar but also additional properties 
may still be available for allocation elsewhere.
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Examples:

It is important to note that many conditions and changes in the system can 
occur that can affect host allocation. At such times, the system attempts to 
optimize the overall resource usage by reshuffling the hosts that are 
available among the timeslots. 

It is not always possible to shuffle the hosts appropriately. When this 
happens, a timeslot might become partially allocated, and thus invalid. As 
soon as the requested host becomes available again or another host can be 
allocated instead, the timeslot becomes valid again.

➤ A load generator is requested for the timeslot. The project’s pool, Pool A, 
contains Host1 and Host2. If Host1 has C+LG purposes, and Host2 has only the 
Load Generator purpose, then the system selects Host2, leaving Host1 available 
for other possible allocation.

➤ A load generator is requested for timeslot. If Host1 belongs to Pool A and has 
C+LG purposes, and Host2 belongs to Pool A and Pool B and has the Load 
Generator purpose, then the system prefers Host1 over Host2, leaving Host2 
available for other allocation, including for projects that use Pool B if necessary. 
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For example:

➤ If an allocated host becomes non-operational the system will try to find 
another host to replace the non-operational host.

➤ In a version-enabled project, if a test is linked to an autostart timeslot and 
is checked out, modified, and checked in again before the timeslot starts, 
the timeslot recalculates the availability of the updated resources.

To view an example of how hosts are allocated, and how they are reshuffled 
when necessary, see "Example of Allocating and Reshuffling Hosts" on 
page 105.

Example of Allocating and Reshuffling Hosts
There are many factors that can affect the allocation of hosts among 
timeslots. Consider the following scenarios which illustrate how hosts are 
allocated among timeslots and how changes in the system can affect the 
host allocation. You will see that the system attempts to optimize the overall 
resource usage by reshuffling the hosts that are available among the 
timeslots. 

Assume the following hosts belong to the project’s host pool:

Host Properties

Host1 Controller

Host2 Controller + Load Generator

Host3 Load Generator with the following property:

➤ Priority = 1_Lowest

Host4 Load Generator with the following properties:

➤ Citrix. The host can run scripts based on Citrix 
protocols.

➤ Priority = 9_Highest
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At 07:00 am, John reserves the following timeslot:

John submits the request. The system allocates Host1 as the Controller, 
leaving Host2 available to serve as either load generator or Controller in 
other timeslots. Additionally, the system allocates Host4 as the load 
generator, since it has higher priority than both Host2 and Host3. The 
following hosts are allocated successfully:

Timeslot Reserved at Reserved for Requested Resources, Properties

TS1 07:00 08:00am - 10:00am 1 Controller, Any

1 Load Generator, Any

Requested Hosts Allocated Hosts

1 Controller, Any Host1

1 Load Generator, Any Host4
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At 07:30 am, Sue submits the following timeslot reservation:

Because Host4 is the only Citrix load generator, the system checks if it can 
allocate a different load generator to John’s timeslot so that Host4 can be 
allocated to Sue’s timeslot instead. 

The necessary hosts are available, so the following reshuffle occurs: 

➤ Host3 is allocated to John; Host4 is allocated to Sue

➤ John’s Controller, Host1 remains allocated to John; Host2, also a 
Controller, (not yet allocated), is allocated to Sue

Timeslot Reserved at Reserved for Requested Resources, Properties

TS2 07:30 09:00am - 11:00am

Autostart

1 Controller, Any

1 Load Generator, Citrix
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Sue successfully submits the request. The new host allocation looks as 
follows:

Note: Host allocation works on a "first-come, first-served" basis. Since John 
reserved Host4 first, if there had been no other host to allocate to his 
timeslot, Host4 would have remained allocated to John, and Sue would not 
have been able to reserve her timeslot successfully.

Timeslot Requested Hosts Allocated Hosts

TS1 1 Controller, Any

1 Load Generator, Any

Host1

Host3 (replaced Host4)

TS2 1 Controller, Any

1 Load Generator, Citrix

Host2

Host4
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At 07:45am, Peter reserves the following timeslot:

Peter is specifically requesting Host2 for his Controller, and any load 
generator. The system checks if the requested hosts can be allocated, taking 
into consideration requests and timing of the other timeslots:

➤ To allocate Host2 to Peter’s timeslot, it must be available by 10:00.

➤ Sue is willing to have any Controller.

➤ John’s timeslot will end at 10:00 and free resources.

The following reshuffle occurs so that all the timeslots can be 
accommodated: 

➤ Sue’s timeslot gives up Host2, and is allocated Host1 instead; Host4 
(Citrix) remains allocated to Sue’s timeslot

➤ Host2 is allocated to John’s timeslot; Host3 remains allocated to John’s 
timeslot

➤ Host2 and Host3 can then be allocated to Peter’s timeslot because John’s 
timeslot will be finished by 10:00 when Peter’s starts.

Timeslot Reserved at Reserved for Requested Resources, Properties

TS3 07:45 10:00am - 12:00pm 1 Controller, Host2

1 Load Generator, Any
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Peter successfully submits his request. The new host allocation looks as 
follows:

Timeslot Requested Hosts Allocated Hosts

TS1 1 Controller, Any

1 Load Generator, Any

Host2

Host3

TS2 1 Controller, Any

1 Load Generator, Citrix

Host1

Host4

TS3 1 Controller, Host2

1 Load Generator, Any

Host2

Host3
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Note: If John and Peter’s timeslots had overlapped, Host2 would not have 
been available for part of Peter’s timeslot. In this case, the reshuffle would 
not have been possible and Peter would not have been able to reserve his 
timeslot successfully.

Now let’s say at 07:55 Host2 becomes non-operational. As a result, TS1 takes 
back Host1, and starts at 08:00. It follows from the information above, that 
TS2 and TS3 both become invalid as their resources have become partially 
allocated.

Then, at 09:05, Host2 becomes operational again. It is allocated to TS2, and 
TS2 starts, though five minutes late, but still during the specified autostart 
retries period. (For details about configuring autostart retries, see "Timeslot 
Settings Page" on page 656.)

At 11:00, TS3 remains invalid (partially allocated) and is unable to start 
because Host2 is still being used by TS2.
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Tasks

How to Reserve Performance Testing Timeslots

This task describes how to reserve resources for running performance tests.

Note: 

➤ This task is part of a higher-level task. For details, see "How to Conduct a 
Performance Test" on page 28.

➤ Product Feature Movie. To view a movie that demonstrates how to 
reserve timeslots, select Help > Product Feature Movies in the ALM main 
window. Under HP ALM Performance Center 11.00 Movies, select 
Timeslots.

To learn more about timeslot reservations, see "Reserving Timeslots 
Overview" on page 96.

This task includes the following steps:

➤ "Prerequisites" on page 112

➤ "Create a timeslot" on page 113

➤ "Verify the availability of the requested resources" on page 113

 1 Prerequisites

➤ Ensure that there is a host pool defined and that at least one of the 
hosts in the pool can be designated as a Controller. 

➤ Ensure that the Host, Vuser, and Concurrent Run limits are defined in 
the project settings.

➤ If you know which test you want run during the timeslot, ensure that 
an instance of that test is included in a test set.
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 2 Create a timeslot

 a On the ALM sidebar, under Lab Resources, select Timeslots. 

 b In the Timeslots toolbar, click the New Timeslot button. 

 c Enter the details of the timeslot and select resources. For user interface 
details, see "Timeslot Reservation Dialog Box" on page 138.

 3 Verify the availability of the requested resources

Do one of the following:

➤ (Recommended) Click Calculate Availability. The system checks the 
availability of the requested resources for the selected timeslot. The 
results of this calculation are displayed in the Timeslot Status tab and 
graphically on the resource availability timeline. 

If the timeslot cannot be reserved, consider the reasons displayed in 
the Timeslot Status tab when reselecting your resources. If the timeslot 
can be reserved, you can click Submit to save the timeslot.

➤ Click Submit. The system calculates the availability of the requested 
resources during the selected timeslot. If all of the resources are 
available, the Timeslot Reservation dialog box closes and the timeslot 
is reserved and displayed in the Timeslots module. If the timeslot 
cannot be reserved, the reasons are displayed in the Timeslot Status 
tab.
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Example:

In this example, 3 hosts were requested for a performance testing 
timeslot: 1 Controller + 1 specific load generator, and 1 automatch load 
generator. There are only 2 hosts in the project’s host pool. The icon at 
the top of the resource availability timeline indicates that the request has 
exceeded the license/project limits, and the exact reason the timeslot 
cannot be reserved is indicated in the Timeslot Status tab.
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How to Reserve Maintenance Timeslots 
(Lab Management only)

This task describes how to reserve hosts for performing maintenance tasks.

Note: 

➤ This task is part of a higher-level task. For details, see "Manage and 
maintain Performance Center lab resources" on page 623.

➤ Product Feature Movie. To view a movie that demonstrates how to 
reserve timeslots, select Help > Product Feature Movies in the ALM main 
window. Under HP ALM Performance Center 11.00 Movies, select 
Timeslots.

To learn more about timeslot reservations, see "Reserving Timeslots 
Overview" on page 96.

This task includes the following steps:

➤ "Create a maintenance timeslot" on page 115

➤ "Verify the availability of the requested hosts" on page 116

 1 Create a maintenance timeslot

 a On the Lab Management sidebar, under Lab Usage, select Timeslots.

 b In the Timeslots toolbar, click the New Maintenance Timeslot button. 

 c Enter the details of the timeslot and select hosts. For user interface 
details, see "Timeslot Reservation: Maintenance Dialog Box (Lab 
Management Only)" on page 146.
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 2 Verify the availability of the requested hosts

Do one of the following:

➤ (Recommended) Click Calculate Availability. The system checks the 
availability of the requested hosts for the selected timeslot. The results 
of this calculation are displayed in the Timeslot Status tab and 
graphically on the resource availability timeline. 

If the timeslot cannot be reserved, consider the reasons displayed in 
the Timeslot Status tab when reselecting your hosts. If the timeslot can 
be reserved, you can click Submit to save the timeslot.

➤ Click Submit. The system calculates the availability of the requested 
hosts during the selected timeslot. If all of the hosts are available, the 
Timeslot Reservation dialog box closes and the timeslot is reserved and 
displayed in the Timeslots module. If the timeslot cannot be reserved, 
the reasons are displayed in the Timeslot Status tab.

Note: If a host that you are trying to reserve for maintenance is reserved 
for another timeslot that has not yet started, and you cannot delay the 
maintenance task, first consult with the user who reserved the other 
timeslot. If he/she agrees, move the start time of the other timeslot, or 
delete it accordingly.
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Reference

Reserving Timeslots User Interface 

This section includes:

 ➤ Timeslots Module Window on page 118

 ➤ Timeslots Module Menus and Buttons on page 127

 ➤ Timeslots Module Fields on page 134

 ➤ Timeslots Module Icons on page 137

 ➤ Timeslot Reservation Dialog Box on page 138

 ➤ Timeslot Reservation: Maintenance Dialog Box (Lab Management Only) 
on page 146

 ➤ Timeslot Reservation: Data Processing Dialog Box on page 151

 ➤ Select Controller Dialog Box on page 155

 ➤ Select Automatch Load Generators Dialog Box on page 158

 ➤ Select Specific Load Generators Dialog Box on page 160

 ➤ Add Hosts Dialog Box on page 163

 ➤ Time Zone Options Dialog Box on page 165
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Timeslots Module Window

This module enables you to reserve timeslots for running performance tests 
or performing maintenance tasks.

It contains the following views: Calendar View, Grid View. You select a view 
from the View menu.

Timeslots Calendar View
This view enables you to view the timeslots in a calendar view. The Calendar 
view is time-oriented. It allows you to view your timeslots scheduled for the 
same day, and to get a visual indication of overlapping timeslots.
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Timeslots Grid View
Enables you to view timeslots in a flat, non-hierarchical view. Each line in 
the grid displays a separate timeslot. This view is useful for filtering the 
timeslots and for viewing the details of multiple timeslots simultaneously.
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To access Use one of the following:

➤ Administrator (Maintenance timeslots): On the 
Lab Management sidebar, under Lab Usage, select 
Timeslots.

➤ Performance Tester (Performance Testing timeslots): 
On the ALM sidebar, under Lab Resources, select 
Timeslots.

Important 
information

➤ The Calendar and Grid views display different types of 
information about the timeslots. To view full details 
about a particular timeslot, open the timeslot in the 
Timeslot Reservation dialog box. For details, see:

➤ "Timeslot Reservation Dialog Box" on page 138

➤ "Timeslot Reservation: Maintenance Dialog Box 
(Lab Management Only)" on page 146

➤ Users can reserve timeslots for maintenance 
(administrators only) or for performance testing. 
Timeslots for data processing tasks, such analyzing test 
results, are reserved automatically by the system when 
needed.

Relevant tasks "How to Reserve Performance Testing Timeslots" on 
page 112

See also "Reserving Timeslots Overview" on page 96
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Main Timeslots Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Timeslots module 
common UI 
elements>

➤ Timeslot menus and buttons. For command and 
button descriptions, see "Timeslots Module Menus and 
Buttons" on page 127.

➤ Timeslot fields. For field definitions, see "Timeslots 
Module Fields" on page 134.

➤ Timeslot icons. For icon descriptions, see "Timeslots 
Module Icons" on page 137.

➤ ALM main menu and sidebar. For details on the Tools 
menu, Help menu and sidebar, see the HP Application 
Lifecycle Management User Guide.

<Calendar> Displays the reserved timeslots in your projects in 
calendar form. 

➤ The timeslots in the calendar view are color-coded as 
follows:

➤ Yellow shading: Maintenance timeslots

➤ Blue shading: Performance testing timeslots 
reserved in the currently signed-in project

➤ Gray shading: Performance testing timeslots 
reserved in other projects

➤ Lilac shading: Data processing timeslots

Available from: Calendar view only

<Date navigator> Enables you to select the day/week to display in the main 
calendar grid.

<grid filters> Located under each column name. Displays the filter that 
is currently applied to a column. If the filter box is 
empty, no filter is currently applied to the column. 

Type directly into the box, or click the box to display the 
Browse button which opens the Select Filter Condition 
dialog box. For more details, see the HP Application 
Lifecycle Management User Guide. 

Available from: Grid view only
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Description tab Describes the currently selected timeslot. 

Available from: Grid view only

Event Log tab Displays a log of events related to the timeslots. For 
details, see "Event Log" on page 351.

Available from: Grid view only

History tab Lists changes made to the currently selected timeslot. For 
more details, see the HP Application Lifecycle Management 
User Guide.

Available from: Grid view only

Host Allocation tab Displays the allocation of the hosts for the selected 
timeslot. For more details, see "Host Allocation Tab" on 
page 124.

Note: 

➤ Calendar view: Located on right of calendar, when a 
timeslot is selected in the calendar.

➤ Grid view: Located in the information panel.

My Timeslots for 
Today

Displays open and future timeslots that you reserved for 
the current day in the current project.

Available from: Calendar view only

Pool Details Displays information about the hosts in the project’s 
pool.

Available from: Calendar view only

Project Limits Displays the Vuser limit, VUDs limit, concurrent run 
limit, and host limit defined for the project.

Available from: Calendar view only

Status tab Displays the status and validity of the selected timeslot.

Available from: Grid view only

UI Elements (A-Z) Description
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Summary tab Displays a summary of the timeslot selected in the 
calendar. For more details, see "Summary Tab" on 
page 125.

Available from: Calendar view only, when a timeslot is 
selected in the calendar.

Timeslots grid Displays the timeslots in your projects in a grid.

Available from: Grid view only

UI Elements (A-Z) Description
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Host Allocation Tab

This tab displays the allocation of hosts for the selected timeslot. For future 
timeslots, the host allocation is a temporary allocation.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

If an allocated host becomes unavailable, the system 
attempts to replace the allocated host with another host 
with similar properties. If no host is available, the 
timeslot becomes partially allocated and is rendered 
invalid.

➤ Calendar view: Located on right of calendar, when a 
timeslot is selected in the calendar.

➤ Grid view: Located in Information panel

UI Elements Description

Requested Displays the requested hosts, including the requested 
properties.

Actual Displays the specific hosts allocated for the timeslot.

May display the following in place of specific host 
names:

➤ Not Allocated. Requested host(s) could not be 
allocated.

➤ Allocated (Deleted). The allocated host was deleted 
after the timeslot start time.

➤ From another pool. The host belongs to a host pool in 
another project to which you do not have access.
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Summary Tab

This tab displays a summary of the timeslot details.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

ID The timeslot ID.

Name The name of the timeslot.

Validity The validity of the timeslot:

➤ Valid. The timeslot is valid.

➤ Failed. The timeslot failed because resources 
unexpectedly became unavailable, because of a change 
in license definitions, or, in the case of performance 
testing timeslots, due to changes in test validity.

Run ID The ID of the test run that is running/ran during the 
timeslot.

Available for: Performance testing timeslots only, and 
when a performance test is selected.

Performance Test The name of the performance test linked to the timeslot.

Available for: Performance testing timeslots only.

Post-run action The post-run action specified for the linked performance 
test.

Available for: Performance testing timeslots only.

Autostart Indicates that you selected to start the linked 
performance test automatically.

Available for: Performance testing timeslots only.

Run state The run state of the performance test linked to the 
timeslot.

Available for: Performance testing timeslots only, and 
when a performance test is selected.

Maintenance state The state of the maintenance timeslot.

Available for: Maintenance timeslots only.
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Processing state The state of the data processing timeslot.

Available for: Data processing timeslots only.

Start time  The start time of the timeslot. 

End time The end time of the timeslot. 

Duration The duration of the timeslot (in minutes). 

Also displays the in HH:MM format in parentheses).

Hosts The number of hosts requested for the timeslot.

Vusers The number of Vusers requested for the timeslot.

Available for: Performance testing timeslots only.

Project The project in which the timeslot was created.

Created by The user who created the timeslot.

Last modified by The user who last modified the timeslot.

Priority modified The date and time that the priority of the timeslot was 
modified.

Description Displays a description of the timeslot.

UI Elements Description
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Timeslots Module Menus and Buttons

The section describes the menus and buttons available in the Timeslots 
module.

To access Use one of the following:

➤ Administrator (Maintenance timeslots): On the 
Lab Management sidebar, under Lab Usage, select 
Timeslots.

➤ Regular user (Performance Testing timeslots): On the 
ALM sidebar, under Lab Resources, select Timeslots.

Important 
information

Some menu commands and buttons are not available in 
all timeslot views. 

Relevant tasks "How to Reserve Performance Testing Timeslots" on 
page 112

See also "Reserving Timeslots Overview" on page 96



Chapter 6 • Reserving Timeslots

128

User interface elements are described below (unlabeled elements are shown 
in angle brackets): 

UI Elements (A-Z) Menu Description

Abort and Free 
Resources

Edit and 
<right-click 
menu>

Aborts the current timeslot and frees 
the reserved resources. 

For performance testing timeslots, if 
a test is running, the run is aborted.

Notes for aborting and freeing 
performance testing timeslots: 

➤ You can perform this operation 
from Lab Management or from 
the project where the timeslot 
was reserved only.

➤ If a test is running, you must have 
Abort and Edit permissions to 
perform this operation. If there is 
no test running, then you need 
only have Edit permissions to 
perform this operation.

Add to Favorites Favorites Opens the Add Favorite dialog box, 
enabling you to add a favorite view 
to your private or the public folder. 
For details, see the HP Application 
Lifecycle Management User Guide.

Available from: Grid view only

Calendar View View When selected, the timeslots are 
displayed in the Calendar view.
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Canned Filters None Enables you to filter the timeslots as 
follows:

➤ All accessible projects. Displays 
all timeslots from all of your 
projects.

➤ Mine (This project). Displays all 
of the timeslots that you created 
in this project.

➤ My Failed (This project). Displays 
all of the timeslots that you 
created in this project that have 
failed.

➤ Mine (All projects). Displays all of 
the timeslots that you created in 
all of your projects.

➤ My Failed (All projects). Displays 
all of the timeslots that you 
created in all of your projects that 
have failed.

Copy URL Timeslots and 
<right-click 
menu>

Copies the selected timeslot and 
pastes its URL as a link. The timeslot 
itself is not copied. Instead, you can 
paste the address into another 
location, such as an email or a 
document. Clicking the link opens 
ALM and takes you to the timeslot 
file or folder. If you are not already 
logged in, ALM first prompts for 
login details.

Delete Edit and 
<right-click 
menu>

Deletes the selected timeslot.

Note: You can only delete future 
timeslot reservations in the current 
project. 

Note for Administrator: You can 
delete future performance testing 
timeslots from Lab Management.

UI Elements (A-Z) Menu Description
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Export Timeslots and 
<right-click 
menu>

Opens the Export Grid Data dialog 
box, enabling you to export the 
resources in the grid as a text file, 
Microsoft Excel worksheet, 
Microsoft Word document, or HTML 
document. 

Choose one of the following 
options: 

➤ Export All. Exports all resources in 
the grid. 

➤ Export Selected. Exports selected 
resources in the grid.

Available from: Grid view only

Find View Opens the Find dialog box, enabling 
you to search for a timeslot in the 
module. For details about search 
options, see the HP Application 
Lifecycle Management User Guide.

Available from: Grid view only

Go To Timeslot Timeslots Opens the Go To Timeslot dialog 
box, enabling you to find a specific 
timeslot by its ID.

Go To Timeslot in 
Calendar/Grid

Right-click 
menu

➤ Calendar view: Goes to the 
selected timeslot in the Grid view.

➤ Grid view: Goes to the selected 
timeslot in the Calendar view.

Note: Toolbar button available in 
Calendar view only.

Grid Filters View and 
<right-click 
menu>

Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Available from: Grid view only

UI Elements (A-Z) Menu Description
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Grid View View When selected, the timeslots are 
displayed in the Grid view.

Information Panel View and 
<right-click 
menu>

Shows/Hides the Information Panel 
in the lower area of the module. 

Available from: Grid view only

New Timeslot Timeslot and 
<right-click 
menu>

Enables you to reserve a new 
timeslot.

Organize Favorites Favorites Organizes your favorite views. For 
details, see the HP Application 
Lifecycle Management User Guide.

Available from: Grid view only

Private Favorites Lists the favorite views that are 
accessible only to the user who 
created them.

Available from: Grid view only

Public Favorites Lists the favorite views that are 
accessible to all users.

Available from: Grid view only

Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For more details, see 
the HP Application Lifecycle 
Management User Guide.

For details about the Timeslot 
module fields, see "Timeslots 
Module Fields" on page 134.

Available from: Grid view only

UI Elements (A-Z) Menu Description
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Send by E-mail Timeslots and 
<right-click 
menu>

Opens the Send E-mail dialog box, 
enabling you to send timeslot details 
to recipients selected from a list or to 
the user who reserved the timeslot. 
For more details, see the 
HP Application Lifecycle Management 
User Guide.

Set Filter/Sort View Enables you to filter and sort the 
timeslots. Any currently applied 
filters or sorting orders are displayed 
below the toolbar. For more details, 
see the HP Application Lifecycle 
Management User Guide.

Note: In the Calendar view you can 
filter the timeslots only.

Show Timeslot Details View Displays the Summary and Host 
Allocation tabs (to the right of the 
calendar grid) which contain details 
about the selected timeslot.

Available from: Calendar view only

Time Zone Options Tools Opens the Time Zone Options dialog 
box, enabling you to display an 
additional time zone in the 
Timeslots calendar view. For details, 
see "Time Zone Options Dialog Box" 
on page 165.

Available from: Calendar view only

UI Elements (A-Z) Menu Description
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Timeslot Details Timeslot and 
<right-click 
menu>

Opens the Timeslot Reservation 
dialog box, enabling you to view 
and modify details of the selected 
timeslot. 

For details, see 

➤ "Timeslot Reservation Dialog Box" 
on page 138

➤ "Timeslot Reservation: 
Maintenance Dialog Box (Lab 
Management Only)" on page 146

Note: You cannot modify past 
timeslots.

Displays the current day only on the 
calendar.

Available from: Calendar view only

Displays the date selected in the date 
selector.

Available from: Calendar view only

Displays the 5-day work week 
around the date selected in the date 
selector.

Available from: Calendar view only

Displays the full week around the 
date selected in the date selector.

Available from: Calendar view only

UI Elements (A-Z) Menu Description
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Timeslots Module Fields 

This section describes the fields in the Timeslots module.

UI Elements (A-Z) Description

Additional Requested 
Vusers

The number of Vusers requested for the timeslot in 
addition to those defined in the linked performance test.

Autostart Enabled Y indicates that the selected performance test will start 
running when the timeslot starts.

Note: For maintenance timeslots, this field is empty.

Consumes VUDs Y indicates that the timeslot will use/used Vusers from 
the VUDs license.

Created By The user who reserved the timeslot.

Created The date and time the timeslot was reserved.

Description A description of the timeslot.

Duration in Minutes The duration of the timeslot in minutes. 

Note: This field displays the duration in HH:MM format 
in parentheses.

End Time The date and time the timeslot is due to end/ended.

Is Active Y indicates an active operation currently occurring in the 
scope of this timeslot.

Examples: 

➤ A performance test is running.

➤ A host is rebooting.

Note: You cannot edit an active timeslot.

Modified The date and time on which the timeslot details were last 
modified.

Modified By The user who last modified the timeslot details.

Name The timeslot’s name.

Post Run Action The action taken after the performance test completes its 
run.
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Project Name The name of the project to which the timeslot belongs.

Requested Hosts The number of hosts (including Controller) requested for 
the timeslot.

Run ID The ID of the run created in the context of the timeslot.

Server End Time The date and time that the timeslot is due to end/ended, 
in terms of the server’s time zone.

Server Start Time The date and time that the timeslot is due to start/
started, in terms of the server’s time zone.

Start Time The date and time that the timeslot is due to start/
started.

State The state of the timeslot.

Performance testing timeslot states:

➤ None. No test is linked to the timeslot.

➤ Not Started. A test is linked to the timeslot but has not 
started running.

➤ <Run states>. Run and post-run states.

Maintenance and data processing timeslot states:

➤ Active. An operation is running during the timeslot.

➤ Inactive. No operation is running during the timeslot.

Test Name The name of the performance test linked to the timeslot.

Note: If a test that is linked to a timeslot is deleted, this 
will affect the timeslot.

Test ID The ID of the performance test linked to the timeslot.

Test Instance ID The ID of the performance test instance linked to the 
timeslot.

Test Validity The validity of the performance test linked to the 
timeslot.

Timeslot ID The ID of the timeslot.

Timeslot Type The type of timeslot: performance testing, maintenance, 
or data processing.

UI Elements (A-Z) Description
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Timeslot Validity The validity of the timeslot based on allocation of 
resources.

➤ Y. Indicates that the timeslot is valid, and that all 
resources were allocated as requested. 

➤ N. Indicates that a valid timeslot became invalid, due 
to license, resource, or test validation issues. In this 
state, the timeslot is partially allocated. For more 
details, see "Understanding Timeslot Failure" on 
page 102.

Total Vusers The total number of Vusers reserved for the timeslot.

Vusers from Test The number of Vusers defined in the linked performance 
test.

UI Elements (A-Z) Description
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Timeslots Module Icons

This section describes the icons available in the Timeslots module.

The icons are described below: 

To access Use one of the following:

➤ Administrator (Maintenance timeslots): On the 
Lab Management sidebar, under Lab Usage, select 
Timeslots.

➤ Performance Tester (Performance Testing timeslots): 
On the ALM sidebar, under Lab Resources, select 
Timeslots.

See also "Timeslots Module Window" on page 118

UI Elements Description

Indicates a valid timeslot. 

Indicates a partially allocated (invalid) timeslot.

Indicates an active timeslot.
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Timeslot Reservation Dialog Box 

This dialog box enables you to reserve a performance testing timeslot and 
view details of a reserved performance testing timeslot.
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To access ➤ New Timeslot Reservation:

On the ALM sidebar, under Lab Resources, select 
Timeslots. Then use one of the following:

➤ On the Timeslots toolbar, click the New Timeslot 
button. 

➤ Calendar view only: Double-click anywhere on the 
calendar, or right-click the target time and select 
New Timeslot.

➤ Existing Timeslot Reservation:

From Lab Management: On the sidebar, under Lab 
Usage, select Timeslots. 

From ALM: On the sidebar, under Lab Resources, select 
Timeslots.

Then use one of the following:

➤ Grid View: Right-click a timeslot of type 
Performance Test and select Timeslot Details. 

➤ Calendar view only: Right-click a performance 
testing (blue) timeslot and select Timeslot Details. 

Important 
information

➤ Use this dialog box to reserve or view a performance 
testing timeslot. 

➤ For maintenance timeslots, see "Timeslot Reservation: 
Maintenance Dialog Box (Lab Management Only)" on 
page 146.

➤ For data processing timeslots, see "Timeslot 
Reservation: Data Processing Dialog Box" on page 151.

Relevant tasks "How to Reserve Performance Testing Timeslots" on 
page 112

See also "Reserving Timeslots Overview" on page 96
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Unlink Test. Unlinks the performance test selected for 
this timeslot.

Opens the Select Automatch Load Generators dialog box, 
enabling you to select automatch load generators with 
specific properties for the timeslot. For more details, see 
"Select Automatch Load Generators Dialog Box" on 
page 158. 

Note: You must request at least one load generator 
(automatch or specific) for the timeslot.

Available: For new, open, or future timeslots

Opens the Select Specific Load Generators dialog box, 
enabling you to select specific load generators for the 
timeslot. For more details, see "Select Specific Load 
Generators Dialog Box" on page 160. 

Note: You must request at least one load generator 
(automatch or specific) for the timeslot.

Available: For new, open, or future timeslots

Remove. Removes the selected load generators from the 
lists of requested load generators.

Note: You can change the selected Controller, but you 
cannot delete it.

Set Start Time as Now. Selects the current time in the 
resource availability chart.

Note: A timeslot whose start time is set to the current 
time opens the immediately upon submitting the 
reservation. 

Calculates the availability of the requested resources for 
the selected timeslot. The results are displayed 
graphically on the resource availability chart, and a 
message is displayed in the Timeslot Status tab.
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<Message bar> Located at the top of the dialog box. Displays messages 
and warnings about the timeslot.

Available for: Existing timeslots only.

<Resource availability 
timeline>

Displays the availability of requested resources on a 
timeline:

➤ Availability not calculated. Displayed on the timeline 
before you calculate the availability of the requested 
resources for a new timeslot, or when modifying a 
timeslot.

➤ Start Times. Indicates available start times for the 
timeslot, when the requested resources are available.

➤ Insufficient Resources. Indicates that not all the 
requested resources are available at the start times 
indicated on the timeline.

➤ Unknown. Displayed before calculating the 
availability of the requested resources for the timeslot. 

➤ License/Project Limit. Indicates license or project 
limit issues at the start times indicated on the 
timeline.

Example. More hosts requested than available in the 
license limit.

➤ Unavailable Resource. Indicates that a requested 
resource is not available at the start times indicated on 
the timeline.

Name A descriptive name for the timeslot.

ID The ID of the timeslot.

UI Elements Description
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Test Enables you to select a performance test to run during 
the timeslot.

Version Control: You cannot link a test that is checked 
out.

Note: 

➤ A linked test must be a valid test, and an instance of 
the test must be included in a test set. For information 
on working with test sets, see the HP Application 
Lifecycle Management User Guide.

➤ If you make changes to the linked test (in the 
Performance Test Designer), the timeslot is updated 
automatically, and you do not need to relink the test 
manually. 

➤ Changes to a linked test might affect the validity of 
the timeslot.

➤ You do not have to link a test to the timeslot. 
However, linking a test to the timeslot gives you the 
option of having a test run automatically during the 
timeslot, without your manual intervention. For 
details, see "Autostart Timeslots" on page 99.

UI Elements Description
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Post-Run The action to be taken when the performance test run is 
complete. Available only when a performance test is 
selected for the timeslot.

➤ Do not collate results. Frees the machines immediately 
after the performance test ends. When the run has 
finished, the run results left on the load generators. 
You can analyze the results at a later stage from the 
Results tab. 

➤ Collate. When the run has finished, the run results are 
collected from all the load generators. 

Note: To prevent loss of or inaccessibility to run data, 
select this option so that the results are collected 
immediately upon completion of the test run.

➤ Collate and Analyze. When the run has finished, the 
run results are collected and analyzed. Data analysis 
requires some time, depending on the size of the 
results file. If there is no timeslot available to include 
the data analysis, then select the Collate option 
instead, and run late Analysis when a data processor 
becomes available. You run late Analysis from the 
Results tab. 

For details, see "Results/Last Run Results Tab" on 
page 354.

Default value: Collate

Autostart The linked performance test automatically starts running 
at the start of the timeslot, without any manual 
intervention. 

Version Control: The last checked-in version of the test 
always runs, even if you have the test checked out at the 
start of the timeslot.

Note: To set autostart retry settings, see "Timeslot 
Settings Page" on page 656.

UI Elements Description
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Vusers Enables you to request a number of Vusers for the 
timeslot.

Note: 

➤ If a test is selected for the timeslot, the number of 
Vusers defined in the test is displayed automatically 
(indicated by an asterisk "*"), and you can reserve 
additional Vusers.

➤ The sum of all Vusers reserved for the requested 
timeslot and other timeslots must not exceed the 
Vuser limit specified in the project settings (Tools > PC 
Project Settings), and must not exceed the number of 
Vusers specified in the license.

Use VUDs When selected, the timeslot allocates VUD-license Vusers 
for the timeslot, rather than regular license Vusers. For 
details about VUDs, see "HP ALM Performance Center 
Licenses Overview" on page 822.

Duration The duration of the timeslot, in hours and minutes.

Note: A timeslot can be reserved for a minimum of 30 
minutes and maximum of 480 hours (20 days).

Start Time The date and time (in hours and minutes) that the 
timeslot starts.

End Time The date and time (in hours and minutes) that the 
timeslot ends.

Requested Hosts grid Displays the hosts requested for the timeslot. By default, 
an automatch Controller is selected. You can change this 
by browsing for a specific Controller. 

Note:

➤ You must request at least one load generator 
(automatch or specific) for the timeslot.

➤ If a test is selected for the timeslot, the hosts defined 
in the test are displayed automatically (indicated by an 
asterisk "*"), and you can request additional hosts.

UI Elements Description



Chapter 6 • Reserving Timeslots

145

Timeslot Status tab Displays the status of the timeslot reservation. 

For details about timeslot failure, see "Understanding 
Timeslot Failure" on page 102.

Description tab Describes the currently selected timeslot. 

Tip: Right-clicking in this area displays a toolbar for 
formatting and spell checking the text.

Additional Details 
tab

Displays additional details related to the timeslot.

Pool and Project tab Displays resources defined in the project’s host pool, as 
well as the project limits.

Event Log tab Displays a log of events related to the timeslot. For 
details, see "Event Log" on page 351.

Available: Only when viewing an existing timeslot.

UI Elements Description
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Timeslot Reservation: Maintenance Dialog Box (Lab 
Management Only)

This dialog box enables you to reserve a maintenance timeslot and view 
details of a reserved maintenance timeslot.
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To access ➤ New maintenance timeslot reservation (Lab 
Management only):

On the Lab Management sidebar, under Lab Usage, 
select Timeslots. Then use one of the following:

➤ On the Timeslots toolbar, click the New 
Maintenance Timeslot button. 

➤ Calendar view only: Double-click anywhere on the 
calendar, or right-click the target time and select 
New Maintenance Timeslot.

➤ Existing maintenance timeslot reservation:

From Lab Management: On the sidebar, under Lab 
Usage, select Timeslots. 

From ALM: On the sidebar, under Lab Resources, select 
Timeslots.

Then use one of the following:

➤ Grid View: Right-click a timeslot of type 
Maintenance and select Timeslot Details. 

➤ Calendar view only: Right-click a maintenance 
(yellow) timeslot and select Timeslot Details. 

Important 
information

➤ Use this dialog box to reserve or view a maintenance 
timeslot (administrator only).

➤ For performance testing timeslots, see "Timeslot 
Reservation Dialog Box" on page 138.

➤ For data processing timeslots, see "Timeslot 
Reservation: Data Processing Dialog Box" on page 151.

Relevant tasks "How to Reserve Maintenance Timeslots  (Lab 
Management only)" on page 115

See also "Reserving Timeslots Overview" on page 96
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Opens the Add Hosts dialog box, enabling you to select 
hosts for the maintenance timeslot. For more details, see 
"Add Hosts Dialog Box" on page 163. 

Note: You must select at least one host for the timeslot.

Available: For new, open, or future maintenance 
timeslots.

Remove. Removes the selected host from the lists of 
requested hosts.

Set Start Time as Now. Selects the current time in the 
resource availability chart.

Note: A timeslot whose start time is set to the current 
time opens the immediately upon submitting the 
reservation. 

Calculates the availability of the requested resources for 
the selected timeslot. The results are displayed 
graphically on the resource availability timeline, and a 
message is displayed in the Timeslot Status tab.

<Message bar> Located at the top of the dialog box. Displays messages 
and warnings about the timeslot.

Available for: Existing timeslots only.
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<Resource availability 
timeline>

Displays the availability of requested resources on a 
timeline:

➤ Availability not calculated. Displayed on the timeline 
before you calculate the availability of the requested 
resources for a new timeslot, or when modifying a 
timeslot. 

➤ Start Times. Indicates suggested start times for the 
timeslots, when the requested resources are available.

➤ Insufficient Resources. Indicates that not all the 
requested resources are available at the start times 
indicated on the timeline.

➤ License/Project Limit. Indicates license or project 
limit issues at the start times indicated on the 
timeline.

Example. More hosts requested than available in the 
license limit.

➤ Unknown. Displayed before calculating the 
availability of the requested resources for the timeslot. 

➤ Unavailable Resource. Indicates that a requested 
resource is not available at the start times indicated on 
the timeline.

Name A descriptive name for the timeslot.

ID The ID of the timeslot.

Duration The duration of the maintenance timeslot, in hours and 
minutes.

Note: A maintenance timeslot can be reserved for a 
minimum of between 15 minutes and maximum of 480 
hours (20 days).

UI Elements Description
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Start Time The date and time (in hours and minutes) that the 
timeslot starts.

Note: If you need to reserve a host for a maintenance 
task, and the host is already reserved for running a test in 
the same timeslot, then you can modify the start of the 
testing timeslot, or delete the testing timeslot. Consult 
with the user who reserved the testing timeslot before 
making any changes.

End Time The date and time (in hours and minutes) that the 
timeslot ends.

Requested Hosts grid Displays the hosts requested for the timeslot. 

Note: You must select at least one host for the timeslot.

Timeslot Status tab Displays the status of the timeslot reservation. 

For details about timeslot failure, see "Understanding 
Timeslot Failure" on page 102.

Description tab Describes the currently selected timeslot. 

Tip: Right-clicking in this area displays a toolbar for 
formatting and spell checking the text.

Additional Details 
tab

Displays additional details related to the timeslot.

Available for: Existing timeslots only.

Event Log tab Displays a log of events related to the timeslot. For 
details, see "Event Log" on page 351.

Available: Only when viewing an existing timeslot’s 
details.

UI Elements Description
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Timeslot Reservation: Data Processing Dialog Box 

This dialog box enables you to view the details of an open or past data 
processing timeslot.
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To access From Lab Management: On the sidebar, under Lab 
Usage, select Timeslots. 

From ALM: On the sidebar, under Lab Resources, select 
Timeslots.

Then use one of the following:

➤ Grid View: Right-click a timeslot of type Data 
Processing and select Timeslot Details. 

➤ Calendar view only: Right-click a data processing 
(lilac) timeslot and select Timeslot Details. 

Important 
information

➤ Use this dialog box to view the details of a current or 
past data processing timeslot.

➤ For performance testing timeslots, see "Timeslot 
Reservation Dialog Box" on page 138.

➤ For maintenance timeslots, see "Timeslot Reservation: 
Maintenance Dialog Box (Lab Management Only)" on 
page 146.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Message bar> Located at the top of the dialog box. Displays messages 
and warnings about the timeslot.

Available for: Existing timeslots only.

<Resource availability 
timeline>

Displays the availability of requested resources on a 
timeline:

➤ Availability not calculated. Displayed on the timeline 
before you calculate the availability of the requested 
resources for a new timeslot, or when modifying a 
timeslot. 

➤ Start Times. Indicates suggested start times for the 
timeslots, when the requested resources are available.

➤ Insufficient Resources. Indicates that not all the 
requested resources are available at the start times 
indicated on the timeline.

➤ License/Project Limit. Indicates license or project 
limit issues at the start times indicated on the 
timeline.

Example. More hosts requested than available in the 
license limit.

➤ Unknown. Displayed before calculating the 
availability of the requested resources for the timeslot. 

➤ Unavailable Resource. Indicates that a requested 
resource is not available at the start times indicated on 
the timeline.

Name A descriptive name for the timeslot. The name is given to 
the timeslot according to data processing task at hand.

ID The ID of the timeslot.

Duration The duration of the data processing timeslot, in hours 
and minutes.

Note: A duration of a data processing timeslot is 
determined internally by the system, depending on the 
processing task at hand.
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Start Time The date and time (in hours and minutes) that the 
timeslot started.

End Time The date and time (in hours and minutes) that the 
timeslot ended or is scheduled to end.

Requested Hosts grid Displays the data processor host reserved for the timeslot. 

Note: The data-processor host is selected automatically 
by the system.

Timeslot Status tab Displays the status of the timeslot reservation. 

For details about timeslot failure, see "Understanding 
Timeslot Failure" on page 102.

Description tab Describes the currently selected timeslot. 

Tip: Right-clicking in this area displays a menu for 
formatting and spell checking the text.

Additional Details 
tab

Displays additional details related to the timeslot.

Event Log tab Displays a log of events related to the timeslot. For 
details, see "Event Log" on page 351.

UI Elements Description
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Select Controller Dialog Box

This dialog box enables you to select a Controller for a performance testing 
timeslot.

 



Chapter 6 • Reserving Timeslots

156

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In ALM:

1  On the ALM sidebar, under Lab Resources, select 
Timeslots. 

2  On the toolbar, click the New Timeslot  button. 

3  In the Timeslot Reservation dialog box, in the 
Requested Hosts grid, click the Controller’s Properties 
column, and click the down arrow.

Important 
information

If you select a Controller host that has multiple purposes 
(C+LG+DP), it is recommended to dedicate the host for 
Controller functionality, and not to select it for other 
functionality as well, to avoid performance issues during 
runtime.

This dialog box is available for performance testing 
timeslots only.

Relevant tasks "How to Reserve Performance Testing Timeslots" on 
page 112

See also "Reserving Timeslots Overview" on page 96

UI Elements Description

Refresh All. Refreshes the grid so that it displays the most 
up-to-date list of Controller hosts based on the filters you 
have selected.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For more details, see the 
HP Application Lifecycle Management User Guide.

For details about the host fields, see "Host Fields" on 
page 689.
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Filter/Sort. Enables you to filter and sort the Controller 
hosts in the grid. Any currently applied filters or sorting 
orders are displayed below the toolbar. For details about 
filtering options, see the HP Application Lifecycle 
Management User Guide.

<Host grid> Lists all the specific Controller hosts. 

Note: Enabled when Specific is selected.

Select a Controller 
for the timeslot

➤ Automatch. Enables the system to allocate an available 
Controller for the timeslot.

➤ Specific. Enables you to select a specific Controller for 
the timeslot. 

Reserve as C + LG Allows the selected host to serve both as a Controller and 
as a load generator.

Note: This option is not recommended. The Controller 
host should be dedicated for Controller functionality, 
and it is recommended not to run Vusers on this host.

UI Elements Description
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Select Automatch Load Generators Dialog Box 

This dialog box enables you to select automatch load generators, with 
selected properties, for a performance testing timeslot. 

 

To access In ALM:

1  On the ALM sidebar, under Lab Resources, select 
Timeslots. 

2  On the toolbar, click the New Timeslot  button. 

3  In the Timeslot Reservation dialog box, in the 
Requested Hosts grid, click .

Important 
information

Specific load generators matching the automatch load 
generators’ properties are allocated in place of the 
automatch load generators.

This dialog box is available for performance testing 
timeslots only.

Relevant tasks "How to Reserve Performance Testing Timeslots" on 
page 112

See also "Reserving Timeslots Overview" on page 96
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Reserve <xx> load 
generators....

The number of automatch load generators to reserve for 
the timeslot. 

Note: The total number of hosts (Controller + load 
generators) reserved for the timeslot may not exceed the 
project’s host and host pool limits defined in the project’s 
settings. For more details, see "Project Settings Details 
Dialog Box" on page 650.

Tip: To select multiple automatch load generator with the 
same properties, you can do one of the following:

➤ In the Reserve <xx> box, enter 1, and select the 
relevant properties. Repeat this for the other 
automatch load generators. If you do this five times, 
for example, then five identical automatch load 
generators are displayed in the Requested Hosts grid.

➤ In the Reserve <xx> box enter the number of 
automatch load generators you want to select with the 
same properties. For example, enter 5. One entry is 
displayed in the Requested Hosts grid, representing all 
five automatch load generators.

<Load Generator 
Properties>

Enables you to specify properties for the requested 
automatch load generators:

➤ Location. The location of the load generators. To find a 
specific location, enter the value in the Find box, and 
click .

➤ Host Attributes. Attributes of the load generators. 
Tip: The list of attributes can be customized. For 
details, see "Load Generator Attribute Customization" 
on page 224.

Note: If no properties are specified, any available load 
generators are allocated.
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Select Specific Load Generators Dialog Box 

This dialog box enables you to reserve specific load generators for a 
performance testing timeslot.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In ALM:

1  On the ALM sidebar, under Lab Resources, select 
Timeslots. 

2  On the toolbar, click the New Timeslot  button. 

3  In the Timeslot Reservation dialog box, in the 
Requested Hosts grid, click Add Specific LGs.

Important 
information

To avoid a timeslot becoming partially allocated in the 
case that a specific host unexpectedly becomes 
unavailable, it is recommended to reserve automatch 
load generators rather than specific load generators. For 
details about selecting automatch load generators, see 
"Select Automatch Load Generators Dialog Box" on 
page 158.

This dialog box is available for performance testing 
timeslots only.

Relevant tasks "How to Reserve Performance Testing Timeslots" on 
page 112

See also "Reserving Timeslots Overview" on page 96

UI Elements Description

Refresh All. Refreshes the grid so that it displays the most 
up-to-date list of load generators based on the filters you 
have selected.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For more details, see the 
HP Application Lifecycle Management User Guide.

For details about the host fields, see "Host Fields" on 
page 689.
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Filter/Sort. Enables you to filter and sort the load 
generators in the grid. Any currently applied filters or 
sorting orders are displayed below the toolbar. For details 
about filtering options, see the HP Application Lifecycle 
Management User Guide.

View menu Enables you to:

➤ Show/hide the grid filters

➤ Show/hide the Summary panel which displays the 
selected load generators

➤ Filter/sort and the grid

➤ Refresh the grid

➤ Select columns to view in the grid

<Specific load 
generators grid>

Displays the specific load generators available for the 
reservation.

Tip: To select multiple load generators, hold down the 
CTRL button on your keyboard while selecting load 
generators in the list.

Selected pane Displays the load generators selected in the grid.

UI Elements Description
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Add Hosts Dialog Box 

This dialog box enables you to reserve hosts for a maintenance timeslot. 

 

To access In Lab Management:

1  On the Lab Management sidebar, under Lab Usage, 
select Timeslots. 

2  On the toolbar, click the New Maintenance Timeslot 
 button. 

3  In the Timeslot Reservation: Maintenance dialog box, 
in the Requested Hosts grid, click .

Important 
information

This dialog box is available in Lab Management only.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to Reserve Maintenance Timeslots  (Lab 
Management only)" on page 115

See also "Reserving Timeslots Overview" on page 96

UI Elements Description

Refresh All. Refreshes the grid so that it displays the most 
up-to-date list of hosts based on the filters you have 
selected.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For more details, see the 
HP Application Lifecycle Management User Guide.

For details about the Host fields, see "Host Fields" on 
page 689.

Filter/Sort. Enables you to filter and sort the hosts in the 
grid. Any currently applied filters or sorting orders are 
displayed below the toolbar. For details about filtering 
options, see the HP Application Lifecycle Management User 
Guide.

View menu Enables you to:

➤ Show/hide the grid filters

➤ Show/hide the Summary panel which displays the 
selected hosts

➤ Filter/sort and the grid

➤ Refresh the grid

➤ Select columns to view in the grid

<Hosts grid> Displays the hosts available for the reservation.

Tip: To select multiple hosts, hold down the CTRL button 
on your keyboard while selecting hosts in the list.

Selected pane Displays the hosts selected in the grid.
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Time Zone Options Dialog Box 

This dialog box enables you to display an additional time zone in the 
Timeslots module calendar view.

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Timeslots module, in calendar view, select Tools > 
Time Zone Options.

Available from: Calendar view only

Important 
information

Displaying an additional time zone is useful if you are 
located in a different time zone to the ALM Platform 
server or other users.

The default time displayed on the calendar is based on 
the local client machine time.

See also "Reserving Timeslots Overview" on page 96

UI Elements Description

Show additional time 
zone

When selected, enables you to select an additional time 
zone to display in the calendar view. 

Time zone label The label by which to display the additional time zone in 
the calendar view.

Available: When Show additional time zone is selected.
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Performance Test Design
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7
Performance Test Design - Introduction

This chapter includes:

Concepts

➤ Performance Test Design Overview on page 170

Tasks

➤ How to Design a Performance Test on page 171

Reference

➤ Performance Test Design User Interface on page 176
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Concepts

Performance Test Design Overview 

When you design a performance test you create the test, define a workload 
for the test and, if desired, associate a topology and monitor profiles which 
provide a diagram of the application under test. You can also enable a 
diagnostics module to collect diagnostics data during the test run.

Performance Test Design Best Practices

Before you start with designing a performance test, is it recommended to:

➤ Create scripts for your test in the relevant application (VuGen scripts, 
QuickTest tests, Service Test tests), and upload them to ALM. For details, 
see the relevant User Guide.

➤ Design topologies of your application under test. For details, see 
Chapter 4, "Topologies."

➤ Configure the monitor machines or monitor-over-firewall agents that you 
want to use to monitor the test run, and define monitor profiles for these 
monitors. For details, see Chapter 5, "Monitor Profiles."

➤ To enable diagnostic modules to collect diagnostics data from the test 
run, you must set up the relevant diagnostics components (server/
mediators). For details, see Chapter 40, "Diagnostics Management."



Chapter 7 • Performance Test Design - Introduction

171

Tasks

How to Design a Performance Test 

This task describes how to design a performance test.

Note: This task is part of a higher-level task. For details, see "How to 
Conduct a Performance Test" on page 28.

To learn more about performance test design, see "Performance Test Design - 
Introduction" on page 169.

This task includes the following steps:

➤ "Prerequisites" on page 172

➤ "Create a new performance test" on page 172

➤ "Design a workload for the test" on page 173

➤ "Select a topology for the test - Optional" on page 173

➤ "Select monitor profiles to monitor the test - Optional" on page 174

➤ "Enable and configure Diagnostics - Optional" on page 174

➤ "Define service level agreements for the test - Optional" on page 175

➤ "Results" on page 175
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 1 Prerequisites

➤ Make sure the relevant scripts/tests have been uploaded/saved to ALM. 
You can use VuGen scripts for performance testing, as well as 
QuickTest and Service Test tests.

➤ VuGen scripts: For details on uploading VuGen scripts, see "Upload 
VuGen Scripts Dialog Box" on page 42. 

➤ QuickTest tests: For details on saving QuickTest tests to ALM, see the 
HP QuickTest Professional User Guide.

➤ Service Test tests: For details on saving Service Test tests to ALM, see 
the HP Service Test User Guide.

➤ Under Lab Resources, select Hosts and make sure that there is at least 
one Controller, one load generator, and one data processor in your 
project’s host pool. If not, contact your administrator to add them.

➤ For optional pre-design best practices, see "Performance Test Design 
Best Practices" on page 170.

 2 Create a new performance test

 a On the ALM sidebar, under Testing, select Test Plan. 

 b Select View > Test Plan Tree.

 c Select the Subject root folder, click New Folder , and rename the 
folder that is added to the tree.

 d In the tree, right-click the new folder, and select New Test. 

 e Fill in the fields in the New Test dialog box. For details, see the 
HP Application Lifecycle Management User Guide.
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In particular, in the Type box, select PERFORMANCE-TEST.

 3 Design a workload for the test

Designing a workload involves creating Vuser group, distributing Vusers 
among the Vuser groups, assigning hosts to the Vuser groups, and 
defining a run schedule for the test. For task details, see "How to Define a 
Performance Test Workload" on page 192.

 4 Select a topology for the test - Optional

Note: Before you can select a topology for a test, you must design the 
topology. To design topologies, see "How to Design Topologies" on 
page 47.

In the Performance Center Designer’s Topology tab, click Select Topology 
and select a topology for the test. For user interface details, see 
"Performance Test Designer > Topology Tab" on page 71. 
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 5 Select monitor profiles to monitor the test - Optional

Note: Before you can select monitors for a test, you must configure 
monitor machines and create monitor profiles. For details, see "How to 
Create and Configure Monitor Profiles" on page 75. 

Similarly, you must define monitor-over-firewall agents in the system 
before you can select them to monitor a test.

In the Performance Center Designer’s Monitors tab, click Add Monitor 
Profile or Add Monitor OFW. The respective tree opens on the right. Select 
a monitor, and drag and drop it into the left pane.

For user interface details, see "Performance Test Designer > Monitors Tab" 
on page 90.

 6 Enable and configure Diagnostics - Optional

Enable and configure diagnostic modules to collect diagnostics data from 
the test run.

➤ For ERP/CRM diagnostics, see "How to Enable and Configure ERP/CRM 
Diagnostics" on page 290.

➤ For J2EE/.NET diagnostics, see "How to Enable and Configure J2EE/
.NET Diagnostics" on page 292.
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 7 Define service level agreements for the test - Optional

Define service level agreements to measure performance metrics against 
performance goals. For details, see "How to Define Service Level 
Agreements" on page 268.

 8 Results

When you save the test, it goes through a validation process. The test is 
valid only if it contain no errors. The result of the validation is stated at 
the bottom of the Test Designer window.

Click the link to open the Test Validation Results dialog box and view the 
details of the validation results. For user interface details, see "Test 
Validation Results Dialog Box" on page 186.

Note: If you make changes to the test, and the test is linked to a timeslot, 
the timeslot is updated with these changes automatically.
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Performance Test Design User Interface 

This section includes:

 ➤ Test Design / Summary Tab on page 177

 ➤ Performance Test Designer Window on page 182

 ➤ Test Validation Results Dialog Box on page 186
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Test Design / Summary Tab

The Test Design / Summary tabs display a detailed summary of a selected 
performance test. 

Test Design Tab
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Summary Tab

 

To access Test Design tab:

1  On the ALM sidebar, under Testing, select Test Plan. 

2  Select a performance test in the test plan tree and click 
the Test Design tab.

Summary tab:

1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Summary tab.

See also ➤ "Performance Test Designer Window" on page 182

➤ HP Application Lifecycle Management User Guide: Test 
Plan Module Window
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

General Details Pane

This pane displays general summary information about the test.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Opens the Performance Test Designer window where you 
design performance tests. For details, see "Performance 
Test Designer Window" on page 182.

Available in: Test Design tab only

Enables you to run the test from the test planning area.

Available in: Test Design tab only

UI Elements Description

<Settings column 
icons>

➤ . Indicates that there is an error in the test design.

➤ . Indicates that test is valid and can run.

➤ . Indicate whether or not:

➤ A topology is selected for the test.

➤ Monitors are selected for the test.

➤ Diagnostics are enabled for the test.

➤ IP Spoofing is enabled for the test.

Test name  The name of the test.

Validation Indicates whether the test is valid or not. If the test is not 
valid or there are notifications about the test, the Details 
column displays a link to the Test Validation Results 
dialog box which lists errors and messages related to the 
test. For details, see "Test Validation Results Dialog Box" 
on page 186.

Workload Type The workload type selected for the test.
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Service Level Agreement Pane

This pane displays service level agreements (SLAs) that are defined for the 
test. 

For user interface details, see "Service Level Agreement Pane" on page 275.

Vusers The number of Vusers defined in the test.

Topology Indicates whether or not a topology is associated with 
the test, and if so, displays the relevant details.

Diagnostics Indicates whether or not diagnostics are enabled for the 
test, and if so, displays the relevant details.

Monitors Indicates whether or not monitor profiles are defined for 
the test, and if so, displays the relevant details.

IP Spoofer Indicates whether or not IP spoofing is enabled for the 
test. For details, see "Test Options Dialog Box" on 
page 219.

Controller/C+LG/LG Displays the number of hosts selected for the test, and 
their properties. 

Important 
information

➤ You create, modify, and delete SLAs in the Summary 
tab. 

➤ In the Test Design tab you can only view a list of 
defined SLAs.

Relevant tasks "How to Define Service Level Agreements" on page 268

See also "Service Level Agreements Overview" on page 266

UI Elements Description
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Groups Pane

This pane displays details about the Vuser groups defined in the test.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Group Name The name of the Vuser group.

Script Name The name of the Vuser script associated with the Vuser 
group.

Script Type The Vuser script type.

Vusers #/% The number/percentage of Vusers distributed to the 
Vuser group.
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Performance Test Designer Window 

This window enables you to define a performance test. Defining a 
performance test includes selecting scripts for the test, scheduling how 
many Vusers to run in each script and for how long, choosing topologies 
and monitor profiles for the test, and enabling collection of diagnostics data 
for the test run.

Version Control: If your project is version-enabled:

➤ To edit a test, you must check it out. 

➤ When you check out a test, only you can edit the test.

➤ If the test is checked out by another user, you cannot check the test out 
as well. You can view the last checked in version in read-only mode.
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To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

Important 
information

In order to continue working in ALM, you must close the 
Performance Test Designer window. Make sure to save 
changes you have made to the test before closing this 
window.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to Design a Performance Test" on page 171

See also ➤ "Enabling and Configuring ERP/CRM and  J2EE/.NET 
Diagnostics" on page 289

➤ "Monitor Profiles" on page 73

➤ "Topologies" on page 45

➤ For version control enabled projects, see the 
HP Application Lifecycle Management User Guide.

UI Elements Description

Enables you to check in saved changes to a performance 
test to create a new, updated version available to other 
users.

Note: Available for version control enabled projects only.

Enables you to check out a performance test so that you 
can make changes to it. 

Note: Available for version control enabled projects only. 

After checking out a test, this button enables you to undo 
the checkout and cancel your changes.

Note: Available for version control enabled projects only.

Opens the Test Options dialog box, enabling you to set 
general Scheduler and testing options. For details, see 
"Test Options Dialog Box" on page 219.

Summary tab Displays a summary of the test. For details, see "Test 
Design / Summary Tab" on page 177.

Workload tab Enables you to design a workload for the test. For details, 
see "Performance Test Designer > Workload Tab" on 
page 202.

Topology tab Enables you to associate a topology with the test. For 
details, see "Performance Test Designer > Topology Tab" 
on page 71.
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Monitors tab Enables you to select monitors to monitor the test. For 
details, see "Performance Test Designer > Monitors Tab" 
on page 90.

Diagnostics tab Enables you to select a diagnostics module to collect 
diagnostics data from the test. For details, see 
"Performance Test Designer > Diagnostics Tab" on 
page 295.

<Validation 
message>

When you save the test, this message displays the test 
validation result. If there are errors or messages, a link to 
the test validation results is displayed. 

For details, see "Test Validation Results Dialog Box" on 
page 186.

UI Elements Description
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Test Validation Results Dialog Box 

This dialog box displays the validation results of your performance test. 

 

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  Use one of the following:

➤ Click the validation link at the bottom of the 
Performance Test Designer window.

➤ In the Summary tab, click the Validation link.

Note: The validation link appears only if the test is 
invalid or there are messages about the test. If the test is 
valid and there are no messages, no validation link is 
displayed.

Important 
information

A performance test that is not valid cannot run. 

Relevant tasks "How to Design a Performance Test" on page 171

See also "Test Design / Summary Tab" on page 177
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Level  The type of message:  Error or  Warning.

Details  Describes the error or warning
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8
Defining Performance Test Workloads

This chapter includes:

Concepts

➤ Performance Test Workload Overview on page 190

➤ Rendezvous Points on page 190

Tasks

➤ How to Define a Performance Test Workload on page 192

➤ How to Distribute Vusers Among Vuser Groups on page 197

Reference

➤ Defining Performance Test Workloads User Interface on page 201
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Concepts

Performance Test Workload Overview 

When you create a performance test you need to define a workload for the 
test. Defining a workload involves selecting a type of workload for the test, 
creating Vuser groups that emulate groups of users running on the 
application, and configuring how they should behave during the test.

You select a workload depending on the type of schedule and schedule run 
mode you want use to run your test, and depending on how you want to 
distribute the Vusers among the Vuser groups in your test.

For details on defining a workload for your performance test, see "How to 
Define a Performance Test Workload" on page 192.

Rendezvous Points 

During a test run, you can instruct multiple Vusers to perform tasks 
simultaneously by using rendezvous points. A rendezvous point creates 
intense user load on the server, enabling you to measure server performance 
under load. 

Suppose you want to measure the performance of an application when 10 
Vusers perform a given task simultaneously. To make sure that multiple 
Vusers act simultaneously you create a rendezvous point in the Vuser script. 
When Vusers arrive at a rendezvous point, they are held there by the 
Controller. The Controller releases the Vusers from the rendezvous either 
when the required number of Vusers arrives, or when a specified amount of 
time has passed.



Chapter 8 • Defining Performance Test Workloads

191

For example, to test an online bank, you could create a test that contains 
two rendezvous points. The first rendezvous ensures that one thousand 
Vusers simultaneously deposit cash. The second rendezvous ensures that 
another thousand Vusers simultaneously withdraw cash. To measure how 
the server performs when only five hundred Vusers deposit cash, you can set 
the release policy so that the Vusers are released when 500 Vusers arrive at 
the rendezvous.

You can configure rendezvous policies when defining the test workload. For 
task details, see "How to Define a Performance Test Workload" on page 192.

You can manually release Vusers waiting at a rendezvous point during a run. 
For task details, "How to Manage a Performance Test Run" on page 340.
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Tasks

How to Define a Performance Test Workload

This task describes how to define a performance test workload.

Note: This task is part of a higher-level task. For details, see "How to Design a 
Performance Test" on page 171.

To learn more about performance testing, see "Performance Test Workload 
Overview" on page 190.

This task includes the following steps:

➤ "Prerequisite" on page 193

➤ "Select a workload" on page 193

➤ "Select a Controller" on page 193

➤ "Create Vuser groups and distribute Vusers to the groups" on page 194

➤ "Distribute load generators among the Vuser groups" on page 194

➤ "Define a schedule for the performance test" on page 194

➤ "Configure test settings - Optional" on page 195

➤ "Define topology, monitoring, and diagnostics options" on page 196
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 1 Prerequisite

Create a performance test. For details, see step 2 of "How to Design a 
Performance Test" on page 171.

 2 Select a workload

In the Test Plan tree, right-click the test and select Edit Test. The test 
opens in the Performance Test Designer window. 

Click the Select Workload Type button adjacent to the Workload type 
box, and select a type of workload for the test. The type of workload you 
choose determines the type of schedule by which the test will run, and 
how the Vusers will be distributed at runtime.

For user interface details about the Workload Types dialog box, see 
"Workload Types Dialog Box" on page 211.

 3 Select a Controller

Click the Select Controller button adjacent to the Controller box, and 
select a host to act as the Controller for the test.

For user interface details about the Select Controller dialog box, see "Select 
Controller Dialog Box" on page 214.
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 4 Create Vuser groups and distribute Vusers to the groups

 a In the Groups pane, select scripts from the Scripts Tree pane on the 
right to run in the test. If the Scripts Tree pane is not open, click the 
Select Scripts button. 

Tip: You can select complete folders of scripts, or select multiple scripts 
while holding down the CTRL key on your keyboard. 

 b (Optional) For each selected script, a Vuser group is created in the 
Groups grid and is given, by default, the same name as the selected 
script. You can change the group name if desired.

 c Distribute Vusers among the Vuser groups according to the Vuser 
distribution method you selected in the workload type. For details, see 
"How to Distribute Vusers Among Vuser Groups" on page 197.

 5 Distribute load generators among the Vuser groups 

Select a method by which to distribute the load generators among the 
Vuser groups, and specify which load generators to distribute to which 
groups.

For details, see "How to Distribute Load Generators Among Vuser Groups" 
on page 225.

 6 Define a schedule for the performance test

Schedule how the Vuser groups are to run in the test. For details, see "How 
to Define a Schedule for the Performance Test" on page 247.
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 7 Configure test settings - Optional

You can configure the following optional settings for your test:

Optional Test Setting Description

Command line arguments Sending command line arguments enables you to 
configure test settings without the need to 
manually define them in the UI. 

In the Groups pane, click the Edit Command Line 
 button. For details, see Edit Command Line in 

the "Groups Pane" user interface details on 
page 205.

Rendezvous Points When you add Vuser groups to the test, their 
associated scripts are scanned for rendezvous 
points. 

To view and manage the rendezvous points, click 
the View Rendezvous  button. For user interface 
details, see "Rendezvous Dialog Box" on page 216.

Runtime Settings 
Configuration

You can configure the runtime settings of uploaded 
Vuser scripts. Runtime settings are applied to Vusers 
when the script runs. 

To open the Runtime Settings dialog box, in the 
Groups pane toolbar, click the Edit Runtime 
Settings  button. For user interface details, see 
"Edit Runtime Settings Dialog Box" on page 516.

Runtime Settings 
Duplication

You can copy runtime settings from one script in 
the test to other scripts of the same script type. In 
the Groups pane toolbar, click the Duplicate 
Runtime Settings  button. 

For details, see Duplicate Runtime Settings in the 
"Groups Pane" user interface details on page 206.
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 8 Define topology, monitoring, and diagnostics options

For task details, see "How to Design a Performance Test" on page 171. 

WAN Emulation WAN Emulation enables you to emulate probable 
WAN effects over your network, thereby creating a 
more realistic performance test. 

To open the WAN Emulation Settings dialog box, in 
the Groups pane toolbar, click the WAN Emulation 

 button. For user interface details, see "WAN 
Emulation Settings Dialog Box" on page 410.

Terminal Services When using manual load generator distribution, 
you can open terminal services sessions on the load 
generators, enabling you to run multiple GUI Vusers 
simultaneously on the same application. For details, 
see Chapter 13, "Terminal Services Dialog Box."

Optional Test Setting Description
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How to Distribute Vusers Among Vuser Groups

This task describes how to distribute Vusers in a performance test among the 
Vuser groups. You distribute Vusers according to the Vuser distribution 
method you selected for the workload.

You can distribute the Vusers by number, by percentage (manually), or by 
percentage using the relative distribution method.

Note: 

➤ In workloads with group schedules, you can distribute Vusers by number 
only.

➤ This task is part of a higher-level task. For details, see "How to Define a 
Performance Test Workload" on page 192.

This task describes how to:

➤ "Distribute Vusers by number" on page 197

➤ "Distribute Vusers by percentage" on page 199

➤ "Distribute Vusers by percentage using relative distribution" on page 200

Distribute Vusers by number

Note: This procedure assumes that you selected By number when you 
selected the workload for the test. For user interface details, see "Workload 
Types Dialog Box" on page 211.
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➤ Basic schedule: In the Performance Test Designer window, in the Groups 
grid, select a group, and in the Vusers column, enter the number of Vusers 
to allocate to that group. 

 

➤ Real-world schedule: You define the number of Vusers when you define 
the test schedule. For details, see "How to Define a Schedule for the 
Performance Test" on page 247. 

For both run modes, the total number of the Vusers assigned to all the 
Vuser Groups is displayed in the Groups pane toolbar.
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Distribute Vusers by percentage

Note: This procedure assumes that you selected By percentage when you 
selected the workload for the test. For user interface details, see "Workload 
Types Dialog Box" on page 211.

 1 In the Performance Test Designer window, in the Groups grid, in the 
Vusers-100% column for each group, enter the percentage of the total 
number of Vusers to allocate to the group. 

Note: The total of all the groups’ percentages must be exactly 100% for 
the test to be valid.
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 2 Allocate a total number of Vusers to run in the test:

➤ Basic mode: In the Groups pane, enter the number of Vusers in the 
Total Vusers box.

 

➤ Real-world mode: You define the number of Vusers when you define 
the test schedule. For details, see "How to Define a Schedule for the 
Performance Test" on page 247.

Distribute Vusers by percentage using relative distribution

In the Performance Test Designer window, in the Groups grid, click the 
Relative Distribution button to define a ratio by which to distribute the 
Vusers from each group. For user interface details, see Relative Distribution 
in the "Groups Pane" on page 204.



Chapter 8 • Defining Performance Test Workloads

201

Reference

Defining Performance Test Workloads User Interface 

This section includes:

 ➤ Performance Test Designer > Workload Tab on page 202

 ➤ Workload Types Dialog Box on page 211

 ➤ Select Controller Dialog Box on page 214

 ➤ Rendezvous Dialog Box on page 216

 ➤ Test Options Dialog Box on page 219
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Performance Test Designer > Workload Tab 

This tab enables you to define a workload for the test. You select a Controller 
for the test, scripts to run in the test and load generators on which to run 
the Vusers. You also define a run schedule for the test.

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Workload tab.

Relevant tasks "How to Define a Performance Test Workload" on 
page 192

See also See "Groups Pane" below for details about:

➤ View Script dialog box

➤ Edit Command dialog box

➤ Relative Distribution dialog box

➤ Duplicate Runtime Settings dialog box

➤ Duplicate Scheduler Settings dialog box
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Workload Tab Common Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Workload Type Displays the workload type for the test. Click  to open 
the Workload Types dialog box and select a type of 
workload for the test. 

For details, see "Workload Types Dialog Box" on page 211.

Controller Displays the Controller selected for the test. Click  to 
open the Select Controller dialog box and select a 
Controller for the test. 

For details, see "Select Controller Dialog Box" on 
page 214.



Chapter 8 • Defining Performance Test Workloads

204

Groups Pane

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Select Scripts. Opens Scripts Tree pane, enabling you to 
select scripts to run in your test. For details, see "Scripts 
Tree pane" below.

View Script. Opens the script selected in the Groups grid 
in a read-only window. 

Versioning: 

➤ As long as a script is checked in, the same version is 
displayed for all users.

➤ If you have checked out the script, the script displayed 
is your own private copy of the script. If you make 
changes to the script, other users will not be able to 
see your changes until you check the script back in. 
Similarly, if other users check in changes to this script, 
you will not be able to see them as long as you have 
the script checked out.

➤ If another user checks out the script, you will still see 
the latest checked-in version.

Note: To view Service Test scripts, Service Test 11.00 must 
be installed on the client machine.

Edit Runtime Settings. Opens the Runtime Settings 
dialog box for the selected script, enabling you to 
configure its runtime settings. 

To use the default settings, click Use Defaults. Vuser 
scripts have individual runtime setting defaults for 
VuGen and the Controller, to support the debugging 
environment of VuGen and the performance testing 
environment of the Controller.

For more information, see Part VII, "Runtime Settings 
Configuration."
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Edit Command Line. Opens the Command Line dialog 
box, enabling you to pass arguments to instruct the 
Controller how to behave. By passing arguments in the 
command line, you configure test settings without the 
need to manually define them in the user interface.

➤ Command line. Type the name and value of the 
parameter you want to send using the format, 
<Parameter_Name> <value>.

Note: For information about the command line 
parsing functions, or for details about including 
arguments on a command line, see the HP LoadRunner 
Online Function Reference, provided with HP Virtual 
User Generator.

➤ <Command line options>. Select whether to:

➤ Apply the command line to the current script only 

➤ Apply the command line to all the scripts in the test

➤ Add the command line to all the scripts in the test

Note: You cannot pass arguments to Service Test tests.

Delete Group. Deletes the selected Vuser group.

UI Elements Description
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Relative Distribution. Opens the Relative Distribution 
dialog box, enabling you to provide a ration by which 
ALM calculates the percentage of Vusers to distribute to 
each Vuser group.

➤ Ratio. The part of total number of Vusers to distribute 
to the corresponding Vuser group. 

➤ Group Name. The name of the Vuser group. 

Example: To distribute 200 Vusers among the groups at a 
ratio of 1:1:3, type 1 for group1, 1 for group2, and 3 for 
group3. 

20% of the Vusers are assigned to group1, 20% to group2, 
and 60% to group3. That is, 40 Vusers are assigned to 
group1, 40 Vusers to group2 and 120 Vusers to group3.

Note: Enabled in percentage mode only.

View Rendezvous. Opens the Rendezvous dialog box, 
enabling you to enable or disable rendezvous points, and 
set policies for how to treat Vusers when they arrive at a 
rendezvous point. For details, see "Rendezvous Dialog 
Box" on page 216.

Duplicate Runtime Settings. Opens the Duplicate 
Runtime Settings dialog box, enabling you to select a 
source script, and copy its runtime settings to one or 
more scripts of the same type.

Note: The source and destination scripts must be of the 
same script type.

UI Elements Description
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Duplicate Scheduler Settings. Opens the Duplicate 
Scheduler Settings dialog box, enabling you to select a 
source Vuser group, and copy its schedule settings to one 
or more Vuser group in the test.

For details, see the instructions on how to copy group 
schedules in "How to Define a Schedule for the 
Performance Test" on page 247.

Note: Available for schedules by group only. 

WAN Emulation Settings. Opens the WAN Emulation 
Settings dialog box, enabling you to emulate probable 
WAN effects over your network, thereby creating a more 
realistic performance test. 

For details, see "WAN Emulation Settings Dialog Box" on 
page 410.

Automatch Load Generator Properties. Opens the 
Automatch Load Generator Properties dialog box, 
enabling you to specify properties for automatch load 
generators. For details, see "Automatch Load Generators 
Properties Dialog Box" on page 239.

Assign Load Generators to Multiple Groups. Opens the 
Assign Load Generators to Multiple Groups dialog box, 
enabling you to assign one or more load generators—
automatch or specific—to multiple Vuser groups at once. 
You can also use this dialog box to remove one or more 
load generators from multiple Vuser groups at once. For 
details, see "Assign Load Generators to Multiple Groups 
Dialog Box" on page 230.

Note: Available only for the Assign manually load 
generator distribution method. See "LG Distribution" 
below.

<grid filters> Located under each column name. Displays the filter that 
is currently applied to a column. If the filter box is 
empty, no filter is currently applied to the column. 

Type directly into the box and press ENTER to apply the 
filter. 

UI Elements Description
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Total Vusers Displays the total number of Vusers distributed to all of 
the Vuser groups participating in the test. For details, see 
"How to Distribute Vusers Among Vuser Groups" on 
page 197.

LG Distribution Enables you to select a method for assigning load 
generators to the Vuser groups in the test.

➤ Assign all to each group. All of the automatch load 
generators are distributed to all of the participating 
Vuser groups. 

➤ Assign manually. Load generators are distributed 
manually.

For details, see "Load Generator Distribution Overview" 
on page 222.

LG Displays the number of automatch load generators 
selected for the test. 

Note: Available only if Assign all to each group is 
selected in the LG Distribution box. 

UI Elements Description
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Groups grid Displays the Vuser groups participating in the test. 

➤ Vusers. (By Number mode) The number of Vusers 
distributed to the Vuser group. 

Default: 10 Vusers

➤ Vusers-100%. (By Percentage mode) The percentage of 
Vusers distributed to the Vuser group. 

Note: The sum of all the groups’ percentages must not 
exceed 100%.

➤ Group Name. The name of the Vuser group.

➤ Script Name. The name of the Vuser script associated 
with the Vuser group. When the group is selected, the 
script name turns into a link. To select a different 
script, click the script name and select a script.

➤ Load Generators. The load generators assigned to the 
Vuser group.

➤ Script Type. The Vuser script type.

➤ Tag. A tag for the Vuser group. Tagging enables 
categorization and easy identification of Vuser groups. 

Examples:

➤ If you have finished configuring runtime and 
Scheduler settings for the group, you could tag the 
group Done. A group that is not yet done, you could 
tag TODO.

➤ Groups running against the Defects or 
Requirements modules, could be tagged DEF or 
REQ.

UI Elements Description
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Scheduler Pane

The Scheduler pane enables you to define a run schedule for your test. For 
details, see "Scheduler Pane" on page 255.

Scripts Tree pane Opens on the right when you click the Select Scripts  
button. Lists all the VuGen scripts and QuickTest/
Service Test tests that have been uploaded to the project.

Drag and drop one or more scripts from the tree into the 
Groups pane or select the scripts and click . 

Tip: You can select whole folders of scripts, or select 
multiple scripts while holding down the CTRL key on 
your keyboard.

After selecting a script, the Scripts Tree pane closes by 
default. 

➤ To keep the Scripts Tree open, click the Dock  
button. 

➤ To enable the Scripts Tree close automatically, click the 
Undock  button.

UI Elements Description
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Workload Types Dialog Box 

This dialog box enables you to select a type of workload for the performance 
test. The type of workload you choose determines the type of schedule by 
which the test will run, and how the Vusers will be distributed at runtime. 

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Workload tab.

4  Next to the Workload type box, click Select Workload 
Type .

Important 
information

If you change the workload, Scheduler settings are lost.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to Define a Performance Test Workload" on 
page 192

See also ➤ "Performance Test Workload Overview" on page 190

➤ "Scheduling Performance Tests Overview" on page 242

UI Elements Description

Basic schedule, by test. Select this workload type to 
configure all the Vuser groups to run together on the 
same test schedule, in the basic run mode. 

Vusers can be distributed:

➤ By number. The Vuser are distributed by number.

➤ By percentage. The Vusers are distributed by 
percentage.

Basic schedule by group. Select this workload type to 
configure each Vuser groups to run on its own test 
schedule, in the basic run mode. 

In group schedules, Vusers are always distributed by 
number.

Real-world schedule, by test. Select this workload type to 
configure all the Vuser groups to run together on the 
same test schedule, in the real-world run mode. 

Vuser can be distributed:

➤ By number. The Vuser are distributed by number.

➤ By percentage. The Vusers are distributed by 
percentage.

Real-world schedule, by group. Select this workload type 
to configure each Vuser groups to run on its own test 
schedule, in the real-world run mode. 

In group schedules, Vusers are always distributed by 
number.
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Select Controller Dialog Box 

This dialog box enables you to select a Controller for the performance test. 

 

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Workload tab.

4  Next to the Controller box, click .

Important 
information

➤ You select only one Controller for a performance test.

➤ Due to possible heavy load on the Controller and load 
generator hosts during a performance test, if you select 
a C+LG host for Controller functionality, it is best 
practice not to assign it as a load generator as well.

Relevant tasks "How to Define a Performance Test Workload" on 
page 192

See also ➤ "Performance Test Workload Overview" on page 190

➤ "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Automatch: 
Dedicated Controller

At runtime, an available Controller host in the project’s 
host pool is allocated for the test run, and is dedicated for 
Controller functionality. Because it is a dedicated 
Controller, it cannot be allocated as a load generator as 
well.

For details about host allocation, see "Host Allocation" on 
page 102.

Specific Select this option if you want to select a specific 
Controller host. The grid lists the specific Controller 
hosts available in the project’s host pool. 

Note: If a host is marked with a red asterisk (*), it is 
already assigned to a Vuser group as a load generator. Due 
to possible heavy load on the Controller and load 
generator hosts during a performance test, if a host is 
assigned to a Vuser group, it is best practice not to select 
it as a Controller as well.
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Rendezvous Dialog Box 

This dialog box enables you to enable/disable rendezvous points defined in 
the Vuser scripts and to set rendezvous policies that determine how the 
Controller handles Vusers at a rendezvous point.

 

To access ➤ During the test design phase: In the Workload tab, 
click View Rendezvous .

➤ During the test run: On the Performance Test Run 
page, click Rendezvous .

Important 
information

Rendezvous points are inserted in the Vuser script when 
creating the script in VuGen. For information, see the HP 
Virtual User Generator User Guide.

Rendezvous points cause multiple Vusers to perform 
tasks at exactly the same time, thereby creating intense 
user load on the server. Enabling rendezvous points 
enables you to check your system's response under 
specific load. 

For each rendezvous point, you can set Policy attributes. 
During the test run, you can manipulate the Vuser 
behavior at the rendezvous points. 
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks ➤ "How to Define a Performance Test Workload" on 
page 192.

➤ "How to Manage a Performance Test Run" on page 340

See also "Rendezvous Points" on page 190

UI Elements Description

Select all. Selects all the rendezvous points in the grid.

Select none. Clears all the selected rendezvous points in 
the grid.

Switch between selected/none selected. Inverts the 
current selection of rendezvous points. 

That is, the non-selected rendezvous points are selected, 
and the selected rendezvous points are cleared.

Enables/Disables the selected rendezvous point. 
Disabling and enabling a rendezvous influences the level 
of server load. 

Releases the Vusers at the selected rendezvous points.

Available from: Performance Test Run page only
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<Rendezvous grid> Displays the details about the rendezvous points in the 
scripts:

➤ Name. The name of the rendezvous point as given in 
the VuGen script.

➤ Status. The status of the rendezvous point: Enabled or 
Disabled.

➤ Contained in Scripts. The names of the scripts in 
which the rendezvous point was defined.

You select a rendezvous point by clicking it.

Policy Enables you to determine how the Controller handles 
Vusers at a rendezvous point. You set the following policy 
attributes for each rendezvous:

➤ Release when. Sets how many Vusers are released from 
a rendezvous point at a time.

➤ X% of all Vusers arrive at the rendezvous. Releases 
the Vusers only when the specified percentage of all 
Vusers have arrived at the rendezvous point. 
Note: This option interferes with the scheduling of 
the test. If you select this option, your test will not 
run as scheduled.

➤ X% of all running Vusers arrive at the rendezvous. 
Releases the Vusers only when the specified 
percentage of all Vusers running in the test have 
arrived at the rendezvous point.

➤ X Vusers arrive at the rendezvous. Releases the 
Vusers only when the specified number of Vusers 
have arrived at the rendezvous point.

➤ Timeout between Vusers. The timeout value (in 
seconds). After each Vuser arrives at the rendezvous 
point, the Controller waits up to the maximum 
timeout period specified for the next Vuser to arrive. If 
the next Vuser does not arrive within the timeout 
period, the Controller releases all the waiting Vusers 
from the rendezvous. Each time a new Vuser arrives, 
the timer is reset to zero. You set a timeout for each 
rendezvous point.

UI Elements Description
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Test Options Dialog Box 

This dialog box enables you to set general Scheduler and testing options.

 

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Workload tab.

4  In the lower-right area of the Performance Test 
Designer window, click .

Important 
information

This is accessible only when the Workload tab is 
displayed.

Relevant tasks ➤ "How to Define a Schedule for the Performance Test" 
on page 247

➤ "How to Enable IP Spoofing in ALM" on page 325

See also "Performance Test Workload Overview" on page 190
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Enable Scheduler Enables the Scheduler so that you can run the test 
according to a user-defined schedule. To define a 
schedule, this option must be selected.

➤ Stop test when Scheduler ends and Vuser are inactive. 
Automatically stops the test when the test schedule 
has stopped and all the Vusers are in any of the 
following inactive states: Down, Pass, Fail, Error, or 
Stop.

➤ Start the Scheduler after a delay of HH:MM:SS. 
Enables you to specify when, after the Run Test 
command has been issued, the Scheduler should start 
running the schedule. If this option is not selected, the 
schedule starts to run as soon as the test starts 
running.

➤ Wait for all groups to initialize. Instructs the Scheduler 
to wait until all the Vusers in all the Vuser groups have 
finished initializing before starting to run any of the 
groups. 

Note: If you select this option, if any of the Vuser 
groups’ Initialize action is Initialize each Vuser just 
before it runs, the Scheduler automatically changes 
this setting to Initialize all Vusers simultaneously.

➤ Pause Scheduler at test start. Pauses the Scheduler at 
the start of a test run, enabling you make changes to 
the test design just before the test is about to run. You 
can then restart the Scheduler manually. 

Enable IP Spoofer After you define multiple IP addresses, and before you 
run the test, select this option to enable IP spoofing.

Note: You must enable IP spoofing before running a test.

For details about multiple IP addressing, see Chapter 14, 
"Multiple IP Addresses."
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9
Load Generator Distribution 

This chapter includes:

Concepts

➤ Load Generator Distribution Overview on page 222

Tasks

➤ How to Distribute Load Generators Among Vuser Groups on page 225

Reference

➤ Load Generators User Interface on page 229
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Concepts

Load Generator Distribution Overview

Load generators are Performance Center hosts on which Vusers run during a 
test run. 

This section includes:

➤ "Load Generator Types" on page 222

➤ "Load Generator Distribution Methods" on page 223

➤ "Load Generator Attribute Customization" on page 224

Load Generator Types
There are two types of load generators:

➤ Specific load generator. An actual load generator. For example, machine 
host1, located in London. 

➤ Automatch load generator. A load generator placeholder, for example 
LG1. When you assign an automatch load generator to a Vuser group, you 
are not assigning a specific load generator to the group, but rather a 
placeholder for a load generator with specific properties. At runtime, 
specific load generators in the project’s host pool that have the same 
properties as the automatch load generators, are allocated in place of the 
automatch load generators.
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Load Generator Distribution Methods
When you design a performance test, you specify how to distribute load 
generators among the Vuser groups participating in the test. You can 
automatically assign all load generators to each Vuser group, or you can 
manually select which load generators to assign to which group.

➤ Automatic load generator distribution. When you select the automatic 
load generator distribution method, during the test design phase all of the 
automatch load generators in the test are distributed to all of the 
participating Vuser groups. 

At runtime, specific load generators in the project’s host pool that have 
the same properties as the automatch load generators, are allocated in 
place of the automatch load generators.

➤ Manual Load Generator Distribution. Using the manual distribution 
method, you can assign specific load generators to Vuser groups. 

If you are not particular about which load generators should be used for 
the test, you can assign automatch load generators to the groups. At the 
initialization stage of the test run, the automatch load generators are 
automatically replaced with specific load generators from the project’s 
host pool that match the automatch load generators’ properties. 

Tip: Manual distribution enables you to distribute your load generators 
among Vuser groups, without overloading any one load generator.
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Load Generator Attribute Customization
You can customize load generator attributes. For details about how to 
customize host attributes, see the HP Application Lifecycle Management 
Administrator Guide.

When customizing load generator attributes, consider the following:

➤ Create attributes that represent properties about your hosts that will help 
tell one host apart from another host when using them for performance 
testing. 

➤ Because you can select multiple attributes for your host, you can define 
an unlimited number of host attributes. They do not need to be related.

➤ Host attributes can refer to anything, for example, Host Memory - High, 
Spanish environment, Very slow machine.
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Tasks

How to Distribute Load Generators Among Vuser Groups

This task describes how to distribute load generators automatically and 
manually among Vuser groups participating in the performance test.

Note: This task is part of a higher-level task. For details, see "How to Define a 
Performance Test Workload" on page 192.

To learn more about load generator distribution, see "Load Generator 
Distribution Overview" on page 222.

➤ "Prerequisites" on page 226

➤ "Select a load generator distribution method" on page 226

➤ "Specify the load generators to use in the test" on page 226

➤ "Select properties for the automatch load generators - optional" on 
page 228
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 1 Prerequisites

Add Vuser groups to participate in the test. For details, see step 4 of 
"Create Vuser groups and distribute Vusers to the groups" on page 194.

 2 Select a load generator distribution method

On the Groups pane toolbar, in the LG Distribution box, select one of the 
following options:

➤ Assign all to each group. Assigns all the load generators automatically 
to each Vuser group. 

➤ Assign manually. Enables you to assign load generators manually to 
the Vuser groups.

 3 Specify the load generators to use in the test

➤ If you selected Assign all to each group in step 2 above, the LG box is 
displayed to the right of the LG Distribution box. 

Type the number of load generators to use in the test and press ENTER. 
The automatch load generators are distributed to each of the Vuser 
groups and are displayed in the Load Generators column.
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➤ If you selected Assign manually in step 2: 

➤ To select same load generators for multiple groups at once, click the 
Assign Load Generators to Multiple Groups button. In the dialog 
box that opens, select automatch and/or specific load generators to 
to multiple groups. 

Similarly, you can remove load generators that have been assigned 
to the groups.

For user interface details, see "Assign Load Generators to Multiple 
Groups Dialog Box" on page 230.

➤ To select load generators for a specific group only, you can use the 
link that appears in the Load Generators column of a selected 
group. Click the link and select automatch and/or specific load 
generators to assign to the group.

For user interface details, see "Select Load Generators Dialog Box" on 
page 235.
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 4 Select properties for the automatch load generators - 
optional

You can select properties for the automatch load generators that are 
assigned to Vuser groups in your test. Properties include a location and 
other attributes. At runtime, each automatch load generator is matched 
up with an available specific load generator (in the project’s host pool) 
with the same properties.

To select properties for automatch load generators, click the Configure 
Automatch Load Generator Properties button, select one or more 
automatch load generators, and enter a location and/or attributes. 

For user interface details, see "Automatch Load Generators Properties 
Dialog Box" on page 239.

Note: If no properties are specified, the automatch load generator is 
matched up with any load generator in the project’s host pool.
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Reference

Load Generators User Interface 

This section includes:

 ➤ Assign Load Generators to Multiple Groups Dialog Box on page 230

 ➤ Select Load Generators Dialog Box on page 235

 ➤ Automatch Load Generators Properties Dialog Box on page 239
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Assign Load Generators to Multiple Groups Dialog Box 

This dialog box enables you to assign one or more load generators—
automatch or specific—to multiple Vuser groups at once. You can also use 
this dialog box to remove one or more load generators from multiple Vuser 
groups at once.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Workload tab.

4  From the LG Distribution drop-down list, select Assign 
manually. 

5  Click Assign Load Generators to Multiple Groups . 

Important 
information

This dialog box is available only when using the manual 
load generator distribution method.

Relevant tasks ➤ "How to Define a Performance Test Workload" on 
page 192

➤ "How to Distribute Load Generators Among Vuser 
Groups" on page 225

UI Elements Description

Enables you to add more automatch load generators for 
the test. Enter the number of load generators in the 
adjacent box and click Add LGs.

Assigns the selected load generators to the selected Vuser 
groups.

Removes the selected load generators from the selected 
Vuser groups.
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Automatch tab Enables you to select automatch load generators to assign 
to Vuser groups in the test, or to remove assigned 
automatch load generators from the Vuser groups.

➤ Name. The name of the automatch load generator. By 
default, these are named LG1, LG2, and so on. 

➤ Properties. The properties by which the automatch 
load generator is matched up with a specific load 
generator in the project’s host pool at runtime. 

Any is displayed by default. This means that the 
automatch load generator can be matched up with 
any load generator in the project’s host pool at 
runtime. 

To specify properties for an automatch load generator, 
click the corresponding link in this column to open 
the Automatch Load Generator Properties dialog box. 
For details, see "Automatch Load Generators Properties 
Dialog Box" on page 239.

Tip: To select all the load generators in the list, select the 
check box in the check box column heading.

UI Elements Description
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Specific tab Enables you to select load generators from the project’s 
host pool to assign to the Vuser groups in the test, or to 
remove them from the Vuser groups.

➤ Name. The name of the load generator.

➤ State. The state of the load generator: Operational; 
Non-operational; Unavailable

Note: Assigned load generators must be operational 
during runtime.

➤ Location. The location of the load generator.

➤ Purpose. The purpose of the load generator, that is, 
Controller, Load Generator, Data Processor, or a 
combination of these.

Note: 

- Only the hosts in the pool with at least a Load 
Generator purpose are displayed. 

- QuickTest tests cannot run on a load generator that 
has been selected as the Controller of the performance 
test. 

- If a load generator is marked with an asterisk (*), this 
indicates that the load generator host has been 
selected as the Controller. It is recommended not to 
use a Controller host as a load generator as well.

Tip: To select all the load generators in the list, select the 
check box in the check box column heading.

UI Elements Description
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<Select Load 
Generators pane>

Enables you to select load generators to assign to the 
Vuser groups in the test, or to remove them from the 
Vuser groups.

➤ Click the Automatch tab to select automatch load 
generators. 

➤ Click the Specific tab to select specific load generators.

Select Groups pane Enables you to select the Vuser groups to which the 
selected load generators are to be assigned, or from which 
they are to be removed.

➤ Name. The name of the Vuser group.

➤ Assigned Load Generators. The load generators 
currently assigned to the Vuser group. 

Tip: To select all the Vuser groups, select the check box in 
the check box column heading.

UI Elements Description
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Select Load Generators Dialog Box 

This dialog box enables you to assign one or more load generators—
automatch or specific—to a Vuser group.
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User interface elements are described below:

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Workload tab.

4  From the LG Distribution drop-down list, select Assign 
manually. 

5  Select a Vuser group in the Groups pane and click the 
link in the Load Generators column.

Important 
information

This dialog box is available only when using the manual 
load generator distribution method.

Relevant tasks ➤ "How to Define a Performance Test Workload" on 
page 192

➤ "How to Distribute Load Generators Among Vuser 
Groups" on page 225

➤ "How to Create a Terminal Session" on page 311

See also "Load Generator Distribution Overview" on page 222

UI Elements Description

Enables you to add more automatch load generators for 
the test. Enter the number of load generators in the 
adjacent box and click Add LGs.

Available: From the Automatch tab only

Terminal Services. Enables you to configure terminal 
services sessions on the selected load generator. For 
details, see Chapter 13, "Configuring Terminal Sessions."

Available: When you select a load generator in the list.
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Automatch tab Enables you to select automatch load generators to assign 
to the selected Vuser group. 

➤ Name. The name of the automatch load generator. By 
default, these are named LG1, LG2, and so on. 

➤ Properties. The properties by which the automatch 
load generator is matched up with a specific load 
generator at runtime. 

Any is displayed by default. This means that the 
automatch load generator can be matched up with 
any load generator at runtime. To specify properties 
for a particular automatch load generator, click the 
corresponding Any link in the Properties column to 
open the Automatch Load Generator Properties dialog 
box. For details, see "Automatch Load Generators 
Properties Dialog Box" on page 239.

Tip: To select all the load generators in the list, select the 
check box in the check box column heading.

UI Elements Description
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Specific tab Enables you to assign load generators from the project’s 
host pool to the selected Vuser group.

➤ Name. The name of the load generator.

➤ State. The state of the load generator: Operational; 
Non-operational; Unavailable.

Note: Assigned load generators must be operational 
during runtime.

➤ Location. The location of the load generator.

➤ Purpose. The purpose of the load generator, that is, 
Controller, Load Generator, Data Processor, or a 
combination of these. 

Notes: 

- Only the hosts in the pool with at least a Load 
Generator purpose are displayed. 

- You can run QTP tests only on load generators that 
are not also assigned as the Controller for the 
performance test.

- If a load generator is marked with an asterisk (*), this 
indicates that the load generator host has been 
selected as the Controller. It is recommended not to 
use a Controller host as a load generator as well.

Tip: To select all the load generators in the list, select the 
check box in the check box column heading.

UI Elements Description
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Automatch Load Generators Properties Dialog Box 

This dialog box enables you to define properties for an automatch load 
generator. Properties include a location, and other host attributes. At 
runtime, a specific load generator in the project’s host pool matching these 
properties is assigned to the Vuser group.

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Workload tab.

4  On the Groups pane tool bar, click Configure 
Automatch Load Generators Properties . 

Relevant tasks ➤ "How to Distribute Load Generators Among Vuser 
Groups" on page 225

➤ "How to Create a Terminal Session" on page 311
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User interface elements are described below:

UI Elements (A-Z) Description

Enables you to add more automatch load generators for 
the test. Click this button, enter a number of automatch 
load generators to add, and click Add.

Available: When the Assign Manually load generator 
distribution method is selected.

Enables you to configure terminal services sessions on 
the selected load generator. For details, see Chapter 13, 
"Configuring Terminal Sessions."

Available: When the Assign Manually load generator 
distribution method is selected.

Load Generators 
pane

Lists the available automatch load generators.

Properties pane Enables you to define properties for the automatch load 
generators selected in the Load Generators list.

➤ Location. Select a load generator location.

➤ Host Attributes. Select attributes for the load 
generator. 

Tip: The list of attributes can be customized. For 
details, see "Load Generator Attribute Customization" 
on page 224.

Example: If you want a Vuser group to use a load 
generator that is located in London, and that has 
medium strength and memory, then under Location, 
select London, and in the Host Attributes list, select Host 
memory: Medium and Host strength: Medium. At 
runtime, the system tries to assign a specific load 
generator with these properties to the Vuser group.
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Scheduling Performance Tests 

This chapter includes:

Concepts

➤ Scheduling Performance Tests Overview on page 242

Tasks

➤ How to Define a Schedule for the Performance Test on page 247

➤ How to Add Actions to a Test Schedule on page 250

➤ How to Edit Scheduler Actions on page 253

Reference

➤ Scheduling Performance Tests User Interface on page 254
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Concepts

Scheduling Performance Tests Overview 

You use the Scheduler to create a schedule that distributes load in a 
performance test in a controlled manner. 

Using the Scheduler, you can:

➤ Set the time at which the test should begin running, and specify how long 
the Scheduler should wait after the Run Test command is issued, and 
before running Vusers.

➤ Stipulate:

➤ how to initialize the Vusers in the test

➤ how many Vusers to start/stop within a given time period

➤ how often to start running the Vusers—simultaneously or gradually

For details, see "Scheduler Actions" on page 258.

➤ Limit the run duration of the Vusers or Vuser groups within the test by 
specifying the amount of time the Vusers or Vuser groups should be in the 
running state. 

➤ Set a test to run according to the runtime settings defined for the enabled 
Vuser groups, or set the Vuser groups to run over and over again until the 
schedule settings instruct them to stop running.

To define a performance test schedule, see "How to Define a Schedule for the 
Performance Test" on page 247.

This section also includes:

➤ "Types of Test Schedules" on page 243

➤ "Schedule Run Modes" on page 245
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Types of Test Schedules 
When you design a performance test, you can define a schedule according 
to which the participating Vuser groups should run in the test. 

You can schedule all the groups to run together on one schedule, or you can 
define a separate schedule for each Vuser group.

Scheduling By Test

When you schedule by test, all the Vuser groups participate in the test run 
simultaneously. That is, the schedule is applied to all the Vuser groups 
concurrently, and each action is applied proportionally to all the Vusers 
groups.

For example, take a test that includes three participating Vuser groups as 
follows:

Group Name Number of Vusers

Group1 10

Group2 20

Group3 30

Total 60
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When scheduling by test, if the scheduler instructs 30 Vusers to start 
running when it starts the test run, a proportional number of Vusers starts 
running from each group as follows:

Note: The same principle applies when the test is in percentage mode. 

Scheduling By Vuser Group

Note: For tests in Vuser group (number) mode only. 

When you schedule by Vuser group, each Vuser group participating in the 
test runs on its own separate schedule. That is, for each Vuser group, you can 
specify when to start running the Vuser group, how many Vusers in the 
group to start and stop running within specified time intervals, and how 
long the group should continue running. 

Group schedules can run separately, or all at the same time.

Group Name Number of Vusers

Group1 5

Group2 10

Group3 15

Total 30
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Schedule Run Modes
You can schedule a test to run according to the runtime settings defined for 
the Vuser groups, or you can let the groups run over and over again until the 
test schedule instructs them to stop running. 

You can schedule a test to run in one of the following run modes:

➤ Real-world run mode. The test runs according to a user-defined group of 
actions that simulate a real-world schedule of events. Vuser groups run 
according to the iterations defined in their run-time settings, but you can 
define how many Vusers to run at a time, how long Vusers should 
continue to run, and how many Vusers to stop running at a time.

➤ Basic run mode. All enabled Vuser groups run together on one schedule, 
each according to its own run-time settings. You can schedule how many 
Vusers to start running at a time, and how long they should run before 
stopping.
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The following table illustrates how the given schedule types run in 
real-world versus basic run mode:

Schedule by 
Run Mode

Real-world Basic

Test All participating Vuser groups 
run together on one schedule. 
The test runs according to a 
user-defined group of actions 
that emulate a true-to-life 
schedule of events. You can 
schedule Vusers to start and 
stop running numerous times 
during the test, and specify 
how long to keep them in their 
running or stopped state.

All participating Vuser groups 
run together on one schedule, 
each according to its own 
run-time settings. You schedule 
when to start running all the 
Vusers, specify how long they 
should run, and then specify 
how to stop running all the 
Vusers.

Group

(Not 
applicable 
when the 
test is in 
Percentage 
mode)

Each participating Vuser group 
runs according to its own 
defined schedule that emulates 
a true-to-life schedule of events 
for that Vuser group. You can 
schedule Vusers in the groups 
to start and stop running 
numerous times during the 
test, and specify how long to 
keep them in their running or 
stopped state.

Each participating Vuser group 
runs according to its own 
schedule, each according to its 
own run-time settings. For each 
Vuser group, you schedule 
when to start running the Vuser 
group, how to start running all 
the Vusers in the group, specify 
how long the Vusers should 
run, and then specify how to 
stop running all the Vusers in 
the group.
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Tasks

How to Define a Schedule for the Performance Test

This task describes how to define a schedule for a performance test. 

Note: This task is part of a higher-level task. For details, see "How to Define a 
Performance Test Workload" on page 192.

This task includes the following steps:

➤ Prerequisites on page 248

➤ Define a set of scheduler actions on page 248

➤ Group schedules only: Copy a Vuser group’s scheduler settings to other 
groups - optional on page 249

➤ Schedule a start time for the test - optional on page 250
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 1 Prerequisites

➤ In the Performance Test Designer (Test Plan > Right-click a test in the 
tree and select Edit Test > Workload tab), make sure the test contains 
scripts.

➤ The Scheduler must be enabled. Click the Options button located at 
the bottom of the Workload tab. In the Test Options dialog box, ensure 
that Enable Scheduler is selected. For user interface details, see "Test 
Options Dialog Box" on page 219. 

 2 Define a set of scheduler actions

The Actions grid displays the default scheduler actions that correspond to 
the workload type selected in the Workload type box.

In real-world schedules, you can add more scheduler actions, and edit or 
delete existing actions.
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In basic schedules, you can edit the existing scheduler actions.

➤ For details about the scheduler actions, see "Scheduler Actions" on 
page 258).

➤ For details about how to add actions (real-world schedules only), see 
"How to Add Actions to a Test Schedule" on page 250).

➤ For details about how to edit actions, see "How to Edit Scheduler 
Actions" on page 253).

 3 Group schedules only: Copy a Vuser group’s scheduler 
settings to other groups - optional

When scheduling by Vuser group, you can copy a Vuser group’s scheduler 
settings to other Vuser groups. 

Note: 

➤ Scheduler settings copied include the scheduler run mode (basic or 
real-world) and the set of defined scheduler actions.

➤ This option is disabled for global schedules.

 a On the Groups grid toolbar, click the Duplicate Scheduler Settings 
button. 

 b Select the source group whose settings you want to copy, and select 
one or more target groups.

 c Click Apply. The source group’s scheduler settings are copied to the 
target groups.
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 4 Schedule a start time for the test - optional

Click the Options button located at the bottom of the Workload tab. 
Select Start the Scheduler after a Delay of, and enter the amount of time 
after which to start running the test.

How to Add Actions to a Test Schedule 

This task describes how to add actions to a real-world test schedule. 

Note: You can add actions to a real-world schedule only.

This task includes the following steps:

➤ Add an action to the schedule from the Actions grid on page 250

➤ Add an action by splitting one action into two actions on page 252

Add an action to the schedule from the Actions grid

Note: A new action is always added after the action selected in the Actions 
grid.

 1 In the Actions grid, select an action after which to insert the new action, 
and click New scheduler action button’s down arrow. 
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 2 Select the type of action to add. 

Note: You can add a Start Vusers, Stop Vusers, or Duration action. For 
details about each type of action, see "Scheduler Actions" on page 258.

 3 In the Properties column, specify the action’s properties.

➤ If you are adding a Start Vusers or Stop Vusers action, enter the number 
of Vusers to start/stop running, and select how to start/stop running 
the Vusers: simultaneously or gradually. 

If you selected gradually, enter the number of Vusers to start/stop at a 
time, and at what time interval.

➤ If you are adding a Duration action, select how long to run the action.

Click Apply change to save the action settings.

 4 When you have finished adding actions to the schedule, click Save at the 
bottom of the Workload tab.

Note: If you navigate away from the Performance Test Designer window 
without clicking Save, changes applied to the schedule are not saved.
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Add an action by splitting one action into two actions

You can add Start Vusers, Duration, and Stop Vusers actions from the 
Actions grid or from the graph by splitting an action into two halves of the 
original actions.

To split an action in two:

 1 Select the action in the grid, or line in the graph that represents the 
action that you want to split. 

Tip: Selecting the action in the Actions grid highlights the corresponding 
line in the graph.

 2 Click the Split Action button. The selected action/line splits in two. In the 
Actions grid, the original action splits into two equivalent actions, each 
representing half of the original action. 

For example:

➤ Splitting a Duration action of 5 minutes results in two Duration 
actions of 2.5 minutes each.

➤ Splitting a Start Vusers action that starts 20 Vusers results in two 
Start Vusers actions, each starting 10 Vusers.

 3 (Optional) Edit each of the actions. For details, see "How to Edit Scheduler 
Actions" on page 253.
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How to Edit Scheduler Actions 

This task describes how to edit scheduler actions. You can edit all types of 
actions. For details about each action type, see "Scheduler Actions" on 
page 258.

To edit a scheduler action:

 1 In the Actions grid, select the action that you want to edit. The Properties 
column becomes editable. 

 2 Modify the action settings and click Apply change.

 3 When you have finished editing the actions, click Save.

Note: If you navigate away from the Performance Test Designer window 
without clicking Save, changes applied to the schedule are not saved.
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Scheduling Performance Tests User Interface 

This section includes:

 ➤ Scheduler Pane on page 255

 ➤ Scheduler Actions on page 258
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Scheduler Pane

This pane enables you to define a schedule for running your performance 
test.

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Workload tab.

Important 
information

If scripts in your test contain rendezvous points, the test 
will not run as scheduled because the rendezvous points 
interfere with the schedule. For details, see "Rendezvous 
Points" on page 190.

Relevant tasks "How to Define a Schedule for the Performance Test" on 
page 247

See also ➤ "Scheduling Performance Tests Overview" on page 242

➤ "Scheduler Actions" on page 258
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

New scheduler action. Enables you to add an action to 
the test schedule. The new action is added after the 
action selected in the grid.

You can add Start Vuser, Duration, and Stop Vuser actions 
only. For details, see "Scheduler Actions" on page 258.

Available from: Real-world schedule only

Delete selected action. Deletes the selected action.

Split selected action. Splits the selected action into two 
identical halves of the original action.

Apply change. Enables you to apply modifications made 
to the actions in the schedule graph.

 Hide/Show Legend. Hides/Shows the graph legend.

Note for group schedules only: When the legend is 
showing, the group selected in the grid’s title bar is 
read-only in the legend. 

To view/hide one or more of the other Vuser groups, 
select/clear the check boxes next to the Vuser groups 
respectively. 
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Scheduled Vusers Displays a total of the Vusers scheduled to run in the test.

Note: 

➤ When the test is in number mode and you are 
defining a basic schedule, the number of scheduled 
Vusers is updated when you modify the number of 
Vusers in the Vuser groups. You can change the 
number of Vusers in a selected group:

➤ In the Groups grid: Select the group and change the 
number of Vusers

➤ In the Actions grid: Select the group in the Action 
grid’s title bar and change the number of Vusers in 
the Start Vusers action.

➤ In real-world schedules, the total number of Vusers is 
the sum of all the Vusers defined in the Start Vusers 
actions.

<Actions grid> Lists the scheduled actions. Initially the grid displays 
default actions that correspond to the schedule type you 
selected for your workload. For details, see "Workload 
Types Dialog Box" on page 211.

For all schedules, some of the actions can be modified. 

In real-world schedules, you can also add and delete 
actions, enabling you to simulate a more true-to-life 
schedule by which to run your test.

<Schedule graph> Provides a graphical representation of the actions listed 
in the Actions grid.

In real-world schedules, you can add new actions from 
the graph by splitting an action into two identical halves.

UI Elements Description
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Scheduler Actions

A performance test schedule contains a sequence of actions that instruct the 
test when to start running a Vuser group, how to initialize Vusers, when to 
start and stop running Vusers, and how long to run an action.

The following sections describe the available scheduler actions.

➤ "Start Group" on page 259

➤ "Initialize" on page 260

➤ "Start Vusers" on page 261

➤ "Duration" on page 262

➤ "Stop Vusers" on page 263

<Title bar> Displays the type of schedule and the number of 
scheduled Vusers, depending in the type of workload is 
selected for the test:

➤ Global Schedule. Displayed when the schedule is a 
schedule by test. 

➤ Group Schedule for <group>. Displayed for group 
schedules. Displays the name of the group whose 
schedule is displayed in the actions grid.

Messages Displays alert messages.

UI Elements Description
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Start Group

The Start Group action defines when to start running a Vuser group. 
By default, the Start Group action appears as the first action in the Actions 
grid when you select a workload of type: by group.

Note: 

➤ The Start Group action is available for group schedules only.

➤ The Start Group action is always followed by the Initialize action. 

➤ The Start Group action cannot be deleted.

Options Description

Start immediately The Scheduler starts running the 
selected Vuser group as soon as the test 
starts running. 

Resulting action: Start immediately 
after the test begins.

Start with delay After the test starts running, the 
Scheduler waits the specified time (in 
hours, minutes, and seconds) before it 
starts running the selected Vuser 
group.

Resulting action: Start (HH:MM:SS) 
after the test begins.

Start when group The Scheduler starts running the 
selected Vuser group immediately after 
the Vuser group specified in this 
option has finished running.

Resulting action: Start when group 
<group name> finishes.
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Initialize 

The Initialize action instructs the Scheduler to prepare the Vusers so that 
they are in the Ready state and can run. By default, the Initialize action 
appears in the Actions grid for all types of schedules.

Note: The Initialize action cannot be deleted.

Options Description

Initialize all Vusers simultaneously The Scheduler initializes all the Vusers in 
the test or selected Vuser group together, 
and waits the specified amount of time 
before running them.

Resulting action: 
Initialize all Vusers simultaneously
Wait for <00:00:00> (HH:MM:SS) after 
initialization

Initialize gradually The Scheduler initializes the specified 
number of Vusers gradually, according to 
the specified time interval (in hours, 
minutes, and seconds), and waits the 
specified amount of time before running 
them.

Resulting action: 
Initialize <XX> Vusers every (HH:MM:SS) 
Wait for (HH:MM:SS) after initialization.

Initialize each Vuser just before it 
runs

The Scheduler initializes each Vuser in the 
test or selected Vuser group just before it 
starts running.

Resulting action: Initialize each Vuser just 
before it runs.

Note: This option is not available for 
Group schedules when Wait for all groups 
to initialize is selected. See  "Wait for all 
groups to initialize" on page 220.
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Start Vusers

The Start Vusers action instructs the Scheduler to start running the Vusers. 

Note: 

➤ The Scheduler starts running Vusers only when they have reached the 
Ready state.

➤ In a basic schedule, the Scheduler always runs all the Vusers, whether 
simultaneously or gradually. In a real-world schedule, you can select how 
many Vusers to start running at a time.

➤ While a test is running, you can add Vuser groups/scripts to the test and 
enable them. When starting the Vusers gradually, if you add a Vuser 
group after all the Vusers in the test have started running, the new group 
will start running immediately.

Options Description

Start XX Vusers: Simultaneously The Scheduler runs the specified 
number of Vusers simultaneously.

Resulting action: Start XX Vusers: 
Simultaneously

Start XX Vusers: gradually
YY Vusers: every <hh:mm:ss> 
(HH:MM:SS)

The Scheduler runs the specified 
number of Vusers (XX) gradually. 
That is, the Scheduler runs YY Vusers, 
and waits the specified time (in hours, 
minutes, and seconds) before running 
another YY Vusers.

Resulting action: Start XX Vusers: 
YY Vusers every <hh:mm:ss> 
(HH:MM:SS)



Chapter 10 • Scheduling Performance Tests

262

Duration

The Duration action instructs the Scheduler to continue running the test in 
the current state, for the specified amount of time. 

Note: 

➤ In a real-world schedule, if a Duration action is not followed by another 
action, the test continues to run indefinitely.

➤ In a real-world schedule, to avoid unexpected behavior during the test 
run, add a Duration action between consecutive Start Vusers and Stop 
Vusers actions.

➤ In a basic schedule, a Run for Duration action is always followed by a 
Stop Vuser action.

Options Description

Run until complete The test runs until all the Vusers have 
finished running.

Resulting action: Run until completion

Run for The test runs in its current state for the 
specified amount of time (in days, 
hours, minutes, and seconds) before 
continuing with the next action. 

Default: 5 minutes 

Maximum definable duration period: 
99.23:59:59 dd.HH:MM:SS.

Resulting action: Run for 
<dd.hh:mm:ss> (dd.HH:MM:SS)

Run indefinitely The test runs indefinitely.

Resulting action: Run indefinitely

Available for: Basic schedule only
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Stop Vusers

The Stop Vusers action instructs the Scheduler to stop the running Vusers. 

Note: 

➤ A basic schedule that has a Run for Duration action, is always followed by 
a Stop Vuser action that stops all the Vusers, simultaneously or gradually.

➤ In a real-world schedule, to avoid unexpected behavior during the test 
run, add a Duration action between consecutive Start Vusers and Stop 
Vusers actions.

➤ In a real-world schedule, if no action is specified after a Run for Duration 
action, the Vusers continue to run indefinitely—that is, the schedule 
continues to run indefinitely. 

➤ When scheduling by group, if Group A is scheduled to run indefinitely, 
and Group B is scheduled to run after Group A, then Group A must be 
stopped manually before Group B can start running.

Options Description

Stop All/XX Vusers: Simultaneously The Scheduler stops the specified 
number (All or XX) of running Vusers 
at once.

Resulting action: Stop <XX> Vusers: 
Simultaneously

Stop All/XX Vuser: gradually The Scheduler stops the specified 
number of Vusers (All or XX) gradually. 
That is, the Scheduler stops YY Vusers, 
and waits the specified time (in hours, 
minutes, and seconds) before stopping 
another YY Vusers.

Resulting action: Stop <XX> Vuser: 
<YY> Vusers every <hh:mm:ss> 
(HH:MM:SS)
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11
Service Level Agreements 

This chapter includes:

Concepts

➤ Service Level Agreements Overview on page 266

Tasks

➤ How to Define Service Level Agreements on page 268

➤ How to Define Service Level Agreements - Use-Case Scenario on page 270

Reference

➤ Service Level Agreement User Interface on page 275
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Concepts

Service Level Agreements Overview 

Service level agreements (SLAs) are specific goals that you define for your 
performance test. After a test run, HP LoadRunner Analysis compares these 
goals against performance related data that was gathered and stored during 
the course of the run, and determines whether the SLA passed or failed.

Depending on the measurements that you are evaluating for your goal, ALM 
determines the SLA status in one of the following ways:

SLA Type Description

SLA status determined at 
time intervals over a 
timeline

Analysis displays SLA statuses at set time intervals 
over a timeline within the test run. At each time 
interval in the timeline—for example, every 10 
seconds—Analysis checks to see if the 
measurement’s performance deviated from the 
threshold defined in the SLA.

Measurements that can be evaluated in this way:

➤ Average Transaction Response Time

➤ Errors per Second 

SLA status determined 
over the whole run

Analysis displays a single SLA status for the whole 
test run.

Measurements that can be evaluated in this way:

➤ Transaction Response Time - Percentile

➤ Total Hits per run

➤ Average Hits (hits/second) per run

➤ Total Throughput (bytes) per run

➤ Average Throughput (bytes/second) per run
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Note: 

You can define and edit SLAs in ALM or in HP LoadRunner Analysis. 

For details about viewing post-run SLA statuses in ALM Performance Center, 
see "SLA Report" on page 399. 

For details about viewing post-run SLA statuses in Analysis reports, see the 
HP LoadRunner Analysis User Guide.

Tracking Period 
When you define service level agreements (SLAs) for measurements that are 
evaluated over a timeline, Analysis determines SLA statuses at specified time 
intervals within that timeline. The frequency of the time intervals is called 
the tracking period.

An internally-calculated tracking period is defined by default. You can 
change this tracking period by defining a value which Analysis plugs into a 
built-in algorithm to calculate the tracking period. For details, see "Tracking 
Period Dialog Box" on page 286.
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Tasks

How to Define Service Level Agreements 

This task describes how to define service level agreements (SLAs).

You can define service level agreements (SLAs) which measure performance 
test goals over time intervals during a test run, or over a whole performance 
test run. To learn more, see "Service Level Agreements Overview" on 
page 266 and the HP LoadRunner Analysis User Guide.

Note: This task is part of a higher-level task. For details, see "How to Design a 
Performance Test" on page 171.

Tip: For a use-case scenario related to this task, see "How to Define Service 
Level Agreements - Use-Case Scenario" on page 270.

This task includes the following steps:

➤ "Prerequisites" on page 268

➤ "Run through the SLA wizard" on page 269

➤ "Define a tracking period - optional" on page 269

➤ "Results" on page 270

 1 Prerequisites

Create a performance test. For details, see "How to Design a Performance 
Test" on page 171. 
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Note: To define Average Transaction Response Time or Transaction 
Response Time Percentile SLAs, your performance test must include a 
script that contains at least one transaction.

 2 Run through the SLA wizard

In the Performance Test Designer, click the Summary tab. In the Service 
Level Agreement pane, click New to open the Service Level Agreement 
wizard. For user interface details, see "Service Level Agreement Wizard" on 
page 277.

 a Select a measurement for the SLA.

 b If you are defining an SLA for Transaction Response Time (Average/ 
Percentile), select the transactions to include in your goal. 

 c (Optional) When evaluating SLA statuses over a timeline, select a load 
criterion to take into account and define appropriate load value ranges 
for the load criterion. 

 d Set thresholds for the measurements. 

➤ If the values of Transaction Response Time (Average/Percentile) or 
Errors per Second exceed the defined thresholds, Analysis will 
produce a Failed SLA status.

➤ If value of Total Hits, Average Hits per Second, Total Throughput, or 
Average Throughput are lower than the defined threshold, Analysis 
will produce a Failed SLA status.

 3 Define a tracking period - optional

For measurements whose SLA statuses are determined over time intervals, 
you need to define the frequency of the time intervals, that is, the 
tracking period. For details, see "Tracking Period" on page 267. 

For user interface details, see "Tracking Period Dialog Box" on page 286.
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 4 Results

During post test run analysis, HP LoadRunner Analysis compares the data 
collected from the test run against the settings defined in the SLAs, and 
determines SLA statuses which are included in the default Summary 
Report and the SLA Report. 

For more information, see "Results/Last Run Results Tab" on page 354. 

See also the HP LoadRunner Analysis User Guide.

How to Define Service Level Agreements - Use-Case 
Scenario 
This use-case scenario describes how to define a service level agreement 
(SLA) for Average Transaction Response Time.

Note: For a task related to this scenario, see "How to Define Service Level 
Agreements" on page 268.

This use-case scenario includes the following steps:

➤ "Background" on page 271

➤ "Start the SLA wizard" on page 271

➤ "Select the measurement for the SLA" on page 271

➤ "Select the transactions to evaluate in your goal" on page 271

➤ "Select a load criterion and define appropriate ranges of load - optional" 
on page 272

➤ "Set thresholds" on page 273

➤ "Results" on page 274
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 1 Background

The administrator of HP Web Tours would like to know when the average 
transaction response time for booking a flight and searching for a flight 
exceeds a certain value. Assume that your performance test includes a 
script that includes the following transactions: book_flight and 
search_flight.

 2 Start the SLA wizard

In the Service Level Agreement pane, click New to start the Service Level 
Agreement wizard. Click Next.

 3 Select the measurement for the SLA

On the Measurement page, select Transaction Response Time, and from 
the drop-down list, select Average.

 4 Select the transactions to evaluate in your goal

On the Transactions page, select the transactions to be evaluated: 
book_flight and search_flight.
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 5 Select a load criterion and define appropriate ranges of 
load - optional

On the Load Criteria page, select the load criterion to take into account 
when evaluating the average transaction response time.

In this case, to see the effect that various quantities of Vusers running on 
the system has on the average transaction response time of each 
transaction, in the Load Criterion box, select Running Vusers.

Then set the value ranges for the running Vusers:

Consider less than 20 Vusers to be a light load, 20 – 50 Vusers an average 
load, and 50 Vusers or more a heavy load. Enter these values in the Load 
Values boxes.

Note: 

➤ You can set up to three in-between ranges.

➤ Valid load value ranges are consecutive—there are no gaps in the 
range—and span all values from zero to infinity.
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 6 Set thresholds

On the Thresholds page, you define the acceptable average transaction 
response times for the transactions, taking into account the defined load 
criterion. 

In this case, define the same threshold values for both transactions as 
follows: for a light load, a reasonable average response time can be up to 5 
seconds, for an average load, up to 10 seconds, and for a heavy load, up to 
15 seconds.

Tip: To define the same thresholds for all the transactions, enter the 
values in the Apply to all transactions boxes above the table, and click the 
Apply to all button.
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 7 Define a tracking period - optional

When SLA statuses for a measurement are determined at time intervals 
over a timeline, the frequency of the time intervals is determined by the 
tracking period. 

This step is optional because an internally-calculated tracking period of at 
least 5 seconds is defined by default. You can change the tracking period 
in the Tracking Period dialog box:

 a In the Service Level Agreement pane, click the Tracking Period button.

 b Select Tracking period of at least X seconds, and select a tracking 
period. The time intervals are calculated by Analysis according to a 
built-in algorithm and as a function of the value you enter here.

Example:

If you select a tracking period of 10, and the aggregation granularity 
for the performance test (defined in Analysis) is 6, then the tracking 
period is set to the nearest multiple of 6 that is greater than or equal to 
10, that is, Tracking Period = 12.

For details, see "Tracking Period" on page 267. 

For user interface details, see "Tracking Period Dialog Box" on page 286.

 8 Results

When analyzing your test run, Analysis applies your SLA settings to the 
default Summary Report and the report is updated to include all the 
relevant SLA information. 

For example, it displays the worst performing transactions in terms of 
defined SLAs, how specific transactions performed over set time intervals, 
and overall SLA statuses.

For more information, see the HP LoadRunner Analysis User Guide.
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 Service Level Agreement User Interface 

This section includes:

 ➤ Service Level Agreement Pane on page 275

 ➤ Service Level Agreement Wizard on page 277

 ➤ Tracking Period Dialog Box on page 286

Service Level Agreement Pane 

This pane lists all the service level agreements (SLAs) defined for the 
performance test. 

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Summary tab.



Chapter 11 • Service Level Agreements

276

User interface elements are described below:

Relevant Tasks ➤ "How to Design a Performance Test" on page 171

➤ "How to Define Service Level Agreements" on page 268

See also "Service Level Agreements Overview" on page 266

UI Elements Description

Starts the Service Level Agreement wizard where you can 
define new goals for the performance test.

Opens the Service Level Agreement wizard where you can 
modify the goals defined in the SLA.

Deletes the selected SLA.

Opens the SLA Details dialog box which displays a 
summary of the details of the selected SLA.

Opens the Tracking Period dialog box where you can 
adjust the tracking period for measurements that are 
evaluated per time interval over a timeline. 

For conceptual information, see "Tracking Period" on 
page 267.

For user interface details, see "Tracking Period Dialog 
Box" on page 286.

Service Level 
Agreement list

Lists the SLAs defined for the performance test.
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 Service Level Agreement Wizard 

This wizard enables you to define service level agreements (SLAs). SLAs 
enable you to define performance targets or goals for your performance test. 
During a test run, ALM measures performance and collects data. This data is 
compared against thresholds defined in the SLAs.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access To view a list of defined SLAs: 

1  On the ALM sidebar, under Testing, select Test Plan, 
and select a test in the tree. 

2  Click the Test Design tab. The Service Level Agreement 
pane lists the defined SLAs.

To define SLAs: 

1  On the ALM sidebar, under Testing, select Test Plan, 
right-click a test in the tree, and select Edit Test. 

2  In the Performance Test Designer window, click the 
Summary tab. 

3  In the Service Level Agreement pane, click .

Important 
information

You can define SLAs in the Performance Test Designer 
only.

Relevant tasks "How to Define Service Level Agreements" on page 268

Wizard map This wizard contains:

Introduction > Measurement Page > (Transactions Page) > 
(Load Criteria Page) > Thresholds Page > Summary Page

See also "Service Level Agreements Overview" on page 266

UI Elements Description

Skip this page next 
time

When this option is selected, the SLA wizard starts on the 
Measurements page. For details, see "Measurement Page" 
on page 279.

To view the Introduction page again, on the 
Measurement page click Back and clear the Skip this page 
next time option.
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 Measurement Page 
This wizard page enables you to select a measurement for the SLA. Some 
measurements are measured at time intervals over a timeline, and others are 
measured over the whole test run.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

General information about this wizard is available here: 
"Service Level Agreement Wizard" on page 277.

Wizard map The Service Level Agreement Wizard contains:

Introduction > Measurement Page > (Transactions Page) 
> (Load Criteria Page) > Thresholds Page > Summary Page

See also "Service Level Agreements Overview" on page 266

UI Elements Description

Transaction Response 
Time 

➤ Percentile. Measures the percentage of transactions 
whose transaction response time falls below a specific 
threshold. The SLA is measured over the whole run.

➤ Average. Measures whether the average transaction 
response time of the transactions over a specified time 
interval exceeds the defined threshold.

Note: Transaction Response Time SLAs can be defined 
only when at least one of the scripts participating in the 
test includes a transaction.

Errors per Second Measures whether the errors per second over a specified 
time interval exceed the defined threshold.

Total Hits Measures whether the total number of hits over the 
whole test run reach the defined threshold.

Average Hits per 
Second

Measures whether the average hits per seconds over the 
whole test run reach the defined threshold.
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 Transactions Page 
This wizard page enables you to include transactions critical to your test in 
the evaluation.

Total Throughput Measures whether the total throughput over the whole 
test run reaches the defined threshold.

Average Throughput Measures whether the average throughput over the 
whole test run reaches the defined threshold.

Important 
information

➤ General information about this wizard is available 
here: "Service Level Agreement Wizard" on page 277.

➤ The Transaction page is displayed only when at least 
one of the scripts participating in the test includes a 
transaction.

Wizard map The Service Level Agreement Wizard contains:

Introduction > Measurement Page > (Transactions Page) 
> (Load Criteria Page) > Thresholds Page > Summary Page

See also "Service Level Agreements Overview" on page 266

UI Elements Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

 Load Criteria Page
This wizard page enables you to select a load criterion for your goal and 
define appropriate load value ranges. For example, you can define the SLA to 
show the behavior of errors per second when there are less than 5 running 
Vusers, when there are between 5 and 10 running Vusers, and when there 
are 10 or more running Vusers.

UI Elements Description

Available 
Transactions

Lists the transactions in the scripts participating in the 
test. 

To move a script to the Selected Transaction list, 
double-click it.

Note: You must select at least one transaction for 
evaluation.

Selected Transactions Lists the transactions in the scripts that have been 
selected for the SLA.

To remove a script from this list, double-click it.

Note: At least one transaction must be listed.

Important 
information

➤ General information about this wizard is available 
here: "Service Level Agreement Wizard" on page 277.

➤ This page is available only when defining the Average 
Transaction Response Time or Errors per Second SLAs.

➤ In the next wizard step (Thresholds page), you will set 
different thresholds per each of these load value 
ranges.

Wizard map The Service Level Agreement Wizard contains:

Introduction > Measurement Page > (Transactions Page) > 
(Load Criteria Page) > Thresholds Page > Summary Page

See also "Service Level Agreements Overview" on page 266



Chapter 11 • Service Level Agreements

282

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Measurement The measurement selected for the SLA.

Load Criterion The load criterion to consider when evaluating the goal.

➤ None. Does not consider any load criterion.

➤ Running Vusers. Considers the impact of the running 
Vusers.

➤ Throughput. Considers the impact of throughput.

➤ Hits per Second. Considers the impact of the hits per 
second.

For Average Transaction Response Time, you can also 
select:

➤ Transactions per second. Considers the impact of the 
transactions per second.

➤ Transactions per second (passed). Considers the 
impact of the transactions per second that passed the 
evaluation.

Load Values Values of load to consider when evaluating the goal. 

Value ranges must be consecutive, spanning all values 
from zero to infinity.

➤ Less than. The lower range is always from 0 up to, but 
not including, the value entered here. 

Example: If you enter 5, the lower range is between 0 
and 5, but does not include 5.

➤ Between. The in-between ranges include the lower 
value of the range, but not the upper value.

Example: If you enter 5 and 10, the range is from 5 
and up to, but not including, 10.

Note: You can set up to three in-between ranges.

➤ Greater than. The upper range is from the value 
entered here, and higher.

Example: If you enter 10, the upper range is from 10 
and up.
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 Thresholds Page 
This wizard page enables you to define thresholds for the selected 
measurement. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

General information about this wizard is available here: 
"Service Level Agreement Wizard" on page 277.

Wizard map The Service Level Agreement Wizard contains:

Introduction > Measurement Page > (Transactions Page) > 
(Load Criteria Page) > Thresholds Page > Summary Page

See also "Service Level Agreements Overview" on page 266

UI Elements Description

Measurement The measurement selected for the SLA.

Percentile Percentage of transactions to measure against the 
configured threshold.

Available for the following measurement: Transaction 
Response Time Percentile 

Apply to all 
transactions

Enables you to define a threshold or a set of thresholds 
for all of the listed transactions. Click  to apply 
the thresholds to all of the listed transactions 
simultaneously.

Note: Threshold values for the transactions do not have 
to be the same. You can assign different values for each 
transaction.

Available for the following measurement: Average 
Transaction Response Time
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Provide a threshold 
value for all 
transactions

Enables you to define one threshold for all of the listed 
transactions. Click  to apply the value to all of 
the listed transactions simultaneously.

Note: The threshold values for the transactions do not 
have to be the same. You can assign different values for 
each transaction.

Available for the following measurements: Transaction 
Response Time Percentile 

Threshold/
<Threshold table>

The minimum/maximum threshold value for the 
selected measurement.

➤ Transaction Response Time Percentile: If the resulting 
value over the whole run exceeds the defined 
threshold values, the SLA produces a Failed status.

➤ Average Transaction Response Time and Errors per 
Second: If the resulting value over the specified time 
interval exceeds the threshold values, the SLA 
produces a Failed status for that time interval.

➤ Average/Total Throughput and Average Hits per 
Second/Total Hits: If the resulting value over the 
whole run is lower than the threshold value, the SLA 
produces a Failed status.

Notes: 

➤ Transaction Response Time Percentile and Average 
Transaction Response Time: When more than one 
transaction is selected, all of the transactions are listed 
in a table enabling you to define thresholds for each 
transaction separately.

➤ Average Transaction Response Time and Errors per 
Second: When a load criterion is selected, the table 
displays the load value ranges, enabling you to define 
thresholds per range of load values. For details, see 
"Load Criteria Page" on page 281.

UI Elements Description
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 Summary Page 
This wizard page displays a summary of the SLA you defined and enables 
you to define more SLAs.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

General information about this wizard is available here: 
"Service Level Agreement Wizard" on page 277.

Wizard map The Service Level Agreement Wizard contains:

Introduction > Measurement Page > (Transactions Page) > 
(Load Criteria Page) > Thresholds Page > Summary Page

See also "Service Level Agreements Overview" on page 266

UI Elements Description

Define another 
service level 
agreement 

Enables you to define another SLA while still in the SLA 
wizard. 

If this option is selected, clicking Finish takes you directly 
to the page where you can select a measurement for 
another SLA.
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 Tracking Period Dialog Box 

This dialog box enables you to set a tracking period for service level 
agreements.

To access 1  In the Performance Test Designer, click the Summary 
tab.

2  In the Service Level Agreement pane, click the 
Tracking Period button.

Important 
information

For measurements evaluated over a timeline, Analysis 
determines SLA statuses at specified time intervals within 
that timeline. These time intervals are known as the 
tracking period. 

Relevant tasks "How to Define Service Level Agreements" on page 268

See also "Service Level Agreements Overview" on page 266
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Internally calculated 
tracking period

Analysis automatically sets a tracking period over which 
SLA statuses are determined. 

Minimum tracking period: 5 seconds

Tracking period of at 
least <xx> seconds

Analysis sets the tracking period as close as possible to 
the value specified here. 

Minimum tracking period: 5 seconds

Example:

Assume that you select a tracking period of X=10, and 
assume that the aggregation granularity for the 
performance test is 6. The tracking period is set to the 
nearest multiple of 6 that is greater than or equal to 10. 
That is, Tracking Period = 12.

For this option, Analysis uses the following formula: 

Tracking Period = Max(5 seconds, m(Aggregation 
Granularity))

where m is a multiple of the performance test’s 
aggregation granularity such that 
m(Aggregation Granularity) is greater than or equal to X.
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12
Enabling and Configuring ERP/CRM and 
J2EE/.NET Diagnostics 

This chapter includes:

Tasks

➤ How to Enable and Configure ERP/CRM Diagnostics on page 290

➤ How to Enable and Configure J2EE/.NET Diagnostics on page 292

➤ How to View Diagnostics Results on page 293

Reference

➤ Diagnostics User Interface on page 294
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Tasks

How to Enable and Configure ERP/CRM Diagnostics

This task describes how to configure the ERP/CRM Diagnostics modules to 
communicate with the Mediator, and how to define the servers that you 
want to monitor in order to generate diagnostics data.

To learn more about ERP/CRM diagnostics, see "ERP/CRM Diagnostics 
Overview" on page 833.

Note: This task is part of a higher-level task. For details, see "How to Design a 
Performance Test" on page 171.

 1 Prerequisites

➤ Make sure that the ERP/CRM Mediator is installed and configured. If 
this is not the case, consult the administrator for help.

➤ Make sure that the performance test is not already running.

 2 Manually define transactions in the Vuser script

To ensure that valid diagnostics data are generated, manually define the 
transactions in the Vuser script rather than using automatic transactions. 
Make sure to disable the following options in the Run-Time Settings’ 
General : Miscellaneous node: Define each action as a transaction and 
Define each step as a transaction.

 3 (Siebel/Siebel DB) Add think time after transactions

When preparing your script for collection of diagnostics data, we 
recommend that you add think time at the end of each transaction using 
the ratio of one second per hour of testing.
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 4 (Oracle 11i) Clear the server of users while the diagnostics 
module is running.

Make sure that no real or other virtual users are working on the Oracle 
server while the diagnostics module is running, as this may affect 
diagnostics results. 

 5 (Oracle 11i) Select the Oracle NCA application version

The Oracle 11i Diagnostics module supports Oracle NCA versions 11.5.0 
and later. Enter the version of your Oracle application server in VuGen’s 
run-time settings to enable the built-in trace mechanism.

Note: To check the version of your Oracle server, log on to the Oracle 
server and select Help > About Oracle. The version of your Oracle server is 
displayed in the Oracle Application field.

To enter your Oracle application version, open the script in VuGen and 
select Vuser > Run-Time Settings. In the Oracle NCA: Client Emulation 
node, select the version of Oracle NCA that you are using in the 
Diagnostics > Application Version field. 

Note: If the Oracle 11i trace cannot be enabled using the built-in 
mechanism, you can enable it manually in the Vuser script using the 
nca_set_custom_dbtrace and nca_set_dbtrace_file_index functions. This 
may occur if you are using a custom application that does not have a 
standard user interface.
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 6 Enable the diagnostics module

On the ALM sidebar, under Testing, select Test Lab. Then select the 
desired performance test, and select Test Design > Edit Test > Diagnostics 
tab where you enable and configure the relevant diagnostics module. For 
user interface details, see "Performance Test Designer > Diagnostics Tab" 
on page 295.

How to Enable and Configure J2EE/.NET Diagnostics 

This step describes how to capture J2EE/.NET diagnostics metrics in a 
performance test, and how to select the probes that are included in the test.

To learn more about J2EE/.NET diagnostics, see "J2EE/.NET Diagnostics 
Overview" on page 832.

Note: This task is part of a higher-level task. For details, see "How to Design a 
Performance Test" on page 171.

Enable J2EE/.NET diagnostics from the Diagnostics Tab

Select the desired performance test, and then select Test Design > Edit Test > 
Diagnostics tab where you enable and configure J2EE/.NET Diagnostics. For 
user interface details, see "Performance Test Designer > Diagnostics Tab" on 
page 295.
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How to View Diagnostics Results 

You view results for ERP/CRM as well as J2EE/.NET diagnostics in HP 
LoadRunner Analysis.

 1 Open Analysis

 a Select Start > Programs > LTS > Analysis.

 b Open the desired results file from the following location: 

<LTS installation>\orchidtmp\Results\<Domain Name+Project 
Name>\Run_<Run number>\res<Run number>\res<Run number>.lrr

 2 View results in the Analysis diagnostics graphs

You can use the Analysis diagnostics graphs and reports to view the 
performance data and drill down to pinpoint problem areas in any layer 
of the application.

For information about specific diagnostics graphs, see the following 
sections in the HP LoadRunner Analysis User Guide:

➤ Siebel Diagnostics Graphs

➤ Siebel DB Diagnostics Graphs

➤ Oracle 11i Diagnostics Graphs 

➤ SAP Diagnostics Graphs

➤ J2EE & .NET Diagnostics Graphs
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Reference

Diagnostics User Interface 

This section includes:

 ➤ Performance Test Designer > Diagnostics Tab on page 295

 ➤ J2EE/.NET Configuration Dialog Box on page 297

 ➤ Oracle 11i Configuration Dialog Box on page 299

 ➤ Oracle 11i Server Configuration Dialog Box on page 300

 ➤ SAP Configuration Dialog Box on page 301

 ➤ Siebel Configuration Dialog Box on page 303

 ➤ Siebel DB Configuration Dialog Box on page 305

 ➤ Siebel DB Server Configuration Dialog Box on page 306

 ➤ Siebel Server Configuration Dialog Box on page 307



Chapter 12 • Enabling and Configuring ERP/CRM and  J2EE/.NET Diagnostics

295

Performance Test Designer > Diagnostics Tab 

This tab enables you to enable and define the ERP/CRM and J2EE/.NET 
diagnostics modules for a performance test.

 

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Performance Test Designer window, click the 
Diagnostics tab.

Important 
information

➤ The contents of the tab are disabled while the 
performance tests is running. You must enable and 
configure the diagnostics modules before running the 
test.

➤ The settings that you configure are per performance 
test. All scripts in the performance test run under the 
same diagnostics configuration.

Relevant tasks ➤ "How to Enable and Configure ERP/CRM Diagnostics" 
on page 290

➤ "How to Enable and Configure J2EE/.NET Diagnostics" 
on page 292
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User interface elements are described below:

UI Elements (A-Z) Description

Configure Click the  button to configure each diagnostics type. 

For user interface information for the specific diagnostic 
types, see:

➤ "J2EE/.NET Configuration Dialog Box" on page 297

➤ "Oracle 11i Configuration Dialog Box" on page 299

➤ "SAP Configuration Dialog Box" on page 301

➤ "Siebel Configuration Dialog Box" on page 303

➤ "Siebel DB Configuration Dialog Box" on page 305

Enable the following 
Diagnostics for X% 
of all relevant Vusers 
in the test

Specify the percentage of Vusers for which you want to 
collect diagnostics data. This value determines how many 
of the transactions on the application server are reported 
to the Controller. Reducing this percentage will reduce 
the overhead on the application server for Web Page, 
Oracle 11i, and J2EE & .NET Diagnostics. 

Example: If you enter a sampling value of 25% and run 
12 Vusers in group1, 8 Vusers in group2, and 1 Vuser in 
group3, diagnostics data will be collected for 3 Vusers in 
group1, 2 Vusers in group2, and 1 Vuser in group3.

Note: The minimum percentage of Vuser sampling 
allowed is 1%, or 1 Vuser per group, whichever is more. 

The maximum percentage allowed is the lowest of the 
Max. Vuser Sampling values of all the selected 
diagnostics types.

Example: If you enable Web Page (max 10%), Oracle 11i 
(max 5%) and J2EE/.NET (max 100%) diagnostics, the 
percentage of Vuser participation for J2EE/.NET 
Diagnostics cannot exceed 5%.

Max Vuser Sampling The maximum percentage of the amount of Vusers 
specified in the Enable the following Diagnostics for X% 
... that can be collected.
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J2EE/.NET Configuration Dialog Box 

This dialog box enables you to set up the J2EE/.NET diagnostics module.

To access 1  Select Testing > Test Plan, then select the desired test.

2  Select Test Design > Edit Test > Diagnostics tab.

3  Select Enable the following diagnostics for X% of all 
relevant Vusers in the test.

4  Select Enable by J2EE/.NET Application Diagnostics, 
then click the Configure button .

Important 
information

The dialog box is read only while the performance test is 
running.

Relevant tasks "How to Enable and Configure J2EE/.NET Diagnostics" on 
page 292

See also J2EE & .NET Diagnostics Graphs in the HP LoadRunner 
Analysis User Guide.
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User interface elements are described below: 

UI Elements (A-Z) Description

Monitor server 
requests

Select to capture a percentage of server requests which 
occur outside the context of any Vuser transaction. For 
more information, see"J2EE/.NET Diagnostics 
Overview" on page 832. 

Notes: 

➤ The server requests will be captured at the same 
percentage that was selected for the percentage of 
Vusers in the Diagnostics Distribution dialog box.

➤ Enabling this option imposes an additional overhead 
on the probe. 

Select Probes Table ➤ . Selects a probe for monitoring. At least one probe 
must be selected. 

➤ Probe Name. The name of the probe.

➤ Group. The probe group.

➤ Host Name. The host the probe is running on (or the 
application server on which the probe is installed).

Note: If you upgraded your Diagnostics installation, 
probes from existing performance tests may appear with 
a red status. Clear any probes that appear in red.

There is a firewall 
between the 
Mediator and the 
Controller. Use the 
MI Listener for 
collating results.

Select if the Diagnostics server (or a Diagnostics server in 
Mediator mode in a distributed environment) is located 
behind a firewall.

Note: If there is a firewall between the Controller and the 
Diagnostics Server involved in a load test, you must 
configure the Controller and the Diagnostics Server to 
use the MI Listener to enable the transfer of the offline 
analysis file. For more information, refer to the HP 
Diagnostics Installation and Configuration Guide.

Troubleshoot 
diagnostics for J2EE/
.NET connectivity

Click to open the HP Diagnostics System Health Monitor 
to enable you to investigate any connectivity issues 
between the Diagnostics components.
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Oracle 11i Configuration Dialog Box 

This dialog box enables you to set up the Oracle 11i Diagnostics module to 
communicate with the Mediator.

User interface elements are described below:

To access 1  Select Testing > Test Plan, then select the desired test.

2  Select Test Design > Edit Test > Diagnostics tab.

3  Select Enable the following diagnostics for X% of all 
relevant Vusers in the test.

4  Select Enable by Oracle 11i Diagnostics, then click the 
Configure button .

Relevant tasks "How to Enable and Configure ERP/CRM Diagnostics" on 
page 290

See also ➤ "Oracle 11i Server Configuration Dialog Box" on 
page 300

➤ Oracle 11i Diagnostics Graphs in the HP LoadRunner 
Analysis User Guide

UI Elements (A-Z) Description

Opens the Oracle 11i Server Configuration dialog box 
where you can add Oracle 11i servers and to enter server 
information. For more information, see "Oracle 11i 
Server Configuration Dialog Box" on page 300.

Tests the connections between the Oracle 11i Diagnostics 
module and the Mediator.

Note: This does not check the connections to the Oracle 
servers.

Enables you to edit the server details.
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Oracle 11i Server Configuration Dialog Box 

This dialog box enables you to add Oracle 11i servers and to add server 
information.

User interface elements are described below:

Name The name of the Mediator used to collect and process the 
Oracle 11i diagnostics data. Only one Mediator is 
supported for each diagnostics module.

Servers Table ➤ Server Name. The name of the Oracle server.

➤ Platform. The platform of the Oracle server.

➤ Log Directory. The directory where the Oracle trace 
files (*.trc) are written. 

To access In the Oracle 11i Configuration dialog box, click Add 
Server.

Relevant tasks "How to Enable and Configure ERP/CRM Diagnostics" on 
page 290

See also "Oracle 11i Configuration Dialog Box" on page 299

UI Elements (A-Z) Description

Domain The Oracle server domain.

Log Directory A location where the Oracle application saves the trace 
files. The trace files can be saved in a shared directory on 
the Oracle server or in a separate folder.

Password/Passphrase The user password or passphrase.

Platform The Oracle server platform.

UI Elements (A-Z) Description
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SAP Configuration Dialog Box 

This dialog box enables you to add SAP servers and to add server 
information.

Private Key File The name of the file where the Private Key is stored. This 
can be found on the Mediator. If you specify the file 
name only (without a path), the configuration 
automatically looks for the file in the Mediator’s 
<Mediator Root>\bin directory.

Server Name The name of the Oracle server.

Use Secure Shell Select if you are working with a Secure Shell connection.

User Name The user name of the server where trace files are stored.

Note: For Windows platforms, the user should have 
administrator privileges. 

To access 1  Select Testing > Test Plan, then select the desired test.

2  Select Test Design > Edit Test > Diagnostics tab.

3  Select Enable the following diagnostics for X% of all 
relevant Vusers in the test.

4  Select Enable by SAP Diagnostics, then click the 
Configure button .

Relevant tasks "How to Enable and Configure ERP/CRM Diagnostics" on 
page 290

See also SAP Diagnostics Graphs in the HP LoadRunner Analysis 
User Guide

UI Elements (A-Z) Description



Chapter 12 • Enabling and Configuring ERP/CRM and  J2EE/.NET Diagnostics

302

User interface elements are described below:

UI Elements (A-Z) Description

Validates the connection to the SAP server.

When you click Validate, the Controller produces a 
report of all the servers that are available for diagnostics 
through the Server Host.

Client Number The client number of the selected user.

Name The name of the Mediator used to collect and process the 
SAP diagnostics data. Only one Mediator is supported for 
each diagnostics module.

Note: If you are using a Mediator that is over a firewall, 
enter the local machine key of the Mediator instead of 
the Mediator machine name.

Server Host Name The name of the SAP server.

System Router string Optional. Enter the system router string of the SAP server.

System number The system number of the SAP server.

User Name The user’s unique name for logging onto the SAP server.

User Password The user’s password for logging onto the SAP server.
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Siebel Configuration Dialog Box 

This dialog box enables you to set up the Siebel Diagnostics module to 
communicate with the Mediator.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Testing > Test Plan, then select the desired test.

2  Select Test Design > Edit Test > Diagnostics tab.

3  Select Enable the following diagnostics for X% of all 
relevant Vusers in the test.

4  Select Enable by Siebel Application Diagnostics, then 
click the Configure button .

Relevant tasks "How to Enable and Configure ERP/CRM Diagnostics" on 
page 290

See also ➤ "Siebel DB Server Configuration Dialog Box" on 
page 306

➤ Siebel Diagnostics Graphs in the HP LoadRunner 
Analysis User Guide

➤ Siebel DB Diagnostics Graphs in the HP LoadRunner 
Analysis User Guide

UI Elements (A-Z) Description

Opens the Siebel Server Configuration dialog box where 
you can add Siebel servers and to enter server 
information. For more information, see "Siebel Server 
Configuration Dialog Box" on page 307.

Tests the connections between the Siebel Diagnostics 
module and the Mediator.

Note: This does not check the connections to the Siebel 
servers.

Enables you to edit the server details.
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Name The name of the Mediator used to collect and process the 
Siebel diagnostics data. Only one Mediator is supported 
for each diagnostics module.

Servers Table ➤ Server Name. The name of the Siebel server.

➤ Platform. The platform of the Siebel server.

➤ Log Directory. The Siebel server directory where Siebel 
log files (*.SARM) are written. 

UI Elements (A-Z) Description
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Siebel DB Configuration Dialog Box 

This dialog box enables you to add Siebel DB servers and to add server 
information.

User interface elements are described below:

To access 1  Select Testing > Test Plan, then select the desired test.

2  Select Test Design > Edit Test > Diagnostics tab.

3  Select Enable the following diagnostics for X% of all 
relevant Vusers in the test.

4  Select Enable by Siebel Database Diagnostics, then 
click the Configure button .

Relevant tasks "How to Enable and Configure ERP/CRM Diagnostics" on 
page 290

See also ➤ "Siebel DB Server Configuration Dialog Box"

➤ Siebel DB Diagnostics Graphs in the HP LoadRunner 
Analysis User Guide

UI Elements (A-Z) Description

Opens the Siebel DB Server Configuration dialog box 
where you can add Siebel DB servers and to enter server 
information. For more information, see "Siebel DB Server 
Configuration Dialog Box" on page 306.

Tests the connections between the Siebel DB Diagnostics 
module and the Mediator.

Note: This does not check the connections to the Siebel 
servers.

Enables you to edit the server details.
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Siebel DB Server Configuration Dialog Box 

This dialog box enables you to add Siebel DB servers and add server 
information.

User interface elements are described below:

Name The name of the Mediator used to collect and process the 
Siebel diagnostics data. Only one Mediator is supported 
for each diagnostics module.

Servers Table ➤ Server Name. The name of the Siebel server.

➤ Platform. The platform of the Siebel server.

➤ Log Directory. The Siebel server directory where Siebel 
log files (*.SARM) are written. 

To access In the Siebel DB Configuration dialog box, click Add 
Server.

Relevant tasks "How to Enable and Configure ERP/CRM Diagnostics" on 
page 290

See also "Siebel DB Configuration Dialog Box"

UI Elements (A-Z) Description

Domain The Siebel server domain.

Log Directory A location where the Siebel application saves the trace 
files. The trace files can be saved in a shared directory on 
the Siebel server or in a separate folder.

Password/Passphrase The user password or passphrase.

Platform The Siebel server platform.

UI Elements (A-Z) Description
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Siebel Server Configuration Dialog Box 

This dialog box enables you to add Siebel servers and to enter server 
information.

User interface elements are described below:

Private Key File The name of the file where the Private Key is stored. This 
can be found on the Mediator. If you specify the file 
name only (without a path), the configuration 
automatically looks for the file in the Mediator’s 
<Mediator Root>\bin directory.

Server Name The name of the Siebel server.

Use Secure Shell Select if you are working with a Secure Shell connection.

User Name The user name of the server where trace files are stored.

Note: For Windows platforms, the user should have 
administrator privileges. 

To access In the Siebel Configuration dialog box, click Add Server.

Relevant tasks "How to Enable and Configure ERP/CRM Diagnostics" on 
page 290

See also "Siebel Configuration Dialog Box"

UI Elements (A-Z) Description

Domain The Siebel server domain.

Log Directory A location where the Siebel application saves the trace 
files. The trace files can be saved in a shared directory on 
the Siebel server or in a separate folder.

Password/Passphrase The user password or passphrase.

Platform The Siebel server platform.

UI Elements (A-Z) Description
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Private Key File The name of the file where the Private Key is stored. This 
can be found on the Mediator. If you specify the file 
name only (without a path), the configuration 
automatically looks for the file in the Mediator’s 
<Mediator Root>\bin directory.

Server ID The Siebel server ID.

Server Name The name of the Siebel server.

Server Type The Siebel server type.

Use Secure Shell Select if you are working with a Secure Shell connection.

User Name The user name of the server where trace files are stored.

Note: For Windows platforms, the user should have 
administrator privileges. 

UI Elements (A-Z) Description
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13
Configuring Terminal Sessions 

This chapter includes:

Concepts

➤ Terminal Sessions Overview on page 310

Tasks

➤ How to Create a Terminal Session on page 311

➤ How to Connect to a Terminal Session on page 314

➤ How to Configure a Terminal Session over a Firewall on page 318

Reference

➤ Terminal Sessions User Interface on page 319

Troubleshooting and Limitations on page 322
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Concepts

Terminal Sessions Overview 

Using Performance Center’s terminal sessions, you can run multiple load 
generators simultaneously in your performance test on a terminal server. 
Performance Center allows you to create a new terminal session, or connect 
to an existing session.

Using terminal sessions enables you to overcome the limitation of being 
able to run only a single GUI Vuser on a Windows-based load generator. GUI 
Vusers, which operate graphical user interface (GUI) applications, are 
defined in a GUI Vuser script. You create GUI Vuser scripts using HP’s 
QuickTest Professional (for Web applications). By opening a terminal server 
session for each GUI Vuser, you can run multiple GUI Vusers on the same 
application.

You select the number of terminals to be used in your performance test 
(provided that you have sufficient terminal sessions running), and the 
maximum number of Vusers that can be run per terminal. The maximum 
number of Vusers depends on the Vuser type used in the script. For GUI 
Vusers, the maximum is one Vuser for each terminal session. Performance 
Center then evenly distributes the number of Vusers among the client 
sessions.

For details on how to create or connect to a terminal session, see "How to 
Create a Terminal Session" on page 311.
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Tasks

How to Create a Terminal Session

This task describes how to create a new terminal session.

To learn about terminal sessions, see "Terminal Sessions Overview" on 
page 310.

Note: 

➤ You can enable terminal sessions when configuring performance tests 
with manual load generator distribution only. 

➤ The Terminal Services Manager does not support terminal sessions 
connected over a firewall. To configure terminal sessions over a firewall, 
see "How to Configure a Terminal Session over a Firewall" on page 318.

This task includes the following steps:

➤ "Prerequisites" on page 312

➤ "Configure the Performance Center agent on the load generator machine" 
on page 312

➤ "Check the Terminal Services logon settings" on page 313

➤ "Windows 2003 operating systems: Ensure that each user is not restricted 
to one session" on page 313

➤ "Add the load generator to the system" on page 313

➤ "Configure the terminal session" on page 313
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 1 Prerequisites

➤ Ensure that a load generator host is installed on the terminal server 
machine. For details, see the HP Application Lifecycle Management 
Installation Guide.

Note: You cannot use terminal sessions on UNIX load generators.

➤ Ensure that the Remote Desktop Connection client software is installed 
on the Controller machine. 

Note: For computers running Microsoft Windows XP or Windows Server 
2003, the Terminal Services client program (Remote Desktop Connection) 
is already installed. Remote Desktop Connection can also be installed on 
other 32-bit Windows-based operating systems.

If you are running a terminal client session on a Windows Server 2003 or 
Windows XP SP2 machine, make sure that the Performance Center user 
has Create Global Object privileges. Add the Performance Center 
Administrators group (or group the Performance Center user belongs to) 
to the Create Global Object privilege under Local Security Policies\Users 
Rights on the terminal server machine. 

 2 Configure the Performance Center agent on the load 
generator machine

 a Select Start > Programs > HP Performance Center Host > 
Advanced Settings > Performance Center Agent Configuration. The 
Agent Configuration dialog box opens.

 b Select Enable Terminal Services and click OK. 

 c When prompted to restart the agent, click OK.
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 3 Check the Terminal Services logon settings

Ensure that the correct terminal services settings are selected for the 
Remote Desktop Connection client.

To configure the correct Terminal Server logon settings:

 a On the load generator machine, select Start > Programs > 
Administrative Tools > Terminal Services Configuration. The Terminal 
Services Configuration dialog box opens. Right-click RDP-TCP, and 
select Properties to open the RDP-TCP Properties dialog box.

 b Click the Logon Settings tab.

 c Make sure that Use client-provided logon settings is selected and that 
Always prompt for password is not selected.

 4 Windows 2003 operating systems: Ensure that each user is 
not restricted to one session

For load generators running on Windows 2003 operating systems:

 a Select Start > Programs > Administrative Tools > Terminal Services 
Configuration. The Terminal Services Configuration dialog opens.

 b Select the Server Settings node from the left pane.

 c In the right pane, ensure that the Restrict each user to one session 
attribute is No.

 5 Add the load generator to the system

Use the New Host dialog box to add the load generator the system. For 
user interface details, see "New Host Dialog Box (Lab Management Only)" 
on page 699.

 6 Configure the terminal session

You configure the terminal session from the Terminal Services dialog box. 
For user interface details, see "Terminal Services Dialog Box" on page 320.
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How to Connect to a Terminal Session

This task describes how to connect an existing terminal session.

To learn about terminal sessions, see "Terminal Sessions Overview" on 
page 310.

Note: 

➤ You can enable terminal sessions when configuring performance tests 
with manual load generator distribution only. 

➤ The Terminal Services Manager does not support terminal sessions over a 
firewall. To configure terminal sessions over a firewall, see "How to 
Configure a Terminal Session over a Firewall" on page 318.

This task includes the following steps:

➤ "Prerequisites" on page 315

➤ "Run the Performance Center agent as a process" on page 316

➤ "Configure the Performance Center agent on the load generator" on 
page 316

➤ "Add the load generator to the system" on page 316

➤ "Launch a terminal session from the Controller" on page 317

➤ "Configure the terminal session" on page 317
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 1 Prerequisites

➤ Ensure that a load generator host is installed on the terminal server 
machine. For details, see the HP Application Lifecycle Management 
Installation Guide.

Note: You cannot use terminal sessions on UNIX load generators.

➤ Ensure that the Remote Desktop Connection client software is installed 
on the Controller machine. 

Note: For computers running Microsoft Windows XP or Windows Server 
2003, the Terminal Services client program (Remote Desktop Connection) 
is already installed. Remote Desktop Connection can also be installed on 
other 32-bit Windows-based operating systems.

If you are running a terminal client session on a Windows Server 2003 or 
Windows XP SP2 machine, make sure that the Performance Center user 
has Create Global Object privileges. Add the Performance Center 
Administrators group (or group the Performance Center user belongs to) 
to the Create Global Object privilege under Local Security Policies\Users 
Rights on the terminal server machine. 
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 2 Run the Performance Center agent as a process

 a On the load generator machine, run <Performance Center Host 
installation>\launch_service\bin\Magentconfig.exe. The Agent 
Runtime Settings dialog box opens.

 b Select Manual log in to this machine.

Note: You must run the Performance Center agent as a process for each 
terminal session that you are running.

 3 Configure the Performance Center agent on the load 
generator

 a Select Start > Programs > Performance Center Host > 
Advanced Settings > Performance Center Agent Configuration. The 
Agent Configuration dialog box opens.

 b Select Enable Terminal Services and click OK. 

 c When prompted to restart the agent, click OK.

 4 Add the load generator to the system

Use the New Host dialog box to add the load generator the system. For 
user interface details, see "New Host Dialog Box (Lab Management Only)" 
on page 699.
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 5 Launch a terminal session from the Controller

Note: You must open a terminal session for each terminal that you want 
to run Vusers on during the performance test.

 a Select Start > Programs > Accessories > Communication > Remote 
Desktop Connection, or select Start > Run and run the mstsc 
command. The Remote Desktop Connection dialog box opens.

 b Click Options.

 c In the General tab, enter the name or IP address of a terminal server, or 
select a terminal server from the list of available servers.

 d Enter you user name, password, and domain name (if required) for 
login onto the terminal server.

 e Click Connect to open a Terminal Client window.

 6 Configure the terminal session

You configure the terminal session from the Terminal Services dialog box. 
For user interface details, see "Terminal Services Dialog Box" on page 320.
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How to Configure a Terminal Session over a Firewall 

This task describes how to configure a terminal session on a load generator 
that is located over a firewall.

 1 Open the load generator machine console.

 2 If the Performance Center Agent is not running as a process, run <load 
generator host installation>\launch_service\bin\magentproc.exe. 

 3 Configure the Performance Center Agent on the console:

 a Select Enable Firewall Agent, click Settings. In the Local Machine Key 
field, enter a virtual load generator name, for example, machine_ofw.

 b Select Enable Terminal Services, and click OK.

 4 Create one or more terminal sessions on the load generator console 
machine.

Keep in mind the following:

➤ For each terminal session, run the agent configuration as above. For 
each session, specify a different Local Machine Key name, for example, 
machine_ofw_1, machine _ofw_2, etc.

➤ If you stop the agent on a terminal session, you must reconfigure the 
settings for that particular session before restarting the agent.

➤ When selecting the load generator for the scenario in the Controller, 
select the local machine key for each individual virtual load generator 
used.
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Reference

 Terminal Sessions User Interface 

This section includes:

 ➤ Terminal Services Dialog Box on page 320

 ➤ Performance Center Agent Runtime Settings Dialog Box on page 322
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Terminal Services Dialog Box 

This dialog box enables you to configure terminal sessions.

 

To access Use one of the following:

➤ In the Select Load Generators dialog box, select a load 
generator and click the Terminal Services button . 
For more information, see "Select Load Generators 
Dialog Box" on page 235.

➤ In the Automatch Load Generators Properties dialog 
box, select a load generator then click Terminal 
Services. For more information, see "Automatch Load 
Generators Properties Dialog Box" on page 239.

➤ During Runtime, on the Performance Test Run page, 
click the Load Generators button. Then click 
Terminal Sessions Settings.

Important 
information

During runtime, you can set or change terminal services 
settings only when the load generator is non-operational.

Relevant tasks "How to Create a Terminal Session" on page 311
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Connects to existing 
Terminal Services 
session

Enables a connection to an existing terminal session.

Creates new 
Terminal Services 
sessions

Enables the Controller to launch terminal sessions 
automatically using the Remote Desktop Connection.

Enable Terminal 
Services

Applies the settings to the load generator running on the 
terminal server.

Maximum number of 
Vusers to run in a 
Terminal Service

Enter the maximum number of Vusers that you want to 
run in a terminal session. 

Note: The maximum number of Vusers depends on the 
Vuser type used in the script. For GUI Vusers, the 
maximum is one Vuser for each terminal session.

Number of Terminal 
Services to open on 
Load Generator

Enter the number of terminals in your performance test. 

Note: You must open a terminal session for each terminal 
on which you want to run Vusers during the 
performance test.
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Performance Center Agent Runtime Settings Dialog Box 

This dialog box enables you to run the Performance Center Agent as a 
service, or as a process.

User interface elements are described below:

Troubleshooting and Limitations 

This section describes troubleshooting and limitations for configuring 
terminal sessions.

➤ Host name is an IP address or domain name

You cannot set terminal services for a machine name that was added as an 
IP address or a domain name, when your environment is configured with 
a local user.

When your environment is configured with the default 
Performance Center system user (IUSR_METRO), you cannot set terminal 
services for a machine name that was added as an IP address or a domain 
name (for example, 127.0.0.1, localhost.com). 

Workaround: Delete the host from Lab Management (Hosts module), and 
add the host again using the host name only.

UI Elements (A-Z) Description

Allow virtual users to 
run on this machine 
without user login

Select to run the Performance Center Agent as a service. 
You must enter your user credentials.

Note: This is the default selection.

Manual log in to this 
machine

Select to run the Performance Center Agent as a process. 
This enables you to run multiple GUI Vusers on the same 
load generator. 
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Multiple IP Addresses 

This chapter includes:

Concepts

➤ Multiple IP Addresses Overview on page 324

Tasks

➤ How to Enable IP Spoofing in ALM on page 325

➤ How to Configure Multiple IP Addresses on UNIX on page 328

Reference

➤ IP Wizard on page 330
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Concepts

Multiple IP Addresses Overview 

Application servers and network devices use IP addresses to identify clients. 
The application server often caches information about clients coming from 
the same machine. Network routers try to cache source and destination 
information to optimize throughput. If many users have the same IP 
address, both the server and the routers try to optimize. Since Vusers on the 
same load generator have the same IP address, server and router 
optimizations do not reflect real-world situations.

The Multiple IP Addresses feature enables Vusers running on a single load 
generator to be identified by many IP addresses. The server and router 
recognize the Vusers as coming from different load generators and as a 
result, the testing environment is more realistic.

This feature can be implemented on Windows and UNIX platforms, and 
applies to the following protocols:

Client/Server DNS, Windows Sockets

Custom Javascript Vuser, VB Vuser, VB Script Vuser

E-business FTP, Web (HTTP/HTML), Web Services

ERP/CRM Oracle NCA, Oracle Web Applications 11i, 
PeopleSoft Enterprise, SAP-Web, Siebel-Web

Legacy RTE

Mailing Services Internet Messaging (IMAP), POP3, SMTP

Streaming Data Real



Chapter 14 • Multiple IP Addresses

325

Tasks

How to Enable IP Spoofing in ALM

The following steps describe how to add IP addresses to a load generator to 
enable IP Spoofing.

This task includes the following steps:

➤ "Create multiple IP addresses on the load generator." on page 325

➤ "Update the server’s routing table with the new addresses" on page 326

➤ "Enable the Multiple IP Addresses feature from ALM" on page 327

 1 Create multiple IP addresses on the load generator. 

➤ Windows: Run the IP Wizard to create multiple IP addresses. For details 
on running the IP Wizard, see "IP Wizard" on page 330.

The new IP addresses are added to the load generator once and are 
used for all performance tests. After running the wizard, restart the 
load generator machine.

➤ UNIX: Manually configure the new IP addresses for UNIX load 
generators. For details, see "How to Configure Multiple IP Addresses on 
UNIX" on page 328.
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 2 Update the server’s routing table with the new addresses

Once the client machine has new IP addresses, the server needs the 
addresses in its routing table, so that it can recognize the route back to the 
client. If the server and client share the same netmask, IP class, and 
network, the server’s routing table does not require modification.

Note: If there is a router between the client and server machines, the 
server needs to recognize the path via the router. Make sure to add the 
following to the server routing table: 

➤ A route from the Web server to the router, 

➤ Routes from the router to all of the IP addresses on the load generator. 

Update the Web server routing table as follows:

 a Edit the batch file that appears in the IP Wizard Summary page. An 
example .bat file is shown below. 

 b For each occurrence of [CLIENT_IP], insert your IP address instead.

 c Run the batch file on the server machine.
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 3 Enable the Multiple IP Addresses feature from ALM

After you define multiple IP addresses, you set an option to tell the 
Controller to use this feature.

 a On the ALM sidebar, under Testing, select Test Plan. In the tree, 
right-click a performance test select Edit Test. In the Performance Test 
Designer window, click the Workload tab and click the Options button 
at the bottom of the window. Select Enable IP Spoofer. 

Note: You must select this option before running a performance test.

 b Specify how the Controller should allocate the IP addresses: per 
process or per thread. For details, see the Controller’s general run 
option settings described in "Run Options > General" on page 668.
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How to Configure Multiple IP Addresses on UNIX 

The following sections describe how to manually configure multiple 
IP addresses on the following UNIX load generators:

➤ "HP 11.0 or Later" on page 328

➤ "Linux" on page 328

➤ "Solaris 2.5, 2.6, 7.0, 8.0" on page 329

HP 11.0 or Later

To define multiple IP addresses for a single Ethernet card, you need 
IP Aliasing compiled into the kernel. To do this, use the ifconfig command:

Substitute the new IP address for x.x.x.x, and insert the correct information 
for the subnet mask. Place this command in the rc.local file so that it 
executes upon boot.

Linux

To define multiple IP addresses for a single Ethernet card, you need 
IP Aliasing compiled into the kernel. To do this, use the ifconfig command:

Substitute the new IP address for x.x.x.x, and insert the correct information 
for subnet mask. Place this command in the rc.local file so that it executes 
upon boot.

/sbin/ifconfig lan1:0 x.x.x.x netmask 255.255.x.x up

/sbin/ifconfig eth0:0 x.x.x.x netmask 255.255.x.x up
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Solaris 2.5, 2.6, 7.0, 8.0

To configure the hme0 device to support more than one IP address:

 1 Create entries in /etc/hosts for each hostname on your physical machine:

Create /etc/hostname.hme0:n files that contain the hostname for the 
virtual host n. 

Note: hostname.hme0:0 is the same as hostname.hme0.

The above changes will cause the virtual hosts to be configured at boot 
time. 

 2 You can also directly enable or modify logical hosts’ configuration by 
running ifconfig directly on one of the logical hosts, using the hme0:n 
naming scheme:

To verify the current configuration, use ifconfig –a.

128.195.10.31  myhost
128.195.10.46  myhost2
128.195.10.78  myhost3

/etc/hostname.hme0   (Contains name myhost)
/etc/hostname.hme0:1 (Contains name myhost2)
/etc/hostname.hme0:2 (Contains name myhost3)

% ifconfig hme0:1 up
% ifconfig hme0:1 129.153.76.72
% ifconfig hme0:1 down
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Reference

IP Wizard

This wizard enables you to create and save new IP addresses on Windows 
machines.

To access Use one of the following:

➤ Start > Program Files > Performance Center Host > 
Tools > IP Wizard

➤ From the Performance Center Host’s \bin directory, 
run ipwizard.exe. 

Important 
information

➤ The IP wizard resides on each load generator.

➤ The new addresses can be a range of addresses defined 
by the Internet Assignment Numbers Authority. They 
are for internal use only, and cannot connect to the 
Internet. This range of addresses is the default used by 
the IP Wizard.

➤ The IP Wizard only works on machines with a fixed IP, 
not on machines with a DHCP.

➤ Before any of the changes made can take effect, you 
must restart the machine after you run the wizard, and 
the Web server’s routing table may need to be updated.

Relevant tasks "How to Enable IP Spoofing in ALM" on page 325
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IP Wizard Welcome - Step 1 of 3

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

IP Wizard - Step 2 of 3 - Optional

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Create new settings Enables you to define new IP settings on the load 
generator. 

Load previous 
settings from file

Enables you to use an existing file with IP address 
settings.

Restore Original 
Settings

Restores original settings. 

UI Elements Description

<Web Server Address 
box>

If you have more than one network card, enables you to 
choose the card to use for IP addresses.

This step enables the IP Wizard to check the server’s 
routing table to see if it requires updating after new IP 
addresses are added to the load generator.

For details, see "Update the server’s routing table with the 
new addresses" on page 326.
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IP Wizard - Step 3 of 3 - Optional

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Opens the Add dialog box, enabling you to add a new IP 
address. 

➤ Private Address Spaces. The class that represents the 
correct submask for the machine’s IP addresses.

➤ From IP. Adds IP addresses starting with this number.

➤ Submask. IP addresses include two components, a 
netid and hostid. The submask determines where the 
netid portion of the address stops and where the 
hostid begins.

➤ Number to add. The number of IP addresses to add.

➤ Verify that new IP addresses are not already in use. 
Instructs the IP Wizard to check the new addresses. 
The IP Wizard adds only the addresses that are not 
already in use.

Removes a selected IP Address.

IP Address The IP addresses on the load generator machine.

Subnet Mask The submasks of the IP addresses on the load generator 
machine.

Number of IPs added The number of IP addresses added to the load generator 
machine.
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IP Wizard - Summary

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Summary area> Displays a summary of the operations performed by the 
IP Wizard.

Take note of the location of the batch file (.bat). This is 
used to update the routing table if necessary. See "Update 
the server’s routing table with the new addresses" on 
page 326.

Reboot now to 
update routing 
tables

If you updated the routing table, rebooting initializes the 
Windows device drivers with the new addresses.
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Performance Test Execution

This chapter includes:

Concepts

➤ Running Performance Tests Overview on page 338

Tasks

➤ How to Manage a Performance Test Run on page 340

Reference

➤ Performance Test Execution User Interface on page 347
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Concepts

Running Performance Tests Overview 

After planning, designing and scheduling your performance test, you run it 
to create load on your application and to test its performance.

This section includes:

➤ "Performance Test Execution Flow" on page 338

➤ "Monitoring Performance Test Execution" on page 339

➤ "Analyzing Performance Test Results" on page 339

Performance Test Execution Flow
The following table explains the various stages of the test run flow.

Run stage Description

Start of run At the start of the run, the Controller checks the test 
configuration information, invokes the applications 
that were selected to run with the test, and then 
distributes each Vuser script to its designated load 
generator. When the Vusers are ready, they start 
running their scripts.

During run During the run, you can see a synopsis of the test 
and can also drill down to see which Vuser actions 
are causing the application problems. 

The online graphs display performance data 
collected by the monitors. You use this information 
to isolate potential problem areas in your system.

End of run The test run ends when all the Vusers have 
completed their scripts, when the duration runs 
out, or when you terminate it.
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Monitoring Performance Test Execution
Online monitors enable you to monitor performance test execution. During 
a test run, you can view graphs that display information about the load that 
Vusers generate on your Web server and other applications. ALM 
Performance Center displays this data in real-time during test execution.

At the conclusion of the performance test, you can use HP LoadRunner 
Analysis to view a summary and graphs of the data collected from these 
monitors during the test run. For detailed information on the available 
graphs, see the HP LoadRunner Analysis User Guide.

For a list of supported monitor types, see "Monitor Types" on page 418.

Analyzing Performance Test Results
HP LoadRunner Analysis lets you analyze performance test data off-line, 
from any computer on which Analysis is installed. You use Analysis to 
generate various graph views, merge graphs, drill down within graphs, 
change zoom level and granularity, and so forth.

Analysis integrates with ALM Performance Center to let you analyze data 
collected during a performance test run. You can download raw results and 
sessions for analysis on a local machine. After analyzing the data, you can 
upload the analysis data (HTML and Rich reports) to Performance Center to 
share the results with other users.

For Analysis to access an ALM project, your version of Analysis must be 
properly configured, and be connected to ALM Performance Center.

For information about how to work with ALM Performance Center from 
within Analysis, see the HP LoadRunner Analysis User Guide.

For details about running performance tests, see "How to Manage a 
Performance Test Run" on page 340.
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Tasks

How to Manage a Performance Test Run

This task describes the workflow for running a performance test, and the 
available options for managing the test run.

Note: 

➤ Version Control: If your project is version-enabled: If you have checked 
out your test or related scripts, the checked-out versions are used. If 
another user has checked out the test or scripts and you want to run the 
test or script, the last checked-in version is used.

➤ Product Feature Movie. To view a movie that demonstrates the 
performance testing lifecycle, select Help > Product Feature Movies in 
the ALM main window. Under HP ALM Performance Center 11.00 
Movies, select Lifecycle of a Run.

To learn more about running performance tests, see "Running Performance 
Tests Overview" on page 338.

This task includes the following steps:

➤ "Prerequisite" on page 341

➤ "Begin test execution" on page 341

➤ "Manage Vusers during the test run - optional" on page 341

➤ "Manage runtime monitors, monitor over firewall machines, and load 
generators during the test run" on page 342

➤ "Manually stop the test run and collate run results - Optional" on 
page 342

➤ "View test results and manage result files" on page 342

➤ "Analyze test run results" on page 343
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➤ "View performance improvements and regressions" on page 343

 1 Prerequisite

Make sure that the performance test you want to run is valid. For more 
information, see "How to Design a Performance Test" on page 171. 

 2 Begin test execution

 a In the Test Lab module, create a test set that includes an instance of 
the performance test you want to run. For information on working 
with test sets, see the HP Application Lifecycle Management User Guide.

 b In the Execution Grid tab, right-click the test you want to run, and 
select Run Test. The Select Timeslot dialog box opens, enabling you to 
select a timeslot for the test run. For user interface details, see "Select 
Timeslot Dialog Box" on page 372.

 c Select an available timeslot and click Run. The Initializing Run page 
opens. The Initializing Run page displays the performance test 
initialization steps performed by ALM Performance Center, and the 
status for each step. If each step is completed successfully, the 
performance test starts running and the Performance Test Run page 
opens. 

➤ For Initializing Run page user interface details, see "Initializing Run 
Page" on page 348.

➤ For Performance Test Run page user interface details, see 
"Performance Test Run Page" on page 358.

 3 Manage Vusers during the test run - optional

You can override the defined schedules and manually control the 
behavior of Vusers during a performance test run.

For task details, see "How to Manage Vusers During a Test Run" on 
page 343.
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 4 Manage runtime monitors, monitor over firewall machines, 
and load generators during the test run

You can perform actions related to the status and management of runtime 
monitors, monitor over firewall machines, and load generators during a 
performance test run.

For task details, see "How to Manage Monitoring and Load Generator 
Information During a Test Run" on page 345.

 5 Manually stop the test run and collate run results - Optional

You can manually stop a test run, for example, if you want to delay data 
collection and analysis until a more convenient time. 

➤ To stop the test run gradually. On the Performance Test Run page, 
click the Stop Run button. The Stop Run dialog box opens, which 
prompts you to select a post-run collation option. Select an option, 
then click Stop. All Vusers in the test move to the Gradual Exiting 
state. For user interface details, see "Stop Run Dialog Box" on page 376.

➤ To stop the test run immediately. After clicking the Stop button in the 
Stop Run dialog box, the Stop Run button on the Performance Test 
Run page changes to Stop Now. Click the button to stop all Vusers 
immediately.

 6 View test results and manage result files

➤ View test results. For task details, see the HP Application Lifecycle 
Management User Guide.

➤ Managing test run result and session files. You view and manage result 
files generated by the test run in the Test Lab module’s Results tab. For 
user interface details, see "Results/Last Run Results Tab" on page 354.
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 7 Analyze test run results

You use HP LoadRunner Analysis to analyze test run data off-line, from 
any computer on which Analysis is installed. For information on how to 
access your ALM Project from Analysis, see the HP LoadRunner Analysis 
User Guide.

If there are SLAs defined for the performance test, you can calculate SLA 
results, and view these results in the Analysis Summary report and SLA 
report which can be accessed from the test run’s Result tab. For details, see 
"Results/Last Run Results Tab" on page 354.

 8 View performance improvements and regressions

You can use the Trend Reports feature to view improvements or 
regressions in performance across several test runs. For more information, 
see "Trending" on page 575.

How to Manage Vusers During a Test Run
The following steps describe runtime options for managing the behavior of 
Vusers during a performance test run.

Note: This task is part of a higher level task. For more information, see "How 
to Manage a Performance Test Run" on page 340.

This task includes the following steps:

➤ "View details of individual Vusers" on page 344

➤ "Run Vusers" on page 344

➤ "Add/Edit Vuser groups" on page 344

➤ "View Vuser scripts" on page 345

➤ "Manually release Vusers from a Rendezvous" on page 345
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View details of individual Vusers

You can view status details of individual Vusers, and run/stop a single Vuser 
currently in the down/run state, irrespective of its defined schedules.

On the Performance Test Run page, click the Vusers Details button. The 
Vusers dialog box opens, enabling you to run or stop individual Vusers. For 
user interface details, see "Vusers Dialog Box" on page 390.

Run Vusers

You can initialize, run, or stop any number of Vusers irrespective of their 
defined schedules. In addition, you can add new Vusers to the performance 
test.

On the Performance Test Run page, click the Run Vusers button. The Run 
Vusers dialog box opens, enabling you to run additional Vusers. For user 
interface details, see "Run Vusers Dialog Box" on page 392.

Add/Edit Vuser groups

You can add Vuser groups, or you can modify existing groups during the test 
run.

To open the Add/Edit Vuser Group dialog box:

➤ To add a group. On the Performance Test Run page, click the Design 
Groups and Scheduler button. Then select Add Groups. The Add/Edit 
Vuser Group dialog box opens, enabling you to add a Vuser group.

➤ To edit a group. On the Performance Test Run page, on the Groups pane, 
place the mouse cursor over the name of the group you want to edit. 
Click the down arrow that appears adjacent to the name, and select Edit 
Group. The Edit Group dialog box opens, enabling you to edit the group’s 
details. 

For user interface details, see "Add/Edit Groups Dialog Box" on page 395.
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View Vuser scripts

On the Performance Test Run page, on the Groups pane, place the mouse 
cursor over a group name. Click the down arrow that appears adjacent to 
the name, and select View Script. The View Script dialog box opens up, 
enabling you to view the code for each action in the script.

Manually release Vusers from a Rendezvous

You can manually release a Vusers from a rendezvous before the Controller 
releases them.

On the Performance Test Run page, click the View Rendezvous button. The 
Rendezvous Policy dialog box opens. For user interface details, see 
"Rendezvous Dialog Box" on page 216.

How to Manage Monitoring and Load Generator 
Information During a Test Run
The following steps describe runtime options for managing monitor profile, 
monitor-over-firewall, and load generator information during a 
performance test run.

Note: This task is part of a higher level task. For more information, see "How 
to Manage a Performance Test Run" on page 340.

This task includes the following steps:

➤ "Manage Runtime Monitors" on page 346

➤ "Edit Monitor Over Firewall Information" on page 346

➤ "Manage load generators" on page 346
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Manage Runtime Monitors

You can add, edit, or remove currently running monitors during a 
performance test run.

On the Performance Test Run page, click the Monitors button, and select 
Run Time Monitors. The Monitor Profile Content dialog box opens. For user 
interface details, see "Monitor Profile Content Dialog Box" on page 383.

Edit Monitor Over Firewall Information

You can change the status of a monitor over firewall machine during a 
performance test run.

On the Performance Test Run page, click the Monitors button, and select 
Monitors Over Firewall. The Monitors Over Firewall dialog box opens. For 
user interface details, see "Monitor Over Firewall Dialog Box" on page 388.

Manage load generators

You can perform the following actions with load generators during a 
performance test run: View status and machine utilization, connect and 
disconnect load generators, add load generators to the test, and configure 
terminal sessions.

On the Performance Test Run page, click the Load Generators button. The 
Load Generators dialog box opens. For user interface details, see "Load 
Generators Dialog Box" on page 385.
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Initializing Run Page

The Initializing Run page displays the performance test initialization steps 
performed by ALM Performance Center and the status for each step.

 

To access In the Select Timeslot dialog box, click Run. For 
information about the Select Timeslot dialog box, see 
"Select Timeslot Dialog Box" on page 372.

Relevant tasks "How to Manage a Performance Test Run" on page 340
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User interface elements are described below:

Initialization Steps

The Initialization steps are described below:

UI Elements (A-Z) Description

Description A detailed description of the current status of the step.

Messages Displays error messages generated when a step fails. 
These error messages can also be viewed from the 
Event Log. For details about the event log, see "Event 
Log" on page 351.

Status Displays whether the step passed or failed.

Step Name Displays the step name. For explanations about the 
action ALM Performance Center performs for each 
step, see "Initialization Steps" below.

Timeslot Details Displays details of the selected timeslot.

Step Description

RegisterRun ALM Performance Center initializes the run process.

ValidateScripts ALM Performance Center checks that the selected 
scripts’ Run Logic runtime settings are in sync with 
the scripts’ state.

GetReservationData ALM Performance Center checks the required 
resource information from the selected timeslot.

CheckDiskSpace ALM Performance Center checks that there is enough 
disk space on the Controller.
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LaunchController ALM Performance Center initializes the Controller so 
that other testing entities, such as load generators and 
scripts can connect to it.

If there is a problem launching the Controller, ALM 
Performance Center automatically attempts to find 
an alternative Controller. This attempt appears as an 
additional initialization step.

If no alternative Controller is available, the step fails.

ConnectToLGs ALM Performance Center checks that the required 
load generators are valid and connects them to the 
Controller. If this step fails, ALM Performance Center 
attempts to find alternative load generators 
automatically. If this step still fails, check the test 
definitions and select different load generators for the 
test.

DownloadScripts ALM Performance Center downloads the required 
Vuser scripts.

StartControllerServices ALM Performance Center initializes the Controller’s 
configuration settings in preparation to run the 
performance test.

MapVirtualHosts ALM Performance Center maps virtual hosts to actual 
hosts.

LoadLTOMToController ALM Performance Center creates the performance test 
and adds the Vuser scripts to the Controller.

StartRun ALM Performance Center starts the performance test 
run.

Step Description
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Event Log

The Event Log displays the events that occur in a project, reporting the 
source and severity of each event.

 

To access Use one of the following:

➤ Select Tools > Event Log.

➤ Select the Event Log tab. 

Available from the following modules:

➤ In Lab Management. Hosts, Test Runs, Timeslots, 
PC Servers

➤ In the ALM project. Timeslots (Grid view only), 
Hosts, Test Lab (select the Test Runs tab)



Chapter 15 • Performance Test Execution

352

User interface elements are described below:

Important 
information

➤ The Event Log is only available in the Grid view.

➤ The Event Log displays information for the relevant 
selection. That is, it displays events for an entire 
project, timeslot, host, server, and so on.

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

Set Filter. Enables you to filter and sort the resources in 
the event log. Any currently applied filters or sorting 
orders are displayed below the toolbar. For more details, 
see the HP Application Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
event log and their order. For more details, see the 
HP Application Lifecycle Management User Guide.

Refresh. Refreshes the event log so it displays the most 
up-to-date information.

Export. Opens the Export All Grid Data dialog box, 
enabling you to export the resources in the grid as a text 
file, Microsoft Excel worksheet, Microsoft Word 
document, or HTML document. 

Action The category of action where the event occurred. 

Example. Create Server.

Context The specific entity where the event occurred. 

Example. PC Server: VM05

Creation Date The date and time the event was logged.

Description A description of the event.

Event Log ID The event ID.

Event Name The name of the event.

Event Type An indication of the event’s severity. From most to least 
severe: error, warning, or info.
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Flow Context ID A GUID that indicates a unique action which relates to 
several events. For example, running a test.

Module The ALM module where the event originated. 

Example. Testing.

Project Name The project in which the event occurred.

Responsible The user, or automated system process responsible for the 
event.

Source The system element where the event originated.

Sub Module The ALM sub module where the event occurred. 

Example. Test Lab.

UI Elements (A-Z) Description
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Results/Last Run Results Tab 

This tab enables you to manage results related actions for individual test 
runs.

 

To access ➤ Results tab. On the ALM sidebar, under Testing, select 
Test Lab. Then select the Test Runs tab. The Results tab 
is available in the Information Panel below.

➤ Last Run Results tab. On the ALM sidebar, under 
Testing, select Test Lab. In the left pane select a test 
set, then select the Execution Grid tab in the right 
pane. The Last Run Results tab is displayed in the area 
below.

Important 
information

➤ Results tab. Displays information for the selected test 
run in the Test Runs tab.

➤ Last Run Results tab. Displays information for the last 
test run of the selected test in the Execution Grid tab.

Relevant tasks "How to Manage a Performance Test Run" on page 340
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User interface elements are described below:

UI Elements (A-Z) Description

Collate Results. Collates results of test runs that have not 
yet been collated.

Notes: 

➤ If a test is running on the Controller that will perform 
the collating, ALM Performance Center issues an alert. 
Click OK to proceed with collating the results, or 
Cancel to defer the action until later.

➤ Should the Collate Results process encounter an error, 
the Collate Errors dialog box appears, displaying 
details of the error. To analyze the partially collated 
results, select Analyze partially collated results. Note 
that analyzing partially collated results is an 
irreversible operation.

Recover Results. Enables you to recover and collate the 
results of a failed test run. 

Notes: 

➤ Only enabled when the test run is in the Failed state.

➤ Enables you to collate results only up to the point 
where the test failed.

Analyze Results. Analyzes results for the selected test run. 
ALM Performance Center generates analysis data and 
deletes the temporary results from the load generators 
and the Controller. 

Note: Only enabled when the test run state is Before 
Creating Analysis Data.

Recalculate SLA. Opens the Calculate SLA dialog box. For 
details, see "Calculate Service Level Agreement Dialog 
Box" on page 401.

Note: This feature is available only if SLAs were defined 
during the performance test design phase. For more 
information about SLAs, see "Service Level Agreements" 
on page 265.
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Show HTML Report. Opens an HTML version of the 
Analysis Summary report, which analyzes the data 
collected during the performance test run. The report 
provides general information about the performance test, 
lists statistics about the test run, and provides links to 
graphs containing test run data.

For more details regarding the summary report, see the 
HP LoadRunner Analysis User Guide.

SLA Report. Opens the SLA Report for the selected test 
run. For details, see "SLA Report" on page 399.

Note: This feature is available only if SLAs were defined 
during the performance test design phase. Fore more 
information about SLAs, see "Service Level Agreements" 
on page 265.

Download File. Enables you to download the selected file 
in the grid.

Upload File. Enables you to upload a file to the Results 
tab.

Delete. Deletes the selected result file.

Stop. Stops the current action.

Note: Appears to the right of the progress bar.

<grid> Contains a table that displays all available result files. 
These results include the Analysis session files, raw 
results, a topology snapshot (if a topology is defined for 
the test), among others.

<progress bar> Displays the progress of the current action. 

Description A description of the result file.

ID The result file ID.

Modified The date the result file was last modified.

Modified by The user who last modified the result file.

Name The name of the result file.

UI Elements (A-Z) Description
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State Displays the current state of the selected test runs.

Type The type of result file. 

UI Elements (A-Z) Description



Chapter 15 • Performance Test Execution

358

Performance Test Run Page

The Performance Test Run page displays a detailed overview of the running 
performance test, and enables you to perform all runtime test run actions.

 

To access The Performance Test Run page opens as a tab in My 
Performance Center automatically when a performance 
test starts, or when you join a running test from My 
Performance Center.

Relevant tasks "How to Manage a Performance Test Run" on page 340
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Performance Test Details Pane - Toolbar Buttons

The Performance Test Details pane displays details on the running test.

 

User interface elements are described below:

To access The pane is located in the upper area of the Performance 
Test Details page.

UI Elements (A-Z) Description

Displays the Performance Test Run page Details pane 
Groups view. For more information, see "Performance 
Test Details Pane - Groups View" on page 361.

Displays the Performance Test Run page Details pane 
Transactions view. For more information, see 
"Performance Test Details Pane - Transactions View" on 
page 363.

Displays the Performance Test Run page Details pane 
Messages view. For more information, see "Performance 
Test Details Pane - Messages View" on page 364.

Vusers Details. Displays specific details for each Vuser in 
the performance test, and enables you to run or stop 
individual Vusers irrespective of their defined schedules. 
For user interface details, see "Vusers Dialog Box" on 
page 390.

Run Vusers. Enables you to run additional Vusers during 
the course of a performance test. That is, you can run 
Vusers that are not included in the test’s original defined 
schedule. For user interface details, see "Run Vusers 
Dialog Box" on page 392.
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 Stop Run/Stop Run Now. Enables you to stop a running 
performance test. 

➤ Stop Run. Stops the test gradually by moving all 
running Vusers to the Gradual Exiting state. For user 
interface details, see "Stop Run Dialog Box" on 
page 376.

➤ Stop Run Now. Enabled only after you click the 
Stop Run button. Enables you to stop the Vusers 
immediately. 

Design Groups and Scheduler. Click the arrow adjacent 
to the button for the following options:

➤ Add Group. Enables you to add a Vuser group to a 
running performance test, or to edit Vuser group 
settings during a test run. For user interface details, see 
"Add/Edit Groups Dialog Box" on page 395.

➤ Edit Scheduler. Enables you to edit the scheduler 
during a test run. For user interface details, see "Edit 
Scheduler Dialog Box" on page 381.

Monitors. Click the arrow adjacent to the button for the 
following options:

➤ Runtime Monitors. Displays a list of monitors which 
are currently running during a performance test, and 
enables you to add, edit, and remove monitors during 
the run. For user interface details, see "Monitor Profile 
Content Dialog Box" on page 383.

➤ Monitor Over Firewall Agent. Enables you to change 
the status of a monitor over firewall machine. For user 
interface details, see "Monitor Over Firewall Dialog 
Box" on page 388.

View Rendezvous. Enables you to enable/disable 
rendezvous points defined in the Vuser scripts and to set 
rendezvous policies that determine how the Controller 
handles Vusers at a rendezvous point. For user interface 
details, see "Rendezvous Dialog Box" on page 216.

UI Elements (A-Z) Description
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Performance Test Details Pane - Groups View

The Groups view of the Details pane displays the statuses of the Vusers in 
the performance test.

 

User interface elements are described below:

Load Generators. Enables you to manage the load 
generator in the performance test. For user interface 
details, see "Load Generators Dialog Box" on page 385.

Timeslot Duration. Enables you to extend or shorten the 
duration of the performance test. For user interface 
details, see "Timeslot Duration Dialog Box" on page 375.

Refresh. Enables you to change the rate at which 
Performance Center refreshes the displayed graph data.

Filter Items. Enables you to filter the information being 
displayed.

To access In the Performance Test Run page, in the Details pane, 
click Groups.

Note: Displayed by default.

UI Elements (A-Z) Description

Down The number of Vusers that are down.

Error The number of Vusers for which a problem occurred. 

Exiting

(displayed as Exit)

The number of Vusers that have finished running, or 
have been stopped, and are exiting now.

UI Elements (A-Z) Description
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Failed The number of Vusers that have finished running. The 
script failed.

Gradual Exiting

(displayed as G. Exit)

The number of Vusers that are finishing their current 
iteration before exiting.

Init The number of Vusers that are being initialized on the 
host machine.

Name The Vuser group name.

Passed The number of Vusers that have finished running. The 
script passed.

Paused The number of Vusers that have been paused.

Pending The number of Vusers that are ready to be initialized and 
are waiting for an available load generator, or are 
transferring files to the load generator. The Vusers run 
when the conditions set in their scheduling attributes are 
met. 

Ready The number of Vusers that have already performed the 
init section of the script and are ready to run. 

Rendezvous

(displayed as 
Rendez)

The number of Vusers that have arrived at the 
rendezvous and are waiting to be released.

Run The number of Vusers that are running. The Vuser script 
is being executed on a host machine.

Stopped The number of Vusers that have been stopped manually.

UI Elements (A-Z) Description
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Performance Test Details Pane - Transactions View 

The Transactions view of the Details pane displays how many transactions 
have been executed successfully or unsuccessfully.

 

User interface elements are described below:

To access In the Performance Test Run page, in the Details pane, 
click Transactions.

UI Elements (A-Z) Description

Failed The number of times the transaction failed.

Name The transaction name.

Pass The number of times the transaction passed.

Stopped The number of times the transaction stopped.

Success Rate % The transactions success rate percentage.

TPS The number of times per second the transaction has run.
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Performance Test Details Pane - Messages View 

The Messages view of the Details pane displays error, warning, debug, and 
output messages that are sent to the Controller by the Vusers and load 
generators during a test run.

 

User interface elements are described below:

To access In the Performance Test Run page, in the Details pane, 
click Transactions.

Important 
information

To view details of specific messages, click the number for 
the message type to open the Output Details dialog box. 
For user interface details, see "Output Details Dialog Box" 
on page 378.

UI Elements (A-Z) Description

Script Name The name of the script that generated the message.

Total Debug Sent only if the debugging feature is enabled in the 
Controller. To enable the feature, select Tools > 
PC Project Settings > Controller Options > Debug 
Information.

Total Errors The total number of error messages received. Error 
messages usually indicate that the script failed. 

Total Messages The total number of messages received.

Total Output The total number of output messages received from the 
Vuser script.

Total Warnings The total number of warning messages received. Warning 
messages indicate that the Vuser encountered a problem, 
but the test continued to run. 
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Summary Pane

The Summary pane displays a synopsis of the running performance test.

 

User interface elements are described below:

To access Displayed in the upper left corner of the Performance 
Test Run page.

UI Elements (A-Z) Description

Controller The Controller being used in the test.

Elapsed Time The amount of time since the test began running.

Errors The number of Vuser errors that occurred during the test 
run.

Failed Transactions The number of completed, unsuccessful transactions 
performed during the test run.

Hits per Sec How many hits (HTTP requests) there have been to the 
Web server by Vusers during each second of the test run.

Passed Transactions The number of completed, successful transactions 
performed during the test run.
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Online Graphs Pane

The online monitor graphs are used to display performance measurements 
for those resources being monitored in a performance test.

 

Run ID The run ID.

Running Vusers The number of Vusers currently running in the test.

Scheduler State The current state of the scheduler.

State The current run state.

Test The name of the test.

User The name of the user who is running the test.

To access Displayed in the lower section of the Performance Test 
Run page.

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

# Graphs. Enables you to select the number of graphs 
being displayed.

Graph Configuration. Opens the Graph Configuration 
dialog box which enables you to configure the graphs 
display. The following options are available:

➤ Granularity. The interval of the test displayed in the 
graph.

➤ Time Display. The time displayed on the x-axis.

➤ Relative to the test start. Displays the amount of 
time that has elapsed since the beginning of the test 
(in hours, minutes, and seconds)

➤ Controller clock. Displays the time on the 
Controller clock.

➤ None. No clock or time is displayed.

➤ Scale. Select the desired scale:

➤ Automatic. Each measurement in the graph is 
displayed in the scale that best suits it.

➤ None. Each measurement’s true values are displayed 
in the graph.

➤ Line Style. Select the desired line style:

➤ With markers. Lines in the graph are marked with 
dots.

➤ Without markers. Lines in the graph are smooth.

➤ Apply to all visible graphs. Applies the changes to all 
displayed graphs.

Duplicate Graph. Enables you to duplicate a graph. 

Rename Graph. Enables you to rename a graph.
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Diagnostics Transaction Breakdown. Opens HP 
Diagnostics, displaying the Transactions view, which 
displays performance metrics and drilldown options for 
the relevant transaction. For more information about 
interpreting data in the Diagnostics Transactions view, 
see the section that describes the transaction views in the 
HP Diagnostics User Guide.

Notes: 

➤ Only enabled if your system is configured to work 
with HP Diagnostics.

➤ To ensure that you can view Diagnostics data during a 
performance test run, in the Java Settings’ Java 
Control Panel, click the Network Settings button and 
select Direct Connection. 

<graph legend> Displays details about graph. The following information 
is displayed.

➤ V. Selects the measurement to be displayed on the 
graph.

➤ B. Displays the measurement in bold. 

➤ <color>. Enables you to select in which color the 
measurement appears in the graph.

➤ Name. The measurement name.

➤ Machine. The machine on which the monitor is 
running.

➤ Scale. The graph scale.

➤ Max. The measurement’s maximum value.

➤ Min. The measurement’s minimum value. 

➤ Avg. The measurement’s average value.

➤ Std. The measurement’s standard deviation.

➤ Last. The measurement’s last value.

Graphs Displays a tree which lists all the configured online 
monitors graphs.

UI Elements (A-Z) Description
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Graph Selection Tab

This tab displays a tree which lists all the configured online monitors 
graphs, and enables you to select which graphs to display in the Online 
Graphs pane.

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Click the Graphs tab, on the right of the Online Graphs 
pane.

UI Elements (A-Z) Description

<Online graphs tree> Displays a list of the configured online monitors. Select a 
monitor to display its graph in the Online Graphs pane.
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Topology Tab

This tab displays the topology selected for the performance test, enabling 
you to track the SiteScope monitor status on each component of your AUT.

 

To access Click the Topology tab, on the right of the Online 
Graphs pane.

Important 
information

➤ To ensure that SiteScope monitoring data can be 
displayed for the topology, ensure that the relevant 
SiteScope server is up and running and that 
connectivity has been established.

➤ After the test run, a snapshot of the topology is 
included among the run result files. For details, see 
"Results/Last Run Results Tab" on page 354.

See also "Topologies Overview" on page 46
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Zoom in/out. Enables you to zoom in and out of the 
topology tab.

Fit to screen. Enables you to fit the whole topology to the 
current screen size.

Edit monitor. Opens HP SiteScope, enabling you to edit 
the monitors defined on the component selected in the 
Topology tab. 

Note: During a test run, you can only edit monitors that 
were defined on the components when designing the 
topology. You cannot add new monitors during the test 
run.

<Topology display 
area>

Displays the topology selected for the test.

If monitors are defined on a component in the topology, 
the following icons may appear:

➤ . Indicates that all of the monitors on the 
component are working successfully.

➤ . Indicates that there is an error with at least one of 
the monitors on the component.

➤ . Indicates that at least one of the monitors on the 
component is not working or not receiving data.

➤ . Indicates a warning on at least one of the 
monitors on the component.
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Select Timeslot Dialog Box 

This dialog box enables you to request and reserve resources upon manually 
running a performance test. 

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Opens when you run a performance test. 

Relevant tasks "How to Manage a Performance Test Run" on page 340

See also ➤ "Running Performance Tests Overview" on page 338

➤ "Ad Hoc Timeslot Reservations" on page 97

UI Elements (A-Z) Description

Calculates the availability of the resources required for 
running the test, and refreshes the list of available 
timeslots. 

Uses the hosts reserved by the selected timeslot and runs 
the test. The Performance Center Dashboard opens 
displaying the Performance Test Run page.
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<Requested 
Resources link>

Open the Test Information box which displays the 
required test resources—Controller, and load generators 
and Vusers—as defined in the test.

<select timeslot grid> When you click Calculate Availability, the grid is 
populated with a list of timeslots that can currently 
provide the requested resources for the run.

You select a timeslot based on the result in the Remarks 
column:

➤ NEW. Indicates a new timeslot that can be created 
especially for this run.

➤ RECOMMENDED. Displayed when the test you are 
about to run is linked (without Autostart) to the 
timeslot. When the timeslot was reserved, all the 
resources needed for this test were reserved. It is 
therefore recommended to use this timeslot rather 
than creating a new one. 

➤ UPDATE REQUIRED. Indicates that the timeslot can 
offer some of the resources needed for the test but you 
need to update the timeslot to include all the other 
required resources too.

Note: The resource requiring the update is marked 
with an asterisk (*).

For details about other fields displayed in this grid, see 
"Timeslots Module Fields" on page 134. 

UI Elements (A-Z) Description
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Post-run action The action to be taken when the test run is complete.

➤ Do not collate results. Frees the machines immediately 
after the performance test ends. When the run has 
finished, the run results are left on the load generators. 
You can analyze the results at a later stage from the 
Results 

➤ Collate. When the run has finished, the run results are 
collected from all the load generators. This is 
recommended because collation of results takes only a 
few minutes, and can prevent loss of or inaccessibility 
to results in case any of your load generators becomes 
unavailable.

➤ Collate and Analyze. When the run has finished, the 
run results are collected and analyzed. Data analysis 
requires some time, depending on the size of the 
results file. If there is no timeslot available to include 
the data analysis, select the Collate option instead, 
and run late Analysis when a data processor becomes 
available. You run late Analysis from the Results tab. 
For user interface details, see "Results/Last Run Results 
Tab" on page 354. 

Default value: Collate 

Run duration The amount of time, in hours and minutes, that you 
need the resources reserved. This should be enough time 
to run the test and perform the post-run action that you 
select. 

Use VUDs Requests VUDs Vusers for the test rather than regular 
Vusers. For details about VUDs, see "HP ALM 
Performance Center Licenses Overview" on page 822.

UI Elements (A-Z) Description
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Timeslot Duration Dialog Box 

This page enables you to extend or shorten the current timeslot.

 

User interface elements are described below:

To access During runtime, on the Performance Test Run page, click 
the Timeslot Duration button .

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

Refreshes the Timeslot Remaining Time information.

Prolong Timeslot by 
X minutes

Prolongs the timeslot duration by the selected number of 
minutes.

Shorten Timeslot by 
X minutes

Shortens the timeslot duration by the selected number of 
minutes.



Chapter 15 • Performance Test Execution

376

Stop Run Dialog Box 

This page enables you to stop a running performance test and to select a 
post-run collation option.

 

User interface elements are described below:

To access During a test run, on the Performance Center 
Dashboard’s Performance Test Run page, click the Stop 
Run button .

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

Moves all running Vusers to the Gradual Exiting state.

Collate and analyze 
results

ALM Performance Center collates the run data from the 
load generators and generates analysis data. After data is 
collated, ALM Performance Center automatically deletes 
the temporary results from the load generators and 
controllers. You can display the results using analysis 
tools such as graphs and reports, or download the results 
for analysis on a local machine. This option takes the 
most time.
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Collate only ALM Performance Center collates the run data from the 
load generators. After data is collated, ALM 
Performance Center automatically deletes the temporary 
results from the load generators. You can download the 
raw results from the Results tab, or manually analyze 
results at a later point from the Results tab. 

Note: This is the default setting.

Do not collate results Frees the machines immediately after the test ends. You 
can collate and analyze results at a later point from the 
Results tab.

Free current timeslot Frees the current timeslot once the test has stopped.

UI Elements (A-Z) Description
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Output Details Dialog Box 

This dialog box enables you to view details of messages that are received 
during a test run.

 

To access On the Performance Test Run page, in the Details pane, 
click Messages. Then in the grid, click the number of 
messages for the message type whose details you want to 
view. For more details about the Messages view of the 
Details pane, see "Performance Test Run Page" on 
page 358.

Relevant tasks "How to Manage a Performance Test Run" on page 340
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User interface elements are described below:

UI Elements (A-Z) Description

Opens the Vuser activity log, which enables you to view a 
list of messages per individual Vuser. The log contains the 
following information:

➤ Activity log for Vuser. The selected Vuser whose ID is 
being displayed.

➤ Refresh. Enables you to refresh the log.

➤ Download log. Enables you to download the log.

➤ Log Message area. Displays a list of all messages 
received for the selected Vuser. 

➤ Snapshot. Generates a snapshot (a graphical 
representation of the Web page) of the point in the 
test run where an error occurred. Before using this 
feature, you must install the Snapshot Viewer on your 
desktop, and enable the Show Snapshot on Error 
option in the script’s runtime settings. For more 
information on the runtime settings, see "Script 
Runtime Settings" on page 511.

Refresh. Enables you to refresh the dialog box 
information.

Action The action in the script where the message was 
generated. 

Code The message code.

Host The host that generated the message.

Iteration The iteration during which the message was generated. 

Line Number The line in the script where the message was generated. 

Message The received message.

Script The script that generated the message.

Time The time the message was generated.
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Type The type of message. The possible message types are:

➤ Notify. Provides runtime information.

➤ Error. Usually indicates that the script failed.

➤ Warning. Indicates that the Vuser encountered a 
problem, but that the test continued to run.

➤ Debug. Sent only if the debugging feature is enabled 
in the Controller. To enable the feature, select Tools > 
PC Project Settings > Controller Options > Debug 
Information.

Vuser The Vuser which generated the message.

UI Elements (A-Z) Description
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Edit Scheduler Dialog Box 

This dialog box enables you to edit scheduler settings during a performance 
test run.

 

User interface elements are described below:

To access On the Performance Test Run page, click the Design 
Groups and Scheduler button . Then select Edit 
Scheduler.

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

Stops the scheduler and enables it for editing.

Pauses the scheduler.

Restarts the scheduler after editing.
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<edit scheduler 
section>

Enables you to edit a defined schedule. For more 
information, see "Scheduler Actions" on page 258.

Global/Groups 
Schedule

Displays whether the current schedule has been defined 
by test or by group. 

➤ Start Time. Enter a delay time for the scheduler to 
restart after editing. To restart the scheduler 
immediately, leave this setting blank.

➤ Wait. (Groups schedule only) Select to initialize all 
Vuser groups together.

➤ Group. (Groups schedule only) Select individual 
groups to display and edit their schedules.

Schedule Graph Provides a graphical representation of the defined 
schedule actions.

Status Displays the current scheduler status.

UI Elements (A-Z) Description
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Monitor Profile Content Dialog Box 

This dialog box displays a list of monitors which are currently running 
during a performance test, and enables you to add, edit, and remove 
monitors during the run.

The monitors that are displayed are a combination of the of the monitors 
from all the monitor profiles that were associated to the test, as well as a set 
of ’host’ monitors which are added automatically to every test for each host 
which is used in the test.

 

To access On the Performance Test Run page, click the Monitors 
button , and select Runtime Monitors.

Important 
information

➤ Monitors which are defined as part of a monitor 
profile but fail to run do not appear in the list of 
monitors. 

➤ Default host monitors cannot be modified during 
runtime.

Relevant tasks "How to Manage a Performance Test Run" on page 340
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User interface elements are described below:

UI Elements (A-Z) Description

Add Monitor. Click to add a monitor to the performance 
test. For more information about monitors, see "Add New 
Monitors Page" on page 81.

Edit Monitor. Click to edit the selected monitor. The 
relevant monitor type page opens, enabling you to edit 
the monitor information.

Delete Selected Item. Deletes the selected monitor.

Refresh Monitors List. Refreshes the monitors list.

Check Out. Opens the Check Out dialog box, enabling 
you to check out selected entities. For details, see the 
HP Application Lifecycle Management User Guide.

Available for: Version-control-enabled projects only

Check In. Opens the Check In dialog box, enabling you 
to check in selected entities. For details, see the 
HP Application Lifecycle Management User Guide.

Available for: Version-control-enabled projects only

Undo Check Out. Cancels the check out of selected 
entities and discards changes.

To undo checkouts for entities checked out by other 
users, you must have the appropriate user permissions. 
For more information, refer to the HP Application Lifecycle 
Management Administrator Guide.

When you undo a checkout, any changes you made to 
non-versioned fields while the entity was checked out are 
not cancelled and the new values remain. For details, see 
the HP Application Lifecycle Management User Guide.

Available for: Version-control-enabled projects only
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Load Generators Dialog Box 

This dialog box enables you to view load generator status and machine 
utilization, connect and disconnect load generators, add load generators to 
the test, and to configure terminal sessions.

 

User interface elements are described below:

To access On the Performance Test Run page, click the Load 
Generators button.

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

Select All. Selects all displayed load generators. 

Deselect All. Deselects all displayed load generators.

Invert Selection. Inverts the current selection of load 
generators. That is, the non-selected load generators are 
selected, and the selected load generators are cleared.

Disconnect. Disconnects the selected load generator for 
the performance test.

Connect. Connects the selected load generator for the 
performance test.
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Add Load Generators. Opens the Add Load Generators 
dialog box, which enables you to add load generators to 
the test. For user interface details, see "Add Load 
Generators Dialog Box" on page 387. 

Terminal Session Settings. Opens the Terminal Services 
dialog box, which enables you to configure terminal 
sessions for the load generator. For user interface details, 
see "Terminal Services Dialog Box" on page 320.

Refresh. Refreshes the information displayed in the load 
generators dialog box.

Name The load generator name.

Details Load generator details.

Platform The platform on which the load generator is running.

Status The current status of the load generator. The possible 
statuses are:

➤ Active. The load generator is connected.

➤ Busy. The load generator is running Vusers.

➤ Disconnecting. The load generator is disconnecting.

➤ Down. The load generator is not connected.

➤ Failed. A connection with the load generator could 
not be established.

➤ Ready. The load generator is connected.

UI Elements (A-Z) Description
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Add Load Generators Dialog Box 

This dialog box enables you to add load generators to a running 
performance test.

 

To access In the Load Generators dialog box, click the 
Add Load Generators button . 

Relevant tasks "How to Manage a Performance Test Run" on page 340

See also Chapter 9, "Load Generator Distribution"
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User interface elements are described below:

Monitor Over Firewall Dialog Box 

This dialog box enables you to change the status of a monitor over firewall 
machine during a test run.

UI Elements (A-Z) Description

Add X Automatch 
Load Generators

Enables you to add a specified number of automatch load 
generators. 

Add Specific Load 
Generators

Enables you to add specific load generators. The load 
generator table lists the specific load generators which 
are available, displaying the following information for 
each load generator:

➤ Name. The load generator name.

➤ State. The current state of the load generator: 
Operational, Non-Operational, or Unavailable.

➤ Purpose. The purpose of the load generator, that is, 
Controller, Load Generator, Data Processor, or a 
combination of these.

➤ Location. The location of the load generator.

➤ Host Attributes. Select attributes for the load 
generator.

To access On the Performance Test Run page, click the Monitors 
button , and select Monitor Over Firewall Agent.

Relevant tasks "How to Manage a Performance Test Run" on page 340



Chapter 15 • Performance Test Execution

389

User interface elements are described below:

UI Elements (A-Z) Description

Select All. Selects all displayed monitor over firewall 
machines. 

Deselect All. Deselects all displayed monitor over firewall 
machines.

Invert Selection. Inverts the current selection of monitor 
over firewall machines. 

That is, the non-selected machines are selected, and the 
selected machines are cleared.

Disconnect. Disconnects the selected monitor over 
firewall machine for the performance test.

Connect. Connects the selected monitor over firewall 
machine for the performance test.

Refresh. Refreshes the information displayed in the 
monitor over firewall agent dialog box.
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Vusers Dialog Box 

This dialog box displays specific details for each Vuser in the performance 
test, and enables you to run or stop individual Vusers irrespective of their 
defined schedules.

 

User interface elements are described below:

To access During Runtime, on the Performance Center Dashboard’s 
Performance Test Run page, click the Vusers Details 
button .

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

Select All. Selects all displayed Vusers. 

Deselect All. Deselects all selected Vusers.
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Invert Selection. Inverts the current selection of Vusers. 
That is, the non-selected Vusers are selected, and the 
selected Vusers are cleared.

Run Selected Vusers. Runs the selected Vusers. 

Pause Selected Vusers. Pauses the selected Vusers. 

Stop Selected Vusers Gradually. Stops the selected Vusers 
gradually. The Vusers complete the current iteration 
before stopping.

Stop Selected Vusers Immediately. Stops the selected 
Vusers immediately.

Reset Selected Vusers. Resets the selected Vusers to the 
Down state.

Show Selected Vusers Log. Opens the Vuser Activity Log, 
which displays runtime information for the selected 
Vuser. The log displays the following information:

➤ Activity log for Vuser. The selected Vuser.

➤ Refresh. Refreshes the information displayed in the 
log.

➤ Download log. Enables you to download the log.

➤ Close. Closes the log. 

➤ Log Message. Displays the logged Vuser messages.

➤ Show snapshot. Generates a snapshot of the point 
where an error occurred a test run. Before using this 
feature, you must install the snapshot viewer on your 
desktop, and enable the Snapshot on Error option in 
the Runtime Settings for the Vuser script. For more 
information on configuring the runtime settings, see 
"Script Runtime Settings" on page 511.

Refresh. Refreshes the information displayed in the 
dialog box.

Elapsed Time The amount of time the Vuser has been running.

UI Elements (A-Z) Description
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Run Vusers Dialog Box 

This dialog box enables you to initialize, run, or stop any number of Vusers 
irrespective of their defined schedules. In addition, you can add new Vusers 
to the performance test.

 

Group Filters displayed Vusers by Vuser group.

ID The Vuser’s ID.

Load Generator Filters displayed Vusers by load generators.

Status Filters displayed Vusers by their current status.

To access On the Performance Test Run page, click the Vuser 
Details button .

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

by Vusers.  The Vusers being given an instruction are 
distributed according to Vuser groups.

by Load Generator. The Vusers being given an 
instruction are distributed according to load generators.

by Number. Enables you to give an instruction to a 
specific number of Vusers per Vuser group/load 
generator.

by Percentage. Enables you to give an instruction to a 
specific number of Vusers, which are then distributed 
among the Vuser groups/load generators according to a 
percentage which you define.

Example: If you choose to run an additional 200 Vusers, 
among three Vuser groups, A, B, and C, and you define 
the percentage distribution as A = 75%, B = 20%, and 
C = 5%, then the Vusers would be distributed as follows:

A. 150 Vusers

B. 40 Vusers

C. 10 Vusers

Note: When selecting this method, you enter the 
number of Vusers to run in the box adjacent to the 
by Percentage button.

Enter the number of Vusers per Vuser group/load 
generator.

Enter the percentage distribution per Vuser group/load 
generator.

Performs the selected instruction.

Group Lists the Vuser groups in the test. 
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Load Generator Lists the load generators in the test. 

Perform the 
following Action

Give the desired instruction to the defined number of 
Vusers. The possible actions are:

➤ Add new Vusers to Down state. Add the desired 
number of Vusers to the Down state. 

➤ Initialize Vusers from Down. Initializes the desired 
number of Vusers currently in the Down state.

➤ Run Vusers from Down. Runs the desired number of 
Vusers currently in the Down state.

➤ Run Vusers from Ready. Runs the desired number of 
Vusers currently in the Ready state.

➤ Stop Vusers. Moves the desired number of Vusers from 
the Run state to the Gradual Exiting state.

➤ Reset Vusers. Moves the desired number of Vusers 
from the Stopped state to the Down state.

Note: You cannot perform an action on more Vusers than 
are currently in a particular state. For example, if you 
define 10 Vusers and select Initialize Vusers from Down, 
but there are only five Vusers in the Down state, only 
those five Vusers are initialized.

UI Elements (A-Z) Description
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Add/Edit Groups Dialog Box 

This dialog box enables you to add a Vuser group to a running performance 
test, or to edit Vuser group settings during a test run.

 

To access ➤ When adding a Vuser group. On Performance Test 
Run page, click the Design Groups and Scheduler 
button . Then select Add Groups.

➤ When editing a Vuser group. On the Performance Test 
Run page, on the Groups pane, place the mouse cursor 
over the name of the group you want to edit. Click the 
downward arrow that appears adjacent to the name, 
and select Edit Group.

Important 
information

To edit a Vuser group, all Vusers must be in the inactive 
state.

Relevant tasks "How to Manage a Performance Test Run" on page 340
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User interface elements are described below:

UI Elements (A-Z) Description

Enables you to view and change the runtime settings for 
the Vuser script.

Opens the script in VuGen.

Command Line Type the name and value of the parameter you want to 
send using the format, <Parameter_Name> <value>.

For information about the command line parsing 
functions, or for details about including arguments on a 
command line, see the HP LoadRunner Online Function 
Reference, provided with HP Virtual User Generator.

Group Name The name of the Vuser group.

Load Generators The load generators on which the group is running.

Protocol The Vuser script’s protocol.

Script The name of the Vuser script.

Vusers The number of Vusers assigned to the group.
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View Script Dialog Box 

This dialog box enables you view the code for each action in a running vuser 
script.

 

User interface elements are described below:

To access On the Performance Test Run page, on the Groups pane, 
place the mouse cursor over the name of a group. Click 
the downward arrow that appears adjacent to the name, 
and select View Script.

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements  Description

Enables you to download the script.

Name The script’s name.
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Type The script type.

Actions Lists the actions included in the script. Click on an action 
to view it’s code in the right pane. 

Included files Displays files included in the script.

UI Elements  Description
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SLA Report

This report displays the post-run SLA statuses of the SLA goals defined for 
the performance test.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access On the ALM sidebar, under Testing, select Test Lab. Select 
the Test Runs tab. Use one of the following:

➤ In the information panel, in the Results tab, click the 
SLA Report  button. 

➤ In the left pane select a test set. Select the Execution 
Grid tab in the right pane. In the area below, in the 
Last Run Results tab, click the SLA Report  button.

Important 
information

The SLA report is available only if SLAs were defined for 
the performance test. 

Relevant tasks "Analyzing Performance Test Results" on page 339

See also "Service Level Agreements Overview" on page 266

UI Elements (A-Z) Description

Export to Excel. Enables you to export the selected 
section of the SLA report to an Excel file.

Export to PDF. Enables you to export the selected section 
of the SLA report to a .pdf file.

Export to CSV. Enables you to export the selected section 
of the SLA report to a .csv file.

Export to Word. Enables you to export the selected 
section of the SLA report to a Word file.

<Test run details> The details of the performance test run to which to the 
SLA report data relates are displayed at the top of the 
report. 

<SLA grids> The results for each SLA are displayed in separate grids.

Tip: Each set of results can be exported to Excel, Word, 
PDF, and CSV format.

<SLA status 
indicators>

. Indicates a failed SLA status.

. Indicates a passed SLA status.

. Indicates that there is no data about the SLA status.
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Calculate Service Level Agreement Dialog Box

This dialog box enables you to change the test time range included in the 
Service Level Agreement (SLA). 

 

To access 1  On the ALM sidebar, under Testing, select Test Lab.

2  Select the Test Runs tab. 

3  In the information panel, in the Results tab, click the 
Recalculate SLA Report  button. 

Important 
information

The Recalculate SLA button is available only if SLAs were 
defined for the performance test. 

Relevant tasks "Analyzing Performance Test Results" on page 339

See also "Service Level Agreements Overview" on page 266
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Recalculates the SLA according to the defined 
information.

Calculate SLA for 
whole run duration

Calculates the SLA over the whole test run.

Calculate SLA for 
part of run duration

Calculates the SLA over part of the test run. Enter the 
desired Start Time and End Time over which to calculate 
the SLA.
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16
WAN Emulation 

This chapter includes:

Concepts

➤ WAN Emulation Overview on page 404

Tasks

➤ How to Integrate WAN Emulation into a Performance Test on page 408

Reference

➤ WAN Emulation User Interface on page 410

Troubleshooting and Limitations on page 412
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Concepts

WAN Emulation Overview 

HP Performance Center is integrated with third party software that enables 
you to accurately test point-to-point performance of WAN-deployed 
products under real-world network conditions. By installing this WAN 
emulation software on your load generator, you can introduce highly 
probable WAN effects such as latency, packet loss, and link settings. As a 
result, you can test your application in a more realistic environment that 
better represents its actual deployment.

You can create more meaningful results by configuring several load 
generators with the same unique set of WAN effects, and by giving each set a 
unique location name, for example, London. When viewing performance 
test results in Analysis, you can group metrics from different load generators 
according to their location names. For information on grouping metrics 
according to an emulated location name, see the section that deals with 
applying filter and sort criteria to graphs in the HP LoadRunner Analysis User 
Guide.

This section also includes: 

➤ "Typical Network Emulation Settings" on page 405

➤ "Emulated Locations" on page 405

➤ "Excluding Machines from WAN Emulation" on page 406

➤ "Viewing WAN Emulation Monitors" on page 407
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Typical Network Emulation Settings
The WAN Emulator allows you to emulate probable WAN effects over your 
network, thereby creating a more realistic performance test. The following 
table presents the most typical effects which you can configure:

Emulated Locations
To receive more meaningful results, you can configure groups of load 
generators to emulate conditions unique to specific geographic locations. 
For example, London and New York.

To view the results for each group of load generators individually in 
Analysis, you can group the results of the performance test by the emulated 
location name. In other words, for any graph in Analysis, all the results of 
the ’New York based’ load generators can be grouped together, as can all the 
results of the ’London based’ load generators, and so on.

Effect Description

Latency The Latency value you define represents the time, in 
milliseconds, that it takes an IP packet to cross the 
WAN. This is usually effected by geographical 
distance, the available bandwidth, the network load 
on the route between the two ends, and whether 
this is a terrestrial link or not.

Packet Loss The Packet Loss value you define represents the 
chance of losing IP packets while data travels 
through a WAN. Packets can get lost due to link 
faults or due to extreme network load.

Bandwidth The Bandwidth value you define represents your 
network’s capacity to transfer data over the WAN.
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Note: In cases where you have to configure more than one load generator 
per location, make sure that each load generator designated for a specific 
location is configured with the same settings.

For information on grouping Analysis graph data by emulated location 
name, see the section that deals with applying filter and sort criteria to 
graphs in the HP Analysis User Guide.

Excluding Machines from WAN Emulation
When a machine is excluded from the WAN Emulation, network traffic to 
that machine does not suffer any WAN effects and will not be included in 
the WAN Emulation results.

During a performance test run, machines, that if emulated, may affect the 
results of the actual performance test (for example, the Controller) must be 
excluded. Accordingly, the following machines are excluded by default:

➤ The Controller machine or the MI Listener and proxy server. 

➤ The Diagnostics Commander server. 

➤ The Performance Center server. 

➤ The SiteScope server (configured to monitor Performance Center servers 
and hosts).

In addition to the machines which are excluded by default, the integrated 
third party software may provide an interface for excluding additional 
machines from the WAN Emulation. 

Note: The option to exclude machines from the WAN Emulation might not 
be available. To check for the availability of this option, consult the relevant 
third party software documentation.
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In addition to the machines which are excluded by default, the following 
are some additional situations where you should exclude machines from 
WAN Emulation:

➤ In a Multiprotocol performance test that includes a Web server and a 
database server; where information from the database server is not 
required as a part of the performance test. In such a case, you would 
exclude the database server.

➤ You may want to exclude all deployment and software upgrade servers.

➤ Where you run and store scripts on a shared network drive.

Viewing WAN Emulation Monitors
The WAN Emulation starts and stops automatically as you start and stop the 
performance test. WAN Emulation monitors are assigned automatically 
when the performance test run starts and WAN metrics are automatically 
collected during the performance test run. You can view the WAN metrics 
during the performance test run in the Windows Resources monitor. 

If a load generator is connected over a firewall, you must add the monitors 
manually using the Monitor Over Firewall component. For information 
about how to add and configure a monitor over firewall machine, see the 
Test Resources section in the HP Application Lifecycle Management User Guide.

For details on how to integrate WAN Emulation into your performance test, 
see "How to Integrate WAN Emulation into a Performance Test" on page 408.
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Tasks

How to Integrate WAN Emulation into a Performance 
Test

This task describes how to integrate WAN Emulation into your performance 
test and how to view the WAN metrics in Analysis.

To learn more about WAN Emulation, see "WAN Emulation Overview" on 
page 404.

 1 Prerequisites

➤ Make sure that you have a properly designed performance test. For 
more information, see "How to Define a Performance Test Workload" 
on page 192.

➤ Make sure that the relevant third party components are installed on 
the following machines:

➤ the Performance Center server

➤ the load generators

➤ the Controller

Note: You may also be required to install the third party software on 
additional components. For more information, see the relevant WAN 
emulation software installation documentation
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 2 Configure WAN Emulation Settings

 a Enable WAN Emulation. In the WAN Emulation Settings dialog box, 
select Enable WAN Emulation. For user interface details, see "WAN 
Emulation Settings Dialog Box" on page 410.

 b Determine emulated locations. In the WAN Emulation Settings dialog 
box, determine emulated locations for the WAN Emulation.

 c Determine WAN Emulation settings for each load generator. In the 
WAN Emulation Settings dialog box, click WAN Emulation Settings to 
open the third party software settings dialog box.

 3 View WAN metrics in HP LoadRunner Analysis

WAN metrics are automatically collected during the performance test run.

You can view all the WAN metrics in the Windows Resources monitor, as 
well as in Analysis using all of the available analysis tools, including the 
option to group metrics by emulated location, and to correlate data such 
as response time with WAN metrics. For more information, see the HP 
LoadRunner Analysis User Guide.
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WAN Emulation User Interface 

This section includes:

 ➤ WAN Emulation Settings Dialog Box on page 410

WAN Emulation Settings Dialog Box 

This dialog box enables you to enable WAN Emulation on selected load 
generators, define Emulated locations, and access the third party software 
settings pages.

To access 1  In the Testing > Test Plan module, select a test, then 
click the Test Design tab. 

2  Click the Edit Test button.

3  In the Workload tab, click the WAN Emulation 
Settings  button.

Important 
information

This dialog box is only enabled if the relevant third party 
software is installed on one of the selected load 
generators.

Relevant tasks "How to Integrate WAN Emulation into a Performance 
Test" on page 408
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User interface elements are described below:

UI Elements (A-Z) Description

Opens the third party software WAN Emulation 
Settings dialog box. 

For detailed information on configuring the WAN 
Emulation settings via the third party software 
components, see the relevant third party software 
documentation. 

Restores any changes made in the dialog box.

Emulated Location ➤ In the load generator list table: Displays an 
emulated location that has been defined for the 
load generator.

➤ In the <load generator name> WAN Emulation 
settings pane: Enter an emulated location for the 
load generator. 

For more information, see the section that deals with 
Emulated Locations in "WAN Emulation Overview" 
on page 404.

Emulation Displays whether WAN Emulation is enabled or 
disabled for the load generator.

Enable WAN Emulation Select to enable WAN Emulation on the selected load 
generator.

Load Generator A list of load generators assigned to the performance 
test.
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Troubleshooting and Limitations

When configuring the WAN Emulator, be aware of the following limitations:

Load generator running on a UNIX platform
WAN emulation software integration may not be available on the UNIX 
platform. In this case, the following limitations apply:

➤ If you selected one of the manual load generator distribution methods for 
your performance test, then the option of running a WAN Emulation on 
the load generator will be disabled.

➤ If you selected one of the automatic load generator distribution methods, 
then the performance test will return an error message upon 
commencement.

Load generator that is also the Controller

➤ If you selected one of the manual load generator distribution methods for 
your performance test, then the option of running a WAN Emulation on 
the load generator will be disabled.

➤ If you selected one of the automatic load generator distribution methods, 
then we recommend that you disable the option of running Vusers on the 
Controller for the project. Otherwise, an error message appears when the 
performance test starts.

Removing Load Generators from the Performance Test

➤ If you remove a load generator using one of the automatic load generator 
distribution methods, then the most recently added load generator is 
removed, and any WAN Emulation settings configured on it will not 
apply to the performance test. 

➤ If you remove a load generator using one of the manual load generator 
distribution methods, and subsequently re-add the load generator to the 
performance test, then any WAN Emulation settings that were defined on 
that load generator will be lost. To run WAN Emulation on that load 
generator, you must define the relevant settings again.
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17
Working with ALM Performance Center 
Online Monitors

This chapter includes:

Concepts

➤ Monitoring Process Overview on page 416

Tasks

➤ How to Set Up the Monitoring Environment – Workflow on page 417

Reference

➤ Monitor Types on page 418
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Concepts

Monitoring Process Overview

Before monitoring a performance test, you need to set up and configure the 
ALM Performance Center monitoring components. Each monitor has 
different configuration requirements that are explained in the specific 
monitoring chapters. The following diagram illustrates the ALM 
Performance Center monitoring process. 

Before monitoring a server, perform the following steps:

➤ Configure the monitoring environment on the server machine (if 
necessary).

➤ Configure the monitor on the Controller machine. 

For details, see "How to Set Up the Monitoring Environment – Workflow" on 
page 417.
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Tasks

How to Set Up the Monitoring Environment – Workflow

This task describes how to set up the ALM Performance Center online 
monitoring environment. You specify the machines and measurements that 
the Controller will monitor during performance test execution in the ALM 
Test Resources module. During performance test execution, the collected 
measurement data appears in the online graphs.

 1 Configure the monitoring environment on the server 
machine

To use the following monitors, you must first install or configure 
monitoring components on the server machine. For details about 
configuring the monitoring components, see the specific monitoring 
sections.

 2 Configure the monitors on the Controller

To obtain performance data for a monitor, you need to configure the 
monitor (from the Controller), and indicate which statistics and 
measurements you want to monitor.

➤ For information about selecting the servers to monitor and selecting the 
measurements to monitor, see "How to Create and Configure Monitor 
Profiles" on page 75.

➤ For details about each monitor’s default measurements, refer to the 
relevant reference section for the monitor.

➤ Citrix

➤ J2EE & .NET Diagnostics 

➤ Network Delay

➤ Oracle 

➤ PeopleSoft (Tuxedo)

➤ SAPGUI

➤ Tuxedo

➤ UNIX
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Monitor Types

All of the monitors allow you to view a summary of the collected data at the 
conclusion of the performance test. Using LoadRunner Analysis, you can 
generate a graph for any of the monitors. For more information, see the HP 
LoadRunner Analysis User Guide.

The online monitors are divided into the following categories:

Monitor Type Description

Web Resource Monitors Provide information about the number of Web 
connections, throughput volume, HTTP responses, 
server retries, and downloaded pages at the Web 
servers during performance test run. For more 
information, see "Web Resource Monitors" on 
page 421.

Run-Time and Transaction 
Monitors

Display the transaction rate and response times, and 
the number and status of Vusers participating in the 
performance test, as well as the number and types 
of errors that the Vusers generate. For more 
information, see "Run-Time and Transaction 
Monitoring" on page 431.

System Resource Monitors Measure the Windows, UNIX, Server, SNMP, and 
SiteScope resources used during a performance test 
run. For more information, see "System Resource 
Monitoring" on page 437.

Network Delay Monitors Displays information about the network delays on 
your system. For more information, see "Network 
Delay Monitoring" on page 447.
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Web Server Resource 
Monitors

Measure statistics related to the Microsoft IIS and 
Apache Web servers during the performance test 
run. For more information, see "Web Server 
Resource Monitoring" on page 459.

Web Application Server 
Resource Monitors

Measure statistics related to the Microsoft ASP 
application servers during the performance test run. 
For more information, see "Web Application Server 
Resource Monitoring" on page 465. 

Database Server Resource 
Monitors

Measure statistics related to the SQL server, and 
Oracle databases during the performance test run. 
For more information, see "Database Resource 
Monitoring" on page 469.

ERP/CRM Server Resource 
Monitors

Measure statistics related to the SAPGUI and 
PeopleSoft (Tuxedo) servers during the performance 
test run. For more information, see "ERP/CRM 
Server Resource Monitoring" on page 479.

J2EE & .NET Diagnostics 
Monitors

Provide information to trace, time, and 
troubleshoot individual transactions through J2EE 
Web, application, and database servers. For more 
information, see the HP Diagnostics User Guide.

Application Deployment 
Solutions Monitors

Measures statistics related to the Citrix MetaFrame 
XP server during a performance run. For more 
information, see "Application Deployment Solution 
Monitoring" on page 497.

Middleware Performance 
Monitors

Measures statistics related to the Tuxedo server 
during a performance test run. For more 
information, see "Middleware Performance 
Monitoring" on page 489

Monitor Type Description
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Web Resource Monitors

This chapter includes:

Concepts

➤ Web Resource Monitoring Overview on page 422

Reference

➤ HTTP Status Codes on page 428
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Concepts

Web Resource Monitoring Overview 

The Web Resource monitor enables you to analyze the following resources 
on the Web server during a performance test run: throughput, HTTP 
requests, downloaded pages, server retries, TCP/IP connections, and SSL 
Connections.

You can view the following resource monitor graphs during a test run:

Hits per Second Graph
The Hits Per Second graph shows the number of hits (HTTP requests) to the 
Web server (y-axis) as a function of the elapsed time in the performance test 
(x-axis). This graph can display the whole step, or the last 60, 180, 600, or 
3600 seconds. You can compare this graph to the Transaction Response 
Time graph to see how the number of hits affects transaction performance.

Throughput Graph 
The Throughput graph shows the amount of throughput (y-axis) on the 
Web server during each second of the test run (x-axis). Throughput is 
measured in bytes and represents the amount of data that the Vusers 
received from the server at any given second. You can compare this graph to 
the Transaction Response Time graph to see how the throughput affects 
transaction performance.

In the following example, the Transaction Response time graph is compared 
with the Throughput graph. It is apparent from the graph that as the 
throughput decreases, the transaction response time also decreases. The 
peak throughput occurred at approximately 1 minute into the step. The 
highest response time also occurred at this time.
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Example

HTTP Responses per Second Graph 
The HTTP Responses per Second graph shows the number of HTTP status 
codes (y-axis)—which indicate the status of HTTP requests, for example, 
“the request was successful” or “the page was not found”—returned from 
the Web server during each second of the performance test run (x-axis).

The HTTP responses are grouped by status code. You can also group the 
results shown in this graph by script (using the "Group By" function) to 
locate scripts which generated error codes. 

For a list of status codes and their explanations, see "HTTP Status Codes" on 
page 428.
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Pages Downloaded per Second Graph 
The Pages Downloaded per Second graph shows the number of Web pages 
(y-axis) downloaded from the server during each second of the test run 
(x-axis). This graph helps you evaluate the amount of load Vusers generate, 
in terms of the number of pages downloaded. 

Note: To view the Pages Downloaded per Second graph, you must select 
Pages per second (HTML Mode only) from the script’s run-time settings 
Preferences tab before running your performance test. 

Like throughput, downloaded pages per second is a representation of the 
amount of data that the Vusers received from the server at any given second. 

➤ The Throughput graph takes into account each resource and its size (for 
example, the size of each .gif file, the size of each Web page). 

➤ The Pages Downloaded per Second graph takes into account simply the 
number of pages. 

In the following example, the Throughput graph is compared with the Pages 
Downloaded per Second graph. It is apparent from the graph that 
throughput is not proportional to the number of pages downloaded per 
second. For example, between 15 and 16 seconds into the performance test, 
the throughput decreased while the number of pages downloaded per 
second increased.
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Example

Retries per Second Graph 
The Retries Per Second graph shows the number of attempted Web server 
connections (y-axis) as a function of the elapsed time in the performance 
test (x-axis). 

A server connection is retried when: 

➤ the initial connection was unauthorized

➤ proxy authentication is required

➤ the initial connection was closed by the server

➤ the initial connection to the server could not be made

➤ the server was initially unable to resolve the load generator’s IP address
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Connections Graph 
The Connections graph shows the number of open TCP/IP connections 
(y-axis) at each point in time of the performance test (x-axis). One HTML 
page may cause the browser to open several connections, when links on the 
page go to different Web addresses. Two connections are opened for each 
Web server.

This graph is useful in indicating when additional connections are needed. 
For example, if the number of connections reaches a plateau, and the 
transaction response time increases sharply, adding connections would 
probably cause a dramatic improvement in performance (reduction in the 
transaction response time).

Connections per Second Graph 
The Connections Per Second graph shows the number of new TCP/IP 
connections (y-axis) opened and the number of connections that are shut 
down each second of the performance test (x-axis). 

This number should be a small fraction of the number of hits per second, 
because new TCP/IP connections are very expensive in terms of server, 
router and network resource consumption. Ideally, many HTTP requests 
should use the same connection, instead of opening a new connection for 
each request.
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SSLs per Second Graph 
The SSLs per Second graph shows the number of new and reused SSL 
Connections (y-axis) opened in each second of the performance test (x-axis). 
An SSL connection is opened by the browser after a TCP/IP connection has 
been opened to a secure server.

Because creating a new SSL connection entails heavy resource consumption, 
you should try to open as few new SSL connections as possible; once you 
have established an SSL connection, you should reuse it. There should be no 
more than one new SSL connection per Vuser. 

If you set your run-time settings to simulate a new Vuser at each iteration 
(using the run-time settings Browser Emulation node), you should have no 
more than one new SSL connection per Vuser per iteration. Ideally, you 
should have very few new TCP/IP and SSL connections each second.
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HTTP Status Codes

The following table displays a list of HTTP status codes. These codes appear 
in the HTTP Responses per Second Graph:

Code  Description Code Description

200 OK 406 Not Acceptable

201 Created 407 Proxy Authentication Required

202 Accepted 408 Request Timeout

203 Non-Authoritative Information 409 Conflict

204 No Content 410 Gone

205 Reset Content 411 Length Required

206 Partial Content 412 Precondition Failed

300 Multiple Choices 413 Request Entity Too Large

301 Moved Permanently 414 Request - URI Too Large

302 Found 415 Unsupported Media Type

303 See Other 416 Requested range not satisfiable

304 Not Modified 417 Expectation Failed

305 Use Proxy 500 Internal Server Error

307 Temporary Redirect 501 Not Implemented

400 Bad Request 502 Bad Gateway

401 Unauthorized 406 Not Acceptable

402 Payment Required 407 Proxy Authentication Required

403 Forbidden 503 Service Unavailable
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For more information on the above status codes and their descriptions, see 
http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html#sec10.

404 Not Found 504 Gateway Timeout

405 Method Not Allowed 505 HTTP Version not supported

Code  Description Code Description

http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html#sec10
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Run-Time and Transaction Monitoring 

This chapter includes:

Concepts

➤ Run-Time Graphs Overview on page 432

➤ Transaction Monitor Graphs Overview on page 435
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Concepts

Run-Time Graphs Overview

The Run-Time monitor provides information about the status of the Vusers 
participating in the performance test, and the number and types of errors 
that the Vusers generate. In addition, the Run-Time monitor provides the 
User-Defined Data Points graph, which displays the real time values for 
user-defined points in a Vuser script. 

The Run-Time monitor is enabled by default—it automatically begins 
monitoring Vusers at the start of a performance test. 

You can view the following Run-Time monitor graphs during a test run:

Running Vusers Graph
The monitor’s Running Vusers graph provides information about the status 
of the Vusers running in the current performance test on all load generator 
machines. The graph shows the number of running Vusers, while the 
information in the legend indicates the number of Vusers in each state.
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The Status field of each Vuser displays the current status of the Vuser. The 
following table describes each Vuser status.

User-Defined Data Points Graph 
The User-Defined Data Points graph displays the real-time values of 
user-defined data points. You define a data point in your Vuser script by 
inserting an lr_user_data_point function at the appropriate place 
(user_data_point for GUI Vusers and lr.user_data_point for Java Vusers). 

For Vuser protocols that support the graphical script representations such as 
Web and Oracle NCA, you insert a data point as a user-defined step. Data 
point information is gathered each time the script executes the function or 
step.

Status Description

Running The total number of Vusers currently running on all load 
generators.

Ready The number of Vusers that completed the initialization 
section of the script and are ready to run.

Finished The number of Vusers that have finished running. This 
includes both Vusers that passed and failed.

Error The number of Vusers whose execution generated an error.

Action1()
{

lr_think_time(1);
lr_user_data_point ("data_point_1",1);
lr_user_data_point ("data_point_2",2);
return 0;

}
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By default, ALM Performance Center displays all of the data points in a 
single graph. The legend provides information about each data point. If 
desired, you can hide specific data points using the legend below the graphs. 

You can also view data points offline, after the completion of the 
performance test. For more information, see the HP LoadRunner Analysis User 
Guide.

Error Statistics Graph
The monitor’s Error Statistics graph provides details about the number of 
errors that accrue during each second of the test run. The errors are grouped 
by error source—for example, the location in the script or the load generator 
name. 

Vusers with Errors Graph
The Vusers with Errors graph provides details about the number of Vusers 
that generate errors during test execution. The errors are grouped by error 
source.
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Transaction Monitor Graphs Overview

The Transaction monitor displays the transaction rate and response time 
during a test run. The Transaction monitor is enabled by default—it 
automatically begins monitoring Vuser transactions at the start of a test run. 
To conserve resources, you can disable the Transaction monitor from the 
Controller. 

You can view the following Transaction monitor graphs during a test run:

➤ The Transaction Response Time graph shows the average response time of 
transactions in seconds (y-axis) as a function of the elapsed time in the 
performance test (x-axis). 

➤ The Transactions per Second (Passed) graph shows the number of 
successful transactions performed per second (y-axis) as a function of the 
elapsed time in the performance test (x-axis). 

➤ The Transactions per Second (Failed, Stopped) graph shows the number 
of failed and stopped transactions per second (y-axis) as a function of the 
elapsed time in the performance test (x-axis). 

➤ The Total Transactions per Second (Passed) graph shows the total 
number of completed, successful transactions per second (y-axis) as a 
function of the elapsed time in the performance test (x-axis). 

Note: 

➤ If there are no transactions defined in your Vuser script or if no 
transactions are being executed, no data will be displayed in the online 
monitor graphs. 

➤ To generate Web Page diagnostics for each transaction, configure the 
Diagnostics options from the Controller. 
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System Resource Monitoring

This chapter includes:

Concepts

➤ System Resource Monitors Overview on page 438

➤ Windows Resource Monitoring on page 438

➤ UNIX Resource Monitoring on page 439

➤ SNMP Resource Monitoring on page 439

➤ SiteScope Resource Monitoring on page 439

Tasks

➤ How to Set up the UNIX Monitoring Environment on page 440

Reference

➤ UNIX Resources Performance Counters on page 442

➤ Windows Resource Performance Counters on page 443
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Concepts

System Resource Monitors Overview 

You use ALM Performance Center’s System Resource monitors to monitor a 
machine’s system resource usage during a performance test run and isolate 
server performance bottlenecks.

A primary factor in a transaction’s response time is its system resource usage. 
Using the ALM Performance Center resource monitors, you can monitor the 
Windows, UNIX, SiteScope Server, and SNMP server on a machine during a 
test run, and determine why a bottleneck occurred on a particular machine. 

The resource monitors are automatically enabled when you execute a test 
run. However, you must specify the machine you want to monitor and 
which resources to monitor for each machine. You can also add or remove 
machines and resources during the test run. 

Windows Resource Monitoring

The Windows Resources monitor shows the Windows resources measured 
during the test run. Windows measurements correspond to the built-in 
counters available from the Windows Performance Monitor. 

If you want to monitor a remote Windows server that does not use Windows 
domain security, you must authenticate the Controller on the remote 
Windows server. To authenticate the Controller, create an account, or 
change the password of the account used to log on to the Controller so that 
it matches the password and user name used to log on to the remote 
monitored Windows machine. When the remote Windows machine 
requests another machine’s resources, it sends the logged-in user name and 
password of the machine requesting the resources.
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UNIX Resource Monitoring

The UNIX Resources monitor shows the UNIX resources measured during 
the test run. This graph helps you determine the impact of Vuser load on the 
various system resources. 

The UNIX kernel statistics measurements include those available by the 
rstatd daemon. For a description of the measurements, see "UNIX Resources 
Performance Counters" on page 442.

Note: You must configure an rstatd daemon on all UNIX machines being 
monitored. For information, refer to the UNIX man pages, or see "How to Set 
up the UNIX Monitoring Environment" on page 440.

SNMP Resource Monitoring 

The SNMP Resource monitor shows statistics for a Windows or UNIX 
machine using the Simple Network Management Protocol (SNMP). The 
SNMP Resources monitor is available for monitoring any machine that runs 
an SNMP agent, using the Simple Network Management Protocol (SNMP). 

SiteScope Resource Monitoring 

The SiteScope Resources monitor graph shows the SiteScope resources 
measured during the test run. The SiteScope monitor can measure server, 
network, and processor performance counters. For detailed information on 
the performance counters that SiteScope can monitor, refer to the relevant 
SiteScope documentation.

Before setting up the SiteScope monitor, ensure that SiteScope has been 
installed on a server. You can install SiteScope on the same machine as the 
Controller, or on a dedicated server. If SiteScope is installed on a machine 
other than the Controller, verify that the SiteScope machine is accessible 
from the Controller machine.
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Tasks

How to Set up the UNIX Monitoring Environment

This task describes how to configure the UNIX environment before setting 
up the UNIX monitor.

This task includes the following steps:

➤ "Verify whether the rstatd daemon is already configured" on page 440

➤ "Configure the rstatd daemon" on page 441

➤ "Configure the monitor for a UNIX machine over a firewall (optional)" on 
page 441

➤ "Configure the monitor measurements on the Controller" on page 441

 1 Verify whether the rstatd daemon is already configured

The rstatd daemon might already be configured, because when a machine 
receives an rstatd request, the inetd on that machine automatically 
activates the rstatd.

➤ The rup command reports various machine statistics, including rstatd 
configuration. Run the following command on the UNIX machine to 
view the machine statistics:

>rup host

➤ You can also use lr_host_monitor and see if it returns any relevant 
statistics.

If the command returns meaningful statistics, the rstatd daemon is 
already configured and activated. If not, or if you receive an error 
message, the rstatd daemon is not configured.
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 2 Configure the rstatd daemon

If the rstatd daemon is not yet configured, follow these steps to configure 
it:

 a On the UNIX machine, run the command: su root

 b Go to /etc/inetd.conf and look for the rstatd row (it begins with the 
word rstatd). If it is commented out (with a #), remove the comment 
directive, and save the file.

 c From the command line, run:

kill -1 inet_pid

where inet_pid is the pid of the inetd process. This instructs the inetd 
to rescan the /etc/inetd.conf file and register all daemons which are 
uncommented, including the rstatd daemon.

 d Run rup again.

If the command still does not indicate that the rstatd daemon is 
configured, contact your system administrator.

 3 Configure the monitor for a UNIX machine over a firewall 
(optional)

To monitor a UNIX machine over a firewall, you must run a UNIX utility 
called rpcinfo and identify the rstatd’s port number. 

Run rpcinfo -p <hostname>. You will receive a list of all RPC servers 
registered in the host’s portmapper, along with the port number. This list 
will not change until rstatd is stopped and rerun.

Some firewalls allow you to open an RPC program number instead of a 
port. In such cases, open program 100001. If are prompted to include a 
version number, specify versions 3 and 4.

 4 Configure the monitor measurements on the Controller

For task details, see "How to Create and Configure Monitor Profiles" on 
page 75.

For a description of the available UNIX monitor measurements, see 
"UNIX Resources Performance Counters" on page 442.
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UNIX Resources Performance Counters

The following default measurements are available for the UNIX machine:

Measurement  Description

Average load Average number of processes simultaneously in 
Ready state during the last minute

Collision rate Collisions per second detected on the Ethernet

Context switches rate Number of switches between processes or threads, 
per second

CPU utilization Percent of time that the CPU is utilized

Disk rate Rate of disk transfers

Incoming packets error 
rate 

Errors per second while receiving Ethernet packets

Incoming packets rate Incoming Ethernet packets per second

Interrupt rate Number of device interrupts per second

Outgoing packets errors 
rate 

Errors per second while sending Ethernet packets

Outgoing packets rate Outgoing Ethernet packets per second

Page-in rate Number of pages read to physical memory, per 
second

Page-out rate Number of pages written to pagefile(s) and removed 
from physical memory, per second

Paging rate Number of pages read to physical memory or 
written to pagefile(s), per second

Swap-in rate Number of processes being swapped

Swap-out rate Number of processes being swapped
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Windows Resource Performance Counters

The following default measurements are available for Windows machines:

System mode CPU 
utilization 

Percent of time that the CPU is utilized in system 
mode

User mode CPU utilization Percent of time CPU is utilized in user mode

Object Measurement Description

System % Total Processor 
Time

The average percentage of time that all the 
processors on the system are busy 
executing non-idle threads. On a 
multi-processor system, if all processors are 
always busy, this is 100%, if all processors 
are 50% busy this is 50% and if 1/4 of the 
processors are 100% busy this is 25%. It 
can be viewed as the fraction of the time 
spent doing useful work. Each processor is 
assigned an Idle thread in the Idle process 
which consumes those unproductive 
processor cycles not used by any other 
threads.

System File Data 
Operations/sec

The rate at which the computer issues read 
and write operations to file system devices. 
This does not include File Control 
Operations.

Measurement  Description
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Processor % Processor Time 
(Windows 2000)

The percentage of time that the processor is 
executing a non-idle thread. This counter 
was designed as a primary indicator of 
processor activity. It is calculated by 
measuring the time that the processor 
spends executing the thread of the idle 
process in each sample interval, and 
subtracting that value from 100%. (Each 
processor has an idle thread which 
consumes cycles when no other threads are 
ready to run). It can be viewed as the 
percentage of the sample interval spent 
doing useful work. This counter displays 
the average percentage of busy time 
observed during the sample interval. It is 
calculated by monitoring the time the 
service was inactive, and then subtracting 
that value from 100%.

System Processor Queue 
Length

The instantaneous length of the processor 
queue in units of threads. This counter is 
always 0 unless you are also monitoring a 
thread counter. All processors use a single 
queue in which threads wait for processor 
cycles. This length does not include the 
threads that are currently executing. A 
sustained processor queue length greater 
than two generally indicates processor 
congestion. This is an instantaneous count, 
not an average over the time interval.

Memory Page Faults/sec This is a count of the page faults in the 
processor. A page fault occurs when a 
process refers to a virtual memory page 
that is not in its Working Set in the main 
memory. A page fault will not cause the 
page to be fetched from disk if that page is 
on the standby list (and hence already in 
main memory), or if it is in use by another 
process with which the page is shared.

Object Measurement Description
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PhysicalDisk % Disk Time The percentage of elapsed time that the 
selected disk drive is busy servicing read or 
write requests.

Memory Pool Nonpaged 
Bytes

The number of bytes in the nonpaged pool, 
a system memory area where space is 
acquired by operating system components 
as they accomplish their appointed tasks. 
Nonpaged pool pages cannot be paged out 
to the paging file. They remain in main 
memory as long as they are allocated.

Memory Pages/sec The number of pages read from the disk or 
written to the disk to resolve memory 
references to pages that were not in 
memory at the time of the reference. This 
is the sum of Pages Input/sec and Pages 
Output/sec. This counter includes paging 
traffic on behalf of the system cache to 
access file data for applications. This value 
also includes the pages to/from non-cached 
mapped memory files. This is the primary 
counter to observe if you are concerned 
about excessive memory pressure (that is, 
thrashing), and the excessive paging that 
may result.

System Total Interrupts/
sec

The rate at which the computer is receiving 
and servicing hardware interrupts. The 
devices that can generate interrupts are the 
system timer, the mouse, data 
communication lines, network interface 
cards, and other peripheral devices. This 
counter provides an indication of how 
busy these devices are on a computer-wide 
basis. See also Processor:Interrupts/sec.

Object Measurement Description
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Objects Threads The number of threads in the computer at 
the time of data collection. Notice that this 
is an instantaneous count, not an average 
over the time interval. A thread is the basic 
executable entity that can execute 
instructions in a processor.

Process Private Bytes The current number of bytes that the 
process has allocated that cannot be shared 
with other processes.

Object Measurement Description
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Network Delay Monitoring

This chapter includes:

Concepts

➤ Network Monitoring Overview on page 448

Tasks

➤ How to Set Up the Network Monitoring Environment on page 450

➤ How to Configure the UNIX Source Machine for  Network Monitoring 
on page 452

Reference

➤ Network Delay Monitoring User Interface on page 455

Troubleshooting and Limitations on page 456
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Concepts

Network Monitoring Overview 

Network configuration is a primary factor in the performance of 
applications. A poorly designed network can slow client activity to 
unacceptable levels. 

You use Network monitoring to determine whether your network is causing 
a delay in the performance test. You can also determine the problematic 
network segment.

In a true Web or client/server system, there are many network segments. A 
single network segment with poor performance can affect the entire system.

The following diagram shows a typical network. To go from the server 
machine to the Vuser machine, data must travel over several segments. 

The Network Delay Time monitor shows the delays for the complete path 
between the source and destination machines (for example the database 
server and Vuser host). The graph maps the delay as a function of the 
elapsed performance test time. Each defined path is represented by a 
separate line with a different color in the graph.
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To measure network performance, the Network monitor sends packets of 
data across the network. When a packet returns, the monitor calculates the 
time it takes for the packet to go to the requested node and return. This time 
is the delay which appears in the Network Delay Time graph.

Note: The delays from the source machine to each of the nodes are 
measured concurrently, yet independently. It is therefore possible that the 
delay from the source machine to one of the nodes could be greater than the 
delay for the complete path between the source and destination machines.

➤ For information about how to set up the network monitoring 
environment, see "How to Set Up the Network Monitoring Environment" 
on page 450.

➤ For information about how to configure the UNIX source machine for 
network monitoring see, "How to Configure the UNIX Source Machine 
for  Network Monitoring" on page 452.
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Tasks

How to Set Up the Network Monitoring Environment

This task describes how to prepare your environment for network 
monitoring.

To lean more about network monitoring, see "Network Monitoring 
Overview" on page 448.

This task includes the following steps:

➤ "Prerequisites" on page 450

➤ "Configure the UNIX source machine - optional" on page 450

➤ "Configure the firewall between the source and destination machines - 
Optional" on page 451

➤ "Configure the Network monitor on the Controller" on page 451

 1 Prerequisites

To enable network monitoring, you must install the Performance Center 
agent on the source machine. You do not have to install the 
Performance Center agent on the destination machine.

To run the Network monitor, you must have administrator privileges on 
the Windows source machine (unless you are using the ICMP protocol).

 2 Configure the UNIX source machine - optional

You can run the Network monitor on UNIX source machines, using UDP 
or ICMP. Before running the Network monitor from a UNIX source 
machine, configure the source machine. For task details, see "How to 
Configure the UNIX Source Machine for  Network Monitoring" on 
page 452.
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 3 Configure the firewall between the source and destination 
machines - Optional 

If you are monitoring a network in which there are firewalls between the 
source and the destination machines, you must configure the firewalls to 
allow the network data packets to reach their destinations.

➤ If you are using the TCP protocol, the firewall that protects the 
destination machine should not block outgoing 
ICMP_TIMEEXCEEDED packets (packets that are sent outside the 
firewall from the machine). In addition, the firewall protecting the 
source machine should allow ICMP_TIMEEXCEEDED packets to enter, 
as well as TCP packets to exit.

➤ If you are using the ICMP protocol, the destination machine’s firewall 
should not block incoming ICMP_ECHO_REQUEST packets, or 
outgoing ICMP_ECHO_REPLY and ICMP_ECHO_TIMEEXCEEDED 
packets. In addition, the firewall protecting the source machine should 
allow ICMP_ECHO_REPLY and ICMP_ECHO_TIMEEXCEEDED packets 
to enter, and ICMP_ECHO_REQUEST packets to exit.

➤ If you are using the UDP protocol, ensure that the UDP protocol can 
access the destination machine from the source machine. The 
destination machine’s firewall should not block outgoing 
ICMP_DEST_UNREACHABLE and ICMP_ECHO_TIMEEXCEEDED 
packets. In addition, the firewall protecting the source machine should 
allow ICMP_DEST_UNREACHABLE and 
ICMP_ECHO_TIMEEXCEEDED packets to enter. 

Note: To run the Network Delay monitor when there are firewalls 
between the Controller and the source machine, you must configure the 
Performance Center agent, MI Listener, and Network Delay monitor for 
monitoring over a firewall. 

 4 Configure the Network monitor on the Controller

For task details, see "How to Create and Configure Monitor Profiles" on 
page 75.
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How to Configure the UNIX Source Machine for 
Network Monitoring

This task describes how to configure a UNIX source machine before running 
the network monitor.

To lean more about network monitoring, see "Network Monitoring 
Overview" on page 448.

This task includes the following steps:

➤ "Assign permissions where Performance Center is installed locally" on 
page 452

➤ "Assign permissions where Performance Center is installed on the 
network" on page 453

➤ "Connect to the Unix Source Machine Through RSH" on page 454

➤ "Connect to the Unix Source Machine Through the Agent" on page 454

 1 Assign permissions where Performance Center is installed 
locally

Follow these steps to assign root permissions to the merc_webtrace 
process:

 a Log in to the source machine as root.

 b Type: cd <performance center_installation>/bin to change to the bin 
directory. 

 c Type: chown root merc_webtrace to make the root user the owner of 
the merc_webtrace file.

 d Type: chmod +s merc_webtrace to add the s-bit to the file permissions.

 e To verify, type ls -l merc_webtrace. The permissions should look like 
this: -rwsrwsr-x.
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 2 Assign permissions where Performance Center is installed on 
the network

In a Performance Center network installation, the merc_webtrace process 
is on the network, not on the source machine disk. The following 
procedure copies the merc_webtrace file to the local disk, configures 
mdrv.dat to recognize the process, and assigns root permissions to 
merc_webtrace:

 a Copy merc_webtrace from <performance center_installation>/bin to 
anywhere on the local disk of the source machine. For example, to 
copy the file to the /local/<performance center> directory, type: cp /
net/tools/performance center_installation/bin/merc_webtrace /local/
<performance center>

Note: All of the source machines that use the same network 
installation must copy merc_webtrace to the identical directory path 
on their local disk (for example, /local/<performance center>), since all 
of them use the same mdrv.dat.

 b Add the following line to the <performance center_installation>/dat/
mdrv.dat file, in the [monitors_server] section:

ExtCmdLine=-merc_webtrace_path /local/xxx

 c Log in to the source machine as root.

 d Type: cd performance center_installation/bin to change to the bin 
directory.

 e Type: chown root merc_webtrace to make the root user the owner of the 
merc_webtrace file.

 f Type: chmod +s merc_webtrace to add the s-bit to the file permissions.

 g To verify, type ls -l merc_webtrace. The permissions should look like: 
-rwsrwsr-x.
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 3 Connect to the Unix Source Machine Through RSH 

Follow these instructions if the Controller is connected to the source 
machine through RSH (default connection mode). In this case you do not 
need to activate the agent daemon. 

Before running the Network monitor the first time, you enter an 
encrypted user name and password in the Network monitor configuration 
file.

 a On the Performance Center host machine, type cd <Performance 
Center installation>/bin to change the bin directory.

 b Run CryptonApp.exe. 

 c In the Password box, type your RSH user name and password, 
separated by a vertical bar symbol. For example, myname|mypw.

 d Click Generate. An encoded string is displayed in the Encoded string 
field.

 e Click Copy to copy the encoded string to the clipboard.

 f Add the following line to the <performance center_installation>/dat/
monitors/ndm.cfg file, in the [hosts] section:

Host = <encrypted string copied from clipboard>

 g Close and open the current performance test. ALM 
Performance Center will read the updated configuration file and 
recognize the source machine for monitoring.

 4 Connect to the Unix Source Machine Through the Agent

Follow these instructions for activating agent daemon on the source 
machine if the Controller is not connected to the source machine 
through RSH. 

 a Type m_daemon_setup -install from the <performance 
center_installation>/bin directory. 

 b Make sure that the agent daemon is running whenever you activate 
the Network monitor.

 c To stop the Network Delay Monitor agent daemon, type 
m_daemon_setup -remove.
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Reference

Network Delay Monitoring User Interface

This section includes:

 ➤ Network Delay Time Graph on page 455

Network Delay Time Graph

The Network Delay Time graph shows the delay for the complete path 
between the source and destination machines (y-axis) as a function of the 
elapsed performance test time (x-axis). 

Each path defined in the Add Destination Machines for Network Delay 
Monitoring dialog box is represented by a separate line with a different color 
in the graph.
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Troubleshooting and Limitations 

This section describes troubleshooting for the Network Delay monitor.

If monitoring is unsuccessful and ALM Performance Center cannot locate 
the source or destination machines, make sure that the specified machines 
are available to your machine. Perform a “ping” operation. At the command 
line prompt, type: 

To check the entire network path, use the trace route utility to verify that 
the path is valid. 

For Windows, type tracert <server_name>.

For UNIX, type traceroute <server_name>.

If the monitoring problem persists once you verify that the machines are 
accessible and that the network path is valid, perform the following 
procedures:

 1 If you are using the TCP protocol, run <performance center root 
folder>\bin\webtrace.exe from the source machine to determine 
whether the problem is related to the Controller, or the WebTrace 
technology on which the Network Delay monitor is based. If you are 
using the UDP or ICMP protocols, the problem must be related to the 
Controller and not WebTrace, since these protocols are not WebTrace 
technology-based.

 2 If you receive results by running webtrace.exe, the problem is related to 
the Controller. Verify that the source machine is not a UNIX machine, 
and contact the Customer Support Web site with the following 
information:

➤ the Controller log file, drv_log.txt, located in the temp directory of the 
Controller machine.

ping server_name 
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➤ the traceroute_server log file, located on the source machine. 

➤ the debug information located in the TRS_debug.txt and 
WT_debug.txt files in the path directory. These files are generated by 
adding the following line to the [monitors_server] section of the 
<performance center root folder>\dat\mdrv.dat file, and rerunning 
the Network monitor:

ExtCmdLine=-traceroute_debug path

 3 If you do not receive results by running webtrace.exe, the problem is 
related to the WebTrace technology, on which the Network Delay 
monitor is based. Perform the following procedures on the source 
machine:

➤ Verify that the packet.sys file (the Webtrace driver) exists in the 
WINNT\system32\drivers directory.

➤ Check whether a driver (such as “Cloud” or “Sniffer”) is installed on 
top of the network card driver. If so, remove it and run WebTrace 
again.

➤ Verify that there are administrator permissions on the machine.

➤ Using ipconfig /all, check that only one IP address is assigned to the 
network card. WebTrace does not know how to handle multiple IP 
addresses assigned to the same card (IP spoofing).

➤ Check the number of network cards installed. Run webtrace –devlist to 
receive a list of the available network cards.

➤ If there is more than one card on the list, run webtrace -dev 
<dev_name>  <destination>, where <dev_name> is one of the network 
card names shown in the list. If you discover that WebTrace is binding 
to the wrong card, you can use webtrace set_device <dev_name> to set 
a registry key that instructs WebTrace to use a specified card instead of 
the default one.

➤ Verify that the network card is of the Ethernet type.

➤ Contact the Customer Support Web site with the output of 
webtrace.exe –debug (for example, webtrace.exe –debug 
www.merc-int.com) and ipconfig /all on the machine.
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22
Web Server Resource Monitoring 

This chapter includes:

Concepts

➤ Web Server Resource Monitoring Overview on page 460

Tasks

➤ How to Change the Apache Default Server Properties on page 461

Reference

➤ Apache Performance Counters on page 462

➤ Microsoft IIS Performance Counters on page 463
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Concepts

Web Server Resource Monitoring Overview 

Web Server Resource monitors provide you with information about the 
resource usage of the Microsoft IIS and Apache Web servers during 
performance test execution. To obtain this data, you need to activate the 
online monitor for the server and specify which resources you want to 
measure before executing the test.

For information about how to configure the monitors on the Controller, see 
"How to Set Up the Monitoring Environment – Workflow" on page 417.
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Tasks

How to Change the Apache Default Server Properties

This task describes how to modify the Apache default server properties that 
are defined in the monitor configuration file.

 1 Open the apache.cfg file in the <performance center root 
folder>\dat\monitors directory.

 2 Edit the following parameters after the Delimiter=: statement:

InfoURL. Server statistics information URL

ServerPort. Server port number 

SamplingRate. Rate (milliseconds) at which the monitor will poll the 
server for the statistics information. If this value is greater than 1000, 
ALM Performance Center will use it as its sampling rate. Otherwise, it will 
use the sampling rate defined in the Monitors tab of the Options dialog 
box.

 3 Save and close the file.
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Reference

Apache Performance Counters

The following table describes the measurements and server properties that 
can be monitored on the Apache Web server during the test run:

Measurement Description

# Busy Servers The number of servers in the Busy state 

# Idle Servers The number of servers in the Idle state

Apache CPU Usage The percentage of time the CPU is utilized by the 
Apache server

Hits/sec The HTTP request rate

KBytes Sent/sec The rate at which data bytes are sent from the Web 
server
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Microsoft IIS Performance Counters

The following table describes the measurements and server properties that 
can be monitored on the Microsoft IIS Web server during the test run:

Object Measurement Description

Web 
Service

Bytes Sent/sec The rate at which the data bytes are sent by the 
Web service

Web 
Service

Bytes Received/
sec

The rate at which the data bytes are received by 
the Web service

Web 
Service

Get Requests/sec The rate at which HTTP requests using the GET 
method are made. Get requests are generally 
used for basic file retrievals or image maps, 
though they can be used with forms.

Web 
Service

Post Requests/sec The rate at which HTTP requests using the POST 
method are made. Post requests are generally 
used for forms or gateway requests.

Web 
Service

Maximum 
Connections

The maximum number of simultaneous 
connections established with the Web service

Web 
Service

Current 
Connections

The current number of connections established 
with the Web service

Web 
Service

Current 
NonAnonymous 
Users

The number of users that currently have a 
non-anonymous connection using the Web 
service

Web 
Service

Not Found Errors/
sec

The rate of errors due to requests that could not 
be satisfied by the server because the requested 
document could not be found. These are 
generally reported to the client as an HTTP 404 
error code.

Process Private Bytes The current number of bytes that the process 
has allocated that cannot be shared with other 
processes.
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Web Application Server Resource 
Monitoring

This chapter includes:

Concepts

➤ Web Application Server Resource Monitoring Overview on page 466

Reference

➤ MS Active Server Pages Performance Counters on page 467
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Concepts

Web Application Server Resource Monitoring Overview 

You use ALM Performance Center’s Web Application Server Resource 
monitors to monitor Microsoft Active Server Pages  servers during a test run 
and isolate application server performance bottlenecks.

The Microsoft Active Server Pages (ASP) monitor displays statistics about the 
resource usage on the ASP server during the test run.
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Reference

MS Active Server Pages Performance Counters

The following table describes the default counters that can be monitored:

Measurement Description

Errors per Second The number of errors per second.

Requests Wait Time The number of milliseconds the most recent request 
was waiting in the queue. 

Requests Executing The number of requests currently executing. 

Requests Queued The number of requests waiting in the queue for 
service. 

Requests Rejected The total number of requests not executed because 
there were insufficient resources to process them.

Requests Not Found The number of requests for files that were not 
found.

Requests/sec The number of requests executed per second. 

Memory Allocated The total amount of memory, in bytes, currently 
allocated by Active Server Pages.

Errors During Script 
Run-Time

The number of failed requests due to run-time 
errors.

Sessions Current The current number of sessions being serviced.

Transactions/sec The number of transactions started per second.
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Database Resource Monitoring

This chapter includes:

Concepts

➤ Database Resource Monitoring Overview on page 470

Tasks

➤ How to Set Up the Oracle Monitoring Environment on page 471

Reference

➤ Oracle Performance Counters on page 475

➤ SQL Server Performance Counters on page 477
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Concepts

Database Resource Monitoring Overview 

ALM Performance Center’s Database Server Resource monitors measure 
database resource usage statistics for Oracle, or SQL Servers during a 
performance test run. You use these monitors to isolate database server 
performance bottlenecks.

The Oracle monitor displays information from Oracle V$ tables: Session 
statistics, V$SESSTAT, system statistics, V$SYSSTAT, and other table counters 
defined by the user in the custom query. 

Before defining the monitoring measurements for the Oracle monitors in 
the Controller, you must set up the monitoring environment on the 
database server. 

For details about the Oracle monitor configuration, see "How to Set Up the 
Oracle Monitoring Environment" on page 471. 
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Tasks

How to Set Up the Oracle Monitoring Environment

This task describes how to set up the monitor environment before 
monitoring an Oracle database server.

Note: If a problem occurs in setting up the Oracle environment, check the 
Oracle server to view the error messages.

This task includes the following steps:

➤ "Prerequisites" on page 471

➤ "Configure the Oracle client/server connection" on page 472

➤ "Connect to the monitored server machine and verify the connection" on 
page 473

➤ "Modify the monitoring sample rate (optional)" on page 474

➤ "Configure the Oracle monitor on the Controller" on page 474

 1 Prerequisites

➤ Ensure that the Oracle client libraries are installed on the Controller 
machine.

➤ Verify that %OracleHome%\bin is included in the path environment 
variable. If it is not, add it.

➤ Ensure that the registries are updated for the version of Oracle that you 
are using and that they have the following key: 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

➤ Ensure that you the Performance Center Server is installed in a 
directory whose path does not include any of the following characters: 
( ) : ; * \ / " ~ & ? { } $ % | < > + = ^ [ ].
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➤ Verify that the Oracle server you want to monitor is up and running. 
Note that it is possible to monitor several Oracle database servers 
concurrently.

Note: Only the 32-bit Oracle client should be installed on the Controller 
machine running the Oracle monitor. If you have a 16-bit and a 32-bit 
Oracle client installation on the Controller machine, the 16-bit 
installation should be uninstalled.

 2 Configure the Oracle client/server connection

Set the connection parameters so the Oracle client (Controller machine) 
can communicate with the Oracle server(s) you plan to monitor. 

On the Controller machine, set the following configuration parameter 
either by editing the tnsnames.ora file in a text editor, or using the Oracle 
service configuration tool. 

Example:

Start > Programs > Oracle for Windows NT > Oracle Net8 Easy Config

➤ a new service name (TNS name) for the Oracle instance

➤ TCP protocol

➤ the host name (name of monitored server machine)

➤ the port number (usually 1521)

➤ the database SID (the default SID is ORCL) 
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Example:

 3 Connect to the monitored server machine and verify the 
connection

 a Obtain a username and password for the service from your database 
administrator, and ensure that the Controller has database 
administrator privileges for the Oracle V$ tables (V$SESSTAT, 
V$SYSSTAT, V$STATNAME, V$INSTANCE, V$SESSION).

 b Verify connection with the Oracle server by performing tns ping from 
the Controller machine. 

Note: There may be a problem connecting if the Oracle server is 
behind a DMZ/firewall that limits its communication to application 
servers accessing it.

 c Run SQL*Plus from the Controller and attempt to log in to the Oracle 
server(s) with the desired username/password/server combination. 

 d Type SELECT * FROM V$SYSSTAT to verify that you can view the 
V$SYSSTAT table on the Oracle server. Use similar queries to verify that 
you can view the V$SESSTAT, V$SESSION, V$INSTANCE, 
V$STATNAME, and V$PROCESS tables on the server. 
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 4 Modify the monitoring sample rate (optional)

To change the length of each monitoring sample (in seconds), edit the 
dat\monitors\vmon.cfg file in the Performance Center root folder. The 
default rate is 10 seconds. 

The minimum sampling rate for the Oracle Monitor is 10 seconds. If you 
set the sampling rate at less than 10 seconds, the Oracle Monitor will 
continue to monitor at 10 second intervals.

 5 Configure the Oracle monitor on the Controller

For task details, see "How to Create and Configure Monitor Profiles" on 
page 75.
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Oracle Performance Counters

The following measurements are most commonly used when monitoring 
the Oracle server (from the V$SYSSTAT table):

Measurement Description

CPU used by this session The amount of CPU time (in 10s of milliseconds) 
used by a session between the time a user call 
started and ended. Some user calls can be completed 
within 10 milliseconds and, as a result, the start and 
end-user call time can be the same. In this case, 0 
milliseconds are added to the statistic. A similar 
problem can exist in the operating system 
reporting, especially on systems that suffer from 
many context switches.

Bytes received via 
SQL*Net from client 

The total number of bytes received from the client 
over Net8.

Logons current The total number of current logons

Opens of replaced files The total number of files that needed to be 
reopened because they were no longer in the 
process file cache.

User calls Oracle allocates resources (Call State Objects) to 
keep track of relevant user call data structures every 
time you log in, parse, or execute. When 
determining activity, the ratio of user calls to RPI 
calls gives you an indication of how much internal 
work is generated as a result of the type of requests 
the user is sending to Oracle.

SQL*Net roundtrips to/
from client 

The total number of Net8 messages sent to, and 
received from, the client.

Bytes sent via SQL*Net to 
client 

The total number of bytes sent to the client from 
the foreground process(es).
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Opened cursors current The total number of current open cursors.

DB block changes Closely related to consistent changes, this statistic 
counts the total number of changes that were made 
to all blocks in the SGA that were part of an update 
or delete operation. These are changes that generate 
redo log entries and hence will cause permanent 
changes to the database if the transaction is 
committed. This statistic is a rough indication of 
total database work and indicates (possibly on a 
per-transaction level) the rate at which buffers are 
being dirtied.

Total file opens The total number of file opens being performed by 
the instance. Each process needs a number of files 
(control file, log file, database file) to work against 
the database.

Measurement Description
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SQL Server Performance Counters

The following table describes the default counters that can be monitored on 
version 6.5 of the SQL Server:

Measurement Description

% Total Processor 
Time

The average percentage of time that all the processors on 
the system are busy executing non-idle threads. On a 
multi-processor system, if all processors are always busy, 
this is 100%, if all processors are 50% busy this is 50% 
and if 1/4 of the processors are 100% busy this is 25%. It 
can be viewed as the fraction of the time spent doing 
useful work. Each processor is assigned an Idle thread in 
the Idle process which consumes those unproductive 
processor cycles not used by any other threads.

% Processor Time The percentage of time that the processor is executing a 
non-idle thread. This counter was designed as a primary 
indicator of processor activity. It is calculated by 
measuring the time that the processor spends executing 
the thread of the idle process in each sample interval, 
and subtracting that value from 100%. (Each processor 
has an idle thread which consumes cycles when no other 
threads are ready to run). It can be viewed as the 
percentage of the sample interval spent doing useful 
work. This counter displays the average percentage of 
busy time observed during the sample interval. It is 
calculated by monitoring the time the service was 
inactive, and then subtracting that value from 100%.

Cache Hit Ratio The percentage of time that a requested data page was 
found in the data cache (instead of being read from disk).

I/O - Batch Writes/
sec

The number of 2K pages written to disk per second, using 
Batch I/O. The checkpoint thread is the primary user of 
Batch I/O.

I/O - Lazy Writes/sec The number of 2K pages flushed to disk per second by the 
Lazy Writer.

I/O - Outstanding 
Reads

The number of physical reads pending.
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I/O - Outstanding 
Writes

The number of physical writes pending.

I/O - Page Reads/sec The number of physical page reads per second.

I/O - Transactions/
sec

The number of Transact-SQL command batches executed 
per second.

User Connections The number of open user connections.

Measurement Description
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ERP/CRM Server Resource Monitoring 

This chapter includes:

Concepts

➤ ERP/CRM Server Resource Monitoring Overview on page 480

Tasks

➤ How to Set Up the PeopleSoft (Tuxedo) Resource Monitor on page 481

➤ How to Set Up the SAPGUI Server Resource Monitor on page 483

Reference

➤ PeopleSoft (Tuxedo) Performance Counters on page 485

➤ SAPGUI Performance Counters on page 487
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Concepts

ERP/CRM Server Resource Monitoring Overview 

You use ALM Performance Center’s ERP/CRM server resource monitors to 
monitor ERP/CRM servers during a performance test run and isolate server 
performance bottlenecks.

➤ The PeopleSoft (Tuxedo) monitor displays statistics about the resource 
usage of a PeopleSoft (Tuxedo) server during the test run.

➤ The SAPGUI monitor displays statistics about the resource usage of an SAP 
R/3 system during the test run. You can use the SAPGUI monitor to view:

➤ the number of configured instances for each SAP system

➤ data for all application instances (not just the one you logged on to)

➤ transactions used and the users that call them

➤ number of users working on the different instances

➤ performance history for recent periods of all instances

➤ response time distribution

➤ resource consumption for any application server 

➤ application server workload for the current day or for a recent period
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Tasks

How to Set Up the PeopleSoft (Tuxedo) Resource 
Monitor

This task describes the working order for setting up the monitoring 
environment. If Tuxedo 7.1 or later is installed, you can monitor more than 
one PeopleSoft (Tuxedo) application server at a time. If Tuxedo 6.5 or earlier 
is installed, you can monitor only one PeopleSoft (Tuxedo) application 
server at a time.

This task includes the following steps:

➤ "Prerequisites" on page 481

➤ "Define the environment variables on the Controller machine" on 
page 482

➤ "Check the Workstation Listener (WSL) Process" on page 482

➤ "Configure the PeopleSoft (Tuxedo) monitor on the Controller" on 
page 482

 1 Prerequisites

Ensure that a Tuxedo workstation client (not a native client), version 6.3 
or later, is installed on the Controller machine. 

Use a Tuxedo 6.x client if a Tuxedo 6.x server is used, and Tuxedo 7.1 or 
later client if a Tuxedo 7.1 or later server is used. 

If you use a Tuxedo 6.5 or earlier server, you can still use a Tuxedo 7.1 or 
later client in order to monitor it, provided that you set the 
WSINTOPPRE71 environment variable to yes.
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Note: A Tuxedo workstation client communicates with the application 
server over the network, and is not required to run the Tuxedo 
application server on the same machine. A native client can only 
communicate with the Tuxedo application server if it is part of the 
relevant Tuxedo domain.

 2 Define the environment variables on the Controller machine

 a Set the TUXDIR variable to the Tuxedo installation directory (for 
example, V:\environ\32\Tuxedo 8.0).

 b Add the Tuxedo bin directory to the PATH variable.

 3 Check the Workstation Listener (WSL) Process

Ensure that the workstation listener (WSL) process is running. This 
enables the application server to accept requests from workstation clients. 

The address and port number used to connect to the application server 
must match those dedicated to the WSL process. 

Note: For information on configuring the WSL, refer to the BEA Tuxedo 
Web site.

 4 Configure the PeopleSoft (Tuxedo) monitor on the Controller

For task details, see "How to Create and Configure Monitor Profiles" on 
page 75.
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How to Set Up the SAPGUI Server Resource Monitor

This task describes the working order for setting up the monitoring 
environment.

Note: The SAPGUI monitor supports SAP server versions 3.1 to 4.6, 
regardless of the SAP R/3 server’s operating system and the platform on 
which it is installed.

This task includes the following steps:

➤ "Prerequisites" on page 481

➤ "Enable the last minute load from the client" on page 484

➤ "Configure the SAPGUI Server Resource monitor on the Controller" on 
page 484

 1 Prerequisites

Note: Once the SAPGUI monitor is activated on the Controller machine, 
you cannot record a SAPGUI protocol script on that machine.

➤ Install the SAPGUI for Windows 6.20 client on the Controller 
machine.

➤ Install the latest patch for the SAPGUI for Windows 6.20 client. The 
lowest supported level is patch 36. (SAPGUI patches can be 
downloaded from https://websmp104.sap-ag.de/patches. You will need 
a valid Service Marketplace username and password to access this site.)

https://websmp104.sap-ag.de/patches
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 2 Enable the last minute load from the client

From the SAPGUI client application, click F6 to determine whether you 
can access the st03 transaction and query for last minute load 
information. 

If this functionality is not already enabled, enable it from the SAP R/3 
client on the Controller machine, using the username and password 
defined in the Controller.

 3 Configure the SAPGUI Server Resource monitor on the 
Controller

For task details, see "How to Create and Configure Monitor Profiles" on 
page 75.
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Reference

PeopleSoft (Tuxedo) Performance Counters

The following table describes the default counters that can be measured. It is 
recommended to pay particular attention to the following measurements: 
% Busy Clients, Active Clients, Busy Clients, Idle Clients, and all the queue 
counters for the APPQ/PSAPPSRV queue.

Monitor Measurements

Machine % Busy Clients - The percent of active clients currently logged in 
to the Tuxedo application server that are waiting for a response 
from the application server.

Active Clients - The total number of active clients currently 
logged in to the Tuxedo application server.

Busy Clients - The total number of active clients currently logged 
in to the Tuxedo application server that are waiting for a 
response from the application server.

Current Accessers - The number of clients and servers currently 
accessing the application either directly on this machine or 
through a workstation handler on this machine. 

Current Transactions - The number of in use transaction table 
entries on this machine.

Idle Clients - The total number of active clients currently logged 
in to the Tuxedo application server that are not waiting for a 
response from the application server.

Workload Completed/second - The total workload on all the 
servers for the machine that was completed, per unit time.

Workload Initiated/second - The total workload on all the 
servers for the machine that was initiated, per unit time.

Queue % Busy Servers - The percent of active servers currently handling 
Tuxedo requests.
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Active Servers - The total number of active servers either 
handling or waiting to handle Tuxedo requests.

Busy Servers - The total number of active servers currently busy 
handling Tuxedo requests.

Idle Servers - The total number of active servers currently 
waiting to handle Tuxedo requests.

Number Queued - The total number of messages which have 
been placed on the queue.

Server Requests/second - The number of server requests handled per 
second.

Workload/second -The workload is a weighted measure of the 
server requests. Some requests could have a different weight 
than others. By default, the workload is always 50 times the 
number of requests.

Workstation 
Handler 
(WSH)

Bytes Received/sec - The total number of bytes received by the 
workstation handler, per second.

Bytes Sent/sec - The total number of bytes sent back to the 
clients by the workstation handler, per second.

Messages Received/sec - The number of messages received by 
the workstation handler, per second.

Messages Sent/sec - The number of messages sent back to the 
clients by the workstation handler, per second.

Number of Queue Blocks/sec - The number of times the queue 
for the workstation handler blocked, per second. This gives an 
idea of how often the workstation handler was overloaded.

Monitor Measurements
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SAPGUI Performance Counters 

The following table lists the most commonly monitored counters:

Measurement Description

Average CPU time The average CPU time used in the work process. 

Average response time The average response time, measured from the time 
a dialog sends a request to the dispatcher work 
process, through the processing of the dialog, until 
the dialog is completed and the data is passed to the 
presentation layer. The response time between the 
SAP GUI and the dispatcher is not included in this 
value.

Average wait time The average amount of time that an unprocessed 
dialog step waits in the dispatcher queue for a free 
work process. Under normal conditions, the 
dispatcher work process should pass a dialog step to 
the application process immediately after receiving 
the request from the dialog step. Under these 
conditions, the average wait time would be a few 
milliseconds. A heavy load on the application server 
or on the entire system causes queues at the 
dispatcher queue.

Average load time The time needed to load and generate objects, such 
as ABAP source code and screen information, from 
the database.

Database calls The number of parsed requests sent to the database.

Database requests The number of logical ABAP requests for data in the 
database. These requests are passed through the R/3 
database interface and parsed into individual 
database calls. The proportion of database calls to 
database requests is important. If access to 
information in a table is buffered in the SAP buffers, 
database calls to the database server are not 
required. Therefore, the ratio of calls/requests gives 
an overall indication of the efficiency of table 
buffering. A good ratio would be 1:10.
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Roll ins The number of rolled-in user contexts.

Roll outs The number of rolled-out user contexts.

Roll in time The processing time for roll ins.

Roll out time The processing time for roll outs.

Roll wait time The queue time in the roll area. When synchronous 
RFCs are called, the work process executes a roll out 
and may have to wait for the end of the RFC in the 
roll area, even if the dialog step is not yet 
completed. In the roll area, RFC server programs can 
also wait for other RFCs sent to them. 

Average time per logical 
DB call

The average response time for all commands sent to 
the database system (in milliseconds). The time 
depends on the CPU capacity of the database server, 
the network, the buffering, and on the input/output 
capabilities of the database server. Access times for 
buffered tables are many magnitudes faster and are 
not considered in the measurement.

Measurement Description
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Middleware Performance Monitoring

This chapter includes:

Concepts

➤ Middleware Performance Monitoring Overview on page 490

Tasks

➤ How to Set Up the Tuxedo Monitoring Environment on page 491

Reference

➤ Tuxedo Performance Counters on page 493

➤ Tuxedo tpinit.ini File on page 495
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Concepts

Middleware Performance Monitoring Overview 

A primary factor in a transaction’s response time is the Middleware 
performance usage. ALM Performance Center’s Middleware Performance 
monitors provide you with information about the Middleware performance 
usage of the Tuxedo server during performance test execution. To obtain 
performance data, you need to activate the online monitor for the server 
and specify which resources you want to measure before executing the 
performance test.

The Tuxedo monitor allows you to measure and view your Tuxedo server 
performance. It provides information about the host machine, workstation 
handler, and queue in a Tuxedo system. To run the Tuxedo monitor, you 
must install the Tuxedo client libraries on the machine you want to 
monitor.
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Tasks

How to Set Up the Tuxedo Monitoring Environment

This task describes the working order for setting up the monitoring 
environment.

Note: If Tuxedo 7.1 or higher is installed on the Controller machine, more 
than one Tuxedo application server can be monitored at a time. However, if 
Tuxedo 6.5 or below is installed on the Controller machine, only one 
Tuxedo application server can be monitored at a time. 

This task includes the following steps:

➤ "Prerequisites" on page 491

➤ "Define the Tuxedo Environment Variables" on page 492

➤ "Check the Workstation Listener (WSL) Process" on page 492

➤ "Configure the Tuxedo monitor on the Controller" on page 492

 1 Prerequisites

Ensure that a Tuxedo workstation client (not a native client) is installed 
on the Controller machine. Use a Tuxedo 6.x client if a Tuxedo 6.x server 
is used, and Tuxedo 7.1 or above client if a Tuxedo 7.1 or above server is 
used. 

If you use a Tuxedo 6.5 or earlier server, you can still use a Tuxedo 7.1 or 
later client to monitor it, provided that you set the WSINTOPPRE71 
environment variable to “yes”.
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Note: A Tuxedo workstation client communicates with the application 
server over the network, and is not required to run the Tuxedo 
application server on the same machine. A native client can only 
communicate with the Tuxedo application server if it is part of the 
relevant Tuxedo domain. 

 2 Define the Tuxedo Environment Variables

Define the Tuxedo environment variables on the Controller machine—set 
the TUXDIR variable to the Tuxedo installation directory (for example, 
V:\environ\32\Tuxedo8.0), and add the Tuxedo bin directory to the PATH 
variable. 

 3 Check the Workstation Listener (WSL) Process

Ensure that the workstation listener (WSL) process is running. This 
enables the application server to accept requests from workstation clients. 

The address and port number used to connect to the application server 
must match those dedicated to the WSL process.

Note: For information on configuring the WSL, refer to the BEA Tuxedo 
Web site (http://edocs.beasys.com/tuxedo/tux81/rf5/
rf5101.htm#1534543).

 4 Configure the Tuxedo monitor on the Controller

For task details, see "How to Create and Configure Monitor Profiles" on 
page 75.
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Reference

Tuxedo Performance Counters

The following table lists the available Tuxedo monitor measurements. It is 
recommended to pay particular attention to the following measurements: 
% Busy Clients, Active Clients, Busy Clients, Idle Clients, and all the queue 
counters for relevant queues:  

Monitor Measurements

Machine % Busy Clients - The percent of active clients currently logged 
in to the Tuxedo application server that are waiting for a 
response from the application server.

Active Clients - The total number of active clients currently 
logged in to the Tuxedo application server.

Busy Clients - The total number of active clients currently 
logged in to the Tuxedo application server that are waiting for 
a response from the application server.

Current Accessers - The number of clients and servers 
currently accessing the application either directly on this 
machine or through a workstation handler on this machine. 

Current Transactions - The number of in-use transaction table 
entries on this machine.

Idle Clients - The total number of active clients currently 
logged in to the Tuxedo application server that are not 
waiting for a response from the application server.

Workload Completed/second - The total workload on all the 
servers for the machine that was completed, per unit time.

Workload Initiated/second - The total workload on all the 
servers for the machine that was initiated, per unit time.
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Queue % Busy Servers - The percent of active servers currently 
handling Tuxedo requests.

Active Servers - The total number of active servers either 
handling or waiting to handle Tuxedo requests.

Busy Servers - The total number of active servers currently 
busy handling Tuxedo requests.

Idle Servers - The total number of active servers currently 
waiting to handle Tuxedo requests.

Number Queued - The total number of messages which have 
been placed on the queue.

Server Requests/second -The number of server requests handled per 
second

Workload/second - Workload is a weighted measure of the 
server requests. Some requests could have a different weight 
than others. By default, the workload is always 50 times the 
number of requests.

Workstation 
Handler (WSH)

Bytes Received/sec - The total number of bytes received by 
the workstation handler, per second.

Bytes Sent/sec - The total number of bytes sent back to the 
clients by the workstation handler, per second.

Messages Received/sec - The number of messages received by 
the workstation handler, per second.

Messages Sent/sec - The number of messages sent back to the 
clients by the workstation handler, per second.

Number of Queue Blocks/sec - The number of times the 
queue for the workstation handler blocked, per second. This 
gives an idea of how often the workstation handler was 
overloaded.

Monitor Measurements
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Tuxedo tpinit.ini File

The tpinit.ini file is saved in the recorded script’s directory. It contains 
information for connecting the Tuxedo monitor to the server. The client 
logon information is located in the Logon section of the tpinit.ini file.

In the following example of a tpinit.ini file, the Tuxedo monitor was 
configured for a server named psft1 using port 7000, and a client named 
bankapp. The logon user name was PS and the password was PS.

[Logon]
LogonServername=//psft1:7000
LogonUsrName=PS
LogonCltName=bankapp
LogonGrpName=
LogonPasswd=PS
LogonData=
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Application Deployment Solution 
Monitoring 

This chapter includes:

Concepts

➤ Application Deployment Solution Monitoring Overview on page 498

Tasks

➤ How to Set up the Citrix Monitoring Environment on page 499

Reference

➤ Citrix MetaFrame Performance Counters on page 501
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Concepts

Application Deployment Solution Monitoring Overview 

Using ALM Performance Center’s Application Deployment Solution 
monitor, you can isolate server performance bottlenecks by monitoring the 
Citrix server during a performance test run.

ALM Performance Center’s Citrix monitor provides you with information 
about the application deployment usage of the Citrix server during 
performance test execution. The Citrix monitor allows you to monitor the 
server performance statistics from Citrix servers. You can monitor multiple 
parameters (counters) with a single monitor instance. This allows you to 
watch server loading for performance, availability, and capacity planning.

To obtain performance data, you need to activate the online monitor for the 
server and specify which resources you want to measure before executing 
the performance test.

For information about how to set up the Citrix monitoring environment, 
see "How to Set up the Citrix Monitoring Environment" on page 499.
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Tasks

How to Set up the Citrix Monitoring Environment

This task describes the working order for setting up the monitoring 
environment.

To learn more about application deployment solution monitoring, see 
"Application Deployment Solution Monitoring Overview" on page 498.

This task includes the following steps:

➤ "Prerequisites" on page 499

➤ "Map the Network Drive" on page 500

➤ "Launch PerfMon" on page 500

➤ "Open the Connection with the Citrix Server" on page 500

➤ "Configure the Citrix monitor on the Controller" on page 500

 1 Prerequisites

➤ Make sure that Citrix Server has been installed and is running.

➤ If Citrix Server machine is running Windows 2000, make sure that the 
server machine is also running the Remote Registry service.

➤ Measurements that monitor instances are valid for the currently 
running Citrix session only. If you run this test again, you will need to 
reconfigure the measurements that are instance-oriented.

To monitor the different instances, ensure that the server login and 
logout procedures are recorded in the Vuser_init and Vuser_end 
sections respectively, and not in the Action section of the script. For 
more information, see the HP Virtual User Generator User Guide. 
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 2 Map the Network Drive

From the Controller machine, map a network drive to the Citrix server 
machine. This ensures that the required authentication is provided to the 
Controller to access the resource counters.

 3 Launch PerfMon

Launch PerfMon from the Controller machine to enable the counters on 
the Citrix server. This allows you to monitor the same counters for the 
ICA Session object on the Citrix monitor.

 4 Open the Connection with the Citrix Server

You can configure the Citrix monitor to view ICA Session object counters 
only if at least one session is being run on the Citrix server. If no “real” 
user has opened a connection with the Citrix server, you need to first 
initialize or run a Citrix Vuser against the server, and only then configure 
the Citrix Monitor and add the ICA Session counters. If you configure the 
Citrix monitor without first initializing or running a Citrix Vuser (or 
connecting to the Citrix server as a “real” user), you will not be able to 
view the ICA Session object.

 5 Configure the Citrix monitor on the Controller

For task details, see "How to Create and Configure Monitor Profiles" on 
page 75.
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Reference

Citrix MetaFrame Performance Counters

The following sections describe some of the counters that can be measured.

➤ "Non-Virtual Counters" on page 501

➤ "Virtual Channel Counters" on page 505

Non-Virtual Counters
The following table describes non-virtual counters: 

Measurement Description

% Disk Time The percentage of elapsed time that the selected 
disk drive services read or write requests.

% Processor Time The percentage of time that the processor executes a 
non-Idle thread. This counter is a primary indicator 
of processor activity. It is calculated by measuring 
the time that the processor spends executing the 
thread of the Idle process in each sample interval, 
and subtracting that value from 100%. (Each 
processor has an Idle thread which consumes cycles 
when no other threads are ready to run.) It can be 
viewed as the percentage of the sample interval 
spent doing useful work. This counter displays the 
average percentage of busy time observed during 
the sample interval. It is calculated by monitoring 
the time the service was inactive, and then 
subtracting that value from 100%.

File data Operations/sec The rate that the computer issues Read and Write 
operations to file system devices. This does not 
include File Control Operations.
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Interrupts/sec The average number of hardware interrupts the 
processor receives and services per second. It does 
not include DPCs, which are counted separately. 
This value is an indirect indicator of the activity of 
devices that generate interrupts, such as the system 
clock, the mouse, disk drivers, data communication 
lines, network interface cards and other peripheral 
devices. These devices normally interrupt the 
processor when they have completed a task or 
require attention. Normal thread execution is 
suspended during interrupts. Most system clocks 
interrupt the processor every 10 milliseconds, 
creating a background of interrupt activity. This 
counter displays the difference between the values 
observed in the last two samples, divided by the 
duration of the sample interval.

Output Session Line Speed This value represents the line speed from server to 
client for a session in bps.

Input Session Line Speed This value represents the line speed from client to 
server for a session in bps.

Page Faults/sec A count of the Page Faults in the processor. A page 
fault occurs when a process refers to a virtual 
memory page that is not in its Working Set in main 
memory. A Page Fault will not cause the page to be 
fetched from disk if that page is on the standby list, 
and hence already in main memory, or if it is in use 
by another process with whom the page is shared.

Measurement Description
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Pages/sec The number of pages read from the disk or written 
to the disk to resolve memory references to pages 
that were not in memory at the time of the 
reference. This is the sum of Pages Input/sec and 
Pages Output/sec. This counter includes paging 
traffic on behalf of the system Cache to access file 
data for applications. This value also includes the 
pages to/from non-cached mapped memory files. 
This is the primary counter to observe if you are 
concerned about excessive memory pressure (that 
is, thrashing), and the excessive paging that may 
result. 

Pool Nonpaged Bytes The number of bytes in the Nonpaged Pool, a 
system memory area where space is acquired by 
operating system components as they accomplish 
their appointed tasks. Nonpaged Pool pages cannot 
be paged out to the paging file, but instead remain 
in main memory as long as they are allocated. 

Private Bytes The current number of bytes this process has 
allocated that cannot be shared with other 
processes.

Processor Queue Length The instantaneous length of the processor queue in 
units of threads. This counter is always 0 unless you 
are also monitoring a thread counter. All processors 
use a single queue in which threads wait for 
processor cycles. This length does not include the 
threads that are currently executing. A sustained 
processor queue length greater than two generally 
indicates processor congestion. This is an 
instantaneous count, not an average over the time 
interval.

Threads The number of threads in the computer at the time 
of data collection. Notice that this is an 
instantaneous count, not an average over the time 
interval. A thread is the basic executable entity that 
can execute instructions in a processor.

Measurement Description
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Latency – Session Average This value represents the average client latency over 
the life of a session.

Latency – Last Recorded This value represents the last recorded latency 
measurement for this session.

Latency – Session 
Deviation

This value represents the difference between the 
minimum and maximum measured values for a 
session.

Input Session Bandwidth This value represents the bandwidth from client to 
server traffic for a session in bps.

Input Session 
Compression

This value represents the compression ratio for 
client to server traffic for a session.

Output Session Bandwidth This value represents the bandwidth from server to 
client traffic for a session in bps.

Output Session 
Compression

This value represents the compression ratio for 
server to client traffic for a session.

Output Session Linespeed This value represents the line speed from server to 
client for a session in bps.

Measurement Description
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Virtual Channel Counters
The following table describes virtual channel counters:

Measurement Description

Input Audio Bandwidth This value represents the bandwidth from client to 
server traffic on the audio mapping channel. This is 
measured in bps.

Input Clipboard 
Bandwidth

This value represents the bandwidth from client to 
server traffic on the clipboard mapping channel. 
This is measured in bps.

Input COM1 Bandwidth This value represents the bandwidth from client to 
server traffic on the COM1 channel. This is 
measured in bps.

Input COM2 Bandwidth This value represents the bandwidth from client to 
server traffic on the COM2 channel. This is 
measured in bps.

Input COM Bandwidth This value represents the bandwidth from client to 
server traffic on the COM channel. This is measured 
in bps.

Input Control Channel 
Bandwidth

This value represents the bandwidth from client to 
server traffic on the ICA control channel. This is 
measured in bps.

Input Drive Bandwidth This value represents the bandwidth from client to 
server traffic on the client drive mapping channel. 
This is measured in bps.

Input Font Data 
Bandwidth

This value represents the bandwidth from client to 
server traffic on the local text echo font and 
keyboard layout channel. This is measured in bps.

Input Licensing 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the licensing channel. This is 
measured in bps.

Input LPT1 Bandwidth This value represents the bandwidth from client to 
server traffic on the LPT1 channel. This is measured 
in bps.
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Input LPT2 Bandwidth This value represents the bandwidth from client to 
server traffic on the LPT2 channel. This is measured 
in bps.

Input Management 
Bandwidth

This value represents the bandwidth from client to 
server traffic on the client management channel. 
This is measured in bps.

Input PN Bandwidth This value represents the bandwidth from client to 
server traffic on the Program Neighborhood 
channel. This is measured in bps.

Input Printer Bandwidth This value represents the bandwidth from client to 
server traffic on the printer spooler channel. This is 
measured in bps.

Input Seamless Bandwidth This value represents the bandwidth from client to 
server traffic on the Seamless channel. This is 
measured in bps.

Input Text Echo 
Bandwidth

This value represents the bandwidth from client to 
server traffic on the local text echo data channel. 
This is measured in bps.

Input Thinwire Bandwidth This value represents the bandwidth from client to 
server traffic on the Thinwire (graphics) channel. 
This is measured in bps.

Input VideoFrame 
Bandwidth

This value represents the bandwidth from client to 
server traffic on the VideoFrame channel. This is 
measured in bps.

Output Audio Bandwidth This value represents the bandwidth from server to 
client traffic on the audio mapping channel. This is 
measured in bps.

Output Clipboard 
Bandwidth

This value represents the bandwidth from server to 
client traffic on he clipboard mapping channel. This 
is measured in bps.

Output COM1 Bandwidth This value represents the bandwidth from server to 
client traffic on the COM1 channel. This is 
measured in bps.

Measurement Description
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Output COM2 Bandwidth This value represents the bandwidth from server to 
client traffic on the COM2 channel. This is 
measured in bps.

Output COM Bandwidth This value represents the bandwidth from server to 
client traffic on the COM channel. This is measured 
in bps.

Output Control Channel 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the ICA control channel. This is 
measured in bps.

Output Drive Bandwidth This value represents the bandwidth from server to 
client traffic on the client drive channel. This is 
measured in bps.

Output Font Data 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the local text echo font and 
keyboard layout channel. This is measured in bps.

Output Licensing 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the licensing channel. This is 
measured in bps.

Output LPT1 Bandwidth This value represents the bandwidth from server to 
client traffic on the LPT1 channel. This is measured 
in bps.

Output LPT2 Bandwidth This value represents the bandwidth from server to 
client traffic on the LPT2 channel. This is measured 
in bps.

Output Management 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the client management channel. 
This is measured in bps.

Output PN Bandwidth This value represents the bandwidth from server to 
client traffic on the Program Neighborhood 
channel. This is measured in bps.

Output Printer Bandwidth This value represents the bandwidth from server to 
client traffic on the printer spooler channel. This is 
measured in bps.

Measurement Description
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Output Seamless 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the Seamless channel. This is 
measured in bps.

Output Text Echo 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the local text echo data channel. 
This is measured in bps.

Output Thinwire 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the Thinwire (graphics) channel. 
This is measured in bps.

Output VideoFrame 
Bandwidth

This value represents the bandwidth from server to 
client traffic on the VideoFrame channel. This is 
measured in bps.

Measurement Description
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28
Script Runtime Settings 

This chapter includes:

Concepts

➤ Script Runtime Settings Overview on page 512

Tasks

➤ How to Configure Runtime Settings on page 513

Reference

➤ Protocol Specific Runtime Settings Types on page 514

➤ Runtime Settings User Interface on page 515
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Concepts

Script Runtime Settings Overview

Before you run a performance test, you can configure the behavior of the 
Vuser scripts in the test using runtime settings. You can configure general 
settings and protocol-specific settings.

This section also includes:

➤ "General Runtime Settings Overview" on page 512

➤ "Protocol-Specific Runtime Settings Overview" on page 512

General Runtime Settings Overview 
After you record a Vuser script, you can configure its runtime settings. The 
runtime settings define the way the script runs, such as delay between 
actions, the number of times to repeat an action, and the level of logging.

Configuring runtime settings allows you to emulate different kinds of user 
activity. For example, you can emulate a user who responds immediately to 
the server, or a user who stops and thinks before each response. You can also 
configure the runtime settings to specify how many times the Vuser should 
repeat a set of actions. The General runtime settings described in this 
chapter apply to all types of Vuser scripts.

For task details, see "How to Configure Runtime Settings" on page 513.

Protocol-Specific Runtime Settings Overview 
Before replaying a Vuser script, you can configure its runtime settings. The 
runtime settings define the way the script runs, using settings that are 
specific for your particular environment.

Since runtime settings are protocol-specific, you will notice that not all 
runtime settings are available. 

For task details, see "How to Configure Runtime Settings" on page 513.
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Tasks

How to Configure Runtime Settings

This task describes how to open and configure runtime settings to define the 
way a script runs.

To learn more about runtime settings, see "Script Runtime Settings 
Overview" on page 512

To configure the runtime settings in a Vuser script:

 1 On the ALM sidebar, under Testing, select Test Plan.

 2 Right-click a performance test in the test plan tree and select Edit Test.

 3 In the Workload tab, select a Vuser group and click Edit Runtime Settings 
. The Edit Runtime Settings dialog box opens.

 4 Select the runtime settings type to edit and define the required 
information. For user interface details, see Edit Runtime Settings Dialog 
Box on page 606.

For a list of runtime settings types that relate to specific protocols, see 
"Protocol Specific Runtime Settings Types" on page 514.

 5 Click OK to save the settings and close the dialog box.
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Reference

Protocol Specific Runtime Settings Types

The following list shows the protocol-specific runtime settings.

Protocol(s)/Category Runtime Setting

Web Services / JMS Advanced

Internet Protocols / Browser Browser Emulation 

Java / Java Environment Settings Classpath Options

Oracle NCA / Oracle NCA Client Emulation

Citrix ICA / Citrix Configuration

Internet Protocols / Internet Protocol Download Filter

WAP, MMS / WAP Gateway

SAPGUI / SAPGUI SAPGUI

Java / Java Environment Settings Java VM

Microsoft .NET / .NET .NET Environment

Internet Protocols / Internet Protocol Preferences

Internet Protocols / Internet Protocol Proxy

WAP, MMS / WAP Radius

Terminal Emulation / RTE RTE

MMS (Multimedia Messaging Service) Server and Protocol

Internet Protocols, NCA / Network Speed Simulation

Citrix ICA / Citrix Timing
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Runtime Settings User Interface 

This section includes:

 ➤ Edit Runtime Settings Dialog Box on page 578
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Edit Runtime Settings Dialog Box 

This dialog box enables you to modify runtime settings in the scripts in the 
test.

 

To access 1  On the ALM sidebar, under Testing, select Test Plan. 

2  Right-click a performance test in the test plan tree and 
select Edit Test.

3  In the Workload tab, select a Vuser group and click 
Edit Runtime Settings .

Important 
information

If you do not edit the runtime settings, the script runs 
using the default runtime settings, or the last saved 
runtime settings if the script was recorded in VuGen. 

Relevant tasks "How to Configure Runtime Settings" on page 513

See also ➤ "Script Runtime Settings Overview" on page 512

➤ HP Virtual User Generator User Guide
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Edit Run Logic Settings 

Every Vuser script contains three sections: Init, Run, and End. You can 
instruct a Vuser to repeat the Run section a specific number of times when 
you run the script. Each repetition is known as an iteration.

The Init and End sections of a Vuser script are not repeated when you run 
multiple iterations.

Within the Run section, you can organize your steps into separate actions. 
You do this when creating the script.

The Run Logic settings let you organize the actions and their sequence. You 
can also organize blocks that perform one or more actions. 

Edit Pacing Settings

The Pacing runtime settings let you control the number of iterations and the 
time between them.

User interface elements are described below:

UI Elements Description

Iteration Count Specifies the number of times to repeat the script’s Run 
section.

As soon as the 
previous iteration 
ends

The new iteration begins as soon as possible after the 
previous iteration ends.

After the previous 
iteration ends with a 
fixed delay of

Starts each new iteration at a fixed delay after the end of 
the previous iteration.



Chapter 28 • Script Runtime Settings

518

Log Settings

During execution, Vusers log information about themselves and their 
communication with the server. The log information is useful for debugging 
purposes.

The Log runtime settings let you disable logging or determine how much 
information is logged to the output—a Standard or Extended log. 

After the previous 
iteration ends with a 
random delay of

Starts each new iteration at a random delay from the end 
of the previous iteration. You specify a range for the 
delay.

When you run the script, the Execution Log shows the 
actual time the Vuser waited between the end of one 
iteration and the start of the next one.

At fixed or random 
intervals, every … [to 
…] seconds

You specify the time between iterations—either a fixed 
number of seconds or a range of seconds from the 
beginning of the previous iteration. For example, you can 
specify to begin a new iteration every 30 seconds, or at a 
random rate ranging from 30 to 45 seconds from the 
beginning of the previous iteration. Each scheduled 
iterations begins only when the previous iteration is 
complete.

When you run the script, the Execution Log shows the 
time the Vuser waited between the end of one iteration 
and the start of the next one.

The Execution Log also indicates if the delay could not be 
achieved, for example where it took the iteration eight 
seconds and the delay was seven seconds.

UI Elements Description
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User interface elements are described below:

UI Elements Description

Disable logging Disabling the log is useful when working with many 
Vusers. If you have tens or hundreds of Vusers logging 
their runtime information to disk, the system may work 
slower than normal. During development, enable logging 
so that you will have information about the replay. You 
should only disable logging after verifying that the script 
is functional.

If you disable logging, it only affects automatic logging. 
Messages sent manually using message functions such as 
lr_output_message, are still issued.

Standard log Creates a standard log of functions and messages sent 
during script execution to use for debugging. Disable this 
option for large performance testing scenarios or profiles. 

If the logging level is set to Standard, the logging mode is 
automatically set to JIT logging when adding it to the 
Controller host. If, however, the logging mode was 
disabled or set to Extended, then running it from a 
Controller host will not affect its logging settings.
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Extended log Creates an extended log, including warnings and other 
messages. Disable this option for large performance tests. 

You can specify which additional information to add to 
the extended log using the Extended log options:

➤ Parameter substitution. Logs all parameters assigned 
to the script with their values. 

➤ Data returned by server. Logs all data returned by the 
server.

➤ Advanced trace. Logs all of the functions and 
messages sent by the Vuser during the session. This 
option is useful when you debug a Vuser script.

Log Options The Log runtime settings let you indicate when to send 
log messages to the log: Send messages only when an 
error occurs or Always send messages. During 
development, you can always send messages. Once you 
verify that your script is functional, you can enable 
logging for errors only.

If you choose to send messages only when errors occur, 
also known as JIT, (Just in Time) messaging, you can set 
an advanced option, indicating the size of the log cache. 

The Advanced options for the Log runtime settings let 
you indicate the size of the log cache. The log cache 
stores raw data about the test execution, to make it 
available should an error occur. When the contents of the 
cache exceed the specified size, it deletes the oldest items. 
The default size is 1KB.

When an error occurs (either an internal error or a 
programmed error using lr_error_message), VuGen 
places the contents of the cache into the log file and 
Execution Log tab. This allows you to see the events that 
led up to the error. 

The actual file size will be greater than the cache size. For 
example, if your cache size is 1KB, the log file size may be 
50 KB. This is normal and only reflects the overhead 
required for formatting the raw data into readable text.

UI Elements Description
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Think Time Settings

Vuser think time emulates the time that a real user waits between actions. 
For example, when a user receives data from a server, they may wait several 
seconds to review the data before responding. Vuser scripts use lr_think_time 
functions to emulate the think time delays. 

The following recorded function indicates that the user waited eight seconds 
before performing the next action:

lr_think_time(8);

By default, when you run a Vuser script, the Vuser uses the think time values 
that were recorded into the script during the recording session. VuGen 
allows you to use the recorded think time, ignore it, limit it, or use a value 
related to the recorded time.

User interface elements are described below:

UI Elements Description

Ignore think time Replays the script ignoring all lr_think_time functions.

Replay the think time 
as recorded

Uses the value recorded. It is the argument that appears 
in the lr_think_time function. For example, 
lr_think_time(10) waits 10 seconds.

Multiply recorded 
value by

Uses a multiple of the recorded think time. This can 
increase or decrease the think time applied during 
playback. For example, if a think time of four seconds 
was recorded, you can instruct your Vuser to multiply 
that value by two, for a total of eight seconds. To reduce 
the think time to two seconds, multiply the recorded 
time by 0.5.
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Miscellaneous Settings

User interface elements are described below:

Use random 
percentage of the 
recorded think time

Uses a random percentage of the recorded think time. 
You set a range for the think time value by specifying a 
range for the think time. For example, if the think time 
argument is 4, and you specify a minimum of 50% and a 
maximum of 150%, the lowest think time can be two 
(50%) and the highest value six (150%)

Limit think time to Limits the think time’s maximum value. You can use this 
option in conjunction with the other options.

UI Elements Description

Error Handling Contains the following options:

➤ Continue on Error. Instructs Vusers to continue script 
execution when an error occurs. This option is turned off 
by default, indicating that the Vuser will exit if an error 
occurs.

➤ Fail open transactions on lr_error_message. Marks all 
transactions in which an lr_error_message function was 
issued, as Failed. The lr_error_message function is issued 
through a programmed If statement, when a certain 
condition is met. 

➤ Generate Snapshot on Error. Generates a snapshot when 
an error occurs. You can see the snapshot by viewing the 
Vuser Log and double-clicking the line at which the error 
occurred. 

Note: It is not recommended to enable both the Continue on 
Error and Generate Snapshot on Error options in a 
performance test environment. This configuration may 
adversely affect the Vusers’ performance.

UI Elements Description
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Multithreading Vusers support multithread environments. The primary 
advantage of a multithread environment is the ability to run 
more Vusers per load generator. Only threadsafe protocols 
should be run as threads.

The following multithreading options are available:

➤ Run Vuser as a thread. Enables multithreading.

Note: The following protocols are not threadsafe: 
Sybase-Ctlib, Sybase-Dblib, Informix, Tuxedo, and 
PeopleSoft-Tuxedo.

➤ Run Vuser as a process. Disables multithreading and runs 
each Vuser as a separate process.

Note: The Controller host uses a driver program (such as 
mdrv.exe or r3vuser.exe) to run your Vusers. If you run 
each Vuser as a process, then the same driver program is 
launched (and loaded) into the memory again and again 
for every instance of the Vuser. Loading the same driver 
program into memory uses up large amounts of RAM 
(random access memory) and other system resources. This 
limits the numbers of Vusers that can be run on any load 
generator.

Automatic 
Transactions

Instructs the Controller host to handle every step or action in 
a Vuser script as a transaction. The Controller assigns the step 
or action name as the name of the transaction. 

The following options are available:

➤ Define each action as a transaction. Disables automatic 
transactions per action.

Default: Enabled.

➤ Define each step as a transaction. Enables automatic 
transactions per step.

Default: Disabled.

Note: If you disable automatic transactions, you can still 
insert transactions manually during and after recording. 

UI Elements Description
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Additional Attributes

You can use the additional attributes node to provide additional arguments 
to a Vuser script. The Additional Attributes settings apply to all types of 
Vuser scripts. 

You specify command line arguments that you can retrieve at a later point 
during the test run using the lr_get_attrib_string. Using this node you can 
pass external parameters to prepared scripts. 

User interface elements are described below:

Advanced Settings

To use JMS as a transport for Web Service calls, there are several resources 
that need to be allocated and configured. Those resources include the JVM, 
JNDI initialization parameters, JMS resources, and timeout values. 

ALM Performance Center lets you configure some of those resources 
through the runtime settings. You can set options in the area of VM (Virtual 
Machine), the JMS connections, and message timeouts.

UI Elements Description

Add new attribute. Adds a new attribute.

Delete attribute. Deletes the selected attribute.

<Additional 
Attributes grid>

A list of the additional attributes and their values.

Description A description of the selected additional attribute.
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User interface elements are described below:

UI Elements Description

Use external VM Enables you to select a VM (Virtual Machine) other than 
the standard one. If you disable this option, Vusers use 
the JVM provided with Performance Center.

JVM Home The location of the external JVM. This should point to 
the JDK home directory, defined by JDK_HOME. 
Performance Center supports JDK 1.4 and above.

Classpath The vendor implementation of JMS classes together with 
any other required supporting classes, as determined by 
the JMS implementation vendor.

Additional VM 
Parameters

Extra parameters to send to the JVM such as 
Xbootclasspath, and any parameters specified by the JVM 
documentation.

JNDI initial context 
factory

The fully qualified class name of the factory class that 
will create an initial context. Select a context factory 
from the list or provide your own.

JNDI provider The URL string of the service provider. 

Example:
Weblogic - t3://myserver:myport
Websphere - iiop://myserver:myport

JMS connection 
factory

The JNDI name of the JMS connection factory. You can 
only specify one connection factory per script.

JMS security principal Identity of the principal (for example the user) for the 
authentication scheme.

JMS security 
credentials

The principal’s credentials for the authentication 
scheme.
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Browser Emulation Settings

You use the Browser Emulation settings to set the browser properties of your 
testing environment.

User interface elements are described below:

Number of JMS 
connections per 
process

The number of JMS connections per mdrv process or 
Vuser. All Vusers sharing a connection receive the same 
messages. 

Default: 1

Maximum: 50 Vusers. 

Note: The less connections per process, the better the 
performance.

Receive message 
timeout options

The timeout for received messages. 

The following options are available:

➤ Indefinite wait. Wait as long as required for the 
message before continuing.

➤ No wait. Do not wait for the Receive message, and 
return control to the script immediately. If there was 
no message in the queue, the operation fails. 

➤ Specify the timeout in seconds. Manually specify a 
timeout value for the message. If the timeout expired 
and no message arrived, the operation fails.

Default: No Wait

UI Elements Description

Customize your 
browser

By default, the user-agent emulates the Microsoft 
Internet Explorer 5.5 browser agent. You can, however, 
instruct the script to emulate a different browser, that is 
compatible with Internet Explorer 5.5. This setting 
creates a User-Agent header that identifies the type and 
version of the browser.

UI Elements Description
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Simulate browser 
cache

Instructs the Vuser to simulate a browser with a cache. By 
default, cache simulation is enabled. When the cache is 
disabled, Vusers will ignore all caching functionality and 
download all of the resources for every request.

Even if you disable the cache simulation, each resource is 
only downloaded once for each page, even if it appears 
multiple times. A resource can be an image, frame, or 
another type of script file.

When running multiple Vusers, every Vuser uses its own 
cache and retrieves images from the cache. If you disable 
this option, all Vusers emulate a browser with no cache. 

You can also set the following browser cache options:

➤ Cache URLs requiring content (HTML). Cache only the 
URLs that require the HTML content. The content 
may be necessary for parsing, verification, or 
correlation. When you select this option, HTML 
content is automatically cached. This option is 
enabled by default. 

Tip: To decrease the memory footprint of the Vusers, 
disable this option, unless it is an explicit requirement 
for your test.

➤ Specify URLs requiring content in addition to HTML 
page. This setting lets you specify the URL content 
types other than HTML pages, that you want to store 
in the cache for verification purposes. For example, 
text/xml or image/gif. Separate multiple content types 
with a semicolon. 

➤ Check for newer versions of stored pages every visit to 
the page. This setting instructs the browser to check 
for later versions of the specified URL, than those 
stored in the cache. When you enable this option, the 
"If-modified-since" attribute is added to the HTTP 
header. This option brings up the most recent version 
of the page, but also generates more traffic during the 
scenario or session execution. By default, browsers do 
not check for newer resources, and therefore this 
option is disabled. 

UI Elements Description
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Download non HTML 
resources

Loads graphic images when accessing a Web page during 
replay. This includes both graphic images that were 
recorded with the page, and those which were not 
explicitly recorded along with the page. When real users 
access a Web page, they wait for the images to load. 
Therefore, enable this option if you are trying to test the 
entire system, including end-user time. To increase 
performance and not emulate real users, disable this 
option. 

Tip: Disable this option if you experience discrepancies in 
image checks, since some images vary each time you 
access a Web page (for example, advertiser banners).

Simulate a new user 
on each iteration

Resets all HTTP contexts between iterations to their states 
at the end of the init section. This setting allows the 
Vuser to more accurately emulate a new user beginning a 
browsing session. It deletes all cookies, closes all TCP 
connections (including keep-alive), clears the emulated 
browser’s cache, resets the HTML frame hierarchy (frame 
numbering will begin from 1) and clears the user-names 
and passwords. This option is disabled by default.

➤ Clear cache on each iteration. Clears the browser 
cache for each iteration in order to simulate a user 
visiting a Web page for the first time. Disable this 
option if you want Vusers to use the browser’s cache, 
simulating a user who recently visited the page. 

UI Elements Description
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Classpath Settings

The Classpath settings let you specify the location of additional classes that 
were not included in the system’s CLASSPATH environment variable. You 
may need these classes to run Java applications and insure proper replay.

User interface elements are described below:

UI Elements Description

Classpath Entries Enter the path of additional classes that were not 
included in the system’s CLASSPATH environment 
variable.

Separate multiple entries with a semicolon.
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Client Emulation Settings

The Oracle NCA Client Emulation runtime settings let you specify the 
communication parameters for your NCA client. You should configure the 
settings to accurately emulate your Oracle NCA environment. 

User interface elements are described below:

UI Elements Description

Socket mode The communication to and from the client is performed 
on a socket level—not on the higher HTTP level.

➤ Timeout (seconds): The time that an Oracle NCA 
Vuser waits for a response from the server. The default 
value of -1 disables the timeout and the client waits 
indefinitely.

Pragma mode In Pragma mode, communication is carried out in the 
Oracle-defined Pragma mode. This communication level, 
above the HTTP and Servlet levels, is characterized by the 
periodic sending of messages. In this mode, the client 
recognizes that the server cannot respond with data 
immediately. The server sends messages at given intervals 
until it is able to send the requested data. 

➤ Max Retries. Indicates the maximum number of 
IfError messages the client will accept from the server 
before issuing an error. IfError messages are the 
periodic messages the server sends to the client, 
indicating that it will respond with the data as soon as 
it is able. 

➤ Retry Interval. Defines the interval between retries in 
the case of IfError messages. 

➤ Include retry intervals in transaction. Includes the 
interval between retry time, as part of the transaction 
duration time. 
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Enable Heartbeat You can enable or disable the heartbeat sent to the Oracle 
server. The heartbeat verifies that there is proper 
communication with the server. If you are experiencing a 
heavy load on the Oracle NCA server, disable the 
heartbeat. If you enable the heartbeat, you can set the 
frequency of how often heartbeat messages are sent to 
the server.

In the Frequency box, you can define the frequency of 
the heartbeat signal. The default is 120 seconds.

Default: Enabled

Forms Version You can specify the version of the Oracle Forms server 
detected during recording. 

Note: Modify this setting only if the server was upgraded 
since the recording.

Diagnostic This section lets you provide information about 
diagnostic modules for the database layer of Oracle 
Applications.

➤ Application version. The version of Oracle Application. 
This option is relevant when using Oracle 
Application—not a custom Oracle NCA application. It 
is only required when using Oracle database 
breakdown. 

UI Elements Description
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Configuration Settings

The Citrix Configuration settings relate to the screen latency, data 
compression, disk cache, and queuing of mouse movements. These settings, 
which will influence the load on the server, should correspond to the 
properties of your Citrix client. To view the client properties, select the icon 
representing the ICA connection in the Citrix Program Neighborhood, and 
select Properties from the right-click menu. Select the Default Options tab.

User interface elements are described below:

UI Elements Description

SpeedScreen Latency 
Reduction

The mechanism used to enhance user interaction when 
the network speed is slow. You can turn this mechanism 
on or off, depending on the network speed. The auto 
option turns it on or off based on the current network 
speed. If you do not know the network speed, set this 
option to Use Server Default to use the machine’s 
default. 

Use data 
compression

Instructs Vusers to compress the transferred data. To 
enable this option, select the check box to the left of the 
option; to disable it, clear the check box. You should 
enable data compression if you have a limited bandwidth 
(enabled by default).

Use disk cache for 
bitmaps

Instructs Vusers to use a local cache to store bitmaps and 
commonly-used graphical objects. To enable this option, 
select the check box to the left of the option; to disable it, 
clear the check box. You should enable this option if you 
have a limited bandwidth (disabled by default).
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Download Filter Settings

The Download Filters runtime setting lets you specify the Web sites from 
which Vusers should download resources during replay. You can indicate 
either the sites to exclude or the sites to include. You control the allowed or 
disallowed sources, by specifying a URL, host name, or host suffix name. 

User interface elements are described below:

Queue mouse 
movements and 
keystrokes

Instructs Vusers to create a queue of mouse movements 
and keystrokes, and send them as packets to the server 
less frequently. This setting reduces network traffic with 
slow connections. Enabling this option makes the session 
less responsive to keyboard and mouse movements. To 
enable this option, select the check box to the left of the 
option; to disable it, clear the check box (disabled by 
default).

Sound quality Specifies the quality of the sound: Use server default, 
Sound off, High sound quality, Medium sound quality, or 
Low sound quality. If the client machine does not have a 
16-bit Sound Blaster-compatible sound card, select Sound 
Off. With sound support enabled, you will be able to play 
sound files from published applications on your client 
machine.

UI Elements Description

Add/Remove Addresses. Enables you to add/remove 
addresses to/from the list of address list.

Include only 
addresses in list

Includes the addresses in the address list. The Vuser filters 
out resources from all Web sites except for those in the 
Include list.

Exclude addresses in 
list

Excludes the addresses in the address list. The Vuser 
downloads resources from all Web sites except for those 
specified in the list

UI Elements Description
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Type The address type: URL, Host, or Host Suffix

Data The address data. 

Note: Depending on the address type, be sure to enter 
the data as follows:

➤ URL. Enter a complete URL beginning with http:// 
or https://.

➤ Host. Enter the name of the host machine with its 
domain, such as www.hp.com.

➤ Host Suffix. The common suffix for several host 
names, such as hp.com. This is useful when you 
have several Web sites on a common domain.

UI Elements Description
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Gateway Settings

You use the Gateway link to set the WAP Gateway settings. 

User interface elements are described below:

UI Elements Description

Connection Options The connection options specify the method that the 
Vuser uses to connect to the WAP gateway.

➤ WAP Gateway. Runs the Vusers accessing a Web server 
via a WAP Gateway. 

➤ HTTP Direct. Runs the Vusers in HTTP mode, accessing 
a Web server directly. 

If you select the HTTP Direct connection mode, the 
remaining WAP Gateway options are not applicable.

Gateway Settings If the Vusers connect through a gateway, the IP, Port, and 
WAP Versions options specify the Gateway connection.

➤ IP. The IP address of the gateway.

➤ Port. The port of the gateway. When running your 
Vusers through a WAP gateway, the Vusers 
automatically use default port numbers, depending on 
the selected mode. However, you can customize the 
settings and specify a custom IP address and port for 
the gateway.

➤ WAP version. The WAP version, 1.x (WSP) or 2.0 
(HTTP proxy). If you recorded in WAP 1.x (WSP), you 
can run the Vusers in either 1.x (WSP), or 2.0 (HTTP 
proxy) mode. If you recorded in WAP 2.0 (HTTP 
proxy), then you can only run the Vusers in the same 
mode.

If you are running the script in WAP 1.x (WSP), you 
can specify several connection and advanced options.
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Advanced Gateway Options

User interface elements are described below:

Gateway Connection 
Mode

The connection mode settings apply to WAP version 1.x 
(WSP) connections. 

➤ Connection-oriented Mode. Sets the connection mode 
for the WSP session to Connection-Oriented.

➤ Connectionless Mode. Sets the connection mode for 
the WSP session to Connectionless.

➤ Enable security. Enables a secure connection to the 
WAP gateway.

Advanced Gateway 
Options

Open the Advanced option in the Gateway runtime 
settings to configure the WAP Capabilities and other 
advanced Gateway options. For details see "Advanced 
Gateway Options" below.

UI Elements Description

Confirm Push 
support

In CO mode, if a push message is received, this option 
instructs the Vuser to confirm the receipt of the message 
(disabled by default). For more information, see the HP 
Virtual User Generator User Guide.

Push support Enables push type messages across the gateway (disabled 
by default).

CAPSessionResume Enables requests for session suspend or resume.

UI Elements Description
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Acknowledge 
headers

Returns standard headers that provide information to the 
gateway.

➤ Server SDU buffer size. The largest transaction service 
data unit that may be sent to the server during the 
session.

Default: 4000

➤ Client SDU buffer size. The largest transaction service 
data unit that may be sent to the client during the 
session. 

Default: 400

➤ MethodMOR. The number of outstanding methods 
that can occur simultaneously.

➤ PushMOR. The number of outstanding push 
transactions that can occur simultaneously.

➤ BearerType. The type of bearer used as the underlying 
transport.

➤ Retrieve messages. When a push messages is received, 
this option instructs the Vuser to retrieve the message 
data from the URL indicated in the push message.

Default: Disabled

Default: Disabled

Support Cookies Provides support for saving and retrieving cookies.

Default: Disabled

WTP Segmentation 
and Reassembly

Enables segmentation and reassembly (SAR) in WTP, 
Wireless Transport Protocol. 

Default: True

➤ WTP Retransmission Time. The time in seconds that 
the WTP layer waits before resending the PDU if it did 
not receive a response. 

Default: 5000

UI Elements Description
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SAPGUI Settings

The SAPGUI runtime settings let you set the general settings for a SAPGUI 
Vuser script. Performance Center uses these settings when running the 
script.

User interface elements are described below:

WTLS Abbreviated 
Handshake

Use an abbreviated handshake instead of a full one, when 
receiving a redirect message.

Default: False

WTLS Deffie Hellman Use the Deffie Hellman encryption scheme for WTLS 
(Wireless Transport Layer Security) instead of the default 
scheme, RSA.

Default: False

➤ WTLS Deffie Hellman identifier. An identifier for the 
Deffie Hellman encryption scheme. This identifier is 
required for the abbreviated handshake with the 
Operwave gateway that uses the Deffie Hellman 
encryption scheme.

➤ Network MTU Size. The maximum size in bytes, of the 
network packet.

Default: 4096

UI Elements Description

Send status bar text Send the text from the status bar to the log file.

Send active window 
title

 Send the active window title text to the log file. 

The Performance runtime settings allow you to indicate 
whether or not to display the SAP client during replay.

Show SAP Client 
during replay

Shows an animation of the actions in the SAP client 
during replay. The benefit of displaying the user interface 
(UI) is that you can see how the forms are filled out and 
closely follow the actions of the Vuser. This option, 
however, requires additional resources and may affect the 
performance of your performance test.

UI Elements Description
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Take ActiveScreen 
snapshots during 
replay

Captures replay snapshots with the Control ID 
information for all active objects. ActiveScreen snapshots 
differ from regular ones, in that they allow you to see 
which objects were recognized by VuGen in the SAPGUI 
client. As you move your mouse across the snapshot, 
VuGen highlights the detected objects. You can then add 
new steps to the script directly from within the snapshot. 
It also allows you to add steps interactively from within 
the snapshot for a specific object. For more information, 
see the HP Virtual User Generator User Guide.

Advanced Advanced options let you set a timeout for the 
SAPfewgsvr.exe process, save a snapshot on error, and 
configure Performance Center to use SAPlogon during 
replay.

Each Vuser invokes a separate SAPfewgsvr.exe process 
during test execution. In some instances, the process 
stays active even after the replay session has ended. You 
can check the Windows Task Manager to see if the 
process is still active.

The Advanced SAPGUI settings let you set a timeout for 
this application. When the timeout is reached, 
Performance Center closes any SAPfewgsvr processes not 
previously terminated.

➤ Replay using running SAPlogon application. Instructs 
the Vusers to use the SAPlogon application that is 
currently running for replay.

➤ Set SAPfewgsvr application timeout. Allows you to 
modify the SAPfewgsvr.exe process timeout.

➤ Timeout to SAPfewgsvr. The SAPfewgsvr.exe process 
timeout in seconds. 

Default: 300 seconds 

UI Elements Description
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Java Environment Settings

For Java scripts, you provide information about the Java virtual machine 
settings in the Java VM section.

User interface elements are described below:

UI Elements Description

Use internal logic to 
locate JDK

Search the PATH, registry, and Windows folder for the 
JDK to use during replay.

Use specified JDK Use the specified JDK during replay.

Using 
Xbootclasspath 
parameters

Replays the script with the Xbootclasspath /p option.

Load each Vuser 
using dedicated class 
loader

Load each Vuser using a dedicated class loader. This will 
allow you to use a unique namespace for each Vuser and 
manage their resources separately.
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.NET Environment Settings

The .NET environment runtime settings let you specify information about 
the application, such as its base path and the location of its configuration 
file.

User interface elements are described below:

UI Elements Description

AUT Application Base 
Path

The AUT (Application Under Test) base directory from 
which DLLs are loaded during replay. By default, during 
recording, all of the necessary DLLs are stored in the 
script’s directory. Use this option to specify the location 
of any missing DLL files for the AUT. This is usually the 
installation path of the recorded application. 

Note: The AUT must be installed on the machine 
running the script. If you leave this box empty, the 
Vusers use the local script\bin directory as the 
application base directory during replay.
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AUT Configuration 
File

The file name of the recorded application’s configuration 
file. Performance Center copies the AUT configuration 
file to the script\bin directory and loads the locally saved 
file. To specify a different location, use a full path. If you 
only specify a file name, and the file is not in the 
script\bin folder, the Vusers load it from the App base 
directory.

AppDomain Per 
Vuser.

Enables execution of each Vuser in a separate app 
domain (true by default). Running Vusers in separate App 
Domains enables each Vuser to execute separately 
without sharing static variables and prevents locking 
between them.

ADO.NET providers deploy a feature called connection 
pooling which can significantly influence performance 
test accuracy. Whenever only one app domain is used for 
all Vusers, connection pooling is turned on—.NET 
Framework keeps the database connections open and 
tries to reuse them when a new connection is requested. 
Since many Vusers are executed in the context of a single 
application domain, they may interfere with one 
another. Their behavior will not be linear and that may 
decrease their accuracy. The default setting, true, 
allocates a separate connection pool for each Vuser. This 
means that there is connection pooling in the scope of 
each Vuser, but the Vusers will not interfere with one 
another. This setting provides more accuracy, but lower 
scalability.

If you disable this option, you need to manually disable 
connection pooling for the database. For more 
information, the HP Virtual User Generator User Guide.

UI Elements Description
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Preferences Settings

You use the Internet Protocol Preferences runtime Settings, to control the 
Vusers in the following areas:

➤ Image and Text Checks

➤ Generating Web Performance Graphs

➤ Advanced Web Runtime Options

➤ Additional Options for Internet Preferences

User interface elements are described below:

UI Elements Description

Checks The Enable image and text checks option allows the 
Vuser to perform verification checks during replay by 
executing the verification functions: web_find or 
web_image_check. This option only applies to test steps 
that were recorded in HTML-based mode. Vusers running 
with verification checks enabled, require additional 
memory.

Generate Web 
performance graphs

Collects data to create several Web Performance graphs: 
Hits per Second and HTTP codes, Pages per Second, and 
Response Bytes per Second. You view the graphs during 
test execution using the online monitors and after test 
execution using HP Analysis. You view the Component 
Breakdown graph after test execution using the Analysis. 
Select the types of graph data for the Vuser to collect.

Note: If you do not use the Web Performance graphs, 
disable all graphs to conserve memory.
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Advanced ➤ WinInet Replay. Instructs Vusers to use the WinInet 
replay engine instead of the standard Sockets replay. 
There are two HTTP replay engines: Sockets-based 
(default) or WinInet based. The WinInet is the engine 
used by Internet Explorer and it supports all of the 
features incorporated into the IE browser. The 
limitations of the WinInet replay engine are that it is 
not scalable, nor does it support UNIX. In addition, 
when working with threads, the WinInet engine does 
not accurately emulate the modem speed and number 
of connections.

The proprietary sockets-based replay is a lighter engine 
that is scalable for performance testing. It is also 
accurate when working with threads. The limitation of 
the sockets-based engine is that it does not support 
SOCKS proxy. If you are recording in that type of 
environment, use the WinInet replay engine.

➤ File and line in automatic transaction names. Creates 
unique transaction names for automatic transactions 
by adding file name and line number to the 
transaction name (enabled by default).

Note: This option places additional information in the 
log file, and therefore requires more memory. 

➤ Non-critical item errors as warnings. This option 
returns a warning status for a function which failed on 
an item that is not critical for performance testing, 
such as an image or Java applet that failed to 
download. This option is enabled by default. If you 
want a certain warning to be considered an error and 
fail your test, you can disable this option. You can set a 
content-type to be critical by adding it to the list of 
Non-Resources. For more information, see the HP 
Virtual User Generator User Guide.

➤ Save snapshot resources locally. Saves the snapshot 
resources to files on the local machine. This feature 
lets the runtime viewer create snapshots more 
accurately and display them quicker. 

UI Elements Description
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Advanced Options for Internet Preferences - HTTP

User interface elements are described below:

Set Advanced 
Options

Enables you to set advanced options in the following 
areas: DNS caching, HTTP version, Keep-Alive HTTP 
connections, Accept server-side compression, 
Accept-Language headers, HTTP-request connect 
timeout, HTTP-request receive timeout, Network buffer 
size, and Step download timeout. 

For more information, see the relevant "Advanced 
Options for Internet Preferences - HTTP" below.

UI Elements Description

HTTP version Specifies which version HTTP to use: version 1.0 or 1.1. 
This information is included in the HTTP request header 
whenever a Vuser sends a request to a Web server. 

Keep-Alive HTTP 
connections

Keep-alive is a term used for an HTTP extension that 
allows persistent or continuous connections. These 
long-lived HTTP sessions allow multiple requests to be 
sent over the same TCP connection. This improves the 
performance of the Web server and clients.

The keep-alive option works only with Web servers that 
support keep-alive connections. This setting specifies 
that all Vusers that run the Vuser script have keep-alive 
HTTP connections enabled.

Default: Enabled

Accept-Language 
request header

Provides a comma-separated list of accepted languages. 
For example, en-us, fr, and so on.

UI Elements Description
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HTTP errors as 
warnings

Issues a warning instead of an error upon failing to 
download resources due to an HTTP error.

➤ HTTP-request connect timeout (seconds). The time, in 
seconds, that a Vuser will wait for the connection of a 
specific HTTP request within a step before aborting. 
Timeouts provide an opportunity for the server to 
stabilize and respond to the user. 

Note: This timeout also applies to the time the Vuser 
will wait for a WAP connection, initiated by the 
wap_connect function.

➤ HTTP-request receive timeout (seconds). The time, in 
seconds, that a Vuser will wait to receive the response 
of a specific HTTP request within a step before 
aborting. Timeouts provide an opportunity for the 
server to stabilize and respond to the user.

Default: 120 seconds

➤ HTTP Keep-Alive timeout. Enter the number of 
seconds to keep idle connections open.

Request Zlib Headers Sends request data to the server with the zlib 
compression library headers. By default, requests sent to 
the server include the zlib headers. This option lets you 
emulate non-browser applications that do not include 
zlib headers in their requests. To exclude these headers, 
set this option to No.

Default: Yes

Accept Server-Side 
Compression

Indicate to the server that the replay can accept 
compressed data. The available options are: None (no 
compression), gzip (accept gzip compression), gzip, 
deflate (accept gzip or deflate compression), and deflate 
(accept deflate compression). 

Note: By accepting compressed data, you may 
significantly increase the CPU consumption. The default 
is to accept gzip, deflate compression.

UI Elements Description
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Advanced Options for Internet Preferences - General

User interface elements are described below:

UI Elements Description

DNS caching Instructs the Vuser to save a host’s IP addresses to a cache 
after resolving its value from the Domain Name Server. 
This saves time in subsequent calls to the same server. In 
situations where the IP address changes, as with certain 
load balancing techniques, be sure to disable this option 
to prevent Vusers from using the value in the cache 
(enabled by default).

Convert from/to 
UTF-8

Converts received HTML pages and submitted data from 
and to UTF-8. You enable UTF-8 support in the recording 
options. For more information, see the HP Virtual User 
Generator User Guide.

Default: No

Step timeout caused 
by resources is a 
warning

 Issues a warning instead of an error when a timeout 
occurs due to a resource that did not load within the 
timeout interval. For non-resources, Performance Center 
issues an error.

Default: Disabled

Parse HTML 
Content-Type

 When expecting HTML, parse the response only when it 
is the specified content-type: HTML, text\html, TEXT any 
text, or ANY, any content-type. 

Note: text/xml is not parsed as HTML. The default is 
TEXT. 

The timeout settings are primarily for advanced users 
who have determined that acceptable timeout values 
should be different for their environment. The default 
settings should be sufficient in most cases. If the server 
does not respond in a reasonable amount of time, check 
for other connection-related issues, rather than setting a 
very long timeout which could cause the scripts to wait 
unnecessarily.
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Step download 
timeout (sec)

The time that the Vuser will wait before aborting a step in 
the script. This option can be used to emulate a user 
behavior of not waiting for more than x seconds for a 
page.

Network buffer size Sets the maximum size of the buffer used to receive the 
HTTP response. If the size of the data is larger than the 
specified size, the server will send the data in chunks, 
increasing the overhead of the system. When running 
multiple Vusers from the Controller, every Vuser uses its 
own network buffer. This setting is primarily for 
advanced users who have determined that the network 
buffer size may affect their script’s performance.

Default: 12kB

Maximum size: 0x7FFF FFFF

Print NTLM 
information

Prints information about the NTLM handshake to the 
standard log.

Print SSL information Prints information about the SSL handshake to the 
standard log.

Max number of error 
matches issued as 
ERRORS

Limits the number of error matches issued as ERRORS for 
content checks using a LB or RB (left boundary or right 
boundary). This applies to matches where a failure occurs 
when the string is found (Fail=Found). All subsequent 
matches are listed as informational messages. 

Default: 10 matches.

Maximum number of 
META Refresh to the 
same page

The maximum number of times that a META refresh can 
be performed per page. 

Default: 2 

ContentCheck values 
in UTF-8

Store the values in the ContentCheck XML file in UTF-8.

UI Elements Description
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Advanced Options for Internet Preferences - Authentication

User interface elements are described below:

UI Elements Description

Fixed think time 
upon authentication 
retry (msec)

Automatically adds a think time to the Vuser script for 
emulating a user entering authentication information 
(username and password). This think time will be 
included in the transaction time.

Default: 0

Disable NTLM2 
session security

Uses full NTLM 2 handshake security instead of the more 
basic NTLM 2 session security response.

Default: 0

Use Windows native 
NTLM 
implementation

Use the Microsoft Security API for NTLM authentication 
instead of the indigenous one.

Enable integrated 
Authentication

Enable Kerberos-based authentication. When the server 
proposes authentication schemes, use Negotiate in 
preference to other schemes.

Default: 0

Induce heavy KDC 
load

Do not reuse credentials obtained in previous iterations. 
Enabling this setting will increase the load on the KDC 
(Key Distribution Server). To lower the load on the server, 
set this option to Yes in order to reuse the credentials 
obtained in previous iterations. This option is only 
relevant when Kerberos authentication is used.

Default: No
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Advanced Options for Internet Preferences - Log

User interface elements are described below:

Advanced Options for Internet Preferences - Web (Click and Script) 
Specific

User interface elements are described below:

UI Elements Description

Print buffer line 
length

Line length for printing request/response header/body 
and/or JavaScript source, disabling wrapping.

Print buffer escape 
only binary zeros

➤ Yes. Escape only binary zeros when printing request/
response headers/body and/or JavaScript source. 

➤ No. Escape any unprintable/control characters.

UI Elements Description

Home Page URL The URL of the home page that opens with your 
browser. 

Default: about:blank

DOM-based snapshots Generates snapshots from the DOM instead of 
from the server responses.

Default: Yes

Charset conversions by 
HTTP

Perform charset conversions by the 
‘Content-Type:....; charset=...’ HTTP response 
header. Overrides ‘Convert from /to UTF-8.’

Reparse when META 
changes charset

Reparse HTML when a META tag changes the 
charset. Effective only when Charset conversions 
by HTTP is enabled. Auto means reparsing is 
enabled only if it used in the first iteration.

Fail on JavaScript error Fails the Vuser when a JavaScript evaluation error 
occurs. ALM issues a warning message only after a 
JavaScript error, but continuing to run the script.

Default: No. 
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Initialize standard classes 
for each new window 
project

When enabled, the script—the src compiled 
script, will not be cached.

Ignore acted on element 
being disabled

Ignore the element acted on by a Vuser script 
function being disabled. 

Optimize timers at end of 
step

When possible, executes a setTimeout/setInterval/
<META refresh> that expires at the end of the step 
before the expiration time.

Default: Yes

Single setTimeout/
setInterval threshold 
(seconds)

Specifies an upper timeout for the 
window.setTimeout and window.setInterval 
methods. If the delay exceeds this timeout, these 
methods will not invoke the functions that are 
passed to them. This emulates a user waiting a 
specified time before clicking on the next 
element.

Default: 5 seconds

Accumulative setTimeout/
setInterval threshold 
(seconds)

Specifies a timeout for the window.setTimeout 
and window.setInterval methods. If the delay 
exceeds this timeout, additional calls to 
window.setTimeout and window.setInterval will 
be ignored. The timeout is accumulative per step. 

Default: 30 seconds

Reestablish setInterval at 
end of step

 0 = No; 1 = Once; 2 = Yes.

History support Enables support for the window.history object for 
the test run. The options are Enabled, Disabled, 
and Auto. The Auto option instructs Vusers to 
support the window.history object only if it was 
used in the first iteration. 

Default: Auto

Note: By disabling this option, you improve 
performance.

UI Elements Description
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Maximum history size The maximum number of steps to keep in the 
history list.

Default: 100 steps

navigator.browserLanguag
e

The browser language set in the navigator DOM 
object’s browserLanguage property. 

Default: The recorded value. 

Note: Scripts created with older recording engines, 
use en-us by default.

navigator.systemLanguage The system language set in the navigator DOM 
object’s systemLanguage property. 

Default: The recorded value. 

Note: Scripts created with older recording engines, 
use en-us by default.

navigator.userLanguage The user language set in the navigator DOM 
object’s userLanguage property.

Default: The recorded value. 

Note: Scripts created with older recording engines, 
use en-us by default.

screen.width Sets the width property of the screen DOM object 
in pixels.

Default: 1024

screen.height Sets the height property of the screen DOM object 
in pixels.

Default: 768

screen.availWidth Sets the availWidth property of the screen DOM 
object in pixels.

Default: 1024

screen.availHeight Sets the availHeight property of the screen DOM 
object in pixels.

Default: 768

UI Elements Description
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Proxy Settings

You use the Proxy runtime Settings to set the proxy-related settings. The 
following proxy options are available in the runtime settings. 

User interface elements are described below:

Default block size for DOM 
memory allocations

Sets the default block size for DOM memory 
allocations. If the value is too small, it may result 
in extra calls to malloc, slowing the execution 
times. Too large a block size, may result in an 
unnecessarily big footprint.

Default: 16384 bytes

Memory Manager for 
dynamically-created DOM 
objects

➤ Yes. Use the Memory Manager for 
dynamically-created DOM objects.

➤ No. Does not use the Memory Manager, for 
example when multiple DOM objects are 
dynamically created in the same document as 
under SAP. 

➤ Auto—Use the protocol recommended. 

Default: Yes for all protocols except for SAP

JavaScript Runtime memory 
size (KB)

Specifies the size of the JavaScript runtime 
memory in kilobytes. 

Default: 256 KB

JavaScript Stack memory 
size (KB)

Specifies the size of the JavaScript stack memory 
in kilobytes (default is 32 KB). 

Default: 32 KB

UI Elements Description

No proxy  All Vusers should use direct connections to the Internet. 
This means that the connection is made without using a 
proxy server.

Obtain the proxy 
settings from the 
default browser

All Vusers use the proxy settings of the default browser 
from the machine upon which they are running.

UI Elements Description
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Use custom proxy ➤ Use automatic configuration script. Enables you to 
specify a JavaScript file (usually with a .pac extension) 
containing proxy assignment information. This script 
tells the browser when to access a proxy server and 
when to connect directly to the site, depending on the 
URL. In addition, it can instruct the browser to use a 
specific proxy server for certain addresses and another 
server for other addresses.

Specify either a web location beginning with http://. 
For example, http://hostname/proxy.pac. 

➤ Use proxy server. Select to supply actual proxy server 
details.

➤ HTTP (Address of proxy to use). The HTTP proxy 
server’s IP address or name. 

➤ HTTP Port. The HTTP port.

➤ HTTPS (Address of proxy to use). The HTTPS proxy 
server’s IP address or name.

➤ HTTPS Port. The HTTPS port.

➤ Use same server for all protocols. Select to use same 
proxy server for all Internet protocols (HTTP, 
HTTPS) rather than specifying a specific server for 
secure sites.

Note: You can specify one proxy server for all HTTP 
sites, and another proxy server for all HTTPS (secure) 
sites.

UI Elements Description
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Radius Settings

RADIUS (Remote Authentication Dial-In User Service) is a client/server 
protocol and software that enables remote access servers to communicate 
with a central server to authenticate dial-in users. It also authorize their 
access to the requested system or service.

RADIUS allows a company to maintain user profiles in a central database 
that all remote servers can share. It provides better security, allowing a 
company to set up a policy that can be applied at a single administered 
network point. Using a central service enables you to track usage for billing 
and store network statistics.

RADIUS has two sub-protocols:

➤ Authentication. Authorizes and controls user access.

➤ Accounting. Tracks usage for billing and for keeping network statistics.

Exceptions When specifying proxy server information, you can 
specify that all Vusers use a specified proxy server. In 
such a case, if there are any URLs that you want Vusers to 
access directly, that is, without using the proxy server, 
type the list of these URLs in the Exceptions box.

➤ Do not use proxy server for addresses beginning with. 
Type the addresses you want to exclude from the 
proxy server. Use semicolons to separate entries.

➤ Do not use proxy server for local (intranet) addresses. 
Select this check box to exclude local addresses, such 
as those from an Intranet, from the proxy server.

Authentication When specifying proxy server information, if the proxy 
server requires authentication for each Vuser, use this 
dialog box to type the relevant password and user name.

➤ User Name. The user name for Vusers to access the 
proxy server.

➤ Password. The password required by Vusers to access 
the proxy server.

UI Elements Description
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For Vusers, the RADIUS protocol is supported for WSP replay for both of the 
Radius sub-protocols—authentication and accounting. You supply the 
dial-in information in the Radius runtime settings:

User interface elements are described below:

UI Elements Description

Network Type The accounting network type: GPRS (General Packet 
Radio Service) or CSD (Circuit-Switched Data).

IP Address The IP address of the Radius server.

Authentication port 
number

The authentication port of the Radius server

Accounting port 
number

The accounting port of the Radius server

Secret Key The secret key of the Radius server.

Connection Timeout 
(sec)

The time in seconds to wait for the Radius server to 
respond. 

Default: 120 seconds.

Retransmission 
retries

The number of times to retry after a failed transmission.

Default: 0

Store attributes 
returned by the 
server to parameters

Allow Vusers to save attributes returned by the server as 
parameters, which can be used at a later time. 

Default: False

Radius client IP Radius packets source IP, usually used to differentiate 
between packets transmitted on different NIC cards on a 
single load generator machine.



Chapter 28 • Script Runtime Settings

557

RTE Settings 

Terminal Emulator runtime settings allow you to configure your TE Vusers 
so that they accurately emulate real users performing remote terminal 
emulation. You can configure settings for the number of connection 
attempts, device names, typing delay, and X-System synchronization.

User interface elements are described below:

UI Elements Description

Maximum number of 
connection attempts

The TE_connect function is generated when you record a 
connection to a host. When you replay an RTE script, the 
TE_connect function connects the terminal emulator to 
the specified host. If the first attempt to connect is not 
successful, the Vuser retries a number of times to connect 
successfully. Details of each connection are recorded in 
the report file output.txt.

Enter the maximum number of times that a Vuser will try 
to connect.

Default: Vusers try to connect 5 times.

Use original device 
name

In certain environments, each session (Vuser) requires a 
unique device name. The TE_connect function generates 
a unique 8-character device name for each Vuser, and 
connects using this name. 

Select this option to connect using the device name that 
is contained within the com_string parameter of the 
TE_connect function.

The original device name setting only applies to IBM 
block-mode terminals. 

Default: Selected
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Delay before typing The delay setting determines how Vusers execute 
TE_type functions.

➤ First key (milliseconds). Specifies the amount of time 
that a Vuser waits before entering the first character in 
a string.

➤ Subsequent key (milliseconds). Specifies the amount 
of time that a Vuser waits between submitting 
successive characters.

Note: If you type zero for both the first key and the 
subsequent key delays, the Vuser will send characters as a 
single string, with no delay between characters.

You can use the TE_typing_style function to override the 
Delay settings for a portion of a Vuser script. 

X-System 
synchronization

RTE Vuser scripts use the TE_wait_sync function for 
synchronization. You can set a timeout value and a 
stable-time value that applies to all TE_wait_sync 
functions. 

➤ Timeout (seconds). When you replay a TE_wait_sync 
function, if the system does not stabilize before the 
synchronization timeout expires, the TE_wait_sync 
function returns an error code. 

To set the synchronization timeout, type a value (in 
seconds).

Default: 60 seconds

➤ Stable time (milliseconds). After a Vuser executes a 
TE_wait_sync function, the Vuser waits until the 
terminal is no longer in the X-SYSTEM mode. After the 
terminal returns from the X-SYSTEM mode, the Vuser 
still monitors the system for a short time. This makes 
sure that the terminal has become stable, that is, that 
the system has not returned to the X-SYSTEM mode. 
Only then does the TE_wait_sync function terminate. 

To set the time that a Vuser continues to monitor the 
system after the system has returned from the 
X-SYSTEM mode, type a value (in milliseconds).

Default: 1000 milliseconds.

UI Elements Description
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Server and Protocol Settings

The following section describes the runtime settings specific to MMS 
(Multimedia Messaging Service) Vusers. These runtime setting allow you to 
configure the Server and Protocol settings.

User interface elements are described below:

Speed Simulation Settings

The Speed Simulation setting lets you emulate your network connection.

Using these settings, you select a bandwidth that best emulates the 
environment under test.

UI Elements Description

MMSC URL The URL of the MMSC (Multimedia Messaging Center) 
server.

MMS Version The version of the MMS protocol used by the script.

Timeout (seconds) The time that the server waits for incoming messages.

Default: 60 seconds.

SMSC IP The IP address of the SMSC server used for sending MMS 
notifications over SMPP.

SMSC Port The IP port of the SMSC server used for sending MMS 
notifications over SMPP.

Automatic WAP 
Connections

Defines when to connect and disconnect from a WAP 
gateway. This setting is only relevant when a WAP 
gateway is used. The possible values are: 

➤ Per Iteration. Connect at the beginning of each 
iteration and disconnect at the end of each iteration.

➤ Per Send or Receive. Connect and disconnect at the 
beginning and end of each message.

➤ None. Do not use automatic WAP connections.

Default: Per Iteration

Default Sender 
address

The default address sent in the Sender header. 

Default: +999999
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User interface elements are described below:

Timing Settings

The Citrix Timing runtime settings relate to the connect and waiting 
timeouts. These settings apply to the entire script. To set the waiting time 
for a specific section of the script, use the Set Waiting Time step in the Vuser 
script. The new waiting time applies from the point of insertion until the 
end of the script or the next Set Waiting Time step.

User interface elements are described below:

UI Elements Description

Use maximum 
bandwidth

By default, bandwidth emulation is disabled and the 
Vusers run at the maximum bandwidth that is available 
over the network.

Use bandwidth Indicate a specific bandwidth level for your Vuser to 
emulate. You can select a speed ranging from 14.4 to 512 
Kbps, emulating analog modems, ISDN, or DSL.

Use custom 
bandwidth

Indicate a bandwidth limit for your Vuser to emulate. 
Specify the bandwidth in bits, where 1 Kilobit=1024 bits.

UI Elements Description

Connect time The time in seconds to wait idly at an established 
connection before exiting.

Default: 180 seconds

Waiting time The time in seconds to wait idly at a synchorinization 
point before exiting.

Default: 60 seconds.

Typing rate The delay in milliseconds between keystrokes.
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29
Personalizing Performance Center

This chapter includes:

Concepts

➤ My Performance Center Overview on page 564

Tasks

➤ How to Work with My Performance Center on page 565

Reference

➤ My Performance Center User Interface on page 567
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Concepts

My Performance Center Overview 

My Performance Center provides an interface specifically designed for 
facilitating execution of day-to-day performance testing activities. It allows 
you to create a personalized view of performance testing features. You can 
edit tests and test assets, as well as run and track test runs using 
My Performance Center.

For information about how to use My Performance Center, see "How to 
Work with My Performance Center" on page 565.
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Tasks

How to Work with My Performance Center

This task describes the main performance testing actions that can be 
performed from within My Performance Center.

Note: To view a movie that demonstrates how use My Performance Center, 
select Help > Product Feature Movies in the ALM main window. Under 
HP ALM Performance Center 11.00 Movies, select My Performance Center.

To learn more about My Performance Center, see "My Performance Center 
Overview" on page 564.

➤ "Join a running performance test" on page 565

➤ "Run a performance test" on page 566

➤ "View and download performance test results" on page 566

Join a running performance test

 1 Select Perspectives > Performance Tests.

 2 In the Test Runs view, identify the currently running test you want to 
join. Currently running tests display the Running state and the run name 
appears as a link.

Tip: To view all currently running tests, add the Currently Running Tests 
view to a User Perspective.
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 3 Click the run name to join the test. The Performance Test Run page 
opens, enabling you to view and manage the test. For user interface 
details, see "Performance Test Run Page" on page 358.

Run a performance test

 1 Select Perspectives > Performance Tests.

 2 In the Performance Test Set view, select an instance of the test you want 
to run, and click Run Test. The Select Timeslot dialog box opens, enabling 
you to select a timeslot for the test run. For user interface details, see 
"Select Timeslot Dialog Box" on page 372.

 3 Select an available timeslot and click Run. The Initializing Run page 
opens. The Initializing Run page displays the performance test 
initialization steps performed by ALM Performance Center, and the status 
for each step. If each step is completed successfully, the performance test 
starts running and the Performance Test Run page opens. For user 
interface details, see "Initializing Run Page" on page 348.

View and download performance test results

 1 Select Perspectives > Performance Test.

 2 In the Test Runs view, select the completed test run whose results you 
want to view. The results are displayed in the Test Run Results view.

 3 To download result files, click Download.
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Reference

My Performance Center User Interface 

This section includes:

 ➤ My Performance Center Window on page 568

 ➤ My Performance Center Views on page 571
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My Performance Center Window

This section describes the My Performance Center window.

 



Chapter 29 • Personalizing Performance Center

569

User interface elements are described below:

To access 1  In your web browser, enter the Performance Center 
Server URL in the following format:

http://<server name>/loadtest

2  Log in to your domain and project with your ALM 
credentials.

Important 
information

➤ If more than one Performance Center Server is 
installed in your system together with a load balancer, 
you should access My Performance Center by entering 
the load balancer’s URL. Alternatively, you can also 
enter the server’s defined internal URL.

➤ You must have the relevant permissions in order to 
login to My Performance Center. For more 
information, see the HP Application Lifecycle 
Management Administrator Guide.

Relevant tasks "How to Work with My Performance Center" on page 565

UI Elements (A-Z) Description

Edit Layout. Enables you to drag and drop views. 

Refresh. Refreshes the current display.

Download Applications. Opens the Download 
Applications window, enabling you to download 
standalone applications needed for working with ALM 
Performance Center.

Open Menu. Opens a menu that contains the following 
options for managing the view:

➤  Select Columns. Enables you to select which 
columns to display in the view.

➤  Refresh this View. Refreshes the information 
displayed in the view.

➤  Remove this View. Removes the view. 
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Show in Normal/Maximized View. Alternates the view 
between normal and maximized. 

Minimizes or restores the view.

Perspectives ➤ System Perspectives. Enables you to select a 
predefined groups of views. The group of views are:

➤ Project Activity. Displays views related to project 
activity.

➤ Performance Tests. Displays views related to 
managing performance tests.

➤ Test Resources. Displays views related to managing 
test resources.

➤ Trending. Enables you to view performance 
trending information.

➤ Lab Resources. Displays views relating to managing 
lab resources.

➤ Error Handling. Displays views related to managing 
test errors.

➤ Community. Provides views that enable easy access 
to Performance Center RSS feeds, links to relevant 
groups and forums, and the product’s Web site.

➤ User Perspectives. Enables you create a personalized 
group of views to suit your specific testing needs.

Views Contains a list of the available views. For information 
about the available views, see "My Performance Center 
Views" on page 571.

UI Elements (A-Z) Description
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My Performance Center Views

This section describes the views that are available in My Performance 
Center.

User interface elements are described below:

To access In My Performance Center, select Views.

Important 
information

When a System Perspective is selected, the Views list is 
set to Read Only, and a check mark in the relevant check 
box identifies which views are included in the currently 
selected perspective. 

When creating a User Perspective, you use the check 
boxes to select which views to include in your 
perspective.

UI Elements (A-Z) Description

AUT Hosts Enables you to view and manage AUT hosts For more 
information about AUT Hosts, see "AUT Host 
Management" on page 861.

Appears in System Perspective: Lab Resources

Currently Running 
Tasks

Enables you to keep track of currently running tasks in 
the system.

Appears in System Perspectives: Project Activity, Error 
Handling

Event Log Displays aa list of events generated for a specific test run 
selected in the Test Runs view. For more information 
about the Event Log, see "Initializing Run Page" on 
page 348.

Appears in System Perspective: Error Handling

System Perspective filter. Filter by date

User Perspective filters. Filter by date, Filter by Related 
Test Runs
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Last Modified 
Entities

Enables you to keep track of changes to performance 
testing entities.

Appears in System Perspective: Project Activity

Monitor Profiles Enables you to create and manage existing monitor 
profiles. For more information about monitor profiles, 
see "Monitor Profiles" on page 73.

Appears in System Perspective: Test Resources

System Perspective filter. Filter by date

User Perspective filters. Filter by date, Filter by Related 
Test Set

Performance Center 
Hosts

Enables you to view and manage Performance Center 
hosts. For more information about hosts, see "Lab 
Resource Management" on page 671.

Appears in System Perspectives: Lab Resources Error 
Handling

Performance Test Set Enables you to view and edit selected test instances 
within test sets. You can create, edit, rename, and remove 
test instances. You can also run tests directly from this 
view. For more details about working with test sets, see 
HP Application Lifecycle Management User Guide: .

Appears in System Perspective: Performance Tests

Performance 
Trending

Enables you to create trend reports in order to identify 
performance improvements and regressions. For more 
information about trending, see "Trending" on page 575.

UI Elements (A-Z) Description
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Test Run Results Displays result information for a test run selected in the 
Test Runs view. 

➤ For information on viewing test runs and test run 
results, see HP Application Lifecycle Management User 
Guide.

➤ For information on managing test run results, see 
"Results/Last Run Results Tab" on page 354.

Appears in System Perspective: Performance Tests

System Perspective filter. Filter by date

User Perspective filter. Filter by date

Test Runs Enables you to view and manage results for individual 
test runs. 

➤ For more information on viewing test runs and test 
run results, see HP Application Lifecycle Management 
User Guide.

➤ For information on managing test run results, see 
"Results/Last Run Results Tab" on page 354.

Appears in System Perspectives: Project Activity, 
Performance Tests, Error Handling

System Perspective filter. Filter by date

User Perspective filters. Filter by date, Filter by Related 
Test Set

Timeslots Enables you to view reserved timeslots for the project. For 
more information on timeslots, see "Reserving Timeslots" 
on page 95.

Appears in System Perspectives: Project Activity, 
Performance tests, Lab Resources, Error Handling

System Perspective filter. Filter by date

User Perspective filter. Filter by date

UI Elements (A-Z) Description



Chapter 29 • Personalizing Performance Center

574

Topologies Displays details about topologies defined in the system. 
For more information on topologies, see "Topologies" on 
page 45.

Appears in System Perspective: Test Resources

System Perspective filter. Filter by date

User Perspective filters. Filter by date, Filter by Related 
Test Set

Topology Preview Displays a preview of the topology defined in a 
performance test selected in the Performance Test Sets 
view. For more information on topologies, see 
"Topologies" on page 45.

VuGen Scripts Enables you to view and upload VuGen scripts to ALM. 
For more information on managing scripts, see "VuGen 
Script Management" on page 37.

Appears in System Perspective: Test Resources 

System Perspective filter. Filter by date

User Perspective filter. Filter by date, Filter by Related 
Test Set

UI Elements (A-Z) Description
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Trending 

This chapter includes:

Concepts

➤ Trend Reports Overview on page 576

Reference

➤ Trend by Quality Attributes Template - Trended Measurements 
on page 582

➤ Measurement Acronyms on page 583

➤ Trend Reports User Interface on page 585
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Concepts

Trend Reports Overview 

The ALM Performance Center trend reports allow you to compare 
performance test run data over time, thereby giving you better visibility and 
control of your application’s performance.

By comparing the same measurement in more than one instance of a test 
run, you can identify whether its performance trend is improving or 
regressing.

For example, if you were interested in the performance trend of the 
transaction response time measurement, the trend report clearly displays 
whether over several instances of a test run, this value has increased or 
decreased from one run to another - a performance regression or 
improvement respectively.

This section also includes:

➤ "Comparison Methods" on page 577

➤ "Trend Thresholds" on page 579

➤ "Custom Measurement Mapping" on page 580
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Comparison Methods
There are two methods of comparing measurements contained in a 
performance test run for the purposes of identifying performance trends: 
Compare to Baseline and Compare to Previous.

It is important to understand the difference between the two comparison 
methods. The following example will illustrate how the same data can yield 
different results depending on the method you select.

Comparison Method Description

Compare to Baseline You select one performance test run in the trend 
report and define it as the baseline. All 
measurements in the report are then compared to 
the measurements contained in the baseline.

Compare to Previous All measurements in a performance test are 
compared to the measurements in the performance 
test run that immediately precedes it in the report.
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As shown in the image below, the average Transaction Response Time 
measurement is being trended from four performance test runs: 3, 4, 
5, and 6.

Performance test run (PT) 3 has been defined as the baseline (as indicated by 
the word Base in parentheses). The average transaction response times 
contained in the other performance test runs are compared to PT 3 only.

In PT 3, the average transaction response time for TRX_01 was 2.045. The 
average transaction response time for the same transaction in PT 5 was 
2.035, which represents a slightly faster response time and therefore a slight 
improvement in the performance of this measurement. The percentage 
difference between the two figures is displayed in brackets, in this case 
-0.49%.

However, if the Compare to Previous comparison method was selected, then 
the average transaction response time in PT 5 would be compared not to 
PT 3, but rather to PT 4 (since 4 precedes it in the table). The value for PT 4 
is 4.073 while for PT 5 it’s 2.035, a percentage difference of -50.04%.
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Using exactly the same data, the two comparison methods have yielded very 
different results. Only a slight improvement with the Compare to Baseline 
method (-0.49%), while a more significant improvement with the Compare 
to Previous method (-50.04%).

Trend Thresholds
To identify significant improvements or regressions in performance, you can 
define unique thresholds to track differentials between measurement being 
compared. If a differential exceeds a defined threshold, that value appears in 
a predetermined color, identifying it as an improvement, minor regression, 
or major regression.

For example, if you define an improvement threshold for comparing 
transaction response times as 50%, then any transaction response time that 
is 50% lower than that of the baseline or previous run (depending on the 
comparison method) will appear in the color you defined for improvements.

In the example below, the following performance thresholds for the 
transaction response time (TRT) measurement have been defined:

➤ Improvement. At least 90% decrease

➤ Major Regression. At least 50% increase

These threshold definitions mean that any performance improvements or 
regressions which exceeds these percentages will be displayed in color, 
making them more identifiable. 

In the following table, the Compare to Previous comparison method is used.
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In the table above, we see that the value of the TRT measurement for the 
Action_Transaction in performance test run 4 is 46900% higher than in 
performance test run 3 - a performance regression which far exceeds the 
defined threshold for major regressions. Therefore, the value appears in red, 
the default color for major regressions. 

The corresponding value for performance test run 5 represents a 100% 
improvement on performance test run 4. Since this percentage exceeds the 
defined threshold for improvements, the value appears in green, the default 
color for improvements.

Custom Measurement Mapping
The Custom Measurement Mapping feature allows you to reconcile 
inconsistent transaction or monitor names between performance test runs, 
thereby allowing you to properly trend these measurements. 

The following are two examples of when you would use the Custom 
Measurement Mapping feature:

➤ Inconsistent transaction name

You run a performance test that contains the transaction BuyBook. A 
while later you run the performance test again. However, in the time 
between the two performance test runs, the transaction name has been 
changed to TRX_01_BuyBook. 

As a result of this inconsistent naming, you cannot obtain any trending 
information for this measurement, as Performance Center cannot 
recognize that the two transactions are actually the same, and compare 
them for trending purposes. 

To overcome this problem, you map the two measurements (BuyBook and 
TRX_01_BuyBook) to a new third measurement which you create, for 
example Buy_Book_mapped. You add this new user-defined measurement 
to the trend report. Performance Center can then compare two instances 
of the Buy_Book_mapped transaction and give you meaningful trending 
information.
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You can give the new transaction the same name as one of the current 
transactions. Additionally, you can configure the mapping so that all 
future instances of the transaction are automatically mapped to the new 
transaction name.

➤ Inconsistent monitor name

You want to compare your application’s performance on different 
operating systems or when running against different Web/application 
servers. 

You run the performance test once on a Windows platform, and then 
again on a UNIX platform. You then want to compare the CPU utilization 
between the two runs. However, each platform provides for a different 
name for this measurement, for example, % Processor Time 
(Processor_Total) in Windows and CPU Utilization in UNIX. 

Performance Center cannot successfully obtain trending information for 
this measurement because the measurement names are different.

To overcome this problem, you map the two measurements 
(% Processor Time (Processor_Total) and CPU Utilization) to a third 
measurement which you create, for example CPU_mapped. You then add 
this new user-defined measurement to the trend report. Performance 
Center can then compare the two instances of the CPU_mapped 
transaction and give you meaningful trending information. 

You can give the new monitor the same name as one of the current 
monitors. Additionally, you can configure the mapping so that all future 
instances of the monitor are automatically mapped to the new monitor 
name.
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Reference

Trend by Quality Attributes Template - Trended 
Measurements

The following table shows which measurements are trended, and by which 
quality attribute the information is displayed when the Trend by Quality 
Attributes template is selected:

Quality Attribute Trended Measurement

Performance Transaction Response Time (compared to baseline). 
For more information on comparison methods, see 
"Comparison Methods" on page 577.

System Performance CPU utilization

Disk utilization

Available memory

Availability Transaction Summary (compared to baseline). For 
more information on comparison methods, see 
"Comparison Methods" on page 577.

Repeatability Transaction Percentiles (compared to baseline). For 
more information on comparison methods, see 
"Comparison Methods" on page 577.

Stability Errors Statistics

Transaction Failures
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Measurement Acronyms

The following table lists all the measurement acronyms that might be used 
in the trend report:

Data Type Full Name Initials

Vusers Running Vusers VU

Errors Errors ERR

Transactions Transaction 
Response Time

TRT

Transaction Per 
Second

TPS

Transaction 
Summary

TRS

Web Resources Hits per Second

Throughput

Connections

WEB

User defined data 
points

User Defined Data 
Points

UDP

System Resources Windows 
Resources

WIN

UNIX Resources UNX

Server Resources SRVR

SNMP SNMP

SiteScope SiS

Firewalls CheckPoint 
Firewall 1

FW

Web Server 
Resources

Apache APA

MS IIS IIS

iPlanet PLA
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Web Application 
Server Resources

Ariba ARI

ATG Dynamo ATG

BroadVision BDV

ColdFusion CFU

MS ASP ASP

Oracle Application 
Server

OAS

SilverStream SST

Weblogic WL

Websphere WS

Database Server 
Resources

DB2 DB2

Oracle ORA

MS SQL SQL

Sybase SYB

ERP/CRM Server 
Resources

SAP SAP

SAP Portal SAPP

SAP CCMS CCMS

SAP GUI SAPU

Siebel Web Server SIEB

Siebel Server 
Manager

SIEB

PeopleSoft PSFT

J2EE Server Request J2EE

.NET Server Request NET

Additional 
Components

COM+ COM

.NET NET

Data Type Full Name Initials
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Trend Reports User Interface 

This section includes:

 ➤ Performance Trending Page on page 586

 ➤ Create New Trend Report Page on page 588

 ➤ <Report Name> Trend Report on page 590

 ➤ Select Columns Dialog Box on page 602

 ➤ Select Test Runs to Trend Report Dialog Box on page 606

 ➤ Threshold Settings Dialog Box on page 609

 ➤ Custom Measurement Mapping Dialog Box on page 611

 ➤ Add Trend Views to Tab Dialog Box on page 613

 ➤ Measurements Configuration Dialog Box on page 615

Application 
Deployment 
Solution

Citrix MetaFrame 
XP

CTRX

Middleware 
Performance

TUXEDO 
Resources

TUX

IBM WebSphere 
MQ

MQ

Application Traffic 
Measurement

F5 BIG-IP F5

Data Type Full Name Initials
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Performance Trending Page 

This page enables you to manage trend reports. It displays a list of available 
reports, and enables you to create new reports, and to delete or duplicate 
existing reports.

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Use one of the following:

➤ On the ALM sidebar, under Testing, select Test Lab. 
Select the Test Runs tab, and on the toolbar, click the 
Performance Trending button .

➤ In My Performance Center, select Perspective > 
Trending. For more information, see "Personalizing 
Performance Center" on page 563.

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

<My Performance 
Center common UI 
elements>

For My PC menus and buttons, see "My Performance 
Center Window" on page 568.

Opens the Trend Report creation page, which enables 
you to create trend reports.

Creates a duplicate of the selected report.



Chapter 30 • Trending

587

Enables you to edit the report details.

<Performance 
Trending table>

Displays a list of all available trend reports.

Description A description of the report.

Last Modified The date on which the report was last modified.

Responsible The user who created the report

Report Name The name of the report.

Runs The number of trended runs contained in the report.

UI Elements (A-Z) Description
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Create New Trend Report Page 

This page enables you to create trend reports.

 

General Details Pane

User interface elements are described below:

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, click the New 
Trend Report button .

Relevant tasks "How to Manage a Performance Test Run" on page 340

UI Elements (A-Z) Description

Name The name of the report.

Description A description of the report.



Chapter 30 • Trending

589

Contents and Layouts Pane

User interface elements are described below:

UI Elements (A-Z) Description

Description A description of the selected template.

Transaction Trends 
template

Provides trend views that display trending information 
for the following measurements:

➤ Transaction Response Time

➤ Transaction Pass/Fail Summary

➤ Transactions per Second

Transactions and 
Monitors Trends 
template

Provides trend views that display trending information 
for the following measurements:

➤ Transaction Response Time

➤ Transaction Summary

➤ System Resources (specifically: CPU utilization, Disk 
utilization, and Available memory

Trend by Quality 
Attributes template

Provides trend views that display trending information 
from the point of view of quality attributes. For a table 
which displays which measurements are trended and by 
which quality attribute, see "Trend by Quality Attributes 
Template - Trended Measurements" on page 582. 

User Defined 
template

This template provides only the basic layout for the 
report with no further predefined tab or trend view 
configuration.
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<Report Name> Trend Report 

This page enables you to manage the test runs that are included in the 
report, as well as to manage the trend views which display the trending 
information.

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, in the Trend 
Reports grid, click the name of the report to open. The 
report opens as an additional tab on the My 
Performance Center Dashboard.

UI Elements (A-Z) Description

Exports the report to PDF format.

Enables you to drag and drop trend views within a trend 
view tab.

Enables you to view tabs that are not currently displayed.

Note: A maximum of five tabs can be displayed at one 
time.
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Trend Overview Tab
The Trend Overview tab is used for managing the information contained in 
the trend report. 

Refreshes the information contained in the report.

Add a New Tab. Adds a new tab to the report.

<Trend Views> Trend views are display items that present trending 
information, and are contained within the <trend view 
tabs>. For more information, see "Trend Views" on 
page 596.

<Trend View tabs> The <trend view tabs> contain the trend views and are 
defined by the template on which the report is based. For 
more information, see "Trend View Tabs" on page 595.

Trend Overview tab The Trend Overview tab displays the test runs trended in 
the report, and provides options for managing the test 
runs. For more information, see "Trend Overview Tab" on 
page 591.

To access The Trend Overview tab is displayed by default when you 
access a <report name> Trend Report.

Important 
information

The Trend Overview tab is common to all trend reports, 
irrespective of which template is selected.

See also "<Report Name> Trend Report" on page 590

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

 Add runs to trend report. Opens the Select Test Runs to 
Trend Report dialog box. For user interface details, see 
"Select Test Runs to Trend Report Dialog Box" on 
page 606. 

Remove run from trend report. Remove test runs from 
the trend report.

Set run as baseline. Sets the selected test run as the 
baseline run for comparing test runs. For more 
information on comparison methods, see "Comparison 
Methods" on page 577.

Note: The first run which is added to the report is 
automatically defined as the baseline.

Move Run Up/Down. Moves the selected test run up or 
down in the run order. Changing the position of the test 
run may have an effect on the comparison value when 
the Compare to previous method is selected. For more 
information on comparison methods, see "Comparison 
Methods" on page 577.

Customize Table Columns. Customizes which columns 
appear in the Trended Runs table. For user interface 
details, see "Select Columns Dialog Box" on page 602.

Set Threshold. Opens the Threshold Settings dialog box, 
which enables you to define the thresholds to be used for 
identifying performance improvements and regressions. 
For user interface details, see "Threshold Settings Dialog 
Box" on page 609. 

Customize Measurement Mapping. Opens the Custom 
Measurement Mapping dialog box, which enables you to 
define and customize mapped measurements. For user 
interface details, see "Custom Measurement Mapping 
Dialog Box" on page 611. 



Chapter 30 • Trending

593

<Trended runs table> Displays information for all trended test runs in the 
report. It is divided into three section, General Details, 
Workload Characteristics, and Performance Overview.

General Details Columns in this section display general information 
relating to the test run. 

For a list of the available fields under this section see 
Customize Table Columns above.

Performance 
Overview

Columns in this section contain information relating to 
the overall performance of your application. 

The purpose of this section is to provide you with basic 
overview trending information without having to open a 
trend view. The basic trend information is shown by 
upward or downward arrows that indicate performance 
improvements or regressions with regards the baseline 
only. For more information on comparison methods, see 
"Comparison Methods" on page 577.

For a list of the available fields under this section see 
Customize Table Columns above.

UI Elements (A-Z) Description
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Run Information 
pane

Displays details for the selected test run. The following 
information is displayed: 

➤ Performance Test Set. The test set from which the test 
was run.

➤ Test. The name of the test.

➤ Comments. Comments about the test run.

➤ Run Date. The date of the test run.

➤ State. The publish state of the run. Either Trended or 
Not Trended. If Not Trended, then the reason for this 
error appears in this field. A link appears to republish 
the run after you have fixed the error.

Workload 
Characteristics

Columns in this section are intended to display enough 
information in order for you to identify whether the test 
runs are similar enough in terms of workload, and 
therefore suitable for trending.

The values displayed in this section are relevant only for 
the selected time range. Changing the selected time 
range will likely lead to different results. For more 
information on the Define Time Range filter, see "Select 
Test Runs to Trend Report Dialog Box" on page 606.

For a list of the available fields under this section see 
Customize Table Columns above.

UI Elements (A-Z) Description
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Trend View Tabs
A report tab can contain any number of trend views. The tabs are defined by 
the template on which the report is based, and which sets the name of the 
tab and automatically includes trend views that are related to it’s name.

User interface elements are described below:

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, in the Trend 
Reports grid, click the name of the report to open. The 
report opens as an additional tab on the My 
Performance Center Dashboard. The trend view tabs 
are displayed by default.

Important 
information

The trend view tabs which appear by default depend on 
which template the report is based on.

See also "<Report Name> Trend Report" on page 590

UI Elements (A-Z) Description

<tab management 
menu>

Right-click a tab name to open the tab management 
menu, which contains the following options:

➤  Add View to Tab. Opens the Add Trend Views to 
Tab dialog box. For user interface details, see "Add 
Trend Views to Tab Dialog Box" on page 613.

➤  Edit Tab Title. Enables you to change the name of 
the tab.

➤  Move Tab Left. Moves the tab left in the tab order.

➤  Move Tab Right. Moves the tab right in the tab 
order.

➤  Delete This Tab. Deletes the tab and all of the 
trend views contained in it, from the report.

<Trend view> A display item that presents trending information. For 
more information, see "Trend Views" on page 596.
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Trend Views
A trend view is a display item that presents trending information for a 
particular performance metric, for example, transaction response time.

Edit Trend View Menu

This menu contains options that enable you to edit the trend view’s display 
and comparison settings.

User interface elements are described below:

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, in the Trend 
Reports grid, click the name of the report to open. The 
report opens as an additional tab on the My 
Performance Center Dashboard. The trend view tabs 
are displayed by default.

Trend Views are contained within the trend view tabs. 
The trend view tabs are displayed by default.

See also "<Report Name> Trend Report" on page 590

To access On the trend view, click the Open edit menu button . 

UI Elements (A-Z) Description

3D Mode (stacked 
bar chart view only)

Enables you to view the chart in 3D.

Color Trends (table 
view only)

Activates the trend report’s threshold settings. For more 
information about thresholds, see "Trend Thresholds" on 
page 579.

Compare to 
baseline/previous 
(table view only)

Enables you to change the comparison method displayed 
in the trend view. For more information on comparison 
methods, see "Comparison Methods" on page 577.

Delete Trend View Deletes the trend view.
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Do not show 
difference (table 
view only)

Enables you to hide value differentials between test runs. 
It is recommended to use this setting when exporting the 
report to a CSV format.

Edit Display Setting Enables you to change the appearance of the trend view. 
The available settings are:

➤ Table view. This view is best suited for displaying 
comparisons between measurements. You can view 
threshold settings in this view only. For more 
information, see "Display Setting: Table" below.

➤ Line graph view. This view is best suited for displaying 
trending information graphically over a timeline. For 
more information, see "Display Setting: Line Graph" 
below.

➤ Stacked bar chart view. This view displays trending 
information graphically over a timeline. It is best 
suited for trending a small number of multiple 
measurements. For more information, see "Display 
Setting: Stacked" below.

Edit Trend View Title Enables you to edit the trend view title.

Export to CSV (table 
view only)

Enables you to export the report to a CSV format.

Select Measurements Opens the Measurements Configuration dialog box, 
which enables you to add measurement to the trend 
view. For user interface details, see "Measurements 
Configuration Dialog Box" on page 615.

Show difference as 
value/percentage 
(table view only)

Enables you to define how to display value differentials 
between test runs in the trend view - as values or as 
percentages.

Show Values (stacked 
bar chart view only)

Enables you to view the measurement values on the 
actual bar columns.

UI Elements (A-Z) Description
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Display Setting: Table

This section explains the Table trend view display setting.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  On the trend view, click the Edit Menu button . 

2  Select Edit Display Setting.

3  In the Edit Display Setting dialog box, select Table.

Important 
information

You can view threshold settings in table view only.

UI Elements (A-Z) Description

<Measurement value 
name>

The name of the measurement value being trended, for 
example, minimum, maximum, average, and so on. 

<Measurement 
value>

The actual value of the measurement being trended, and 
it’s comparison value, displayed per test run. For more 
information about comparison methods, see "Trend 
Reports Overview" on page 576.

Name The name of the measurement being compared.

Type The type of measurement being compared.
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Display Setting: Line Graph

This section explains the Line Graph trend view display setting.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  On the trend view, click the Edit Menu button . 

2  Select Edit Display Setting.

3  In the Edit Display Setting dialog box, select Line.

Important 
information

➤ When you hold the cursor over the line graph, a 
tooltip appears displaying the exact amount of units 
for that measurement, correct to the nearest test run 
on the timeline. In other words, if you hold the cursor 
near the left point of the line graph, you see the value 
of the first test run.

➤ When you click a section in the line graph/
measurement in the legend, it becomes highlighted, as 
does the corresponding section in the legend/line 
graph.

UI Elements (A-Z) Description

<graph slope> The upward or downward slope of the line represents an 
upward or downward change in the measurement’s unit. 
For example, a higher transaction response time (which 
is a performance regression), or a higher transactions per 
second value (which is a performance improvement).

<x-axis> Lists the test runs according to their run date.

<y-axis> The relevant unit of measurement.

Example: For the Transaction Response Time 
measurement, the y-axis values represent seconds, while 
for the transactions per second measurement, the values 
represent the number of transactions.

B Displays the measurement in bold.
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C Displays the color of the measurement as it appears in 
the graph. Click the colored square in the column to 
select a different color for the measurement.

Function Displays the value of the measurement being trended.

Name The name of the measurement.

Scale Indicates the scale of the measurement. When viewing 
information in the line graph view, you can adjust the 
scale of any measurement to make comparing 
measurements more meaningful.

To change the scale of a measurement, click the value in 
the column and select the desired scale from the Set Scale 
box that opens. You can also apply the selected scale to 
all the measurements in the graph.

Type Contains an acronym that identifies the measurement 
type. For a full list of available acronyms, see 
"Measurement Acronyms" on page 583.

V Determines whether the measurement is visible. All 
measurements are displayed by default. Clear the check 
box to hide a measurement.

UI Elements (A-Z) Description
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Display Setting: Stacked

This section explains the Stacked Bar Chart trend view display setting.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  On the trend view, click the Edit Menu button . 

2  Select Edit Display Setting.

3  In the Edit Display Setting dialog box, select Stacked.

Important 
information

➤ If different values are selected for the same 
measurement (for example, Maximum and Average 
transaction response times), then the measurements 
appear as stacked bars. That is, the values appear above 
each other for the bar that represents the transaction 
response time measurement for a specific test run.

➤ When you hold the cursor over a bar, a tooltip appears 
which displays the exact number of units for that 
measurement, correct for that test run.

➤ When you click a section in the bar chart/
measurement in the legend, it becomes highlighted, as 
does the corresponding section in the legend/bar 
chart.

UI Elements (A-Z) Description

<bar height> The height of the bar represents the change in the 
measurement’s unit. For example, a higher transaction 
response time, which represents a performance 
regression, or a higher transactions per second value, 
which represents a performance improvement.

<x-axis> Lists the test runs according to their run date.

<y-axis> The relevant unit of measurement.

Example: For the Transaction Response Time 
measurement, the y-axis values represent seconds, while 
for the transactions per second measurement, the values 
represent the number of transactions.
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Select Columns Dialog Box 

This dialog box enables you to select columns to be displayed in the 
<report name> Trend Report’s Trend Overview tab.

C Displays the color of the measurement as it appears in 
the graph. Click the colored square in the column to 
select a different color for the measurement.

Function Displays the value of the measurement being trended.

Name The name of the measurement.

Scale Indicates the scale of the measurement. When viewing 
information in the line graph view, you can adjust the 
scale of any measurement to make comparing 
measurements more meaningful.

To change the scale of a measurement, click the value in 
the column and select the desired scale from the Set Scale 
box that opens. You can also apply the selected scale to 
all the measurements in the graph.

Type Contains an acronym that identifies the measurement 
type. For a full list of available acronyms, see 
"Measurement Acronyms" on page 583.

V Determines whether the measurement is visible. All 
measurements are displayed by default. Clear the check 
box to hide a measurement.

To access On the <report name> Trend Report, select the Trend 
Overview tab, and click the Customize table columns 
button . 

Important 
information

Due to space limitations, the names of the columns in 
the Trend Overview tab may differ from how they appear 
in this dialog box. In these cases, column names as they 
appear in the Trend Overview tab appear in parentheses.

See also "<Report Name> Trend Report" on page 590

UI Elements (A-Z) Description
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Select Columns for ’General Details’ Section

User interface elements are described below:

UI Elements (A-Z) Description

 Test Name ( Test) The name of the test. 

Project Name 
(Project)

The name of the project in which the test was run.

Publish State (State) Indicates whether the test run was successfully added to 
the report or not, either trended or not trended 
respectively. A test run that was not successfully added 
appears in red and a tooltip displays the reason. 

Note: Displayed by default.

Run By The name of the user who ran the test. 

Note: Displayed by default.

Run Date (Date) The date of the load test run.

Note: Displayed by default.

Run Duration 
(Duration)

The duration of the test run, in minutes.

Note: Displayed by default.

Run ID The run ID. 

Note: Displayed by default.

Total Vusers in Run 
(Total Vusers)

The number of Vusers in the test run, within the selected 
time range. 

Trended Time Range 
(Trended Range)

The time range within the test run that is selected for 
trending.
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Select Columns for ’Workload Characteristics’ Section

User interface elements are described below:

UI Elements (A-Z) Description

Hits per Second 
(HPS)

The average number of hits per second within the 
trended time range.

Passed Transactions 
per Minute (TPM)

The number of transactions that passed per minute of the 
test run within the selected time range. 

Note: Displayed by default.

Passed Transactions 
per Second (TPS)

The number of transactions that passed per second of the 
test run within the selected time range. 

Note: Displayed by default.

Throughput per 
Second (Throughput 
per Sec.)

The amount of throughput per second within the 
selected time range.

Total Hits (Hits) The total number of hits per second within the trended 
time range.

Total Number of 
Transactions 
(Transactions)

The total number of transactions in the test run that 
passed, failed or stopped within the selected time range.

Note: Displayed by default.

Total Throughput 
(Throughput)

The total throughput within the trended time range.

Total Vusers in 
Trended Range 
(Trended Vusers)

The maximum number of running Vusers within the 
trended time range. 

Note: Displayed by default.
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Select Columns for ’Performance Overview’ Section

User interface elements are described below:

UI Elements (A-Z) Description

Average Transaction 
Response Time 
(Response Time)

The weighted average transaction response time for all 
the transactions within the selected time range. 

Note: Displayed by default.

Errors per Second 
(EPS)

The average amount of errors per second within the 
selected time range. 

Note: Displayed by default.

Failed Transactions 
(Failed)

The actual amount of transactions that failed within the 
selected time range.

Passed Transactions 
(Passed)

The actual amount of transactions that passed within the 
selected time range.

Total Errors (Errors) The total number of errors within the selected time 
range.

Transaction Success 
Rate (Success)

The percentage of the total amount of transactions that 
passed within the selected time range. 

Note: Displayed by default.
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Select Test Runs to Trend Report Dialog Box 

This dialog box enables you to add performance test runs to the report. 

 

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, in the Trend 
Reports grid, click the name of the report to open. The 
report opens as an additional tab on the My 
Performance Center Dashboard.

3  On the <report name> Trend Report, select the Trend 
Overview tab, and click the Add runs to trend report 
button . 

Important 
information

➤ In order to add performance test runs to the trend 
report, there must be a data processor present in your 
project pool.

➤ The process whereby ALM Performance Center 
extracts the performance test data from Analysis is 
very labor intensive on the data processor, and may 
take anywhere from several minutes to over an hour. It 
is recommended that you use a machine dedicated for 
this purpose.

➤ ALM Performance Center extracts the performance 
test data from Analysis using a granularity of 16 
seconds. This value might be different from the 
defined granularity in Analysis, and may lead to slight 
variations when comparing values between Analysis 
and ALM Performance Center.



Chapter 30 • Trending

607

User interface elements are described below:

UI Elements (A-Z) Description

Populates the test runs table with all analyzed instances 
of the selected test.

Adds the selected test runs to the trend report.

Time Range filter. Opens the Define Time Range dialog 
box, which enables you to change the defined time range 
within a test run for trending purposes. 

In the Define Time Range dialog box, select one of the 
following options:

➤ Trend Complete Run. Makes all data collected from 
the beginning to the end of the test run available for 
trending.

➤ Trend Part of Run. Makes only part of the test run 
available for trending. Select the desired part of the 
run to trend by entering the start and end times in the 
Start Time and End Time boxes.

Duration The duration (in minutes) of the test run.

Exec Date The date of the test run.

Exec Time The time of test run.

Max Vusers The maximum number of running Vusers during the test 
run.

Run ID The Run ID.

Run Name The name of the test run.

Test The tests contained in the selected test set.

Test Set A list of available test sets from which to select test 
instances to trend.
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Time Range The duration of the test run that is selected for trending.

Example: If a test run’s overall duration is 30 minutes, 
and the time range is defined as 0-15min, then only the 
first 15 minutes of the test run will be considered for 
trending.

Default: The whole test run in selected.

Total Errors The total number of errors during the test run.

Total Transactions 
Passes

The total number of passed transaction during the test 
run.

UI Elements (A-Z) Description
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Threshold Settings Dialog Box 

This dialog box enables you to define which percentage differentials 
between measurement constitute significant improvements or regressions in 
performance. 

 

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, in the Trend 
Reports grid, click the name of the report to open. The 
report opens as an additional tab on the My 
Performance Center Dashboard.

3  On the <report name> Trend Report, select the Trend 
Overview tab, and click the Set Thresholds button . 

Important 
information

The threshold definition and color settings are applied 
on a global level and hold true across all trend views in 
the report.
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User interface elements are described below:

UI Elements (A-Z) Description

Improvement Enter the percentage differential that between instances 
of the measurement that will be considered an 
improvement in performance.

Major Regression Enter the percentage differential that between instances 
of the measurement that will be considered a major 
regression in performance.

Measurement Type The type of measurement.

Minor Regression Enter the percentage differential that between instances 
of the measurement that will be considered a minor 
regression in performance.
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Custom Measurement Mapping Dialog Box 

This dialog box enables you to map measurements with different names to a 
new single measurement which you create.

 

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, in the Trend 
Reports grid, click the name of the report to open. The 
report opens as an additional tab on the My 
Performance Center Dashboard.

3  On the <report name> Trend Report, select the Trend 
Overview tab, and click the Custom Measurement 
Mapping button .
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User interface elements are described below:

UI Elements (A-Z) Description

Opens the Add New Mapping dialog box, enabling you 
to create a new mapped measurement.

In the Add New Mapping dialog box, enter the following 
information:

➤ Name. The name of the new mapped measurement.

➤ Description. A description of the new mapped 
measurement.

➤ Data Type. Select the measurement type: Transaction, 
Monitor, or Other.

Creates a duplicate of the selected mapped measurement.

Refreshes the mapped measurements table.

Date Type The mapped measurement’s data type.

Description  A description of the mapped measurement.

Details A table which lists all the test runs in the trend report. 
The runs appear in the same order as they appear in the 
Trend Overview tab.

Click in the Type and Name fields to select which 
measurements to map to the mapped measurement.

The following fields appear in the table:

➤ Run ID. The test run ID.

➤ Type. The measurement type.

➤ Name. The measurement name. 

Note: When you use the Default option, all future 
instances of the measurement are automatically mapped 
to the current settings.

ID The mapped measurement’s ID.

Name The mapped measurement’s name.
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Add Trend Views to Tab Dialog Box 

This dialog box enables you to add trend views to a trend report.

 

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, in the Trend 
Reports grid, click the name of the report to open. The 
report opens as an additional tab on the My 
Performance Center Dashboard.

3  Select the desired trend view tab.

4  Click the Tab Management Menu button, and select 
Add Views to Tab.
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User interface elements are described below:

UI Elements (A-Z) Description

Monitors Trend 
Views

Trend measurements related to monitors.

Other Trend Views Trend measurements other than transactions and 
monitor measurements (Web Resources and Error 
Statistics). Included in this section are three basic 
non-configured trend views, each one based on one of 
the trend view display options. You can select one of 
these trend views and customize it as desired.

Transaction Trend 
Views

Trend measurements related to transactions.
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Measurements Configuration Dialog Box 

Each trend view has a default set of measurements that it trends. This dialog 
box enables you to add additional measurements.

 

To access 1  In My Performance Center, select 
Perspectives > Trending.

2  On the Performance Trending page, in the Trend 
Reports grid, click the name of the report to open. The 
report opens as an additional tab on the My 
Performance Center Dashboard. The trend view tabs 
are displayed by default.

Trend Views are contained within the trend view tabs.

3  On a trend view, select the menu button ,then 
select Select Measurements. 
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Trend Data Types Pane

The Trend Data Types pane contains a list of the measurements that are 
available for trending. Only measurements that contain data appear. 

User interface elements are described below:

Measurement Selection Pane

User interface elements are described below:

UI Elements (A-Z) Description

Monitors All monitor related measurements that contain data.

Others All non-transaction/monitor measurements.

Transactions All transactions that contain data.

User-Defined This node appears only if you have mapped any 
measurements. For more information on mapped 
measurements, see "Trend Reports Overview" on 
page 576.

UI Elements (A-Z) Description

Rule. This icon indicates that the measurement has 
already been selected using an automatic selection rule. 

Define automatic 
selection rule

Opens the Automatic Selection Rule dialog box, which 
enables you use regular expressions to define a rule that 
automatically selects measurements to be included in the 
trend view. The automatic selection rule applies to 
measurements that are currently displayed in the trend 
report data, as well as any future measurements. 

Name The name of the available measurement.

Select values to trend Displays the available values of the selected measurement 
which can be included in the trend view.
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31
Performance Center Administration - 
Introduction

This chapter includes:

Concepts

➤ Performance Center Administration Overview on page 620

Tasks

➤ How to Create Performance Center Administrators on page 621

➤ How to Work with Performance Center Administration on page 622

Reference

➤ Performance Center Administration User Interface on page 626
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Concepts

Performance Center Administration Overview

Performance Center administration is performed in Lab Management. You 
must be a Performance Center administrator to perform these tasks.

Performance Center administrators are defined in the ALM Site 
Administration site. For details on how to create a Performance Center 
administrator user, see "How to Create Performance Center Administrators" 
on page 621.

Performance Center administration responsibilities include managing 
Performance Center lab resources, such as Performance Center hosts and 
hosts pools, creating and maintaining testing assets, and other 
administration tasks. 

For details, see "How to Work with Performance Center Administration" on 
page 622.
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Tasks

How to Create Performance Center Administrators

This task describes how to create a Performance Center administrator user, 
who is responsible for all Performance Center administration tasks in Lab 
Management and in Site Administration.

Note: 

➤ This task is a prerequisite for the task, "How to Work with Performance 
Center Administration" on page 622.

➤ This task is performed in Site Administration. For details about logging in 
to and using Site Administration, refer to the HP Application Lifecycle 
Management Administrator Guide.

To create a Performance Center administrator user:

 1 Log in to Site Administration. 

 2 In the Site Users tab, create a new user. 

 3 In the Lab Management tab, select the Lab Management Users tab.

 4 Add the user you created in step 2, and select the Project Administrator 
option for the new user. 

For Lab Management tab user interface details, see "Lab Management Tab" 
on page 627.
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How to Work with Performance Center Administration

This section lists the tasks that a Performance Center administrator can 
perform.

This task includes the following steps:

➤ "Prerequisites" on page 623

➤ "Perform initial Performance Center configuration" on page 623

➤ "Create Performance Center projects and define project settings" on 
page 623

➤ "Manage and maintain Performance Center lab resources" on page 623

➤ "View and manage performance test runs" on page 623

➤ "View Performance Center usage reports" on page 624

➤ "Upload application patches" on page 624

➤ "Manage Performance Center Servers" on page 624

➤ "Manage Performance Center and Performance Center host licenses" on 
page 624

➤ "Manage Diagnostic Servers and Mediators" on page 624

➤ "Maintain system health" on page 624

➤ "Change the Performance Center system user" on page 625

➤ "Update the Communication Security passphrase" on page 625

➤ "Update the secure host communication settings" on page 625

➤ "Configure general Performance Center settings" on page 625
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Prerequisites

To perform any of these tasks, you must be a Performance Center 
administrator. For details on how to create a Performance Center 
administrator, see "How to Create Performance Center Administrators" on 
page 621. 

Perform initial Performance Center configuration

Immediately after installing the Performance Center components, the 
relevant component’s configuration tool opens, prompting you for initial 
configuration settings. If this configuration was skipped, you must configure 
the settings manually before you can start working with 
Performance Center. 

For details, see "How to Initially Configure Performance Center" on 
page 635.

Create Performance Center projects and define project settings

You create projects in Site Administration, and define the limits and other 
settings for the project in Lab Management, in the Project Settings module. 
For details, see "How to Create a Performance Center Project" on page 640.

Manage and maintain Performance Center lab resources

You manage hosts, host pools, host locations, and relevant MI Listeners 
from the Lab Resources modules. For details, see "How to Manage Lab 
Resources" on page 674. 

When you plan to perform maintenance tasks on the hosts—such as 
installing patches, rebooting hosts, and so on—it is recommended to reserve 
these hosts in timeslots. This way, you can be sure that they will be available 
for maintenance. For details, see "How to Reserve Maintenance Timeslots  
(Lab Management only)" on page 115.

View and manage performance test runs

The test runs from all the Performance Center in the system can be viewed 
and managed in Lab Management, in the Test Runs module. For details, see 
"Test Runs Module Window" on page 740.
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View Performance Center usage reports

Performance Center usage reports provide you with an overall analysis of 
Performance Center site users, resource usage, concurrent resource usage vs. 
license limitations, timeslot usage, as well as resource usage by duration and 
runs. For details, see "How to View Reports and Set Report Filter Criteria" on 
page 751.

You can also export these reports to PDF and Excel format. For details, see 
"How to Export Reports to PDF or Excel Formats" on page 752.

Upload application patches

Before you can install application patches on Performance Center Servers 
and hosts, you must upload the patches to the system. For details, see "How 
to Upload Patches to ALM" on page 785.

Manage Performance Center Servers

You manage Performance Center Servers in Lab Management from the 
PC Servers module. For details, see "How to Manage Performance Center 
Servers" on page 799.

Manage Performance Center and Performance Center host 
licenses

You manage the Performance Center license and Performance Center host 
license in Lab Management from the Licenses module. For details, see 
"License Module Window" on page 827.

Manage Diagnostic Servers and Mediators

Integrating diagnostics modules with ALM enables monitoring and analysis 
of the performance of complex applications under test. For details on setting 
up the diagnostics modules, see Chapter 40, "Diagnostics Management."

Maintain system health

You track and maintain the health of the system in Lab Management, from 
the System Health module. For details, see "System Health Overview" on 
page 918.
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Change the Performance Center system user

You use the System Identity Utility, installed on the Performance Center 
Server, to change the Performance Center system user on the 
Performance Center Server and hosts. For details, see "How to Change the 
System User" on page 898.

Update the Communication Security passphrase

You use the System Identity Utility, installed on the Performance Center 
Server, to update the Communication Security passphrase on the 
Performance Center Server and hosts. For details, see "How to Update the 
Communication Security Passphrase" on page 896.

Update the secure host communication settings

Initially, you define secure communication settings on each 
Performance Center host or standalone load generator using the Host 
Security Setup utility, installed locally on each host or load generator. For 
details, see "How to Configure Security Settings Locally on Hosts" on 
page 938.

To update these settings on all the hosts and load generators simultaneously, 
you can use the Host Security Manager, installed on the Performance Center 
Server. For details, see "How to Update Host Security Settings Remotely" on 
page 940.

Configure general Performance Center settings

You manage general Performance Center settings in Lab Management. On 
the masthead, select Tools > Performance Center General Settings. For user 
interface details, see "General Settings Dialog Box" on page 630.
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Reference

Performance Center Administration User Interface 

This section includes:

 ➤ Lab Management Tab on page 627

 ➤ General Settings Dialog Box on page 630



Chapter 31 • Performance Center Administration - Introduction

627

Lab Management Tab 

Lab Management is the area of ALM that enables all Performance Center 
administration, and is built in the LAB_PROJECT project. 

The Lab Management tab in Site Administration enables you to manage 
LAB_PROJECT project details and define Lab Management users who are 
responsible for Performance Center administration tasks. 

 

To access In Site Administration, click the Lab Management tab.

Important 
information

The Lab Management tab is available only when the 
Performance Center extension is deployed on the 
ALM Platform.

Relevant tasks "How to Create Performance Center Administrators" on 
page 621

See also "Performance Center Administration Overview" on 
page 620
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Edit Connection String. Edits the connection string for 
Lab Management. For details on editing the connection 
string, refer to the HP Application Lifecycle Management 
Administrator Guide.

Ping Project. Checks whether the project database is 
accessible from Site Administration.

Maintain Project. Enables you to verify, repair, and 
upgrade projects. For details, see the HP Application 
Lifecycle Management Administrator Guide.

Activate/Deactivate Project. When you deactivate 
LAB_PROJECT, users cannot log in to Lab Management. 
Any users currently connected to the project are forced to 
log out when you deactivate. LAB_PROJECT is not 
deleted from the server. 

In addition, users cannot connect to projects linked to 
LAB_PROJECT, and currently connected users are 
disconnected.

Restore Lab Project. Restores access to LAB_PROJECT and 
adds it to the Lab Management tab in Site 
Administration. Restoring a LAB_PROJECT allows you to 
use only Performance Center projects that were created 
in the restored LAB_PROJECT.

For more details on the restore process, refer to the 
HP Application Lifecycle Management Administrator Guide.

Remove Lab Project. Removes LAB_PROJECT from the 
Lab Management tab in Site Administration. This does 
not delete LAB_PROJECT from the server and you can 
restore it if necessary. If the project is still active, you are 
prompted to deactivate it. 

Removing LAB_PROJECT deactivates all associated 
Performance Center projects. These projects can be 
enabled only by restoring this version of LAB_PROJECT. 
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Lab Management 
Details tab

Enables you to view and edit LAB_PROJECT details for 
working with Lab Management. For more information 
on the viewing and editing project details, refer to the 
HP Application Lifecycle Management Administrator Guide.

Lab Management 
Users tab

Enables you to assign Lab Management users who are 
responsible for Performance Center administration. For 
more information, refer to the HP Application Lifecycle 
Management Administrator Guide.

UI Elements Description
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General Settings Dialog Box 

This dialog box enables you to define general settings for 
Performance Center.

 

To access In Lab Management, on the ALM masthead select Tools > 
Performance Center General Settings

Important 
information

The settings defined here are general settings for all of 
the Performance Center system.

Relevant tasks "How to Work with Performance Center Administration" 
on page 622

See also "Performance Center Administration Overview" on 
page 620
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

PC Server > PC 
Server Settings page

Enables you to define Performance Center Server cache 
setting: 

➤ Unlimited cache size. The Performance Center Server 
cache size is unlimited and the cache is not cleaned.

➤ Cache size. The Performance Center Server cache size 
in gigabytes.

Data Processor > 
Data Processor 
Settings page

Enables you to define data processor settings:

➤ Data Processor Timeslot minimum length (minutes). 
The minimum amount of time, in minutes, that a data 
processor timeslot should be allotted.

➤ Timeout for pending data processor task (minutes). 
The amount of time a data processing task should be 
allowed to remain in a pending state.
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32
Initial Performance Center 
Configuration

This chapter includes:

Concepts

➤ Initial Performance Center Configuration Overview on page 634

Tasks

➤ How to Initially Configure Performance Center on page 635
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Concepts

Initial Performance Center Configuration Overview

Immediately after installing the Performance Center Server and hosts, the 
relevant component’s configuration tool opens, prompting you for initial 
configuration settings. If any parts of the configuration was skipped, you 
must configure the settings manually before you can start working with 
Performance Center. 

You can perform the configuration by running the configuration tool on the 
relevant machine, or alternatively by defining the settings manually in Lab 
Management.

For details on running the relevant configuration tools, see the HP ALM 
Performance Center Installation Guide.

For details, on configuring the initial settings in Lab Management, see "How 
to Initially Configure Performance Center" on page 635.
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Tasks

How to Initially Configure Performance Center

This task describes how to manually perform the initial configuration of the 
Performance Center Server and hosts in Lab Management.

This task includes the following steps:

➤ "Prerequisites" on page 635

➤ "Log into Lab Management" on page 635

➤ "Add the Performance Center Server(s) to ALM" on page 636

➤ "Add the Performance Center license and the host license" on page 636

➤ "Add Performance Center hosts to the system" on page 636

 1 Prerequisites

➤ The Performance Center Server and Performance Center hosts must be 
installed according to instructions provided in the HP ALM Performance 
Center Installation Guide.

➤ To perform any of these tasks, you must be a Performance Center 
administrator. For details on how to create a Performance Center 
administrator, see "How to Create Performance Center Administrators" 
on page 621. 

 2 Log into Lab Management

 a Open your Web browser and type the ALM Platform URL in the 
following format:

 b In the HP Application Lifecycle Management window that opens, click 
Lab Management. 

http://<ALM Platform name>[<:port number>]/qcbin
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 c Enter your Performance Center Administrator user name and password 
and click Login.

 3 Add the Performance Center Server(s) to ALM

On the Lab Management sidebar, under Lab Settings, select PC Servers, 
and add your Performance Center Server. For details on how to add a 
Performance Center Server, see "How to Manage Performance Center 
Servers" on page 799.

 4 Add the Performance Center license and the host license

On the Lab Management sidebar, under Lab Settings, select Licenses.

Add the Performance Center license, and then the host license. For 
interface details, see "License Module Window" on page 827.

 5 Add Performance Center hosts to the system

On the Lab Management sidebar, under Lab Resources, select Hosts. For 
user interface details, see "New Host Dialog Box (Lab Management Only)" 
on page 699.
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33
Performance Center Project Settings 

This chapter includes:

Concepts

➤ Performance Center Project Settings Overview on page 638

Tasks

➤ How to Create a Performance Center Project on page 640

Reference

➤ Performance Center Project Settings User Interface on page 643
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Concepts

Performance Center Project Settings Overview 

Performance Center projects are ALM projects with the Performance Center 
project extension enabled. The project settings include:

➤ General project details

➤ Using IP addresses as targets for performance testing

➤ VUDs Vusers allocation to the project and usage

➤ Timeslot settings for the project

➤ Controller settings for the project

For task details, see "How to Create a Performance Center Project" on 
page 640.

This section also includes:

➤ "Using Target IP Addresses" on page 639
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Using Target IP Addresses
Target IP addresses are assigned so that the addresses of all hosts on a given 
network share a common prefix. The common prefix defines the network 
portion of the IP address, and the remainder defines the host portion (also 
referred to as the local portion).

The term network in this context refers to a logical network which might 
span one or more physical networks. The network portion of an IP address 
identifies a site and the local portion identifies a single host at that site. 

Using Subnet Masks

A site using subnet addressing must specify a 32-bit subnet mask for each 
network. Each bit in the subnet mask is set to 1 if the network treats the 
corresponding bit in the IP address as part of the network address or 0 if it 
treats the corresponding bit in the IP address as part of the host ID. 

Consider, for example, the subnet mask

(or in decimal form, 255.255.0.0). This subnet mask specifies that the first 
two octets identify the network and the last two octets identify the host on 
that network.

The subnet mask 255.255.255.255 (or in binary form, 11111111 11111111 
11111111 11111111), which you add when defining individual IP addresses, 
specifies that all four octets in the IP address identify the network and host 
as if there were no subnet mask. In practice, this means that null will use the 
exact IP address to target performance tests.

11111111 11111111 0000000 0000000
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Tasks

How to Create a Performance Center Project 

This task describes how to create a Performance Center project. You create 
Performance Center projects in Site Administration, and define project 
settings in Lab Management.

Note: 

➤ This task is part of a higher level task. For details, see "How to Work with 
Performance Center Administration" on page 622.

➤ Product Feature Movie. To view a movie that demonstrates how to create 
a performance testing project, select Help > Product Feature Movies in 
the ALM main window. Under HP ALM Performance Center 11.00 
Movies select Project Setup.

This task includes the following steps:

➤ "Log in to Site Administration" on page 641

➤ "Create a project domain - optional" on page 641

➤ "Create project administrator users" on page 641

➤ "Create a new project" on page 641

➤ "Assign more project administrators to the project - optional" on page 642

➤ "Define the project’s settings" on page 642

➤ "Add and customize the project users" on page 642
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 1 Log in to Site Administration

Open your Web browser and type the ALM Platform URL in the following 
format:

In the HP Application Lifecycle Management window, click Site 
Administration. 

Enter your Site Administrator user name and password and click Login.

 2 Create a project domain - optional

Click the Create Domain button and enter a name for the new domain, 
and click OK. 

 3 Create project administrator users

 a Select the Site Users tab, and click the New User button. The New User 
dialog box opens.

 b Enter the details of the project administrator user, and click OK.

 c Select the user, click Password and enter the password. Click OK.

For more details, see HP Application Lifecycle Management Administrator 
Guide.

 4 Create a new project

 a Click the Site Projects tab, and select the domain in which you want 
to create the project. 

 b Click the Create Project button, and follow the steps to create the 
project. When prompted:

➤ Add the project administrator users you created above.

➤ HP ALM: Select Performance Center Project Extension.

For more details, see HP Application Lifecycle Management Administrator 
Guide.

http://<ALM Platform name>[<:port number>]/qcbin
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 5 Assign more project administrators to the project - optional

To add additional project administrators: 

 a Click the Site Projects tab.

 b In the Projects list on the left, select the project you created.

 c In the right pane, click the Project Users tab.

 d Add another user, and select Project Administrator. 

 6 Define the project’s settings

Performance Center projects are created with default settings which you 
can modify if desired. You define the project settings in Lab Management 
as follows: 

 a Log into Lab Management with your Performance Center 
administrator user name and password. 

 b On the Lab Management sidebar, under Lab Settings, select Project 
Settings. 

 c Define at least the following settings: Host limit, Vuser limit, and 
Concurrent Run limit

For user interface details, see "Project Settings Details Dialog Box" on 
page 650.

Note: Project administrators can view the project settings in the project in 
ALM, and can modify some of the project settings. To access the project 
settings in ALM, on the ALM masthead, select Tools > PC Project Settings. 

 7 Add and customize the project users 

This step is performed by the project administrator. For details, see 
HP Application Lifecycle Management Administrator Guide.
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Reference

Performance Center Project Settings User Interface 

This section includes:

 ➤ Project Settings Module (Lab Management only) on page 644

 ➤ Project Settings Module Fields on page 645

 ➤ Project Settings Module Menus and Buttons on page 646

 ➤ Project Settings Details Dialog Box on page 650

 ➤ Project Settings > Controller Options Page on page 659
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Project Settings Module (Lab Management only)

This module enables you to view and manage all of the Performance Center 
projects and their settings.

 

To access On the Lab Management sidebar, under Lab Settings, 
select Project Settings.

Important 
Information

This module displays a list of all of the 
Performance Center projects in ALM. 

Alternatively, you can access project settings from within 
a particular project.

Relevant tasks "How to Create a Performance Center Project" on 
page 640

See also "Performance Center Project Settings Overview" on 
page 638
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Project Settings Module Fields 

This section describes the Project Settings module fields:

UI Elements (A-Z) Description

<Project Settings 
module common UI 
elements>

➤ Project Settings module fields. For field definitions, 
see "Project Settings Module Fields" on page 645.

➤ Project Settings module menus and buttons. For 
command and button descriptions, see "Project 
Settings Module Menus and Buttons" on page 646.

➤ ALM main menu and sidebar. For details on the Tools 
menu, Help menu and sidebar, see the HP Application 
Lifecycle Management User Guide.

<Project Settings 
grid>

Displays a list of the Performance Center projects in ALM 
and their project settings. 

VUDs transactions 
tab

Displays the VUDs transactions in each projects. For 
details, see "VUDs Transactions Page" on page 654.

History tab Lists changes made to the currently selected project. For 
more details, see the HP Application Lifecycle Management 
User Guide.

Field Description

AUT Pool The project’s AUT host pool.

Concurrent Run Limit The maximum number of concurrent test runs allowed 
within a project. 

Diagnostics Server The Diagnostics Server defined for the project.

Domain Name The domain in which the project was created.

Host Limit The total number of hosts (Controller + load generators) 
reserved for a timeslot may not exceed this limit.
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Project Settings Module Menus and Buttons

The Project Settings module enables you to view and manage 
Performance Center project settings in ALM. 

ID The project’s ID.

Pool The project’s host pool.

Project The name of the project.

VUDs Consumed The number of VUDs consumed by the project.

VUDs Limit The maximum number of VUDs available to the project.

VuGen Working 
Mode

The mode to use to upload scripts from VuGen:

➤ Runtime Files mode. Uploads only the necessary files 
to replay the script correctly. 

➤ User Defined mode. Uploads any available files 
including thumbnails images.

Vuser Limit The maximum number of Vusers a project can run at 
once. The total number used by all of the project's 
concurrent performance tests must not exceed this limit.

To access ➤ Performance Center administrator: On the Lab 
Management sidebar, under Lab Settings, select 
Project Settings.

➤ Project administrator: In ALM, on the masthead, select 
Tools > Performance Center Project Settings.

Important 
information

If you are a project administrator, you can view the 
project settings. You can also modify some of the 
settings.

Field Description
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Menus and toolbars of the Project Settings module are described below: 

UI Elements (A-Z) Where Description

Project Settings 
Details

Project 
Settings and 
<right-click 
menu>

Opens the Project Settings Details 
dialog box, enabling you to view 
and edit details of the selected 
project. 

Add to Favorites Favorites Opens the Add Favorite dialog box, 
enabling you to add a favorite view 
to your private or the public folder. 
For details, see the HP Application 
Lifecycle Management User Guide.

Copy URL Project 
Settings and 
<right-click 
menu>

Copies a selected project and pastes 
its URL as a link. The project itself is 
not copied. Instead, you can paste 
the address into another location, 
such as an email or a document. 
Clicking the link opens up ALM and 
takes you to the project file or folder. 
If you are not already logged in, 
ALM first prompts for login details.

Export Project 
Settings and 
<right-click 
menu>

Opens the Export Grid Data dialog 
box, enabling you to export the 
project settings in the grid as a text 
file, Microsoft Excel worksheet, 
Microsoft Word document, or HTML 
document. 

Choose one of the following 
options: 

➤ All. Exports all project settings in 
the grid. 

➤ Selected. Exports selected project 
settings in the grid.
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Find View Opens the Find dialog box, enabling 
you to search for project settings in 
the module. For details about search 
options, see the HP Application 
Lifecycle Management User Guide.

Go to Project Settings Project 
Settings 

Opens the Go To Project Settings 
dialog box, enabling you to find a 
specific project settings record by its 
ID number.

Grid Filters View and 
<right-click 
menu>

Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Information Panel View and 
<right-click 
menu>

Shows/Hides the Information Panel 
in the lower area of the module. 

Organize Favorites Favorites Opens the Organize Favorites dialog 
box, enabling you to organize the 
list of favorite views by changing 
properties or deleting views. For 
details, see the HP Application 
Lifecycle Management User Guide.

Private Favorites Lists the favorite views that are 
accessible only to the user who 
created them.

Public Favorites Lists the favorite views that are 
accessible to all users.

Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

Replace Edit and 
<right-click 
menu>

In the Project Details grid, opens the 
Replace dialog box, enabling you to 
replace a field value in the grid. For 
more details, see the HP Application 
Lifecycle Management User Guide. 

UI Elements (A-Z) Where Description
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Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For more details, see 
the HP Application Lifecycle 
Management User Guide.

For details about the project setting 
fields, see "Project Settings Module 
Fields" on page 645.

Set Filter/Sort View Enables you to filter and sort the 
project settings in the grid. Any 
currently applied filters or sorting 
orders are displayed below the 
toolbar. For more details, see the 
HP Application Lifecycle Management 
User Guide.

Updated Selected Edit and 
<right-click 
menu>

Opens the Update Selected dialog 
box, enabling you to update a field 
value for a multiple selection in the 
grid. For more details, see the 
HP Application Lifecycle Management 
User Guide.

UI Elements (A-Z) Where Description
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Project Settings Details Dialog Box

This dialog box enables you to configure settings for a Performance Center 
project.

 

To access In Lab Management:

1  On the sidebar, under Lab Settings, select Project 
Settings. 

2  Right-click a project in the grid, and select Project 
Settings Details.

In ALM:

On the ALM masthead, select Tools > 
Performance Center Project Settings.

Important 
information

The Controller Options page is available only when 
logged in to a particular project. You cannot set 
Controller options in Lab Management.
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Common Elements
Common user interface elements are described below (unlabeled elements 
are shown in angle brackets):

Relevant tasks "How to Create a Performance Center Project" on 
page 640

See also "Performance Center Project Settings Overview" on 
page 638

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of projects.

Available in: Lab Management only

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Project The name of the project.
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Details Page
This page displays the general details about the selected project. For details, 
see "Project Settings Module Fields" on page 645.

Target IPs Page
This page enables you to define IP addresses to use as targets for 
performance testing. 

 

Important 
Information

Target IP can be defined on Performance Center hosts 
only, and not on standalone load generators.

Relevant tasks "How to Create a Performance Center Project" on 
page 640

See also "Using Target IP Addresses" on page 639
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

New. Opens the New Target IP dialog box, enabling you 
to define an IP to use a target for performance testing.

Edit. Opens the Target IP Details dialog box, enabling you 
to view and edit details of the selected target IP.

Delete. Enables you to delete the selected target IPs.

Refresh. Refreshes the grid so that it displays the most 
up-to-date information. 

IP A target IP address.

Mask A 32-bit subnet mask for each network.
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VUDs Transactions Page
This page enables you to follow the VUDs transactions in your projects.

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Action The VUDs action performed. For details about the 
possible actions, see "VUDs Actions" below.

In Use by Run ID The ID of the test run that is currently running the 
VUDs.

Owner Run ID The ID of the test run that originally issued the VUDs.

Post Date The date that the transaction occured.

Responsible user 
name

The user, or automaed system process responsible for the 
transaction.

Token Unique ID Identifies all actions that belong to the same transaction.

Example: In one regular run that uses VUDs, there are 3 
Actions: Issued, Pending, and Expired. Each of these 
actions will have different transaction ID, but the same 
Token ID. 
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VUDs Actions

The following table lists the possible VUDs actions.

Updated inuse VUDs The current number of VUDs that are running as a result 
of the transaction. 

Updated Pending 
VUDs

The current number of VUDs that are in the Pending 
state as a result of the transaction. 

Updated project limit The project’s VUDs limit as a result of the transaction.

VUDs number The amount of VUDs involved in the Action.

VUDs Tansaction ID The action ID.

UI Elements (A-Z) Description

Allocated VUDs added to the project’s VUDs limit by the 
administrator.

Deallocated VUDs removed from the project’s VUDs limit by the 
administrator.

Expired VUD’s removed from the license after their 24 hour 
active period has ended. 

Note: VUDs that are involved in a performance test that 
exceeds 24 hours continue to run until completion 
before expiring.

Issued VUDs added to a performance test. 

Notes:

➤ All VUDs involved in a performance test are 
considered to be issued from the start of the test, 
irrespective of whether they have started running or 
not.

➤ The amount of issued VUDs decreases the project’s 
VUDs limit accordingly. 

➤ All unused VUDs are returned to the project’s VUDs 
limit at the conclusion of the test.

UI Elements (A-Z) Description
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Timeslot Settings Page 
This page enables you to configure timeslot settings.

Pending VUDs which have completed a test run but are still 
available for further use as their 24 hour active period has 
not yet ended.

Refunded VUDs which were issued but not used in the test. These 
VUDs are returned to the project’s VUDs limit and may 
be reissued at a later date.

Reused Running VUDs that that are taken from VUDs in the 
Pending state.

Note: ALM Performance Center first reuses VUDs in the 
Pending state before issuing new VUDs. For example, 
assume you define a performance test that includes 100 
VUDs, where the current project limit is 200, and where 
25 VUDs are currently in the Pending state. ALM 
Performance Center first resues the 25 Pending VUDs 
and only issues 75 from the license. The new limit will be 
125.

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Send Alerts To The users who should receive a timeslot alert:

➤ Timeslot creator. The user who reserved the timeslot.

➤ Timeslot modifier. The user who last modified the 
timeslot.

➤ Project administrators. Administrators of the project 
in which the timeslot was reserved.

Rules for Alerts The conditions under which timeslot alerts are sent (both 
conditions must hold):

➤ Send alerts for timeslots scheduled to start in the next 
<XX> hours. Sends an alert when a timeslot is XX 
hours within its due time to start. 

Default value: 72 hours

Minimum value: 12 hours

➤ Send alert if timeslot is in failure state for at least 
<XX> minutes. Sends an alert when the timeslot has 
been invalid for XX minutes. 

Default value: 30 minutes

Maximum value: 360 minutes (6 hours)

Autostart Retries If a performance test linked to a timeslot is scheduled to 
autostart but does not start running, the system 
continues to try to autostart the test until it starts 
running successfully.

The Autostart Retries option enables you to specify when 
the system should stop trying to autostart the test. In any 
event, retries are stopped if there are 30 minutes or less 
left of the timeslot.

Default value: 50%, that is the system stops retries when 
half the timeslot has elapsed.

Maximum value: 99%; Minimum value: 1% 

Note: The system tries to restart a performance test up to 
three times.
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Controller Options Page
This page enables you to configure global Controller options for your 
Performance Center project. 

Note: This page is available only when logged in to a particular 
Performance Center project. You cannot set Controller options in Lab 
Management.

For details, see "Project Settings > Controller Options Page" on page 659.

History Page
This page lists changes made to the project. For more details, see the 
HP Application Lifecycle Management User Guide.
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Project Settings > Controller Options Page 

This page enables you to configure global Controller options for your 
Performance Center project. 
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To access On the ALM masthead, select Tools > PC Project Settings. 
In the Project Settings Details dialog box that opens, 
select Controller Options.

Note: This page is accessible only from the project itself, 
and not from Lab Management.

Important 
information

The Controller is the manager of a performance test. The 
Controller receives the scripts, their runtime settings, and 
a list of the load generators to use. The Controller issues 
instructions to the load generators including which 
scripts to run, how many Vusers to run per script, and the 
timing at which to start running the Vusers. 

During the performance test, the Controller displays 
online monitoring information. At the conclusion of the 
test run, the Controller collates the data for analysis. 

Before you run a performance test, you can configure 
load generator and Vuser options for all your 
performance tests in the project. Although the default 
settings correspond to most environments, you can 
modify the settings to customize the test behavior. 

The settings apply to all future test runs in the project 
and generally only need to be set once. The settings 
apply globally to all the load generators in a performance 
test.

Relevant tasks "How to Create a Performance Center Project" on 
page 640

See also "Performance Center Project Settings Overview" on 
page 638
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Run Options > Monitors

Enables you to activate the Transaction monitor, configure the behavior of 
the transaction data, and set the data sampling rate, debugging, and 
frequency settings for the online monitors.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Transaction Data Configures the behavior of data for the Transaction, Data 
Point, and Web Resource online graphs.

➤ Enable Transaction Monitor. Select this option to 
activate the online Vuser Transaction monitor to begin 
monitoring transactions at the start of a test run.

Sample information at frequency <>. Select the 
frequency, in seconds, at which the online monitor 
samples the data to produce the Transaction, Data 
Point, and Web Resource online graphs. 

The higher the frequency, the less network traffic there 
is. The data is averaged for the frequency period 
defined, and only one value is sent to the Controller.

Default value: 5 seconds. 

Examples: 

➤ For a small test, use a frequency of 1. 

➤ For a large test, use a frequency of 3 - 5. 

Note: You cannot modify these settings during a test run; 
you must stop the test run before deactivating the 
monitor or changing its frequency.
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Send information in 
mode

Specifies how to send data back to the Controller.

➤ Summary. Sends a summary of the transaction data 
back to the Controller. 

➤ Raw Data. Sends all the transaction data back to the 
Controller in raw form. Sending raw data saves time 
because the data does not need to be processed. 

Note: When Raw Data is selected, the volume of data 
being transferred to the Controller may cause more 
network traffic. If the transfer speed is significant to you, 
select Summary.

Server Resource 
Monitors

Configures the behavior of the Server Resource monitors.

➤ Data Sampling Rate. The period of time (in seconds) 
between consecutive data sampling. By default, the 
online monitor samples the data at intervals of three 
seconds. If you increase the sampling rate, the data is 
monitored less frequently. This setting applies to all 
graphs. 

Notes: 

➤ The sampling rate configured here is applied to all 
server monitors that you subsequently activate. It is 
not applied to server monitors that have already been 
activated. To apply the new sampling rate to activated 
server monitors, save your performance test and 
reopen it. 

➤ Each type of monitor has a different minimum 
sampling rate. If the default sampling rate, or the rate 
set here is less than a monitor’s minimum sampling 
rate, the monitor samples data at its minimum 
sampling rate. For example, the minimum sampling 
rate for the Oracle Monitor is 10 seconds. If the data 
sampling rate is set here at less than 10 seconds, the 
Oracle Monitor continues to monitor data at 10 
second intervals.

UI Elements Description
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Run Options > Run-Time Settings

Enables you to specify runtime settings for your test relating to Vuser 
quotas, stopping Vusers, and random sequence seed, to prevent system 
overload, and to control the way in which Vusers stop running.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Debug ➤ Display Debug Messages. The online monitor 
provides debugging capabilities. Select this option to 
display the debug messages in the Output window.

➤ Debug level. For the Network monitor, you can 
indicate the debug (detail) level of messages sent to 
the log, ranging from 1-9.

UI Elements Description

Vusers Quota Vuser quotas prevent your system from overloading. The 
Vuser quotas apply to Vusers on all load generators. 

➤ Number of Vusers that may be initialized 
simultaneously on all load generators. Limits the 
number of Vusers initialized at one time (when you 
send an Initialize command).

Default value: 999

UI Elements Description
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When Stopping 
Vusers

Controls the way Vusers stop running when you 
manually stop a test run:

➤ Wait for the current iteration to end before stopping. 
(Default option) The Vuser completes the iteration it is 
running before stopping. The Vusers move to the 
Gradual Exiting status and exit the test run gradually.

➤ Wait for the current action to end before stopping. 
The Vuser completes the action it is running before 
stopping. The Vusers move to the Gradual Exiting 
status and exit the test run gradually.

➤ Stop immediately. The Vusers stop running 
immediately, moving to the Exiting status and exit the 
test run immediately.

Random advance 
mode of file type 
parameter

➤ Use random sequence with seed. Enables you to set a 
seed number for random sequencing. Select this 
option if you discover a problem during the test run 
and want to repeat the test using the same sequence of 
random values.

➤ Use seed <#>. Each seed value represents one sequence 
of random values used for test execution. Whenever 
you use this seed value, the same sequence of values is 
assigned to the Vusers in the test. 

This setting applies to parameterized Vuser scripts using 
the Random method for assigning values from a data file. 
It also affects the random percentage of recorded think 
time (see information about the Run-Time Settings dialog 
box in the HP Virtual User Generator User Guide). 

UI Elements Description
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Run Options >Timeout

Enables you to set timeouts for various Performance Center commands. 
When a command is issued by the Controller, you can set a maximum time 
for the load generator or Vuser to execute the command. If the command is 
not completed within the time limit, the Controller issues an error message.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

 Command Timeout 
(seconds)

Enable timeout checks. Enables load generator and Vuser 
timeout checks described below. 

Note: If this option is not selected, ALM waits an 
unlimited time for the load generators to connect and 
disconnect, and for the Initialize, Start Vusers, Duration, 
and Stop Vusers actions to be executed.

 Load Generator Load generator timeout limits:

➤ Connect operation (sec). The amount of time (in 
seconds) that elapses before connecting to any load 
generator. If a connection is not successful within this 
time, the status of the load generator changes to 
Failed. 

Default connection timeout: 30 seconds

➤ Disconnect operation (sec). The amount of time that 
elapses before disconnecting from any load generator. 
The load generator does not disconnect within this 
time, the status of the load generator changes to 
Failed. 

Default disconnection timeout: 120 seconds
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Vusers Vuser timeout limits: 

➤ Init stage (sec). The timeout value for the Initialize 
action. 

Default time limit: 180 seconds

➤ Run stage (sec). The timeout value for the Start Vusers 
action. 

Default time limit: 120 seconds

➤ Pause stage (sec). The timeout value for the Duration 
action. 

Default time limit: 120 seconds

➤ Stop stage (sec). The timeout value for the Stop Vusers 
action. 

Default time limit: 120 seconds

Note: Calculations consider the number of active Vusers 
and their influence on the timeout values. For example, 
1000 Vusers trying to initialize take much longer than 
10 Vusers. An internal value is added to the specified 
timeout value based on the number of active Vusers.

UI Elements Description
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Run Options > Debug Information

Enables you to select the type of information to trace during a test run. 
According to the selection here, trace files are created and are used to gather 
information for debugging purposes.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Enable the following 
traces

The trace flags related to performance testing problems 
that you are encountering:

➤ General. Performs a general trace during the test run.

➤ File Transfer. Traces problems with the transfer of files 
during the test run.

➤ Incoming communication. Traces incoming 
communication during the test run.

➤ Outgoing communication. Traces outgoing 
communication during the test run.

Note: The Performance Center agent and the Controller 
create some temporary files that collect information such 
as the parameter file sent to the Vuser, the output 
compilation file, and the configuration file. The 
Performance Center agent files are saved in brr folders in 
the TMP or TEMP directory of the agent machine. The 
Controller files are saved in lrr folders in the TMP or 
TEMP directory of the Controller machine. At the end of 
the test run, all of these files are automatically deleted.
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Run Options > General

Enables you to select a mode for allocating multiple IP addresses when IP 
spoofing is enabled.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

See also  "Test Options Dialog Box" on page 219

UI Elements Description

Multiple IP Address 
Mode

The Controller can allocate an IP address one of the 
following ways:

➤ IP address allocation per process. Allocates 
IP addresses per process. 

➤ IP address allocation per thread. Allocates IP addresses 
per thread, resulting in a more varied range of 
IP addresses in a test run. 

Examples: 

➤ Web Vusers require IP address allocation per process.

➤ WinSock Vuser IP addresses can be allocated per 
thread or per process.
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Run Results > Collate Settings

Enables you to specify behavior related to collation of the run results.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Output Message 
Database

➤ Add output.mdb to RawResults.zip if it is smaller than 
RawResults.zip size (MB). Collator process adds 
output.mdb to RawResults.zip only if it is smaller in 
size than the RawResults.zip file size specified.

➤ Always exclude output.mdb from RawResults.zip. 
Collator process always excludes output.mdb from 
RawResults.zip.

Timeout ➤  Collate timeout in minutes. The maximum amount of 
time the collate process should continue running 
without progress.

➤ Diagnostics collate timeout in minutes. The maximum 
amount of time the collate process should continue 
running without progress when collating results with 
Diagnostics data.
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34
Lab Resource Management

This chapter includes:

Concepts

➤ Lab Resources Overview on page 672

Tasks

➤ How to Manage Lab Resources on page 674

Reference

➤ Lab Resource Modules User Interface on page 684

Troubleshooting and Limitations on page 736
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Concepts

Lab Resources Overview 

The Lab Resource modules enable you to manage the lab resources needed 
for performance testing. These resources include:

Resource Description

Hosts Performance Center hosts are used to control and run 
Vusers, and to process data collected during a performance 
test. A host can be designated as a Controller, load generator, 
or data processor. 

➤ Controller. A host used to manage a performance test. 
During a test run, the Controller issues instructions to the 
load generators including which scripts to run, how many 
Vusers to run per script, and when to start and stop 
running them.  There is only one Controller per 
performance test.

➤ Load generator. A host on which Vusers run during a 
performance test. There can be any number of load 
generators for a given test. 

➤ Data processor. Used for processing and publishing data 
gathered during a test run.

Notes: 

➤ To provide greater flexibility (especially where resources 
are scarce), you can allocate a host with dual purposes as a 
Controller and load generator. In general, this is not a 
recommended practice and is only appropriate for tests 
that have a very small number of Vusers. When allocating 
hosts, the system tries to use single function hosts before 
dual-purpose Controller + load generator host.

➤ Although it is possible to set a host as a Controller and a 
data processor, it is recommended to set up a separate 
host for data processing.

➤ A host that is located over a firewall or is a UNIX host can 
be used as a load generator only. 
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For details about managing lab resources, see "How to Manage Lab 
Resources" on page 674.

Host Pools A host pool is a groups of hosts. Each project has one host 
pool. When managing a host pool, it is important to 
understand the total available resources. The pool must 
contain at least one Controller, one load generator, and one 
data processor. Because hosts can have dual functionality, it 
is recommended that a pool contains, among the other 
hosts, at least one host that can be dedicated fully for 
Controller functionality

Host Locations When selecting hosts for performance testing, their 
locations might be taken into consideration because hosts 
can be located across a wide physical area. Hosts located 
over a firewall can be designated as load generators only

MI Listeners MI Listeners serve as routers between the Controller and the 
Performance Center Agent, thus enabling you to run Vusers 
over a firewall, and collect server monitor data and 
application diagnostics data over a firewall. The MI Listener 
receives data from the Performance Center Agent at regular 
intervals. During the course of the test run, the Controller 
takes the data from the MI Listener to process as runtime 
data.

For detailed information about configuring 
Performance Center to work with firewalls, see the section 
about working with firewalls in the HP ALM Performance 
Center Installation Guide.

Resource Description
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Tasks

How to Manage Lab Resources

This section describes how to manage lab resources needed for designing 
and running performance tests.

Note: 

➤ This task is part of a higher-level task. For details, see "How to Work with 
Performance Center Administration" on page 622.

➤ Lab resources are managed in Lab Management. 

➤ Performance Center hosts can be viewed, and the host status can be 
modified, in the projects themselves.

➤ Product Feature Movie. To view a movie that demonstrates how to set up 
the lab resources required for running a performance test, select Help > 
Product Feature Movies in the ALM main window. Under HP ALM 
Performance Center 11.00 Movies, select Lab Resources.

This task describes how to:

➤ "Add lab resources" on page 675

➤ "Import host data from Excel" on page 676

➤ "Modify/View lab resource details" on page 679

➤ "Check host connections to Performance Center servers" on page 680

➤ "Reboot hosts" on page 681

➤ "Install patches on hosts" on page 681

➤ "Reconfigure hosts" on page 681

➤ "End processes on a host" on page 682

➤ "Link hosts to host pools" on page 682
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Add lab resources

Before you design and run tests, you must add the required resources to 
ALM. These include the hosts (Controllers, load generators, and data 
processors), the host pools to which the hosts belong, the location of the 
hosts, and MI Listeners for hosts that are located over a firewall. For an 
overview on lab resources, see "Lab Resources Overview" on page 672.

Before adding Performance Center hosts, ensure the following:

➤ Performance Center hosts were installed according to the instructions 
provided in the HP ALM Performance Center Installation Guide.

➤ If a host you are adding is in a remote location, make sure that the 
location was added in the Lab Resources > Locations module.

➤ If a host you are adding is over a firewall, it communicates with the 
Performance Center server through an MI Listener. Make sure that the 
MI Listener was added in the Lab Resources > MI Listeners module.

Tip: You can use the Import Hosts feature to import a list of hosts from an 
Excel file into ALM. For details, see "Import host data from Excel" below.

To add a lab resource:

➤ In Lab Management, under Lab Resources, select the relevant resource 
module, and click the New <Resource> button.

Note: Fields marked with an asterisk (*) are mandatory. For details per 
module, see "Lab Resource Module Fields" on page 689.
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Import host data from Excel 

You can import a list of hosts from an Excel file (.xls or .csv) into ALM.

 1 Ensure that the Excel file is set up so that the columns can be recognized 
and mapped by the Import feature. 

➤ The first row of the Excel file must contain the field names, or 
corresponding logical names, that appear in the table below. (Logical 
names are not case sensitive.)

Some fields are mandatory, others are required or optional. 

➤ Mandatory indicates a field that must appear in the Excel file. If you 
omit this field, the import fails. If you omit a value in one of the 
rows of this field’s column, the import of that specific row fails.

➤ Required indicates a field that should appear in the Excel file. If you 
omit this field, the code adds the field with the default value for all 
rows. If you include the field, but omit a value in one of the rows of 
this column, the code adds the default value for that row.

➤ Optional indicates a field does not have to appear in the Excel file. 
Omitting this field has no effect on the import procedure.

➤ Fields representing virtual, reference, and invalid fields are ignored.

➤ Empty columns are allowed.
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Set up the columns and values in the file as follows:

Field name
Logical 
Name

Value Field for

HOST_NAME

Mandatory

Name Any string The valid name of the 
host machine.

HOST_
PURPOSE

Mandatory

Purpose ➤ Controller

➤ Load Generator

➤ Data Processor

The purpose of the 
Performance Center 
host.

Note: This can be any 
combination of the 
three options. Options 
should be separated 
with a semicolon 
without spaces.

Example: 
Controller;Data 
Processor

HOST_STATE

Required

Status ➤ Operational

➤ Non-Operational

➤ Unavailable

Default: Operational

The host state

HOST_
INSTALLATION

Required

Installation ➤ Windows  Host 

➤ Unix Load 
Generator

➤ Windows 
Standalone LG

Default: 
Windows Host

The type of host 
installation.

Note: There is a double 
space in:

➤ "Windows<space>
<space>Host"

➤ "Unix<space><space>
Load Generator"

HOST_
PRIORITY

Required

Priority ➤ 1-Lowest Priority

➤ 2, 3 … 8

➤ 9-Highest Priority

Default: 5

The priority of the 
host
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The fields specified in the table below must not be included in the Excel 
file. During the import of each host, these fields are assigned default 
values.

HOST_SSL_
ENABLED

Required

Enable SSL ➤ Y

➤ N

Default: N

SSL-enabled

HOST_
USERNAME

Optional

Username Any string The user name for 
logging in to the host

HOST_
PASSWORD

Optional

Password Any string The user password for 
logging in to the host

HOST_
DOMAIN

Optional

Domain Any string The host domain

HOST_
DESCRIPTION

Optional

Description Any string Host description

Field name Default value assigned

Belongs to pools General

Location Default

MI Listener None

Field name
Logical 
Name

Value Field for
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Note: If data for these fields is included in the Excel file, the data is 
ignored. Default values that are not relevant for a particular host must be 
modified manually in the Hosts module.

Example:

The following image illustrates an Excel file set up with the following 
AUT hosts: [test]abc, [test]host, and a third host whose name was not 
provided.

 2 Import the Performance Center hosts:

 a On the Lab Management sidebar, under Lab Resources, select Hosts.

 b In the Hosts module, select Hosts > Import. 

 c Browse to the Excel file containing the hosts, and click Open.

At the end of the import process, a report displays the import results, and 
the imported hosts are listed in the Hosts module. Hosts that are not 
imported successfully, must be added manually. 

Modify/View lab resource details

To modify or view a lab resource’s details, in the relevant lab resource 
module, right-click the resource in the grid and select <Resource> Details. 
See "Lab Resource Modules User Interface" on page 684.
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Check host connections to Performance Center servers

On the Lab Management sidebar, under Lab Resources, select Hosts. 
Right-click a host in the grid, and select Check Host. 

The Task Manager opens, and the overall result of each check performed on 
the host, Passed or Failed, is displayed. 

You can view the progress of the host check in the Hosts module’s Check 
Host Status tab.

Based on the purpose and location of the host, the following checks are 
performed on the host:

Alternatively, you can perform the above checks, together with an 
additional connectivity check from the host to a particular URL. Right-click 
a host in the grid, select Check Connectivity to URL, and enter the URL. 

Examples:

➤ Regular URL: http://www.website.com

➤ Machine name: machine22 or http://machine22

Check Performed

Load Generator Host
Controller 

Host

Data 
Processor 

HostRegular UNIX
Stand-
alone

OFW

Ping to Host Yes Yes Yes N/A Yes Yes

Installed Patches Yes N/A N/A N/A Yes Yes

Services Yes N/A N/A N/A Yes Yes

Performance Yes N/A N/A N/A Yes Yes

Over Firewall 
Status

N/A N/A N/A Yes N/A N/A
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Reboot hosts

To reboot a host, on the Lab Management sidebar, under Lab Resources, 
select Hosts. Right-click the host in the grid that you want to reboot, and 
select Reboot Host.

Install patches on hosts

Notes:

➤ To install patches on a host, you first need to have uploaded the patches 
to ALM. For details, see "How to Upload Patches to ALM" on page 785.

➤ Patches can be installed on a host only when the host state is idle.

On the Lab Management sidebar, under Lab Resources, select Hosts. 
Right-click the host in the grid on which to install the patch and select 
Install Patch. 

For user interface details, see "Select Patch to Install Dialog Box" on 
page 713. 

Reconfigure hosts

Reconfiguring a host resets the host license, the Performance Center system 
user (IUSR_METRO), and the Communication Security passphrase on the 
host machine.

To reconfigure a host, on the Lab Management sidebar, under Lab 
Resources, select Hosts. Right-click the host in the grid that you want to 
reconfigure, and select Reconfigure Host. 
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End processes on a host

To end a process on a host, on the Lab Management sidebar, under Lab 
Resources, select Hosts. Select a host, and in the Processes tab, select the 
process and click the Kill Process button.

Link hosts to host pools

You can populate host pools with hosts in one of the following ways:

➤ Hosts module: You can link a host to one or more host pools.

➤ Host Pools module: You can link one or more hosts to a particular host 
pool.

To link a host to one or more host pools:

 1 On the Lab Management sidebar, under Lab Resources, select Hosts:

 2 Right-click a host in the grid, and select Host Details.

 3 Click the down arrow adjacent to Belongs to Pools, and select pools in 
which to include the host, and click OK.
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To link one or more hosts to a host pool:

 1 On the Lab Management sidebar, under Lab Resources, select Host Pools.

 2 Select a host pool in the grid.

 3 In the Linked Hosts tab, click Add Hosts to Pool and select hosts to add to 
the pool, and click Add.
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Reference

Lab Resource Modules User Interface 

This section includes:

 ➤ Lab Resource Module Menus and Buttons on page 685

 ➤ Lab Resource Module Fields on page 689

 ➤ Hosts Module on page 696

 ➤ New Host Dialog Box (Lab Management Only) on page 699

 ➤ Host Details Dialog Box on page 701

 ➤ Processes Page on page 704

 ➤ Services Page on page 706

 ➤ Check Host Status Page on page 708

 ➤ Over Firewall Page on page 710

 ➤ Select Patch to Install Dialog Box on page 713

 ➤ Host Pools Module on page 714

 ➤ New Host Pool Dialog Box on page 716

 ➤ Host Pool Details Dialog Box on page 718

 ➤ Linked Hosts Page on page 720

 ➤ Add Hosts to Pool Dialog Box on page 722

 ➤ Locations Module on page 724

 ➤ New Host Location Dialog Box on page 726

 ➤ Host Location Details Dialog Box on page 728

 ➤ MI Listeners Module on page 730

 ➤ New MI Listener Dialog Box on page 732

 ➤ MI Listener Details Dialog Box on page 734
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Lab Resource Module Menus and Buttons

The Lab Resource modules enable you to manage lab resources.

Common menus and toolbars of the lab resource modules are described 
below (unlabeled elements are shown in angle brackets): 

To access On the Lab Management sidebar, under Lab Resources, 
select <Resource>.

Important 
information

➤ Resources are managed in Lab Management. Only a 
user with administrator privileges can manage these 
resources. 

➤ Non-administrator users can view host details and 
host pool details belonging their projects, and can 
reconfigure and reboot hosts as well as check host 
connectivity on hosts.

➤ This help page relates to all of the resource modules:

➤ Hosts

➤ Host Pools

➤ Host Locations

➤ MI Listeners

All resources are generically referred to as <Resource>.

Relevant tasks "How to Manage Lab Resources" on page 674

UI Elements (A-Z) Where Description

<Resource> Details <Resource> 
and 
right-click 
menu

Opens the <Resource> Details dialog 
box, enabling you to view and edit 
details of the selected resource. 

Add to Favorites Favorites Opens the Add Favorite dialog box, 
enabling you to add a favorite view 
to your private or the public folder. 
For details, see the HP Application 
Lifecycle Management User Guide.
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Copy URL <Resource> 
and 
<right-click 
menu>

Copies a selected resource and pastes 
its URL as a link. The resource itself 
is not copied. Instead, you can paste 
the address into another location, 
such as an email or a document. 
Clicking the link opens up ALM and 
takes you to the resource file or 
folder. If you are not already logged 
in, ALM first prompts for login 
details.

Delete Edit and 
<right-click 
menu>

Deletes the resource selected in the 
grid.

Note: You cannot delete an 
MI Listener that is being used by a 
host.

Export <Resource> 
and 
<right-click 
menu>

Opens the Export All Grid Data 
dialog box, enabling you to export 
the resources in the grid as a text 
file, Microsoft Excel worksheet, 
Microsoft Word document, or HTML 
document. 

Choose one of the following 
options: 

➤ All. Exports all resources in the 
grid. 

➤ Selected. Exports selected 
resources in the grid.

Find View Opens the Find dialog box, enabling 
you to search for a resource in the 
module. For details about search 
options, see the HP Application 
Lifecycle Management User Guide.

UI Elements (A-Z) Where Description
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Go to <Resource> <Resource> Opens the Go To <Resource> dialog 
box, enabling you to find a specific 
resource by its ID number. You can 
only go to resources that are in the 
current filter.

Grid Filters View and 
<right-click 
menu>

Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Import 

(Hosts module only)

Hosts Enables you to import a list of 
Performance Center hosts from an 
Excel file (.xls or .csv) into ALM (.xls 
or .csv format).

Information Panel View and 
<right-click 
menu>

Shows/Hides the Information Panel 
in the lower area of the module. 

New <Resource> <Resource> Enables you to add a resource.

Note: For Hosts, this is available in 
Lab Management only.

Organize Favorites Favorites Organizes your favorite views. For 
details, see the HP Application 
Lifecycle Management User Guide.

Private Favorites Lists the favorite views that are 
accessible only to the user who 
created them.

Public Favorites Lists the favorite views that are 
accessible to all users.

Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

UI Elements (A-Z) Where Description
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Replace Edit and 
<right-click 
menu>

In the <Resource> grid, opens the 
Replace dialog box, enabling you to 
replace a field value in the grid. For 
more details, see the HP Application 
Lifecycle Management User Guide. 

Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For details, see the 
HP Application Lifecycle Management 
User Guide.

For details about the resource fields, 
see "Lab Resource Module Fields" on 
page 689.

Set Filter/Sort View Enables you to filter and sort the 
resources in the grid. Any currently 
applied filters or sorting orders are 
displayed below the toolbar. For 
more details, see the HP Application 
Lifecycle Management User Guide.

Updated Selected Edit and 
<right-click 
menu>

Opens the Update Selected dialog 
box, enabling you to update a field 
value for a multiple selection in the 
grid. For more details, see the 
HP Application Lifecycle Management 
User Guide.

UI Elements (A-Z) Where Description
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Lab Resource Module Fields 

This section described the fields in the Lab Resources modules.

It includes:

➤ "Host Fields" on page 689

➤ "Check Host Status Fields" on page 693

➤ "Host Pool Fields" on page 693

➤ "Host Location Fields" on page 694

➤ "MI Listener Fields" on page 695

Host Fields
This section describes the Performance Center host fields:

Field (A-Z) Description

Active Timeslot ID The ID of the timeslot for which this host is reserved, and 
which is now open.

Belongs to Pools The host pools to which the host is assigned. 

Host pools enable you to control which hosts are 
allocated to which projects. When allocating hosts for a 
test, the system allocates hosts from the project’s host 
pool.

Configuration Last 
Check

The last configuration check performed.

Connectivity Last 
Check

The last connectivity check performed.

Description A description of the host.
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Enable SSL Relevant for Load Generator hosts located over a firewall 
only.

Indicates whether the load generator is to communicate 
with the Controller via SSL (Secure Socket Layer) or not. 

Note: The load generator uses SSL to communicate with 
the Controller during runtime only. For non runtime 
functionality (including collating results), the load 
generator does not use SSL as the communication 
protocol.

Host Attributes The attributes of the host.

Example: Memory, strength, installed components

Tip: You can customize the host attributes. For details, see 
"Load Generator Attribute Customization" on page 224.

Host ID The ID of the host.

Host State The current activity on the host.

➤ Idle. Indicates that the host is not being used.

➤ Installing. Indicates that a patch is being installed on 
the host.

➤ Rebooting. Indicates that the host is rebooting.

➤ <Run states>. Indicates the state of the host during a 
performance test run.

➤ <Data processing states>. Indicates the state of the 
host during a data processing task.

Installation Indicates the type of host installation.

For a standalone installation of the load generator, select 
Windows Standalone LG. 

Note: You cannot modify this field for an existing host.

Installation Last 
Check

The last installation check performed.

Last Run Timeslot ID The ID of the timeslot during which a performance test 
ran or data processing occurred on the host.

Field (A-Z) Description
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Location The location of the host. For example, locations can be 
defined according to physical areas. 

The location also determines whether the host is located 
over a firewall. If so, you need to select an MI Listener 
that will enable data collection.

MI Listener For hosts located over a firewall, the IP address or name 
of the MI Listener that enables data collection.

Name The fully qualified domain name or IP address of the host 
that was assigned when creating the host.

Password The password of the Performance Center system user on 
the host machine.

Default: P3rfoRm@1nce

Note:

➤ The Performance Center system user name and 
password are displayed only for UNIX hosts and for 
any hosts that were migrated from earlier versions of 
Performance Center. 

➤ The system user name and password of newly added 
Windows hosts (details are not displayed here) are the 
same as the system user name and password of the rest 
of the Performance Center·system.

Performance Last 
Check

The last performance check performed. 

Priority A rank assigned to the host. The higher the priority you 
give the host, the more likely the host will be allocated to 
a test. There are a number of criteria to consider when 
assigning priority. The main considerations are whether 
the host is a dedicated machine or a shared resource, and 
the type of hardware installed on the machine.

Field (A-Z) Description
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Purpose The functionality that the host can provide:

➤ Controller

➤ Load generator

➤ Data processor 

Note: 

➤ If the host machine is located over a firewall or is a 
UNIX machine, it can function as a load generator 
only.

➤ If you selected Windows Standalone LG as the 
installation option, Load Generator is automatically 
selected as the purpose for the host and the other 
options are disabled.

Status The status of the host. An indicator is displayed next to 
the host name, according to its current status.

The possible statuses are: 

➤ Operational. The host machine is up and running.

➤ Non-operational. The host machine is down.

➤ Unavailable. There is no information available about 
the status of the host.

User Name The name of the Performance Center system user on the 
host machine.

Default: IUSR_METRO

Note:

➤ The Performance Center system user name and 
password are displayed only for UNIX hosts and for 
any hosts that were migrated from earlier versions of 
Performance Center. 

➤ The system user name and password of newly added 
Windows hosts (details are not displayed here) are the 
same as the system user name and password of the rest 
of the Performance Center·system.

Field (A-Z) Description
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Check Host Status Fields
The following fields are displayed in the Check Host Status page:

Host Pool Fields 
This section describes the host pool fields:

Field (A-Z) Description

Actual Value Actual value resulting from the host connectivity check.

Category The areas in which the Check Host feature checks the 
host:

➤ Configuration

➤ Connectivity

➤ Installation

➤ Performance

Check The sub-areas in which the Check Host feature checks the 
hosts. For example, sub-areas if the Performance check 
are Processor, Memory, System, 

Check Date The date the host was checked.

Check Result ID The ID of each step of the host check.

Error If an error occurred during the check, displays the error.

Expected Value Value expected to result from the host check.

Status Indicates whether the host check passed or failed.

Field (A-Z) Description

C+LG Hosts The number of "Controller+load generator" hosts in the 
host pool.

Controller Hosts The number of Controller hosts in the host pool.

Description A description of the host pool.

DP Hosts The number of data processor hosts in the host pool.

LG Hosts The number of load generator hosts in the host pool.
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Host Location Fields 
This section describes the host location fields:

Pool ID The ID of the host pool.

Pool Name The name of the host pool.

Note: The name may contain up to 255 characters, 
excluding spaces, periods, and any of the following 
characters: 

 : ; * \ / ” ~ & ? { } $ % | < > + = ^ [ ] ( ) 

Total Hosts The total number of hosts (Controllers, load generators, 
data processors, and "Controller + load generators") in 
the host pool.

Field (A-Z) Description

Description A description of the host location.

Location ID The ID of the host location.

Location Name The name of the host location. The name should have a 
logical connection to the host location

Over Firewall Indicates whether the host location is over a firewall or 
not.

Field (A-Z) Description
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MI Listener Fields 
This section describes the MI Listener fields:

Field (A-Z) Description

Description A description of the MI Listener.

MI Listener ID The ID of the MI Listener.

MI Listener IP The IP address of the MI Listener. 

Note: If you have two different IP addresses for the same 
MI Listener—one for internal communication with the 
Controller and a second for public communication with 
a load generator located over a firewall—enter the 
internal IP address here. Enter the public IP address in 
the MI Listener Name field (see below).

MI Listener Name The name of the MI Listener.

Note: If you have two different IP addresses for the same 
MI Listener—one for internal communication with the 
Controller and a second for public communication with 
a load generator located over a firewall—enter the public 
IP address here. Enter the internal IP address in the 
MI Listener IP field (see above).

Purpose The role designated to the MI Listener: 

➤ Diagnostics data collection over a firewall

➤ Monitoring over a firewall

➤ Running Vusers over a firewall
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Hosts Module

This module enables you to view and manage Performance Center hosts.

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access On the sidebar, under Lab Resources, select Hosts.

Important 
Information

Lab Management: The Hosts module displays a list of all 
of the Performance Center hosts in ALM. 

Project: The Hosts module displays a list of all of the 
Performance Center hosts in the project’s host pool.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672

UI Elements Description

Checks connectivity between the selected host and other 
machines in the system.

Performs the same checks as the Check Host button, as 
well as connectivity to any given URL.
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Enables you to remotely reboot host machines.

Note:

➤ You cannot reboot Controller and load generator hosts 
while they are in the Running state. You can only 
reboot these hosts when they are idle.

➤ You cannot reboot a UNIX load generator host.

Opens the Install Patch dialog box, enabling you to select 
patches to install on the selected hosts. For details, see 
"Select Patch to Install Dialog Box" on page 713.

Notes:

➤ You cannot use the Install Patch feature on Controller 
and load generator hosts if they are in the Running 
state. You can only install patches when these hosts 
are idle.

➤ You should use this feature to install 
Performance Center certified patches only.

Available in: Lab Management only.

Resets the following on the selected host machine:

➤ Host license

➤ System user (IUSR_METRO)

➤ Communication Security passphrase

Note: You can reconfigure only one host at a time.

Available in: Lab Management only.

Opens the Data Processor Queue window, enabling you 
to view the pending data processing requests.

Refreshes the grid automatically every 5 seconds.

<Hosts module 
common UI 
elements>

➤ Host module fields. For field definitions, see "Host 
Fields" on page 689.

➤ Host module menus and buttons. For command and 
button descriptions, see "Lab Resource Module Menus 
and Buttons" on page 685.

UI Elements Description
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<Hosts grid> Displays a list of the Performance Center hosts in ALM. 

Description tab Describes the currently selected host. 

Tip: Right-clicking in this area displays a toolbar for 
formatting and spell checking the text.

Event Log tab Displays detailed information about the tasks performed 
on the selected host, the action status, and a description 
of any errors. For details, see "Event Log" on page 351.

Installed PC 
Components tab

Displays a list of the Performance Center components 
installed on the host machine, including versions and 
patches. 

To refresh the grid, click .

Installed Programs 
tab

Displays a list of all of the programs installed on the host 
machine. Details include the version, the publisher of the 
software, and the date it was installed in the host 
machine.

To refresh the grid, click .

Processes tab Displays detailed information about the processes and 
resource usage of the selected host. For details, see 
"Processes Page" on page 704.

Services tab Displays the services running on the host machine. For 
details, see "Services Page" on page 706.

Check Host Status 
tab

Displays the status of each step of the host checks. To see 
host check status details, right click a line in the Check 
Host Status tab, and select Check Hosts Status Details. For 
details, see "Check Host Status Fields" on page 693.

Runs tab Displays detailed information about test runs performed 
on the selected host. For details, see "Test Runs Module 
Window" on page 740. 

UI Elements Description
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New Host Dialog Box (Lab Management Only)

This dialog box enables you to add a Performance Center host to ALM.

 

Over Firewall tab For hosts over a firewall, enables you configure advanced 
over-firewall settings. For details, see "Over Firewall Page" 
on page 710.

History tab Lists changes made to the currently selected host. For 
more details, see the HP Application Lifecycle Management 
User Guide.

To access 1  On the Lab Management sidebar, under Lab 
Resources, select Hosts.

2  In the Hosts module, click the New Host button.

Important 
information

You can add new hosts in Lab Management only.

UI Elements Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks ➤ "How to Initially Configure Performance Center" on 
page 635

➤ "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672

UI Elements Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Name The name for the new host. 

Tip: Give the host a meaningful name. This can be 
derived from the location, purpose, type, identity, or 
operating system of the host. The more information that 
is provided with the name, the easier it is to use and 
maintain the system. Make sure that the name is easy to 
remember and not too long.

Details Required fields are marked with an asterisk (*) and are 
displayed in red. For details on the available host fields, 
see "Host Fields" on page 689.
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Host Details Dialog Box

This dialog box displays details about a selected Performance Center host.

 

To access 1  On the sidebar, under Lab Resources, select Hosts.

2  Right-click a host in the grid and select Host Details.

Important 
information

This dialog box is available both in Lab Management and 
in ALM.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of hosts.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Host ID The ID of the host.

Name The name of the host.

Details Details the currently selected host. For details on the 
available fields, see "Host Fields" on page 689.

Installed PC 
Components

Displays a list of the Performance Center components 
installed on the host machine, including version and 
patches.

Note: Use the navigation bar at the bottom of the page to 
view all the entries.

Event Log Displays detailed information about the tasks performed 
on the selected host, the action status, and a description 
of any errors. For details, see "Event Log" on page 351.

Installed Programs Displays a list of all of the programs installed on the host 
machine. Details include the version, the publisher of the 
software, and the date it was installed in the host 
machine.

Note: Use the navigation bar at the bottom of the page to 
view all the entries.
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Processes Displays detailed information about the processes and 
resource usage of the selected host. For details, see 
"Processes Page" on page 704.

Note: Use the navigation bar at the bottom of the page to 
view all the entries.

Services Displays the services running on the host machine. For 
details, see "Services Page" on page 706.

Note: Use the navigation bar at the bottom of the page to 
view all the entries.

Check Hosts Status Displays the status of each step of the host checks. To see 
host check status details, right click a line in the Check 
Host Status tab, and select Check Host Status Details. For 
details, see "Check Host Status Fields" on page 693.

Runs Displays detailed information about test runs performed 
on the selected host. For details, see "Test Runs Module 
Window" on page 740. 

Note: Use the navigation bar at the bottom of the page to 
view all the entries.

Over Firewall For hosts over a firewall, enables you configure advanced 
over-firewall settings. For details, see "Over Firewall Page" 
on page 710.

History Lists changes made to the currently selected host. For 
more details, see the HP Application Lifecycle Management 
User Guide.

UI Elements Description
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Processes Page 

This page displays detailed information about the processes and resource 
usage of the selected host.

 

To access ➤ From the Hosts module: 

On the sidebar, under Lab Resources, select Hosts. In 
the information panel, select Processes.

➤ From the Host Details dialog box: 

On the sidebar, under Lab Resources, select Hosts. 
Right-click a host and select Host Details. In the Host 
Details dialog box, select Processes.

Important 
information

ALM is unable to display processes and resource usage 
information for UNIX machines or Windows Standalone 
Load Generators.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Refresh. Refreshes the grid so it displays the most 
up-to-date information.

Kill Process. Ends the process selected in the grid.

Notes: 

➤ Hosts module. Kill Process permissions are required to 
end the selected process. 

➤ Performance Center Servers module. A user with 
Viewer permissions has the ability to end the selected 
process.

<Processes grid>  Displays the following details about the processes: 

➤ Name. The name of the process.

➤ PID. The process ID.

➤ Processor Time (%). The percentage of processor time 
used by the process.

➤ Memory Usage (KBytes). The amount of memory (in 
kilobytes) used by the process.

➤ Elapsed Time (d.hh:mm:ss). The amount of elapsed 
time since the start of the process, where d is the 
number of days and hh:mm:ss is the number of hours, 
minutes, and seconds that have elapsed.

<Navigation area> Located at the bottom of the page, enables you to 
navigate through the pages of entries in the grid. The 
total number of entries is displayed on the right of the 
navigation area.
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Services Page 

This page displays the services on the selected host.

 

To access ➤ Hosts module: 

On the sidebar, under Lab Resources, select Hosts. In 
the information panel, select Services.

➤ Host Details dialog box: 

On the sidebar, under Lab Resources, select Hosts. 
Right-click a host and select Host Details. In the Host 
Details dialog box, select Services.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Refresh. Refreshes the grid so it displays the most 
up-to-date information.

Name The name of the service.

Display Name The full name of the service.

Status The status of the service: Running or Stopped.

Startup Type The way the service is set to start up:

➤ Auto. Service starts up automatically.

➤ Disabled. Service is disabled.

➤ Manual. Service must be started manually.

<Navigation area> Located at the bottom of the page, enables you to 
navigate through the pages of entries in the grid. The 
total number of entries is displayed on the right of the 
navigation area.
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Check Host Status Page 

This page displays the status of checks on the selected host.

 

To access ➤ From the Hosts module: 

On the sidebar, under Lab Resources, select Hosts. 
Select a host, and in the information panel, select 
Check Host Status.

➤ From the Host Details dialog box: 

On the sidebar, under Lab Resources, select Hosts. 
Right-click a host and select Host Details. In the Host 
Details dialog box, select Check Host Status.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Check Host Status Details. Opens the Check Host Status 
Details dialog box, enabling you to view each check’s 
details. For field details, see "Check Host Status Fields" on 
page 693.

Refresh. Refreshes the grid so it displays the most 
up-to-date information.

Set Filter/Sort. Enables you to filter and sort the grid. 
Any currently applied filters or sorting orders are 
displayed below the toolbar.For details, see the 
HP Application Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For details, see the HP Application 
Lifecycle Management User Guide.

Find. Opens the Find dialog box, enabling you to search 
for a check. For details, see the HP Application Lifecycle 
Management User Guide.

<Check Host Status 
grid>

Displays the status of the host checks. Click  to select 
columns to display in the grid. For details about the 
fields, see "Check Host Status Fields" on page 693.
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Over Firewall Page 

This page displays communication settings between the load generator host 
and the MI Listener, and enables you to configure advanced over-firewall 
settings for the selected load generator host.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access ➤ From the Hosts module: 

On the sidebar, under Lab Resources, select Hosts. In 
the information panel, select Over Firewall.

➤ From the Host Details dialog box: 

On the sidebar, under Lab Resources, select Hosts. 
Right-click a host and select Host Details. In the Host 
Details dialog box, select Over Firewall.

Important 
information

This page will displays information if the host’s location 
is defined to be over a firewall.

A host over a firewall can be used only as a load generator 
host.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672

UI Elements (A-Z) Description

Connection Timeout 
(seconds)

The length of time the agent should to wait before 
retrying to connect to the MI Listener machine. If zero, 
the connection is kept open from the time the agent is 
run.

Default: 20 seconds

Note: This is a required field.

Connection Type - 
TCP/HTTP

Select either TCP or HTTP, depending on the 
configuration you are using.

Default: TCP
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HTTP HTTP settings for the HTTP connection type:

➤ Proxy Name. The name of the proxy server. This field 
is mandatory if the Connection Type option is set to 
HTTP.

➤ Proxy Port. The proxy server connection port. This 
field is mandatory if the Connection Type option is set 
to HTTP.

➤ Proxy Username. The user name of a user with 
connection rights to the proxy server.

➤ Proxy password. The password of the user with 
connection rights to the proxy server.

➤ Proxy domain. The user’s domain if defined in the 
proxy server configuration. This option is required 
only if NTLM is used.

MI Listener Password The password needed to connect to the MI Listener 
machine.

UI Elements (A-Z) Description
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MI Listener User 
Name 

The user name needed to connect to the MI Listener 
machine.

Use secure 
connection 

Enables connection using the Secure Sockets Layer 
protocol.

Default: Disabled

➤ Check server certificates. Authenticates the SSL 
certificates that are sent by the server. Select Medium 
to verify that the server certificate is signed by a 
trusted Certification Authority. Select High to verify 
that the sender IP matches the certificate information. 
This setting is available only if Use Secure Connection 
is set to True. 

➤ Private Key password. The password that may be 
required during the SSL certificate authentication 
process. This option is relevant only if the Client 
Certificate Owner option is enabled.

➤ Use client certificate. Enable to load the SSL certificate 
(if required by the server to allow the connection to be 
made). This option is relevant only if the Use Secure 
Connection option is enabled.

Default: Disabled

UI Elements (A-Z) Description
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Select Patch to Install Dialog Box

This dialog box enables you to install patches on Performance Center hosts.

 

To access 1  On the Lab Management sidebar, under Lab 
Resources, select Hosts.

2  Right-click the host grid and select Install Patch.

Tip: You can install a patch on multiple hosts 
simultaneously. To select multiple hosts, hold down 
the Ctrl key on your keyboard while selecting the 
hosts.

Important 
information

➤ You can install patches in Lab Management only. 

➤ To install patches on a host, the patches first need to 
have been uploaded to ALM. For details, see "How to 
Upload Patches to ALM" on page 785.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Host Pools Module

This module enables you to view and manage host pools.

 

UI Elements Description

<Patches grid> Displays the patches available in ALM to install on the 
selected host.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access On the Lab Management sidebar, under Lab Resources, 
select Host Pools.

Important 
Information

A host pool is a groups of hosts. Each project has one 
host pool. When managing a host pool, it is important to 
understand the total available resources. The pool must 
contain at least one Controller, one load generator, and 
one data processor. Because hosts can have dual 
functionality, it is recommended that a pool contains, 
among the other hosts, at least one host that can be 
dedicated fully for Controller functionality.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672

UI Elements Description

<Host Pools module 
common UI 
elements>

➤ Host Pools module fields. For field definitions, see 
"Host Pool Fields" on page 693.

➤ Host Pools module menus and buttons. For command 
and button descriptions, see "Lab Resource Module 
Menus and Buttons" on page 685.

<Host Pools grid> Displays a list of the host pools defined in ALM. 

Description tab Describes the currently selected host pool. 

Tip: Right-clicking in this area displays a toolbar for 
formatting and spell checking the text.

Linked Hosts tab Enables you to add hosts to the selected pool and remove 
hosts from the pool. For details, see "Linked Hosts Page" 
on page 720.

History tab Lists changes made to the currently selected host pool. 
For more details, see the HP Application Lifecycle 
Management User Guide.
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New Host Pool Dialog Box

This dialog box enables you to add a host pool to ALM.

 

To access 1  On the Lab Management sidebar, under Lab 
Resources, select Host Pools.

2  In the Host Pools module, click the New Host Pool 
button.

Important 
information

Each project has one host pool which must contain at 
least one Controller, one load generator, and one data 
processor host.

Relevant tasks ➤ "How to Initially Configure Performance Center" on 
page 635

➤ "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Pool Name The name for the new host pool.

Details Required fields are marked with an asterisk (*) and are 
displayed in red. For details on the available host pool 
fields, see "Host Pool Fields" on page 693.
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Host Pool Details Dialog Box

This dialog box displays details about a selected host pool.

 

To access 1  On the Lab Management sidebar, under Lab 
Resources, select Host Pools.

2  Right-click a host pool in the grid and select Host Pool 
Details.

Important 
information

A host pool is a groups of hosts. Each project has one 
host pool. When managing a host pool, it is important to 
understand the total available resources. The pool must 
contain at least one Controller, one load generator, and 
one data processor. Because hosts can have dual 
functionality, it is recommended that a pool contains, 
among the other hosts, at least one host that can be 
dedicated fully for Controller functionality.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of host pools.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Pool Name The name of the host pool.

Details Details the selected host pool. For details on the available 
fields, see "Host Pool Fields" on page 693.

Linked Hosts Enables you to add hosts to the selected pool and remove 
hosts from the pool. For details, see "Linked Hosts Page" 
on page 720.

History Lists changes made to the currently selected host pool. 
For more details, see the HP Application Lifecycle 
Management User Guide.
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Linked Hosts Page 

This page enables you to add hosts to a host pool, and remove hosts from a 
pool.

 

To access ➤ From the Host Pools module: 

On the Lab Management sidebar, under Lab 
Resources, select Host Pools. In the information panel, 
select Linked Hosts.

➤ From the Host Pool Details dialog box: 

On the Lab Management sidebar, under Lab 
Resources, select Host Pools. Right-click a host pool 
and select Host Pool Details. In the Host Pool Details 
dialog box, select Linked Hosts.

Important 
information

The Linked Hosts page enables you to link multiple hosts 
to a host pool.

Alternatively, you can link a single host to multiple host 
pools from the Belongs To Pools field in the host’s 
details. For details, see "Host Fields" on page 689.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Add Hosts to Pool. Opens the Add Hosts to Pool dialog 
box, enabling you to select hosts to add to the host pool. 
For details, see "Add Hosts to Pool Dialog Box" on 
page 722.

Remove Host. Removes the selected hosts from the host 
pool. 

Go to Host. Displays the selected linked host in the Hosts 
module.

Host Details. Opens the Host Details dialog box, enabling 
you to view details about the selected linked host. For 
details, see "Host Details Dialog Box" on page 701. 

Refresh All. Refreshes the grid so it displays the most 
up-to-date information.

Set Filter/Sort. Enables you to filter and sort the grid. 
Any currently applied filters or sorting orders are 
displayed below the toolbar. For details, see the 
HP Application Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For details, see the HP Application 
Lifecycle Management User Guide.

Find. Opens the Find dialog box, enabling you to search 
for a host. For details, see the HP Application Lifecycle 
Management User Guide.

<Linked Hosts grid> Lists the hosts that belong to the host pool. 
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Add Hosts to Pool Dialog Box

This page enables you to select hosts to add to a host pool.

 

To access ➤ From the Host Pools module: 

On the Lab Management sidebar, under Lab Resources, 
select Host Pools. In the information panel, select 
Linked Hosts and click the Add Hosts to Pool  
button.

➤ From the Host Pool Details dialog box: 

On the Lab Management sidebar, under Lab 
Resources, select Host Pools. Right-click a host pool 
and select Host Pool Details. In the Host Pool Details 
dialog box, select Linked Hosts and click the Add Hosts 
to Pool  button.

Important 
information

Alternatively, you can link a single host to multiple host 
pools from the Belongs To Pools field in the host’s 
details. For details, see "Host Fields" on page 689.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672

UI Elements Description

Refresh All. Refreshes the grid so it displays the most 
up-to-date information.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For details, see the HP Application 
Lifecycle Management User Guide.

Set Filter/Sort. Enables you to filter and sort the grid. 
Any currently applied filters or sorting orders are 
displayed below the toolbar. For details, see the 
HP Application Lifecycle Management User Guide.

Adds the selected hosts to the host pool.

<Hosts grid> Lists the hosts available to add to the host pool. 

Selected Displays the hosts selected to add to the pool.



Chapter 34 • Lab Resource Management

724

Locations Module

This module enables you to view and manage host locations.

 

To access On the Lab Management sidebar, under Lab Resources, 
select Locations.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Locations module 
common UI 
elements>

➤ Locations module fields. For field definitions, see 
"Host Location Fields" on page 694.

➤ Locations module menus and buttons. For command 
and button descriptions, see "Lab Resource Module 
Menus and Buttons" on page 685.

<Host Locations 
grid>

Displays a list of the host locations defined in ALM. 

Description tab Describes the currently selected host location. 

Tip: Right-clicking in this area displays a toolbar for 
formatting and spell checking the text.

History tab Lists changes made to the currently selected host 
location. For more details, see the HP Application Lifecycle 
Management User Guide.
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New Host Location Dialog Box

This dialog box enables you to add a host location to ALM.

 

To access 1  On the Lab Management sidebar, under Lab 
Resources, select Locations.

2  In the Host Locations module, click the New Host 
Location button.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Location Name The name for the new host location.

Details Required fields are marked with an asterisk (*) and are 
displayed in red. For details on the available host 
location fields, see "Host Location Fields" on page 694.
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Host Location Details Dialog Box

This dialog box displays details about a selected host location.

 

To access 1  On the Lab Management sidebar, under Lab 
Resources, select Locations.

2  Right-click a location in the grid and select Host 
Location Details.

Important 
information

Host locations must be defined before you can select 
them in a host’s details.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of host locations.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Location ID The ID of the host location.

Location Name The name of the host location.

Details Details the currently selected host location. For details on 
the available fields, see "Host Location Fields" on 
page 694.

History Lists changes made to the currently selected host 
location. For more details, see the HP Application Lifecycle 
Management User Guide.
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MI Listeners Module

This module enables you to view and manage MI Listeners in ALM. 
MI Listeners enable running Vusers over a firewall and collecting server 
monitor data and application diagnostics data over a firewall.

 

To access On the Lab Management sidebar, under Lab Resources, 
select MI Listeners.

Important 
Information

➤ For detailed information about configuring 
Performance Center to work with firewalls, see the 
section about working with firewalls in the HP ALM 
Performance Center Installation Guide.

➤ If an MI Listener is being used by a host, it cannot be 
deleted.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<MI Listeners module 
common UI 
elements>

➤ MI Listeners module fields. For field definitions, see 
"MI Listener Fields" on page 695.

➤ MI Listeners module menus and buttons. For 
command and button descriptions, see "Lab Resource 
Module Menus and Buttons" on page 685.

<MI Listeners grid> Displays a list of the MI Listeners in ALM.

Description tab Describes the currently selected MI Listener.

Tip: Right-clicking in this area displays a toolbar for 
formatting and spell checking the text.

History tab Lists changes made to the currently selected MI Listener. 
For more details, see the HP Application Lifecycle 
Management User Guide.
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New MI Listener Dialog Box

This dialog box enables you to add an MI Listener to ALM.

 

To access 1  On the Lab Management sidebar, under Lab 
Resources, select MI Listeners.

2  In the MI Listeners module, click the New MI Listener 
button.

Important 
information

MI Listeners enable running Vusers over a firewall and 
collecting server monitor data and application 
diagnostics data over a firewall.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

MI Listener Name The name for the new MI Listener.

Details Required fields are marked with an asterisk (*) and are 
displayed in red. For details on the available MI Listener 
fields, see "MI Listener Fields" on page 695.
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MI Listener Details Dialog Box

This dialog box displays details about the selected MI Listener. 

 

To access 1  On the Lab Management sidebar, under Lab 
Resources, select MI Listeners.

2  Right-click an MI Listener in the grid and select 
MI Listener Details.

Important 
information

MI Listeners enable running Vusers over a firewall and 
collecting server monitor data and application 
diagnostics data over a firewall.

Relevant tasks "How to Manage Lab Resources" on page 674

See also "Lab Resources Overview" on page 672
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of MI Listeners.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

MI Listener ID The ID of the MI Listener.

MI Listener Name The name of the MI Listener.

Details Details the currently selected MI Listener. For details on 
the available fields, see "MI Listener Fields" on page 695.

History Lists changes made to the currently selected MI Listener. 
For more details, see the HP Application Lifecycle 
Management User Guide.



Chapter 34 • Lab Resource Management

736

Troubleshooting and Limitations 

This section describes troubleshooting and limitations for lab resources.

➤ Resource Failure. When running a test on the set of allocated hosts, if any 
of the hosts fail, the status of the hosts changes from Operational to 
Non-operational, and an error log describing the problem is sent to the 
Event Log.

You can try to fix the problem according to the description in the error 
log, then change the status back to Operational. If the host is still not 
operational, the status automatically returns to Non-operational in the 
next test run. 

If the Resource Recovery task and the OFW Status Update task (for hosts 
over a firewall) are enable in the Lab Management > System Health > 
Maintenance Tasks tab, Performance Center automatically detects host 
resource failure and attempts to restore the host to the Operational status. 
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35
Test Runs 

This chapter includes:

Concepts

➤ Test Runs Module Overview on page 738

Reference

➤ Test Runs User Interface on page 739
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Concepts

Test Runs Module Overview 

The Test Runs module displays information for all test runs across all 
projects in the system. It enables you to view detailed information relating 
to the run state of the test, the Vusers involved, as well as host and timeslot 
information. You can also drilldown and view details of specific events for 
each test via the Event Log. 
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Reference

Test Runs User Interface 

This section includes:

 ➤ Test Runs Module Window on page 740

 ➤ Test Runs Module Fields on page 741

 ➤ Test Runs Module Menus and Buttons on page 743

 ➤ Run Details Dialog Box on page 746
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Test Runs Module Window

This module displays information for individual test runs across all projects 
in the system.

 

To access On the Lab Management sidebar, under Lab Usage, select 
Test Runs.

Relevant tasks "How to Manage a Performance Test Run" on page 340
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Test Runs Module Fields

The following fields are available in the Test Runs module:

UI Elements (A-Z) Description

<Test Runs module 
common UI 
elements>

➤ Test Runs module fields. For field definitions, see "Test 
Runs Module Fields" on page 741.

➤ Test Runs module menus and buttons. For command 
and button descriptions, see "Test Runs Module Menus 
and Buttons" on page 743.

➤ ALM main menu and sidebar. For details on the Tools 
menu, Help menu and sidebar, see the HP Application 
Lifecycle Management User Guide.

<Test Runs grid> Displays a list of test runs across all projects, displaying 
detailed information for each test run.

<Information panel> Located in the lower area of the module. Displays the 
Event Log tab. For more information, see "Initializing 
Run Page" on page 348.

Field Description

Average Vusers The average number of concurrently running Vusers 
during the run.

Controller The Controller involved in the test run.

Domain/Project The test’s domain and project 

Duration The time, in minutes, that the test took to run.

Note: You should not manually edit this field.

End Date The end date of the run.

Note: You should not manually edit this field.
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Exec date The start date of the run.

Note: You should not manually edit this field.

Exec time The start time of the run.

Note: You should not manually edit this field.

Involved Vusers The number of Vusers that were intitialized at least once 
during the run.

Load Generators The load generators involved in the test run.

Max Vusers The maximum number of concurrently running Vusers 
during the run.

Project ID The test’s project ID.

Run ID The identification number of the test run. This number is 
automatically generated by the system when the load test 
starts running

Run Name The test run name.

Run State The state of the test run. If a test is stuck in a particular 
state, you can change it.

Temp Results 
Directory Path

The path of the directory where the test results are 
temporarily stored.

Test Name The name given to the test when it was created.

Tester The name of the user running the test.

Consume VUDs The number of VUDs used in the test run.

Timeslot ID The ID of the test run timeslot.

Field Description
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Test Runs Module Menus and Buttons

This section describes the menus and buttons available in the Test Runs 
module.

Common menus and toolbars of the Test Runs module are described below: 

To access On the Lab Management sidebar, under Lab Usage, select 
Test Runs.

UI Elements (A-Z) Where Description

Abort Run <right-click 
menu>

Stops a currently running 
performance test.

Note: Only enabled when the 
selected test run is in the Initializing, 
Running or Stopping states.

Add to Favorites Favorites Opens the Add Favorite dialog box, 
enabling you to add a favorite view 
to your private or the public folder. 
For details, see the HP Application 
Lifecycle Management User Guide.

Copy URL Runs and 
<right-click 
menu>

Copies a selected test run and pastes 
its URL as a link. The test run itself is 
not copied. Instead, you can paste 
the address into another location, 
such as an email or a document. 
Clicking the link opens up ALM and 
takes you to the test run file or 
folder. If you are not already logged 
in, ALM first prompts for login 
details.

Delete Edit and 
<right-click 
menu>

Deletes the selected test run. 

Note: Only enables when the 
selected test run is not in one of the 
active states.
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DP Queue <right-click 
menu>

If you analyze a test run after it has 
run, or recalculate the SLA, or add 
the test run to a trend report, then 
the action is added to a data 
processing queue, enabling you to 
see when the action will be 
performed.

Find View Opens the Find dialog box, enabling 
you to search for test runs in the 
module. For details about search 
options, see the HP Application 
Lifecycle Management User Guide.

Go to Run Runs Opens the Go To Run dialog box, 
enabling you to find a specific test 
run by its ID number. You can only 
go to test runs that are in the current 
filter.

Go to Timeslot <right-click 
menu>

Opens the Timeslots module, 
displaying the timeslot for the 
selected test run.

Grid Filters View and 
<right-click 
menu>

Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Information Panel View and 
<right-click 
menu>

Shows/Hides the Information Panel 
in the lower area of the module. 

Organize Favorites Favorites Opens the Organize Favorites dialog 
box, enabling you to organize the 
list of favorite views by changing 
properties or deleting views. For 
details, see the HP Application 
Lifecycle Management User Guide.

UI Elements (A-Z) Where Description
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Private Favorites Lists the favorite views that are 
accessible only to the user who 
created them.

Public Favorites Lists the favorite views that are 
accessible to all users.

Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

Run Details Runs and 
<right-click 
menu>

Opens the Run Details dialog box, 
enabling you to view and edit details 
of the selected test run. 

Run Screen <right-click 
menu>

Opens the Performance Test Run 
screen, enabling you to view and 
manage the test run. For more 
information, see "Performance Test 
Run Page" on page 358.

Note: Only enabled when test run is 
in the Running state.

Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For more details, see 
the HP Application Lifecycle 
Management User Guide.

For details about the test run fields, 
see "Test Runs Module Fields" on 
page 741.

Set Filter/Sort View Enables you to filter and sort the test 
runs in the grid. Any currently 
applied filters or sorting orders are 
displayed below the toolbar. For 
more details, see the HP Application 
Lifecycle Management User Guide.

UI Elements (A-Z) Where Description
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Run Details Dialog Box 

This dialog box displays test run details.

 

To access 1  On the Lab Management sidebar, under Lab Settings, 
select Lab Usage. 

2  Right-click a test run in the grid, and select 
Run Details.

Relevant task "How to Manage a Performance Test Run" on page 340
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User interface elements are described below:

UI Elements (A-Z) Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of projects.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Details Displays the details of the selected test run. For more 
details, see "Test Runs Module Fields" on page 741.

Event Log Lists the events that occurred during the selected test 
run. For more details, see "Event Log" on page 351.

History Lists changes made to the selected test run. For more 
details, see the HP Application Lifecycle Management User 
Guide.
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36
Usage Reports

This chapter includes:

Concepts

➤ Usage Reports Overview on page 750

Tasks

➤ How to View Reports and Set Report Filter Criteria on page 751

➤ How to Export Reports to PDF or Excel Formats on page 752

Reference

➤ Usage Report Time Frames on page 753

➤ Usage Reports User Interface on page 754

Troubleshooting and Limitations on page 782
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Concepts

Usage Reports Overview 

The ALM Performance Center Usage Reports provide you with an overall 
analysis of Performance Center site users, resource usage, concurrent 
resource usage vs. license limitations, timeslot usage, as well as resource 
usage by duration and runs.

The following table provides a description of each report:

For information about how to view the reports, see "How to View Reports 
and Set Report Filter Criteria" on page 751.

Report Description

Resource Summary Provides aggregate data regarding the way projects 
used the various resources of the system.

Concurrency vs. License Provides details of concurrent resource usage per 
project, as well as information regarding how 
system resources were used within license 
limitations.

Timeslot Usage Provides information about the reservation and 
usage of resources associated with timeslots.

Resource by Duration Provides general information about the usage of 
your system resources over the selected time frame. 
You can view statistics for total usage by project, or 
per user within a project. 

Resource by Runs Provides general information about the test runs. 
You can view statistics for total usage by project, or 
per user within a project.

VUDs License Usage per 
Project

Provides information about VUD usage per day for 
each selected project.

Daily VUDs License Usage Provides information about VUD usage per day, 
aggregated across all projects.
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Tasks

How to View Reports and Set Report Filter Criteria 

This task describes how to view the Usage Reports and how to set their filter 
criteria. The filter criteria defines which projects are to be included in the 
reports and over which time frame to display results.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

To learn more about ALM Performance Center reports, see "Usage Reports 
Overview" on page 750.

 1 Select the desired report to view

In Lab Management, select Lab Usage > Usage Reports to view the ALM 
Performance Center reports tree. From the tree, select the desired report 
to view. 

For a description of each report’s user interface elements, see "Usage 
Reports User Interface" on page 754.

 2 Filter the projects to include in the report

Perform the following steps:

 a Click the Select Projects button adjacent to the Projects box.

 b In the Project Selection dialog box, use the arrow buttons to select 
single or multiple projects from the Available projects list.

Note: You must select at least one project to generate a report.
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 3 Select the desired time range for the report

Select the desired time frame for the report from the Time Frame drop 
down list. In addition to the given options, you can set a custom time 
frame.

For an explanation of the given time frames, see "Usage Report Time 
Frames" on page 753.

 4 Update the report to reflect the new filter settings

Click Generate. The report displays the information for the selected 
projects and time frame.

How to Export Reports to PDF or Excel Formats 

The following task describes how to export a Performance Center report to 
either PDF or Excel format.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

Export a report to PDF

➤ To export a report to a PDF file, click the Export to PDF icon in the upper 
right corner of the report.

Export a report to an editable Excel file

➤ To export a report to an editable Excel file, click the Export to Excel icon 
in the upper right corner of the report.
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Usage Report Time Frames

The following table provides an explanation of the time frames available for 
report selection.

Time Frame Explanation

Today From 00.00 to 23.59 of the current day

Yesterday From 00.00 to 23.59 of the previous day

This week From Monday to Sunday of the current week

Previous week From Monday to Sunday of the previous week

This month From beginning to end of the current calendar 
month

Previous month From beginning to end of the previous calendar 
month

This quarter The current quarter

Previous quarter The previous quarter

This year From January to December of the current year

Previous year From January to December of the previous year
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Usage Reports User Interface 

This section includes:

 ➤ Project Selection Dialog Box on page 754

 ➤ Concurrency vs. License Report on page 756

 ➤ Resource Summary Report on page 764

 ➤ Timeslot Usage Report on page 767

 ➤ Resource by Duration Report on page 771

 ➤ Resource Usage by Runs Report on page 775

 ➤ VUDs License Usage per Project Report on page 778

 ➤ Daily VUDs License Usage Report on page 781

Project Selection Dialog Box 

This dialog box enables you to select projects to be included in the reports.

To access In any of the reports, click the Select Projects button  
adjacent to the Projects box.

Important 
information

At least one project must be selected in order to generate 
a report.

Relevant tasks "How to View Reports and Set Report Filter Criteria" on 
page 751
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Filters the Available projects list. The filter supports 
partial text entries.

Click to select or deselect individual projects respectively.

Click to select or deselect all projects respectively.

Available projects list Projects that are available for selection.

Selected projects list The projects that have already been selected.

Default: All the available projects are automatically 
selected.
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Concurrency vs. License Report 

The Concurrency vs. License Report provides details of concurrent resource 
usage per project, as well as information regarding how system resources 
were used within license limitations.

User interface elements are described below:

To access 1  Select Lab Reports > Usage Reports

2  In the list of Usage Reports, select 
Concurrency vs. License

Relevant tasks "How to View Reports and Set Report Filter Criteria" on 
page 751

UI Elements (A-Z) Description

Export to PDF/Excel. Click to export the report to PDF or 
Excel format.

Generates the report.
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Concurrency by 
Project tab

Contains a table that displays concurrent resource usage 
information for each selected project. 

For more information, see "Concurrency by Project 
Table" on page 758.

Filter by: Projects Click the browse button by this field to select which 
project to include in the report.

Filter by: Time Frame Select the desired time frame for the report. For an 
explanation of the given time frames, see "Usage Report 
Time Frames" on page 753.

Overall Concurrency 
tab

Contains a table that displays concurrent resource usage 
information aggregated over all selected projects, as well 
as aggregated over all projects in the system. 

For more information, see "Overall Concurrency Table" 
below.

Overall License 
Usage tab

Contains a graph that displays maximum and average 
Runs and Vuser usage as a percentage of the Performance 
Center license limitations, allowing the administrator to 
determine the percentage of the Performance Center 
license that is actually used.

The usage is aggregated over all selected projects, as well 
as aggregated over all projects in the system.

For more information, see "Overall License Usage Graph" 
below.

UI Elements (A-Z) Description
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Concurrency by Project Table

User interface elements are described below:

Top Projects by Runs 
tab

Contains a graph that displays the maximum and 
average number of concurrent runs per project as a 
percentage of the project limit, which is defined in the 
project settings (Lab Settings > Project Settings). This 
helps the administrator identify those projects that run 
most efficiently within their given limitations.

For more information, see "Top Projects by Runs Graph" 
below.

Top Projects by 
Vusers tab

Contains a graph that displays the maximum and 
average number of concurrent running Vusers per project 
as a percentage of the project limit, which is defined in 
the project settings (Lab Settings > Project Settings). This 
helps the administrator identify those projects that run 
most efficiently within their given limitations.

For more information, see "Top projects by Vusers Graph" 
below.

Important 
Information

You can sort the table according to the values of any 
column. The arrow in the heading displays whether the 
column is sorted in ascending or descending order. Click 
the column heading to reverse the order.

UI Elements (A-Z) Description

Concurrent 
Machines - Avg

The average number of concurrent running machines 
(controllers and load generators) in all of the project’s 
concurrent test runs.

Concurrent 
Machines - Limit

The maximum number of concurrent running machines 
allowed for this project as defined in the project settings 
(Lab Settings > Project Settings).

UI Elements (A-Z) Description
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Concurrent 
Machines - Max

The maximum number of concurrent running machines 
(controllers and load generators) in all of the project’s 
concurrent test runs.

Concurrent Runs - 
Avg

The average number of concurrent test runs for the 
project. For the purposes of this report, a single test run is 
considered a concurrent run.

Concurrent Runs - 
Limit

The maximum number of concurrent runs allowed for 
this project as defined in the project settings (Lab 
Settings > Project Settings). For the purposes of this 
report, a single test run is considered a concurrent run.

Concurrent Runs - 
Max

 The maximum number of concurrent test runs for the 
project. For the purposes of this report, a single test run is 
considered a concurrent run.

Concurrent Vusers - 
Avg

The average number of concurrent running Vusers in all 
of the project’s concurrent test runs.

Concurrent Vusers - 
Limit

The maximum number of concurrent running Vusers 
allowed for this project as defined in the project settings 
(Lab Settings > Project Settings).

Concurrent Vusers - 
Max

The maximum number of concurrent running Vusers in 
all of the project’s concurrent test runs.

Overall Duration The total time tests were run in the project. This value 
shows the actual amount of time the system was used to 
run load tests, and not concurrent duration.

Project The project name. Deleted projects are also included in 
the report and are indicated with a red x.

UI Elements (A-Z) Description
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Overall Concurrency Table

User interface elements are described below:

Important 
Information

You can sort the table according to the values of any 
column. The arrow in the heading displays whether the 
column is sorted in ascending or descending order. Click 
the column heading to reverse the order.

UI Elements(A-Z) Description

Concurrent Machines 
Avg

The average number of concurrent running machines.

Concurrent Machines 
Max

The maximum number of concurrent running machines. 

Concurrent Runs Avg 
(License %)

The average number of concurrent runs. The value in 
brackets is the average number of concurrent runs as a 
percentage of the Performance Center license.

Concurrent Runs 
Max (License %)

The maximum number of concurrent runs. The value in 
brackets is the maximum number of concurrent runs as a 
percentage of the Performance Center license.

Concurrent Runs PC 
License

The maximum number of concurrent runs allowed by 
the Performance Center license.

Concurrent Vusers 
Avg (License %)

 The average number of concurrent running Vusers. The 
value in brackets is the average number of concurrent 
running Vusers as a percentage of the project 
Performance Center license.

Concurrent Vusers 
Max (License %)

The maximum number of concurrent running Vusers. 
The value in brackets is the maximum number of 
concurrent running Vusers as a percentage of the 
Performance Center license.

Concurrent Vusers 
PC License 

The maximum number of concurrent running Vusers 
allowed by the Performance Center license.

Overall Duration The total time tests were run aggregated over all the 
projects.

Project All Projects or Selected Projects.
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Overall License Usage Graph

Example

In the following example the maximum number of Vusers for all projects in 
the system used just 30.1% of the Performance Center license, while the 
average number of Vusers for all projects used just 3.6% of the license. This 
tells the administrator that a significant portion of the Performance Center 
license is not being used.

X-axis Maximum and average percentage of Performance Center 
license being used.

Y-axis Vuser and runs usage aggregated over all projects as well 
as only selected projects.
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Top Projects by Runs Graph

Example

In the following example the Max - Runs value for the project LR_pro is 
30%. This means that the maximum number of concurrent runs for this 
project reached 30% of its limit. The Avg - Runs value for this project shows 
that the average number of concurrent runs reached 12.7% of its limit. 
These values tell the administrator that a significant portion of the project’s 
defined limit of concurrent runs is not being utilized.

Important 
Information

In most circumstances, the graph displays information 
for up to ten selected projects. If there is more than one 
selected project with the same number of maximum 
concurrent runs, all these projects are displayed. In that 
case, more than ten projects might be displayed.

X-axis Maximum and average percentage of allowed concurrent 
runs being used

Y-axis Projects displayed in descending order according to the 
maximum number of concurrent runs.
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Top projects by Vusers Graph

Example

In the following example, the Max - Vusers value for the project proj1 is 
10%. This means that the maximum number of concurrent running Vusers 
for this project reached 10% of its limit. The Avg - Vusers value for this 
project shows that the average number of concurrent running Vusers 
reached 8.4% of its limit. These values tell the administrator that a 
significant portion of the project’s defined limit of concurrent running 
Vusers is not being utilized.

Important 
Information

In most circumstances, the graph displays information 
for up to ten selected projects. If there is more than one 
selected project with the same number of maximum 
concurrent runs, all these projects are displayed. In that 
case, more than ten projects might be displayed.

X-axis Maximum and average percentage of allowed concurrent 
running Vusers being used

Y-axis Projects displayed in descending order according to the 
maximum number of concurrent running Vusers.
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Resource Summary Report 

The Resource Summary Report provides aggregate data regarding the way 
projects used the various resources of the system.

User interface elements are described below:

To access 1  Select Lab Reports > Usage Reports

2  In the list of Usage Reports, select Resource Summary

Relevant tasks "How to View Reports and Set Report Filter Criteria" on 
page 751

UI Elements (A-Z) Description

Export to PDF/Excel. Click to export the report to PDF or 
Excel format.

Generates the report.

Filter by: Projects Click the browse button by this field to select which 
project to include in the report.

Filter by: Time Frame Select the desired time frame for the report. For an 
explanation of the given time frames, see "Usage Report 
Time Frames" on page 753.
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Resource Usage by 
Project tab

Contains a table that provides resource usage 
information for each selected project.

For more information, see "Resource Usage by Project 
Table" below.

Top Projects by 
Machines tab

Contains a graph which displays the number of 
machines used per project, aggregated over all the runs.

X-axis. The number of machines used per project.

Y-axis. Projects displayed in descending order according 
to the number of machines used.

Important information. In most circumstances, the graph 
displays information for up to ten selected projects. If 
there is more than one selected project with the same 
number of maximum concurrent runs, all these projects 
are displayed. In that case, more than ten projects might 
be displayed.

Top Projects by Runs 
tab

Contains a graph that displays the number of test runs 
per project.

X-axis. The number of test runs per project.

Y-axis. Projects displayed in descending order according 
to the number of test runs.

Important information. In most circumstances, the graph 
displays information for up to ten selected projects. If 
there is more than one selected project with the same 
number of maximum concurrent runs, all these projects 
are displayed. In that case, more than ten projects might 
be displayed.

Top Projects by 
Vusers tab

Contains a graph that displays the number of Vusers per 
project, aggregated over all the runs.

X-axis. The number of Vusers per project.

Y-axis. Projects displayed in descending order according 
to the number of Vusers.

UI Elements (A-Z) Description
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Resource Usage by Project Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

You can sort the table according to the values of any 
column. The arrow in the heading displays whether the 
column is sorted in ascending or descending order. Click 
the column heading to reverse the order.

UI Elements (A-Z) Description

Duration The total time tests were run in the project.

Machines The total number of machines that were used in the 
project, aggregated over all the runs.

Project The project name. Deleted projects are also included in 
the report and are indicated by a red x.

Runs The total number of test runs in the project, aggregated 
over all the tests.

Vusers The total number of Vusers in the project, aggregated 
over all the runs.
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Timeslot Usage Report 

The Timeslot Usage Report provides information about the reservation and 
usage of resources associated with timeslots.

To access 1  Select Lab Reports > Usage Reports

2  In the list of Usage Reports, select Timeslot Usage

Relevant tasks "How to View Reports and Set Report Filter Criteria" on 
page 751
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User interface elements are described below:

UI Elements (A-Z) Description

Export to PDF/Excel. Click to export the report to PDF or 
Excel format.

Generates the report.

Filter by: Projects Click the browse button by this field to select which 
project to include in the report.

Filter by: Time Frame Select the desired time frame for the report. For an 
explanation of the given time frames, see "Usage Report 
Time Frames" on page 753.

Timeslot Usage by 
Project tab

Contains a table that displays reservation and usage 
information for duration, machines, and Vusers per 
project.

For more information, see "Timeslot Usage by Project 
Table" on page 770.

Top Projects by 
Duration Usage tab

Contains a graph that displays reservation and usage 
information for timeslot duration per project. It allows 
the administrator to see which projects most efficiently 
use their reserved duration.

X-axis. The total amount of reserved and used duration 
for each project.

Y-axis. Projects displayed in descending order according 
to their duration usage.

Important information. In most circumstances, the graph 
displays information for up to ten selected projects. If 
there is more than one selected project with the same 
number of maximum concurrent runs, all these projects 
are displayed. In that case, more than ten projects might 
be displayed.
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Top Projects by 
Machines Usage tab

Contains a graph that displays reservation and usage 
information for timeslot machines per project. It allows 
the administrator to see which projects most efficiently 
use their reserved number of machines.

X-axis. The total amount of reserved and used machines 
for each project.

Y-axis. Projects displayed in descending order according 
to their Vusers usage.

Important information. In most circumstances, the graph 
displays information for up to ten selected projects. If 
there is more than one selected project with the same 
number of maximum concurrent runs, all these projects 
are displayed. In that case, more than ten projects might 
be displayed.

Top Projects by 
Vusers Usage tab

Contains a graph that displays reservation and usage 
information for timeslot Vusers per project. It allows the 
administrator to see which projects most efficiently use 
their reserved number of Vusers.

X-axis. The total amount of reserved and used Vusers for 
each project.

Y-axis. Projects displayed in descending order according 
to their machines usage.

Important information. In most circumstances, the graph 
displays information for up to ten selected projects. If 
there is more than one selected project with the same 
number of maximum concurrent runs, all these projects 
are displayed. In that case, more than ten projects might 
be displayed.

UI Elements (A-Z) Description
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Timeslot Usage by Project Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

You can sort the table according to the values of any 
column. The arrow in the heading displays whether the 
column is sorted in ascending or descending order. Click 
the column heading to reverse the order.

UI Elements (A-Z) Description

Duration Reserved The amount of time reserved for the project.

Duration Used The amount of time used within the project.

Machines Reserved The number of machines reserved for the project.

Machines Used The number of machines used in the project.

Project The project name. Deleted projects are also included in 
the report and are indicated by a red x.

Vusers Reserved The number of Vusers reserved for the project.

Vusers Used The number of Vusers used in the project.
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Resource by Duration Report 

The Resource by Duration Report provides general information about the 
usage of your system resources over the selected time frame. You can view 
statistics for total usage by project, or per user within a project. 

To access 1  Select Lab Reports > Usage Reports

2  In the list of Usage Reports, select 
Resource Usage by Duration

Relevant tasks "How to View Reports and Set Report Filter Criteria" on 
page 751
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User interface elements are described below:

UI Elements (A-Z) Description

Export to PDF/Excel. Click to export the report to PDF or 
Excel format.

Generates the report.

Filter by: Projects Click the browse button by this field to select which 
project to include in the report.

Filter by: Time Frame Select the desired time frame for the report. For an 
explanation of the given time frames, see "Usage Report 
Time Frames" on page 753.

Resource Usage by 
Project tab

Contains a table that displays resource usage per project 
over the selected time frame.

For more information, see "Resource Usage by Project 
Table" below.

Resource Usage by 
User tab

Contains a table that displays resource usage per user.

For more information, see "Resource Usage by User Table" 
below.
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Resource Usage by Project Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

You can sort the table according to the values of any 
column. The arrow in the heading displays whether the 
column is sorted in ascending or descending order. Click 
the column heading to reverse the order.

UI Elements (A-Z) Description

Avg Machines per 
Active Hour

The average number of machines used per active hour.

Note: An active hour refers to the actual running time of 
your tests within the selected time frame.

Avg Vusers per Active 
Hour

The average number of running Vusers per active hour.

Note: An active hour refers to the actual running time of 
your tests within the selected time frame.

Project The project name. Deleted projects are also included in 
the report and are indicated by a red x.

Total Active Duration The total time tests were run during reserved timeslots.

Note: Active Duration refers to the actual running time 
of your tests within the selected time frame.

Total Reserved 
Duration

The total time reserved, in the Timeslots page, by the 
project.
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Resource Usage by User Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ Only users with privileges in the selected projects are 
shown.

➤ You can sort the table according to the values of any 
column. The arrow in the heading displays whether 
the column is sorted in ascending or descending order. 
Click the column heading to reverse the order.

UI Elements (A-Z) Description

Avg Hosts per Active 
Hour

The average number of hosts used per active hour.

Note: An active hour refers to the actual running time of 
your tests within the selected time frame.

Avg Vusers per Active 
Hour

The average number of running Vusers per active hour.

Note: An active hour refers to the actual running time of 
your tests within the selected time frame.

Full Name The name of the user. Deleted users are also included in 
the report.

Total Active Duration The total time tests were run during reserved timeslots.

Note: Active Duration refers to the actual running time 
of your tests within the selected time frame.

Total Reserved 
Duration

The total time reserved, in the Timeslots page, by the 
user.
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Resource Usage by Runs Report 

The Resource Usage by Runs Report provides general information about the 
test runs. You can view statistics for total usage by project, or per user within 
a project.

User interface elements are described below:

To access 1  Select Lab Reports > Usage Reports

2  In the list of Usage Reports, select 
Resource Usage by Runs

Relevant tasks "How to View Reports and Set Report Filter Criteria" on 
page 751

UI Elements (A-Z) Description

Export to PDF/Excel. Click to export the report to PDF or 
Excel format.

Generates the report.

Filter by: Projects Click the browse button by this field to select which 
project to include in the report.
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Resource Usage by Project Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Filter by: Time Frame Select the desired time frame for the report. For an 
explanation of the given time frames, see "Usage Report 
Time Frames" on page 753.

Resource Usage by 
Project tab

Contains a table that displays test run statistics per 
project over the selected time frame.

For more information, see "Resource Usage by Project 
Table" below.

Resource Usage by 
User tab

Contains a table that displays test run statistics per user.

For more information, see "Resource Usage by User Table" 
below.

Important 
information

➤ Details of all runs with any amount of duration, even 
retries of a single run, are included in the table.

➤ You can sort the table according to the values of any 
column. The arrow in the heading displays whether 
the column is sorted in ascending or descending order. 
Click the column heading to reverse the order.

UI Elements (A-Z) Description

Avg Duration per 
Run

The average time used for the listed runs.

Avg Machines per 
Run

The average number of machines used per run.

Avg Vusers per Run  The average number of Vusers used per run.

Project The project name. Deleted projects are also included in 
the report and are indicated by a red x.

Total Duration The total time used by the listed runs.

UI Elements (A-Z) Description
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Resource Usage by User Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Total Runs The total number of runs in the project.

Total Vusers Involved The total number of Vusers in the project.

Important 
information

➤ Runs of users that have been deleted from the system, 
or who no longer have any privileges, are also 
included in the table.

➤ Details of all runs with any amount of duration, even 
retries of a single run, are included in the table.

➤ You can sort the table according to the values of any 
column. The arrow in the heading displays whether 
the column is sorted in ascending or descending order. 
Click the column heading to reverse the order.

UI Elements (A-Z) Description

Avg Duration per 
Run

The average time used for the listed runs.

Avg Machines per 
Run

The average number of machines used per run.

Avg Vusers per Run The average number of Vusers used per run.

Full Name The name of the user. Deleted users are also included in 
the report.

Total Duration The total time used by the listed runs.

Total Runs The total number of runs associated with the user.

Total Vusers Involved The total number of Vusers associated with the user.

UI Elements (A-Z) Description
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VUDs License Usage per Project Report

The VUDs License Usage per Project Report provides information about 
VUD usage per day for each selected project.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Lab Reports > Usage Reports

2  In the list of Usage Reports, select 
VUDs License Project Usage

Relevant tasks "How to View Reports and Set Report Filter Criteria" on 
page 751

UI Elements (A-Z) Description

Export to PDF/Excel. Click to export the report to PDF or 
Excel format.

Generates the report.

Filter by: Projects Click the browse button by this field to select which 
project to include in the report.

Filter by: Time Frame Select the desired time frame for the report. For an 
explanation of the given time frames, see "Usage Report 
Time Frames" on page 753.

VUDs per Project tab Contains a table that provides information about daily 
VUD usage per selected project. For more information see 
"VUDs per Project Table" below.

VUDs Transactions 
tab

Contains a table that provides information about VUDs 
per transactions. For more information, see "VUDs 
Transactions Table" on page 780.
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VUDs per Project Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ Details of all runs with any amount of duration, even 
retries of a single run, are included in the table.

➤ You can sort the table according to the values of any 
column. The arrow in the heading displays whether 
the column is sorted in ascending or descending order. 
Click the column heading to reverse the order.

UI Elements (A-Z) Description

Allocated The amount of VUDs that were allocated to the project at 
the start of the day.

Consumed The amount of VUDs that were consumed during the 
day.

Date The date for which VUD usage information is shown.

New Value The amount of VUDs that were remaining at the end of 
the day.

Project The name of the project.
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VUDs Transactions Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ Details of all runs with any amount of duration, even 
retries of a single run, are included in the table.

➤ You can sort the table according to the values of any 
column. The arrow in the heading displays whether 
the column is sorted in ascending or descending order. 
Click the column heading to reverse the order.

UI Elements (A-Z) Description

Action The current state of the VUDs.

Date The date for which VUD information is displayed.

In Use The number of VUDs that are currently running. 

New VUDs Limit The number of VUDs that are currently available to the 
project.

Pending The number of VUDs that are available for running.

Project The project name. Deleted projects are also included in 
the report and are indicated by a red x.

Run ID The run ID.

Test Name The performance test name.

Unique ID A unique ID that identifies VUDs from their issue to their 
expiration.

User The user that performed the transaction. 

Value The amount of VUDs that are in the state indicated in 
the Action column.
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Daily VUDs License Usage Report 

The Daily VUDs License Usage Report provides overall VUD usage 
information aggregated for all projects for a specific day.

User interface elements are described below:

To access 1  Select Lab Reports > Usage Reports

2  In the list of Usage Reports, select 
Daily VUDs License Site Usage

Relevant tasks "How to View Reports and Set Report Filter Criteria" on 
page 751

UI Elements (A-Z) Description

Export to PDF/Excel. Click to export the report to PDF or 
Excel format.

Generates the report.

Daily VUDs Usage 
tab

Contains a table that displays daily VUD usage 
information. For more information, see "Daily VUDs 
Usage Table" below.

Filter by: Time Frame Select the desired time frame for the report. For an 
explanation of the given time frames, see "Usage Report 
Time Frames" on page 753.
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Daily VUDs Usage Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Troubleshooting and Limitations 

When viewing the Usage reports in a resolution of 1024x768, to see all user 
interface controls, collapse the ALM modules and/or the reports selection 
tree.

Important 
information

➤ Details of all runs with any amount of duration, even 
retries of a single run, are included in the table.

➤ You can sort the table according to the values of any 
column. The arrow in the heading displays whether 
the column is sorted in ascending or descending order. 
Click the column heading to reverse the order.

UI Elements (A-Z) Description

Added The amount of VUDs that were added on the day.

Consumed The amount of VUDs that were used on the day.

Date The date for which VUD usage information is shown.

New Value The amount of VUDs that were remaining at the end of 
the day.
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37
Patch Management

This chapter includes:

Concepts

➤ Patches Overview on page 784

Tasks

➤ How to Upload Patches to ALM on page 785

Reference

➤ Patch Management User Interface on page 786
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Concepts

Patches Overview 

ALM Performance Center allows you to upload a patch to the system and to 
then install the patch on the appropriate host or server.
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Tasks

How to Upload Patches to ALM

This task describes how to upload patches to ALM Performance Center.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

To upload a patch:

 1 On the Lab Management sidebar, under Lab Settings, select Patches.

 2 Click the New Patch button. The Select Patch dialog box opens, enabling 
you to select a patch (.msp/.msi) to upload.

 3 Click Open. The New Patch dialog box opens.

 4 Enter the details for the new patch and click OK. The patch is added to 
the system and appears in the Patches grid.
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Reference

Patch Management User Interface 

This section includes:

 ➤ Patches Module Window on page 787

 ➤ Patches Module Fields on page 788

 ➤ Patches Module Menus and Buttons on page 789

 ➤ Patch Details Dialog Box on page 792
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Patches Module Window

This module enables you to view and upload patches.

 

To access On the Lab Management sidebar, under Lab Settings, 
select Patches.

Relevant tasks "How to Upload Patches to ALM" on page 785

See also ➤ "How to Manage Lab Resources" on page 674

➤ "How to Manage Performance Center Servers" on 
page 799
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Patches Module Fields 

This section describes the Patches module fields:

UI Elements (A-Z) Description

<Information panel> Located in the lower area of the module. Displays a 
description about the patch selected in the grid.

<Patches grid> Displays a list of the patches that have been uploaded to 
ALM Performance Center.

<Patches module 
common UI 
elements>

➤ Patches module fields. For field definitions, see 
"Patches Module Fields" on page 788.

➤ Patches module menus and buttons. For command 
and button descriptions, see "Patches Module Menus 
and Buttons" on page 789.

➤ ALM main menu and sidebar. For details on the Tools 
menu, Help menu and sidebar, see the HP Application 
Lifecycle Management User Guide.

Field Description

Description Displays a description of the selected patch.

ID The patch ID.

Name The patch name.

Path The patch path. 
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Patches Module Menus and Buttons

This section describes the menus and buttons available in the Patches 
module.

User interface elements are described below: 

To access On the Lab Management sidebar, under Lab Settings, 
select Patches.

UI Elements (A-Z) Where Description

Add to Favorites Favorites Opens the Add Favorite dialog box, 
enabling you to add a favorite view 
to your private or the public folder. 
For details, see the HP Application 
Lifecycle Management User Guide.

Copy URL Patches and 
<right-click 
menu>

Copies a selected patch and pastes 
its URL as a link. The patch itself is 
not copied. Instead, you can paste 
the address into another location, 
such as an email or a document. 
Clicking the link opens up ALM and 
takes you to the patch file or folder. 
If you are not already logged in, 
ALM first prompts for login details.

Export Patches and 
<right-click 
menu>

Opens the Export Grid Data dialog 
box, enabling you to export the 
patches in the grid as a text file, 
Microsoft Excel worksheet, 
Microsoft Word document, or HTML 
document. 

Choose one of the following 
options: 

➤ All. Exports all project settings in 
the grid. 

➤ Selected. Exports selected project 
settings in the grid.
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Find View Opens the Find dialog box, enabling 
you to search for patches in the 
module. For details about search 
options, see the HP Application 
Lifecycle Management User Guide.

Go to Patch Patches Opens the Go To Patch dialog box, 
enabling you to find a specific patch 
by its ID number. You can only go to 
patches that are in the current filter.

Grid Filters View and 
<right-click 
menu>

Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Information Panel View and 
<right-click 
menu>

Shows/Hides the Information Panel 
in the lower area of the module. 

New Patch Patches Opens the Select Patch dialog box, 
which enables you to select a patch 
to upload.

Organize Favorites Favorites Opens the Organize Favorites dialog 
box, enabling you to organize the 
list of favorite views by changing 
properties or deleting views. For 
details, see the HP Application 
Lifecycle Management User Guide.

Patch Details Patches and 
<right-click 
menu>

Opens the Patch Details dialog box, 
enabling you to view and edit details 
of the selected patch. 

Private Favorites Lists the favorite views that are 
accessible only to the user who 
created them.

Public Favorites Lists the favorite views that are 
accessible to all users.

UI Elements (A-Z) Where Description
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Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

Replace Edit and 
<right-click 
menu>

In the Project Details grid, opens the 
Replace dialog box, enabling you to 
replace a field value in the grid. For 
more details, see the HP Application 
Lifecycle Management User Guide. 

Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For more details, see 
the HP Application Lifecycle 
Management User Guide.

For details about the patches fields, 
see "Patches Module Fields" on 
page 788.

Set Filter/Sort View Enables you to filter and sort the 
patches in the grid. Any currently 
applied filters or sorting orders are 
displayed below the toolbar. For 
more details, see the HP Application 
Lifecycle Management User Guide.

Updated Selected Edit and 
<right-click 
menu>

Opens the Update Selected dialog 
box, enabling you to update a field 
value for a multiple selection in the 
grid. For more details, see the 
HP Application Lifecycle Management 
User Guide.

UI Elements (A-Z) Where Description
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Patch Details Dialog Box

This dialog box enables you to view details of a patch in ALM.

 

User interface elements are described below:

To access On the Lab Management sidebar, under Lab Settings, 
select Patches.

Relevant tasks "How to Upload Patches to ALM" on page 785

See also ➤ "How to Manage Lab Resources" on page 674

➤ "How to Manage Performance Center Servers" on 
page 799

UI Elements (A-Z) Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of projects.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.
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Spelling Options. Enables you to configure how to check 
the spelling.

Details For field definitions, see "Patches Module Fields" on 
page 788.

UI Elements (A-Z) Description
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New Patch Dialog Box 

This dialog box enables you to add new Performance Center patches.

 

To access 1  On the Lab Management sidebar, under Lab Settings, 
select Patches.

2  Click the New Patch button . The Select Patch 
dialog box opens.

3  Navigate to the location of the patch, and click Open.

Relevant tasks "How to Upload Patches to ALM" on page 785
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User interface elements are described below:

UI Elements (A-Z) Description

Clear All Fields. Clears all data in the dialog box.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Details Lists Patches fields. Required fields are displayed in red. 
For details on the available fields, see "Patches Module 
Fields" on page 788.

Tip: Clicking in the Description field on this page 
displays a toolbar for formatting and spell checking the 
text.

Name Type a name for the new patch.

Syntax exceptions: A server name cannot include the 
following characters: \ / : " ? < > | * % ' 
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38
Performance Center Servers 

This chapter includes:

Concepts

➤ Performance Center Servers Overview on page 798

Tasks

➤ How to Manage Performance Center Servers on page 799

Reference

➤ Performance Center Servers Module User Interface on page 802
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Concepts

Performance Center Servers Overview 

Performance Center Servers contain information and resources needed for 
Performance Center functionality. Managing servers involves monitoring 
the server status, editing server information, and checking server 
performance.

Performance Center Servers conduct lab management, test design, run 
operations, and the user interface services for these operations. The online 
Web pages create a heavy load on the Performance Center Server. Using 
built-in load balancers, calls to and from the ALM Platform are balanced 
among the Performance Center Servers in a round-robin fashion. 

Note: Load balancing requires that at least two Performance Center Servers 
are installed in your system.

For details on managing Performance Center servers, see "How to Manage 
Performance Center Servers" on page 799.
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Tasks

How to Manage Performance Center Servers

This task describes the various options for managing the 
Performance Center Servers.

Note: This task is part of the following higher-level tasks:

➤ "How to Initially Configure Performance Center" on page 635

➤ "How to Work with Performance Center Administration" on page 622

To learn more about Performance Center Servers, see "Performance Center 
Servers Overview" on page 798.

➤ "Add a server" on page 799

➤ "Check server connections to Performance Center hosts" on page 800

➤ "Reboot a server" on page 800

➤ "Install a patch on a server" on page 801

Add a server

 1 In Lab Management, select Lab Settings > PC Servers.

 2 Click the New PC Server button.

 3 In the New PC Server dialog box, enter the required information. For user 
interface details, see "New Performance Center Server Dialog Box" on 
page 813.
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Check server connections to Performance Center hosts

On the Lab Management sidebar, under Lab Resources, select PC Servers. 
Right-click a server in the grid, and select Check Server > Check Server. 

The Task Manager opens, and the overall result of each check performed on 
the server, Passed or Failed, is displayed. 

You can view the progress of the server check in the PC Servers module’s 
Check Host Status tab.

The following checks are performed:

➤ Ping to Host. The Performance Center server pings the selected host 
machines.

➤ Ping URL. The selected host pings the listed URL.

Alternatively, you can perform the above checks, together with an 
additional connectivity check from the server to a particular URL. 
Right-click a server in the grid, select Check Server > Check Connectivity to 
URL, and enter the URL. 

Examples:

➤ Regular URL: http://www.website.com

➤ Machine name: machine22 or http://machine22

Reboot a server

On the Lab Management sidebar, under Lab Settings, select PC Servers. 
Right-click the server in the grid that you want to reboot, and select Reboot 
Server.
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Install a patch on a server

Note: To install patches on a server, patches first need to have been 
uploaded to the ALM. For details, see "How to Upload Patches to ALM" on 
page 785.

On the Lab Management sidebar, under Lab Settings, select PC Servers. 
Right-click the server in the grid on which to install the patch and select 
Install Patch.

Tip: You can install a patch on multiple servers simultaneously. To select 
multiple servers, hold down the CTRL key on your keyboard while selecting 
the servers.
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Reference

Performance Center Servers Module User Interface 

This section includes:

 ➤ Performance Center Servers Module Window on page 803

 ➤ Performance Center Servers Module Menus and Buttons on page 805

 ➤ Performance Center Servers Module Fields on page 809

 ➤ Performance Center Server Details Dialog Box on page 811

 ➤ New Performance Center Server Dialog Box on page 813

 ➤ Processes Page on page 815

 ➤ Check Server Status Page on page 817
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Performance Center Servers Module Window

The Performance Center Servers Module window enables you to manage 
Performance Center servers. 

 

To access On the Lab Management sidebar, under Lab Settings, 
select PC Servers.

Relevant tasks "How to Manage Performance Center Servers" on 
page 799
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User interface elements are described below:

UI Elements (A-Z) Description

<PC Servers Module 
common UI 
elements>

➤ PC Servers Fields. For field definitions, see 
"Performance Center Servers Module Fields" on 
page 809.

➤ PC Servers Menus and Buttons. For command and 
button descriptions, see "Performance Center Servers 
Module Menus and Buttons" on page 805.

➤ ALM main menu and sidebar. For details on the Tools 
menu, Help menu and sidebar, see the HP Application 
Lifecycle Management User Guide.

<grid filters> Located under each column name. Displays the filter that 
is currently applied to a column. If the filter box is 
empty, no filter is currently applied to the column. 

Type directly into the box, or click the box to display the 
Browse button, which opens the Select Filter Condition 
dialog box. For more details, see the HP Application 
Lifecycle Management User Guide.

<servers grid> Displays a list of the Performance Center servers. 

<Information panel> Located in the lower area of the module. Displays 
information about the server selected in the grid.

Description tab Describes the currently selected server. 

Click in the text box to display a toolbar for formatting 
and spell checking the text. 

Event Log tab Displays detailed information about the tasks performed 
on the selected server, the action status, and a description 
of any errors. For details, see "Initializing Run Page" on 
page 348.

Installed PC 
Components tab

Displays a list of the Performance Center components 
installed on the server machine, including version and 
patches. 

To refresh the grid, click .



Chapter 38 • Performance Center Servers

805

Performance Center Servers Module Menus and Buttons 

This section describes the menus and buttons available in the 
Performance Center Servers module.

User interface elements are described below:

Processes tab Displays detailed information about the processes and 
resource usage of the selected server. For details, see 
"Processes Page" on page 815.

Check Server Status 
tab

Displays the status of each step of the server checks. To 
see check server status details, right click a line in the tab, 
and select Check Server Status Details. For details, see 
"Check Server Status Page" on page 817.

History tab Lists changes made to the currently selected host. For 
more details, see the HP Application Lifecycle Management 
User Guide.

To access On the Lab Management sidebar, under Lab Settings, 
select PC Servers.

Relevant tasks "How to Manage Performance Center Servers" on 
page 799

UI Elements (A-Z) Menu Description

PC Servers Checks connectivity between the 
selected server and other machines 
in the system.

PC Servers 
and 
<right-click 
menu>

Enables you to remotely reboot the 
selected server.

UI Elements (A-Z) Description
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PC Servers 
and 
<right-click 
menu>

Opens the Install Patch dialog box, 
enabling you to select patches to 
install on the selected server.

PC Servers 
and 
<right-click 
menu>

Enables you to define the internal 
and external ALM Platform URL.

The internal URL is used by all 
Performance Center components to 
connect to the ALM Platform. 

The URL must be in the following 
format: http://<alm_platform>:<port>

Example: http://myalm:8080

Note: For SSL connectivity the 
ALM Platform internal URL must 
begin with https, for example: 
https://myalm:443

 PC Servers 
and 
<right-click 
menu>

Resets the system information on 
the selected server. For example, 
internal/external URLs, user 
identity, and so on.

Copy URL PC Servers Copies the selected server and pastes 
its URL as a link. The server itself is 
not copied. Instead, you can paste 
the address into another location, 
such as an email or a document. 
Clicking the link opens up ALM and 
takes you to the resource file or 
folder. If you are not already logged 
in, ALM first prompts for login 
details.

Delete Edit and 
<right-click 
menu>

Deletes the selected server in the 
grid.

UI Elements (A-Z) Menu Description
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Export PC Servers 
and 
<right-click 
menu>

Opens the Export Grid Data dialog 
box, enabling you to export the 
servers in the grid as a text file, 
Microsoft Excel worksheet, 
Microsoft Word document, or HTML 
document. 

Choose one of the following 
options: 

➤ All. Exports all servers in the grid. 

➤ Selected. Exports selected servers 
in the grid.

Find View Opens the Find dialog box, enabling 
you to search for server in the 
module. For details, see the 
HP Application Lifecycle Management 
User Guide.

Go to PC Server PC Servers Opens the Go To PC Servers dialog 
box, enabling you to find a specific 
server by its ID number. You can 
only go to servers that are in the 
current filter.

Grid Filters View Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Information Panel View Shows/Hides the Information Panel 
in the lower area of the module. 

New PC Server PC Servers Enables you to add a PC Server.

UI Elements (A-Z) Menu Description
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PC Server Details PC Servers 
and 
<right-click 
menu>

Opens the PC Servers Details dialog 
box, displaying details of the 
selected server. For more 
information, see 
"Performance Center Server Details 
Dialog Box" on page 811. 

Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

Replace Edit and 
<right-click 
menu>

In the PC Servers grid, opens the 
Replace dialog box, enabling you to 
replace a field value in the grid. For 
more details, see the HP Application 
Lifecycle Management User Guide.

Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For more details, see 
the HP Application Lifecycle 
Management User Guide.

For details about the PC Servers 
fields, see "Performance Center 
Servers Module Fields" on page 809.

Set Filter/Sort View Enables you to filter and sort the 
servers in the grid. Any currently 
applied filters or sorting orders are 
displayed below the toolbar. For 
more details, see the HP Application 
Lifecycle Management User Guide.

Updated Selected Edit Opens the Update Selected dialog 
box, enabling you to update a field 
value for a multiple selection in the 
grid. For more details, see the 
HP Application Lifecycle Management 
User Guide.

UI Elements (A-Z) Menu Description
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Performance Center Servers Module Fields 

This section describes the Performance Center Servers module fields.

User interface elements are described below:

To access On the Lab Management sidebar, under Lab Settings, 
select PC Servers.

Relevant tasks "How to Manage Performance Center Servers" on 
page 799

UI Elements (A-Z) Description

Configuration Last 
Check

Displays whether the last configuration check passed or 
failed.

Connectivity Last 
Check

Displays whether the last connectivity check passed or 
failed.

Description A description of the Performance Center Server.

External URL The URL used to connect to the Performance Center 
Server from an external source.

Note: For SSL connectivity add a Performance Center 
server using the following format for the external URL:

https://<pc_server>

Example: https://mypcs:443

Installation Last 
Check

Displays whether the last installation check passed or 
failed.

Internal URL The URL used for all internal communication between 
the Performance Center Server and the ALM Platform, as 
well as for load balancing. 

Name The server name that you assign when you configure a 
new server.

Performance Last 
Check

Displays whether the last performance check passed or 
failed.

Server ID The server ID. 
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Server State The current state of the server. The possible states are:

➤ Idle. The server is idle.

➤ Installing patch. The installation patch is being 
installed on the server, and the server is temporarily 
unavailable.

➤ Rebooting. The server is rebooting and is temporarily 
unavailable.

Default: Idle

Status The current server status. The possible statuses are:

➤ Operational. The server is working.

➤ Non-operational. The server is not working.

➤ Unavailable. The server is not available.

UI Elements (A-Z) Description
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Performance Center Server Details Dialog Box 

The PC Servers Details dialog box enables you to view and update a single 
server.

 

To access 1  On the Lab Management sidebar, under Lab Settings, 
select PC Servers.

2  Right-click a server and select PC Server Details.

Relevant tasks "How to Manage Performance Center Servers" on 
page 799
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User interface elements are described below:

UI Elements (A-Z) Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of servers.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Details Details the currently selected server. For details on the 
available fields, see "Performance Center Servers Module 
Fields" on page 809.

Event Log Displays detailed information about the tasks performed 
on the selected server, the action status, and a description 
of any errors. For details, see "Initializing Run Page" on 
page 348.

History Lists changes made to the currently selected server. For 
more details, see the HP Application Lifecycle Management 
User Guide.

Installed PC 
Components

Displays a list of the Performance Center components 
installed on the server machine, including version and 
patches. 

To refresh the grid, click .

Processes Displays detailed information about the processes and 
resource usage of the selected server. For details, see 
"Processes Page" on page 815.

Server Check Status Displays the status of each step of the server checks. To 
see server check status details, right click a line in the tab, 
and select Server Check Status Details. For details, see 
"Check Server Status Page" on page 817.
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New Performance Center Server Dialog Box 

This dialog box enables you to add new Performance Center servers.

 

To access 1  On the Lab Management sidebar, under Lab Settings, 
select PC Servers.

2  Click the New PC Server button .

Relevant tasks "How to Manage Performance Center Servers" on 
page 799
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User interface elements are described below:

UI Elements (A-Z) Description

Clear All Fields. Clears all data in the dialog box.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Details Lists PC Server fields. Required fields are displayed in red. 
For details on the available fields, see 
"Performance Center Servers Module Fields" on page 809.

Tip: Clicking in the Description field on this page 
displays a toolbar for formatting and spell checking the 
text.

Name Type a name for the new server.

Syntax exceptions: A server name cannot include the 
following characters: \ / : " ? < > | * % ' 
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Processes Page 

This page displays detailed information about the processes and resource 
usage of the selected server.

 

To access ➤ From the PC Servers module: 

On the Lab Management sidebar, under Lab Settings, 
select PC Servers. In the information panel, select 
Processes.

➤ From the PC Servers Details dialog box: 

On the Lab Management sidebar, under Lab Settings, 
select PC Servers. Right-click a server and select Server 
Details. In the PC Server Details dialog box, select 
Processes.

Relevant tasks "How to Manage Performance Center Servers" on 
page 799

See also "Performance Center Servers Overview" on page 798
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Refresh. Refreshes the grid so it displays the most 
up-to-date information.

Kill Process. Ends the process selected in the grid.

Notes: 

➤ Hosts module. Kill Process permissions are required to 
end the selected process. 

➤ Performance Center Servers module. A user with 
Viewer permissions has the ability to end the selected 
process.

<Processes grid>  Displays the following details about the processes: 

➤ Name. The name of the process.

➤ PID. The process ID.

➤ Processor Time (%). The percentage of processor time 
used by the process.

➤ Memory Usage (KBytes). The amount of memory (in 
kilobytes) used by the process.

➤ Elapsed Time (d.hh:mm:ss). The amount of elapsed 
time since the start of the process, where d is the 
number of days and hh:mm:ss is the number of hours, 
minutes, and seconds that have elapsed.

<Navigation area> Located at the bottom of the page, enables you to 
navigate through the pages of entries in the grid. The 
total number of entries is displayed on the right of the 
navigation area.
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Check Server Status Page 

This page displays the status of each step of the server checks.

 

To access ➤ From the PC Servers module: 

On the Lab Management sidebar, under Lab Settings, 
select PC Servers. In the information panel, select 
Check Server Status.

➤ From the PC Servers Details dialog box: 

On the Lab Management sidebar, under Lab Settings, 
select PC Servers. Right-click a server and select 
PC Server Details. In the PC Server Details dialog box, 
select Check Server Status.

Relevant tasks "How to Manage Performance Center Servers" on 
page 799

See also "Performance Center Servers Overview" on page 798
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Check Server Status Details. The following fields are 
displayed:

➤ Actual Value. Actual value resulting from the server 
connectivity check.

➤ Check. The sub-areas in which the Check Server 
feature checks the servers.

➤ Check Result ID. The ID of each step of the server 
check.

➤ Expected Value. Value expected to result from the 
server check.

➤ Category. The areas in which the Check Server feature 
checks the server: Configuration, Connectivity, 
Installation, and Performance.

➤ Check Date. The date the server was checked.

➤ Error. If an error occurred during the check, displays 
the error.

➤ Status. Indicates whether the server check passed or 
failed.

Refresh. Refreshes the page.

Set Filter/Sort. Enables you to filter and sort the grid. 
Any currently applied filters or sorting orders are 
displayed below the toolbar. For details, see the 
HP Application Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For details, see the HP Application 
Lifecycle Management User Guide.

Find. Opens the Find dialog box, enabling you to search 
in the grid. For details, see the HP Application Lifecycle 
Management User Guide.
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<Check Server Status 
grid>

Displays the status of the server checks. Click  to 
select columns to display in the grid.

Actual Value Actual value resulting from the server connectivity 
check.

Category The areas in which the Check Server feature checks the 
Server: 

➤ Configuration

➤ Connectivity

➤ Installation

➤ Performance

Check The sub-areas the Check Server feature checks. For 
example, sub-areas in the Performance check are 
Processor, Memory, System, 

Check Date The date the server was checked. 

Check Result ID The ID of each step of the server check. 

Error If an error occurred during the check, displays the error. 

Expected Value Value expected to result from the server check. 

Status Indicates whether the server check passed or failed. 

UI Elements (A-Z) Description
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39
Performance Center Licensing 

This chapter includes:

Concepts

➤ HP ALM Performance Center Licenses Overview on page 822

Reference

➤ Host License Types on page 825

➤ Host License Vuser Types on page 826

➤ Performance Center Licensing User Interface on page 826
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Concepts

HP ALM Performance Center Licenses Overview 

Licenses Definition Process
To work with HP ALM Performance Center, each of the following licenses 
must be defined:

ALM License

The ALM license defines the number of concurrent users in ALM. The ALM 
license is configured as part of the ALM installation process and is managed 
in Site Administration. For more information about the ALM license, see the 
HP Application Lifecycle Management Administrator Guide.

Performance Center and Host Licenses

There are two licenses that are specific to ALM Performance Center:

➤ Performance Center license. Defines the number of concurrent runs per 
performance test, as well as Vuser limits. For more information about the 
Performance Center license, see "Performance Center License Overview" 
below.

➤ Host license. A license which is automatically installed on the host as you 
add the host to ALM. It defines the limits of Vuser use per protocol on the 
host.

The Performance Center and Host licenses are configured directly after 
installation of the Performance Center Server. For configuration details, see 
the HP ALM Performance Center Installation Guide. 

If this configuration was skipped, you can configure the Performance Center 
and Host licenses manually. For more information, see "License Module 
Window" on page 827.



Chapter 39 • Performance Center Licensing

823

Performance Center License Overview
There are two types of Performance Center licenses: Perpetual and VUD.

Perpetual License 

There are two types of Perpetual licenses:

VUD-Based License 

A Virtual User Day (VUD) license provides you with a specified number of 
Vusers (VUDs) that you can run an unlimited number of times within a 24 
hour period (the Virtual User Day). 

At the end of a Virtual User Day, the remaining number of licensed VUDs is 
calculated by subtracting the number of used VUDs, or in the case of 
concurrent usage, the maximum number of concurrent running VUDs, 
from the total number of licensed VUDs. 

For example, a user has a license that allows him to run 1,000 VUDs. He 
creates a performance test that requires 200 Vusers and runs for 45 minutes. 
He runs the test at 8:00am, 10:00am, 2:00pm, and at 4:00pm. In each case, 
the test finishes before the next one begins. Because there is no concurrent 
Vuser usage, he can re-use the same 200 VUDs for each test run, meaning 
that at the end of the 24-hour period, only 200 VUDs are deducted from the 
license, leaving 800 for future use. 

However, if the user starts the second run at 8:30am, the first test is still 
running run before the second test initializes. This overlap requires 400 
Vusers to run concurrently (200 for each test). At the end of the day, 400 
VUDs are deducted from the license, because that is the highest number of 
concurrent Vusers. The total left for future use is 600 VUDs.

Type Definition

Regular The standard Performance Center license. It is limited by the total 
number of concurrent runs and Vusers, and may have an 
expiration date.

Additive A license that is added to a regular license. It increases the 
concurrent runs and Vuser limits of the regular license, but does 
not affect an expiration date.
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Notes:

➤ You can run VUDs on HP developed protocols, with the exception of: 
COM/DCOM, VB Com, VB Vuser, VB Script Vuser, VB.NET Vuser, and 
VB.NET Template.

➤ You cannot run VUDs on SDK protocols.

➤ You cannot run VUDs on a GUI Vuser script, such as WinRunner and 
QuickTest Professional scripts. 

➤ When using a VUD based Performance Center license, a Host license is 
not relevant. 



Chapter 39 • Performance Center Licensing

825

Reference

Host License Types

The following table displays a list of available host license types. To learn 
more about host licenses, see "HP ALM Performance Center Licenses 
Overview" on page 822.

License Type Description

Permanent The license never expires.

Time Limited The license is limited by a start date and an 
expiration date.

Temporary A Time Limited license that is granted for a 
predefined number of days after product 
installation.

Plugged The license requires a dongle.
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Host License Vuser Types 

The following table displays a list of the available host license Vuser types.

Performance Center Licensing User Interface 

This section includes:

 ➤ License Module Window on page 827

Vuser Type Description

<bundle type> Bundle Each bundle contains a collection of protocols. 
When you select a protocol bundle, this dialog box 
displays a list of included protocols.

Global The global license lets you run all Vuser types, 
provided you stay within the global or total limit. 
The number following Global indicates the total 
number of Vusers purchased. 
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License Module Window

This page enables you to view summaries of your perpetual and VUD-based 
licenses, as well as host license information.

 

To access On the Lab Management sidebar, under Lab Settings, 
select License.

Relevant tasks ➤ "How to Work with Performance Center 
Administration" on page 622

➤ "How to Initially Configure Performance Center" on 
page 635

See also "HP ALM Performance Center Licenses Overview" on 
page 822
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Performance Center Licenses Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Add PC License. Click to add a Performance Center 
license. 

Note: You can only add a Performance Center license if 
you have the required permissions. 

 Show All Licenses/Hide All Obsolete Licenses. Click to 
display all Performance Center licenses or to remove 
obsolete licenses in the left pane.

Licenses Details. Click to open the Licenses Details dialog 
box which displays the following information:

➤ Date Assigned. The date the license was added to the 
system.

➤ License Key. The license key.

➤ Type. The license type.

Note: You can only view license details if you have the 
required permissions.

<Available licenses 
list>

A list in the left-hand pane that lists all current perpetual 
and VUD-based licenses. Select a license to view specific 
details on the right.

PC Licenses Select to display summary information for all perpetual 
and VUD-based licenses. The information is displayed in 
the adjacent pane on the right.

Perpetual License 
Summary

Displays summary information for all perpetual licenses.

Note: Only displayed when PC Licenses in the upper left 
pane in selected.

VUDs License 
Summary

Displays summary information for all VUD-based 
licenses.

Note: Only displayed when PC Licenses in the upper left 
pane in selected.
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Hosts License Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Add Host License. Adds a host license. 

Note: You can only add host licenses if you have the 
required permissions.

Licenses Details. Click to open the Licenses Details dialog 
box which displays the following information:

➤ Date Assigned. The date the license was added.

➤ License Key. The license key.

➤ Type. The license type.

Note: You can only view host license details if you have 
the required permissions.

<Available licenses 
list>

A list in the left-hand pane that lists all current host 
licenses. Select a license to view specific details on the 
right.
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Host Licenses A list of available host licenses keys. Select a license key 
to view its information in the License Key Information 
pane.

License Key 
Information pane

Displays information for a selected license. The following 
information is displayed:

➤ License Type. The type of license available for the 
license key you selected. For a list of the available 
license types, see "Host License Types" on page 825.

➤ License Validity. The time limitation of the selected 
license key.

➤ Vuser Types. A list of Vuser protocols available for the 
selected license key, or a list of protocol bundles for 
the new licensing implementation. For a list of the 
available host license Vuser types, see "Host License 
Vuser Types" on page 826.

➤ Monitors and Modules. The online monitors available 
for the selected license key, and the modules included 
in the license. For example, Diagnostics for J2EE/.NET. 
If All Monitors is displayed in the list, it means that 
your license enables you to work with all the 
Controller online monitors. When you select 
All Monitors, the unlabelled box at the bottom of the 
License Key Information pane displays a list of 
included monitors. 

UI Elements (A-Z) Description
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40
Diagnostics Management

This chapter includes:

Concepts

➤ J2EE/.NET Diagnostics Overview on page 832

➤ ERP/CRM Diagnostics Overview on page 833

Tasks

➤ How to Add ERP/CRM Mediators on page 838

➤ How to Add HP Diagnostics Servers on page 839

➤ How to Pre-Configure Siebel/Siebel DB Diagnostics on page 840

➤ How to Pre-Configure Oracle 11i Diagnostics on page 845

➤ How to Pre-Configure SAP Diagnostics on page 847

➤ How To Enable and Disable Logging On the Siebel Server on page 848

➤ How To Enable Logging on the Oracle Server on page 850

➤ How To Set and Disable the Oracle Server Diagnostics Password 
on page 852

Reference

➤ Diagnostics User Interface on page 854
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Concepts

J2EE/.NET Diagnostics Overview 

The HP Diagnostics integration with HP Application Lifecycle Management 
(ALM) allows you to monitor and analyze the performance of 
Java 2 Enterprise Edition (J2EE), .NET-connected, SAP, Oracle, and other 
complex environments.

During a performance test, you can drill down into HP Diagnostics data for 
the whole test or for a particular transaction. After the test, you can use HP 
LoadRunner Analysis to analyze offline diagnostics data generated during 
the test.

Monitoring Server Requests
When configuring a performance test to use J2EE/.NET Diagnostics, you can 
instruct ALM to capture a percentage of server requests which occur outside 
the context of any Vuser transaction.

The benefit of enabling this functionality is that calls into a back-end VM 
can be captured even in the case where: 

➤ The probe is not capturing RMI calls

➤ RMI calls cannot be captured (perhaps because an unsupported 
application container is being used)

➤ The application uses some other mechanism for communications 
between multiple VMs

For more information about working with diagnostics for J2EE and .NET, see 
the HP Diagnostics User Guide.
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ERP/CRM Diagnostics Overview 

The following sections provide an overview of ERP/CRM diagnostics.

Understanding ERP/CRM Diagnostics
During a performance test, the ALM diagnostics modules trace, time, and 
troubleshoot individual transactions across the Web, application, and 
database servers. You can drill down from a slow end-user transaction all the 
way to the bottlenecked method or SQL statement. The ALM 
Performance Center diagnostics modules enable organizations to: 

➤ Rapidly isolate application components that have a significant impact on 
end-user experience

➤ Provide developers with precise data on how to make performance 
improvements

ERP/CRM Diagnostics Modules Architecture
ERP/CRM Diagnostics architecture, as shown in the diagram below, is 
comprised of the following components:

➤ ERP/CRM Mediator. The ERP/CRM Mediator (“Mediator”) gathers and 
correlates offline transaction data from the Web, database, and 
application servers. For information on installing the Mediator, see the HP 
ALM Performance Center Installation Guide.
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➤ Controller. Before test execution, the Controller transfers all server 
information to the Mediator and distributes the percentage of users that 
will participate in the monitoring. After test execution, the Controller 
collects the aggregated transaction data files from the Mediators and 
collates the results. Results are transferred to the Siebel diagnostics, SAP 
diagnostics, or Oracle DB results directory.

If you do not want to collate the information right after the load test, you 
can perform collation at a later time.

The files are then transferred to the results directory per diagnostics type 
as follows:

➤ Siebel results are transferred to the \sbl_bd directory. 

➤ Oracle 11i results are transferred to the \ora_bd directory. 

➤ SAP results are transferred to the \sap_bd directory. 

➤ Load Generator. When you execute a load test, the Controller distributes 
each Vuser to a load generator, and the load generator executes the Vuser 
script.

➤ Analysis. Displays detailed diagnostics graphs and reports. For more 
information about the diagnostics graphs, see the HP LoadRunner Analysis 
User Guide.
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Connecting the Mediator to a Remote Server
When you set up the ERP/CRM Diagnostics modules, you define a server to 
monitor by entering the user name of the server where trace/log files are 
stored. This section explains how the Mediator connects to the server when 
it is a remote Windows or UNIX server.

Connecting to a Remote Windows Server

When monitoring a remote Windows server, the Mediator attempts to 
connect to the server using the configuration details which you enter in the 
<diagnostics type> Server Configuration Dialog Box during the diagnostics 
configuration process. This configuration should give administrator 
permissions to the remote machine. 

Connecting to a Remote UNIX Server

When monitoring a remote UNIX server, the Mediator supports the remote 
shell connection type. For more information on remote shell connections, 
see the section that describes verifying the UNIX load generator installation 
in the HP Application Lifecycle Management Installation Guide.

Siebel and Siebel DB Diagnostics Overview
Siebel Diagnostics are split into the following modules:

➤ Siebel Diagnostics Module. Enables you to break down Siebel transactions 
into layers, areas, sub-areas, servers, and scripts. You can also view the 
transaction chain of calls and call stack statistics to track the percentage 
of time spent on each part of the transaction. Siebel-Web Vusers support 
Siebel Diagnostics. 

➤ Siebel DB Diagnostics Module. Helps you rapidly identify and resolve 
database performance problems. You can view the SQLs for each 
transaction, identify the problematic SQL queries of each script, and 
identify at which point problems occurred. Siebel-Web Vusers support 
Siebel DB Diagnostics. 



Chapter 40 • Diagnostics Management

836

Note: Siebel Diagnostics (Siebel Application Response Measurements) 
supports Siebel application servers versions 7.53 and 7.7.

For information on how to pre-configure the Siebel/Siebel DB Diagnostics 
modules, see "How to Pre-Configure Siebel/Siebel DB Diagnostics" on 
page 840.

Oracle 11i Diagnostics Overview
Oracle 11i Diagnostics helps pinpoint performance problems on Oracle NCA 
systems. The diagnostics information drills down from the transaction to 
the SQL statements, and to the SQL stages of each statement. Oracle NCA 
Vusers support Oracle 11i Diagnostics. 

For information on how to pre-configure the Oracle 11i Diagnostics module, 
see "How to Pre-Configure Oracle 11i Diagnostics" on page 845.

SAP Diagnostics Overview
SAP Diagnostics enables you to pinpoint the root cause of a certain problem 
(i.e. DBA, Network, WAS, Application, OS/HW) quickly and easily, and 
engage with the relevant expert only, without having to present the 
problem to a whole team of people. 

The following table outlines the supported versions and required Kernel 
patches for the SAP Application Server and the SAPGUI Client:

For information on how to configure the SAP Diagnostics module, see "How 
to Pre-Configure SAP Diagnostics" on page 847.
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Server-side Data Collection

SAP Diagnostics is based on SAP Distributed Statistical Records (DSR). For 
each dialog step performed on application server, a statistical record is 
generated, which includes information such as response time components, 
database statistics, RFC times, and so on. 

The Diagnostics Mediator is responsible for collecting diagnostics data from 
the server during a performance test.

Vuser Coloring

SAP Diagnostics allows replaying the SAPGUI protocol. You set the 
percentage of colored Vusers in the Configuration dialog (up to 100% 
allowed). Coloring of SAPGUI users creates no overhead on the Application 
server.
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Tasks

How to Add ERP/CRM Mediators 

This task describes how to add diagnostics servers and mediators in order to 
work with J2EE/.NET and ERP/CRM diagnostics.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

 1 Prerequisite

Make sure that the mediator is installed in the same LAN as the 
monitored server. For information on installing the ERP/CRM Mediator, 
see the HP ALM Performance Center Installation Guide. 

 2 Add and configure the mediator

 a On the Lab Management sidebar, under Lab Settings, select 
Diagnostics. 

 b Select the ERP/CRM Diagnostics tab.

 c Click the New Diagnostics Mediator button , and enter the 
required information. For user interface details, see "Diagnostics 
Module Fields" on page 856.
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How to Add HP Diagnostics Servers 

This task describes how to add an HP Diagnostics server to allow you to 
monitor and analyze J2EE/.NET environments.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

 1 On the Lab Management sidebar, under Lab Settings, select Diagnostics. 

 2 Select the J2EE/.NET Diagnostics tab.

 3 Click the New Diagnostics Server button , and enter the required 
information. For user interface details, see "Diagnostics Module Fields" on 
page 856.

 4 Under Lab Settings, select Project Settings. Right-click the relevant 
project and select Project Settings Details. Add the relevant server 
information in the Diagnostics Server field.

Note: To ensure that diagnostics data is available online, make sure that the 
time on the diagnostics server is synchronized with its probes.
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How to Pre-Configure Siebel/Siebel DB Diagnostics

This task describes the pre-configuration steps to be performed by the ALM 
administrator which allow the performance tester to enable and run Siebel 
diagnostics.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

This task includes the following steps:

➤ "Prerequisite" on page 840

➤ "If connecting to a UNIX server with a remote shell (RSH/RCP) 
connection" on page 840

➤ "Configure the server machine to enable diagnostics" on page 841

➤ "Copy files from the Siebel Application Server to the Mediator" on 
page 843

➤ "Synchronize clocks" on page 844

➤ "(Siebel DB) Enable logging on the Siebel Server" on page 845

 1 Prerequisite

Make sure that the ERP/CRM mediator is installed and configured. For 
more information, see "How to Add ERP/CRM Mediators" on page 838.

 2 If connecting to a UNIX server with a remote shell (RSH/RCP) 
connection

➤ Verify that the RSH and RCP daemons are running on the UNIX server.

➤ Verify that the UNIX user has permission to run remote shell 
commands. To check this, type the following at the DOS command 
prompt:

 

rsh <server machine name> -l <UNIX user login name> -n <command>
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Example:

Note: You can use only RSH commands that work from the DOS 
command prompt window.

➤ Verify that no output is generated after executing the RSH 
command. 

Note: You should not generate output from the .login, .profile, and 
.cshrc files (for example, by echo, or in any other way, including 
commands that generate output indirectly, such as biff). Where an 
existing user generates output in the RSH step that cannot be deleted, 
you should create a new user that does not generate output, and who 
has permissions to run RSH and RCP commands on the server 
machine.

 3 Configure the server machine to enable diagnostics

To configure Siebel application and Web servers for diagnostics data 
collection:

 a Enable Siebel Diagnostics on all Siebel application and Web servers 
involved in the test.

Set the environment variable on the Siebel server to:

Then restart the server. 

 b Optimize the server performance settings.

rsh my_unix -l my_name -n “cd ~;pwd”

SIEBEL_SarmEnabled=true 
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You change the maximum memory caching and file size using the 
following variables:

The SIEBEL_SarmMaxMemory value controls the size of the buffer that 
Siebel keeps in the memory before writing the information to the 
Siebel log files. You can improve server performance by increasing the 
parameter value. However, information from the end of the run will be 
missing from the Analysis graphs.

We recommend the following settings:

➤ SIEBEL_SarmMaxMemory

➤ SIEBEL_SarmMaxFileSize

If more than one Siebel log file is generated on the server every 10 
seconds, you should increase the SIEBEL_SarmMaxFileSize.

SIEBEL_SarmMaxMemory= <bytes> 
SIEBEL_SarmMaxFileSize = <bytes> 

Value Number of Vusers

5000 Less than 20 (low loads)

1000000 More than 100 (high loads)

Value Number of Vusers

5000000 Less than 20 (low loads)

25000000 More than 100 (high loads)
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 c Generate a list of Siebel Server IDs.

On the Siebel server, open a command window and run the following 
command:

where:

/u  <username> is the server administrator username

/p  <password> is the server administrator password

/g  <gateway server> is the gateway server address

/e  <entrpr server> is the enterprise server name

/c  <command> is the execute a single command

This command generates a list of all the Siebel application servers and 
their IDs. Keep a record of the server IDs, since this information is 
required in the Siebel Server Configuration dialog box.

 4 Copy files from the Siebel Application Server to the Mediator

After configuring the application server, copy the files listed below from 
the Siebel Application server \bin directory to either the <Mediator 
Root>\bin directory, <Windows>\System32 directory, or any other directory 
in PATH on the Mediator machine:

For Siebel 7.53, copy the following files:

<Siebel bin directory>\srvrmgr /u <username> /p <password> /g <gateway 
server> /e <entrpr server> /c "list servers show SBLSRVR_NAME, SV_SRVRID" 

➤ sarmanalyzer.exe

➤ sslcver.dll

➤ sslcsym.dll

➤ sslcshar.dll

➤ sslcosa.dll
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For Siebel 7.7, copy the following files:

 5 Synchronize clocks

➤ On Windows Siebel Servers. Ensure that all the machines’ clocks in the 
Siebel system are synchronized. This ensures that the correlation of 
SQLs to transactions is correct.

Synchronize the Siebel Gateway and load generators’ clocks by 
running the following command from the load generator:

Replace <Gateway name> with the name of the Siebel Gateway.

➤ On Unix Siebel Servers. Ensure that all the machines’ clocks in the 
Siebel system are synchronized. This ensures that the correlation of 
SQLs to transactions is correct.

You can synchronize the clocks on a UNIX system in one of the 
following ways:

➤ Use the date command on the UNIX Siebel Gateway server to 
change the time manually, so it will be synchronized with the Load 
Generator’s clock.

➤ Change the time on the load generator so that it will be 
synchronized with the UNIX Siebel Gateway server.

➤ Configure the time difference in Analysis. For more information, see 
the chapter about Siebel DB Diagnostics Graphs in the HP 
LoadRunner Analysis User Guide.

➤ sarmanalyzer.exe

➤ libarm.dll

➤ msvcp70.dll

➤ msvcr70.dll

➤ sslcacln.dll

➤ sslccore.dll

➤ sslcevt.dll

➤ sslcos.dll

➤ sslcosa.dll

➤ sslcosd.dll

➤ sslcrsa.dll

➤ sslcscr.dll

➤ sslcshar.dll

➤ sslcsrd.dll

➤ sslcsym.dll

➤ sslcver.dll

net time \ <Gateway name> /set /y
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 6 (Siebel DB) Enable logging on the Siebel Server

For task details, see "How To Enable and Disable Logging On the Siebel 
Server" on page 848.

How to Pre-Configure Oracle 11i Diagnostics 

This task describes the pre-configuration steps to be performed by the ALM 
administrator which allow the performance tester to enable and run 
Oracle 11i diagnostics.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

This task includes the following steps:

➤ "Prerequisite" on page 846

➤ "If connecting to a UNIX server with a remote shell (RSH/RCP) 
connection" on page 846

➤ "Enable logging on the Oracle server" on page 847

➤ "Set or Disable the Oracle server diagnostics password - optional" on 
page 847
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 1 Prerequisite

Make sure that the ERP/CRM mediator is installed and configured. For 
more information, see "How to Add ERP/CRM Mediators" on page 838.

 2 If connecting to a UNIX server with a remote shell (RSH/RCP) 
connection

➤ Verify that the RSH and RCP daemons are running on the UNIX server.

➤ Verify that the UNIX user has permission to run remote shell 
commands. To check this, type the following at the DOS command 
prompt:

 

Example:

Note: You can only use RSH commands that work from the DOS 
command prompt window.

➤ Verify that no output is generated after executing the RSH command. 

Note: You should not generate output from the .login, .profile, and 
.cshrc files (for example, by echo, or in any other way, including 
commands that generate output indirectly, such as biff). Where an 
existing user generates output in the RSH step that cannot be deleted, 
you should create a new user that does not generate output, and who 
has permissions to run RSH and RCP commands on the server 
machine.

rsh <server machine name> -l <UNIX user login name> -n <command>

rsh my_unix -l my_name -n “cd ~;pwd”
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 3 Enable logging on the Oracle server

For task details, see "How To Enable Logging on the Oracle Server" on 
page 850.

 4 Set or Disable the Oracle server diagnostics password - 
optional

To help ALM deal with the Oracle server diagnostics password, you can 
either set the password in the Vuser script, or you can disable the 
password request on the server itself. For task details, see "How To Set and 
Disable the Oracle Server Diagnostics Password" on page 852.

How to Pre-Configure SAP Diagnostics

This task describes the pre-configuration steps to be performed by the ALM 
administrator that allows the performance tester to enable and run SAP 
diagnostics.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

Install the ERP/CRM Mediator

Make sure that the ERP/CRM mediator is installed and configured. For more 
information, see "How to Add ERP/CRM Mediators" on page 838.

Note: When using SAP Diagnostics, ensure that a SAPGUI client is installed 
on the same machine as the ERP/CRM Mediator.
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How To Enable and Disable Logging On the Siebel Server

This task describes how to enable and disable logging on the Siebel server.

Note: 

➤ This task is part of a higher-level task. For details, see "How to Work with 
Performance Center Administration" on page 622.

➤ Enabling logging on the Siebel server can negatively impact server 
performance. We recommend that you disable logging and restore the 
default logging settings at the conclusion of the performance test.

This task includes the following steps:

➤ "To enable logging on the Siebel server" on page 848

➤ "To disable logging on the Siebel server" on page 849

To enable logging on the Siebel server

Perform the following steps:

 a Open a command window and run the following command:

where:

/u  <username> is the server administrator username

/p  <password> is the server administrator password

/g  <gateway server> is the gateway server address

/e  <entrpr server> is the enterprise server name

/s <siebel server > is the siebel server (the default server)

<Siebel bin directory>\srvrmgr /g <gateway server> /s <Siebel server> /e 
<enterprise server name> /u <username> /p <password> 



Chapter 40 • Diagnostics Management

849

 b Enter the following commands:

Example:

For the Call Center component, enter sccobjmgr_enu as the component 
name, as follows:

To disable logging on the Siebel server

Perform the following steps:

 a Open a command window and run the following command:

where:

/u  <username> is the server administrator username

/p  <password> is the server administrator password

/g  <gateway server> is the gateway server address

/e  <entrpr server> is the enterprise server name

/s <siebel server > is the siebel server (the default server)

 b Enter the following commands:

change evtloglvl ObjMgrsqllog=4 for comp <component name>

evtloglvl EventContext=3 for comp <component name>

evtloglvl ObjMgrSessionInfo =3 for comp <component name> 

change evtloglvl ObjMgrsqllog=4 for comp sccobjmgr_enu

<Siebel bin directory>\srvrmgr /g <gateway server> /s <Siebel server> /e 
<enterprise server name> /u <username> /p <password> 

change evtloglvl ObjMgrsqllog=0 for comp <component name>

change evtloglvl EventContext=0 for comp <component name>

change evtloglvl ObjMgrSessionInfo =0 for comp <component name> 
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How To Enable Logging on the Oracle Server 

This task describes how to enable logging on the Oracle server.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

This task includes the following steps:

➤ "Verify that the trace diagnostics are enabled" on page 850

➤ "Set the trace file size to unlimited" on page 851

 1 Verify that the trace diagnostics are enabled

Perform the following steps:

 a Log on to the Oracle application server with administrator privileges, 
and select the desired module in the Oracle application. The 
Responsibilities dialog box opens.

 b Select System Administrator and click OK. 

 c In the Functions tab, select Profile > System and click Open. The 
System Profile Values dialog box opens.

 d In the Display section, select Site and Profiles with No Values, enter 
%Diagnostics% in the Profiles field, and then click Find.

 e If any diagnostics profiles are disabled (denoted by a “Yes” in the Site 
column), change the setting to “No”. 

 f Save your settings.
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 2 Set the trace file size to unlimited

For Oracle 9i:

On the Oracle server, run the following command in the SQL editor:

For Oracle 8i:

 a On the Oracle server, run the following command in the SQL editor:

 b Edit the init*.ora file on 
$ORACLE_HOME\admin\<sid>\pfile\init<sid>.ora. Find the line of 
the parameter, change its value, and then save the file.

Note: Verify that you have enough disk space on the database server 
since these trace files can be very large.

Alter system set max_dump_file_size=UNLIMITED scope=both;

Alter system set max_dump_file_size=2048000;
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How To Set and Disable the Oracle Server Diagnostics 
Password 

To help ALM deal with the Oracle server diagnostics password, you can 
either set the password in the Vuser script, or you can disable the password 
request on the server itself.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

This task includes:

➤ "Set the diagnostics password in the Vuser script" on page 852

➤ "Disable the diagnostics password request on the Oracle server" on 
page 852

Set the diagnostics password in the Vuser script

In VuGen, add the nca_set_diagnostics_password(<password>) function to 
your script and select a password.

Note: The nca_set_diagnostics_password function must come after the 
nca_connect_server function.

Disable the diagnostics password request on the Oracle server

Perform the following steps:

 1 Log on to the Oracle server with administrator privileges, and select the 
desired module in the Oracle application. The Responsibilities dialog box 
opens.

 2 Select System Administrator and click OK. 
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 3 In the Functions tab, select Profile > System and click Open. The System 
Profile Values dialog box opens.

 4 In the Display section, select User, and enter the required user name. In 
the Profile field, enter %Utilities:Diagnostics% and click Find. The 
Utilities:Diagnostics profile values are displayed.

 5 In the User column of the Utilities:Diagnostics profile, set the value to 
Yes.

 6 Save your settings.
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Reference

Diagnostics User Interface 

This section includes:

 ➤ Diagnostics Module Window on page 854

 ➤ Diagnostics Module Fields on page 856

 ➤ Diagnostics Module Menus and Buttons on page 857

Diagnostics Module Window 

The Diagnostics Module Window enables you to add and manage ERP/CRM 
mediators and J2EE/.NET servers.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access On the Lab Management sidebar, under Lab Settings, 
select Diagnostics.

Relevant tasks ➤ "How to Add ERP/CRM Mediators" on page 838

➤ "How to Add HP Diagnostics Servers" on page 839

UI Elements (A-Z) Description

<ALM common 
areas>

For details on the ALM common areas, see the 
HP Application Lifecycle Management User Guide.

<Diagnostics module 
fields>

For details on the fields that are available in the 
Diagnostics module, see "Diagnostics Module Fields" on 
page 856.

<Diagnostics module 
menus and buttons>

For details on the icons that are available in the 
Diagnostics module, see "Diagnostics Module Menus and 
Buttons" on page 857.

ERP/CRM 
Diagnostics tab

Enables you to add and manage ERP/CRM Diagnostics 
mediators.

J2EE/.NET 
Diagnostics tab

Enables you to add and manage J2EE/.NET Diagnostics 
servers.

History tab Displays a history of the changes made to the selected 
server/mediator, including the date and time of the 
change and the name of the user who made the change. 

For details, see the HP Application Lifecycle Management 
User Guide.
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Diagnostics Module Fields 

This section describes the Diagnostics module fields.

Field Description

Description A description of the mediator/server.

Enable SSL Select Enable if ALM is communicating with Diagnostics 
through SSL.

Logical Name The logical name given to the mediator/server.

Machine Name / IP The name or IP address of the mediator/server.

Over Firewall Denotes if monitoring over a firewall is enabled or not. 
Select Y for enabled and N for not enabled.

Note: Available for ERP/CRM diagnostice only.

Password Enter the password you use to log in to HP Diagnostics. 

Default: Admin

Note: Available for J2EE/.NET diagnostics only.

Port Enter the port number used by the diagnostics server. 

Default: 2006

Note: Available for J2EE/.NET diagnostics only.

Type The ERP/CRM mediator type.

Note: Available for ERP/CRM diagnostics only.

Username Enter the user name with which you log on to HP 
Diagnostics. 

Note: The user name that you specify should have view, 
change, and execute privileges. For more information 
about user privileges, see the HP Diagnostics Installation 
and Configuration Guide.
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Diagnostics Module Menus and Buttons

This section describes the menus and buttons in the Diagnostics module.

UI Elements (A-Z) Menu Description

Edit and 
<right-click 
menu>

Deletes the selected server/mediator 
from the grid.

Check Server/
Mediator

Diagnostics 
Server/
Mediator and 
<right-click 
menu>

Click to check if the server/mediator 
is up and running.

Copy URL Diagnostics 
Server/
Mediator

Copies a selected server/mediator 
and pastes its URL as a link. The 
server/mediator itself is not copied. 
Instead, you can paste the address 
into another location, such as an 
email or a document. Clicking the 
link opens up ALM and takes you to 
the server/mediator. If you are not 
already logged in, ALM first prompts 
for login details.

Diagnostics 
Server/Mediator 
Details

Diagnostics 
Server/
Mediator and 
<right-click 
menu>

Click to view server/mediator 
details.
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Export Diagnostics 
Server/
Mediator and 
<right-click 
menu>

Opens the Export Grid Data dialog 
box, enabling you to export the 
servers/mediators in the grid as a 
text file, Microsoft Excel worksheet, 
Microsoft Word document, or HTML 
document. 

Choose one of the following 
options: 

➤ All. Exports all servers/mediators 
in the grid. 

➤ Selected. Exports selected servers/
mediators in the grid.

Find View Opens the Find dialog box, enabling 
you to search for field details in the 
module. For details, see the 
HP Application Lifecycle Management 
User Guide.

Go to Diagnostics 
Server/Mediator

Diagnostics 
Server/
Mediator

Opens a dialog box which prompts 
you for the server/mediator ID. Click 
OK to open the server/mediator 
details window.

Grid Filters View and 
<right-click 
menu>

Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Information Panel View and 
<right-click 
menu>

Shows/Hides the Information Panel 
in the lower area of the module. 

New Diagnostics 
Server/Mediator 

Diagnostics 
Server/
Mediator

Click to add a new ERP/CRM 
mediator or J2EE/.NET server. For 
information on the relevant fields, 
see "Diagnostics Module Fields" on 
page 856.

UI Elements (A-Z) Menu Description
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Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

Replace Edit and 
<right-click 
menu>

In the grid, opens the Replace dialog 
box, enabling you to replace a field 
value in the grid. For more details, 
see the HP Application Lifecycle 
Management User Guide.

Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For more details, see 
the HP Application Lifecycle 
Management User Guide.

For details about the Diagnostics 
fields, see "Diagnostics Module 
Fields" on page 856.

Set Filter/Sort View Enables you to filter and sort the 
resources in the grid. Any currently 
applied filters or sorting orders are 
displayed below the toolbar. For 
more details, see the HP Application 
Lifecycle Management User Guide.

Update Selected Edit and 
<right-click 
menu>

Opens the Update Selected dialog 
box, enabling you to update a field 
value for a multiple selection in the 
grid. For more details, see the 
HP Application Lifecycle Management 
User Guide.

UI Elements (A-Z) Menu Description
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41
AUT Host Management 

This chapter includes:

Concepts

➤ AUT Resources Overview on page 862

Tasks

➤ How to Import AUT Host Data from Excel on page 863

Reference

➤ AUT Resource Modules User Interface on page 869
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Concepts

AUT Resources Overview 

Application under test components such as Web/application servers or 
database servers are hosted on machines known as AUT hosts. The hosts are 
grouped together in logical containers, known as AUT host pools. The AUT 
hosts are a core element of the new Topology and SiteScope integration 
features.
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Tasks

How to Import AUT Host Data from Excel 

This task describes how to import a list AUT hosts from an Excel file (.xls or 
.csv) into ALM.

This task includes the following steps:

➤ "Prerequisites" on page 863

➤ "Import the AUT hosts" on page 867

➤ "Results" on page 868

 1 Prerequisites

The Excel file must be set up so that the columns can be recognized and 
mapped by the Import feature. 

➤ The first row of the Excel file must contain the field names, or 
corresponding logical names, that appear in the table below. (Logical 
names are not case sensitive.)

Some fields are mandatory, others are required or optional. 

➤ Mandatory indicates a field that must appear in the Excel file. If you 
omit this field, the import fails. If you omit a value in one of the 
rows of this field’s column, the import of that specific row fails.

➤ Required indicates a field that should appear in the Excel file. If you 
omit this field, the code adds the field with the default value for all 
rows. If you include the field, but omit a value in one of the rows of 
this column, the code adds the default value for that row.

➤ Optional indicates a field does not have to appear in the Excel file. 
Omitting this field has no effect on the import procedure.

➤ Fields representing virtual, reference, and invalid fields are ignored.

➤ Empty columns are allowed.
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Set up the columns and values in the file as follows:

Field name Logical name Value Field for

AUTHOST_
NAME 

Required

Logical Name Any string AUT host logical 
name

Note: If this 
value is empty, 
this will be given 
the same value as 
AUTHOST_MAC
HINE_NAME

AUTHOST_
MACHINE_
NAME

Mandatory

Machine Name / 
IP

The machine name/
IP

AUT host 
physical 
machine name

AUTHOST_
USERNAME

Mandatory

Username The username of 
the machine

User name for 
logging on to the 
AUT host 
machine

AUTHOST_
PASSWORD

Mandatory

Password The password of the 
user name

Password for 
logging on to the 
AUT host 
machine
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AUTHOST_
OS

Required for 
UNIX 
platforms 
only

OS Type ➤ SUNOS (default)

➤ Sun Solaris

➤ MacOSX

➤ Linux

➤ Red Hat 
Enterprise Linux

➤ AIX

➤ FreeBSD

➤ HP-UX

➤ HP/UX

➤ HP/UX 64-bit

➤ NonStopOS

➤ OPENSERVER

➤ SCO

➤ SGI Irix

➤ Tru64 5.x

➤ Tru64 pre 4.x 
(Digital)

AUT host 
machine 
operating system

(For UNIX 
platform only)

AUTHOST_
PLATFORM

Required

Platform ➤ Windows 
(default)

➤ UNIX

AUT host 
platform

AUTHOST_
PROTOCOL

Required

Protocol Windows:

➤ NetBIOS 
(default)

➤ SSH

➤ WMI

UNIX:

➤ rlogin

➤ Telnet (default)

➤ SSH

AUT host 
protocol

Field name Logical name Value Field for
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Example:

The following image illustrates an Excel file set up with the following 
AUT hosts: 1.2.3.4, 5.6.7.8, and a third machine whose name was not 
provided.

AUTHOST_
UNIX_
PROMPT

Required for 
UNIX 
platforms 
only

UNIX Prompt  # (default) UNIX prompt on 
the AUT host 
machine

AUTHOST_
DESCRIPTION

Optional

Description Any string AUT host 
description

Field name Logical name Value Field for
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 2 Import the AUT hosts

 a Open the AUT Hosts module:

➤ In ALM: On the ALM sidebar, under Lab Resources, select AUT Hosts.

➤ In Lab Management: On the Lab Management sidebar, under AUT 
Resources, select AUT Hosts.

 b Select AUT Hosts > Import. 

 c Browse to the Excel file containing the AUT hosts, and click Open.
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 3 Results

The progress of the import process is displayed. At the end of the process, 
a report displays the import results. The imported AUT hosts are listed in 
the AUT Hosts module. AUT hosts that are not imported successfully, 
must be added manually.

Example:

The results from importing the Excel file in step 1 above are illustrated in the 
following image:

Note:

➤ No logical name was provided in the Excel file for machine 1.2.3.4. Therefore, 
the logical name given is equivalent to the machine name/IP.

➤ Machine 1’s operating system was specified as SUNOS, whereas the platform 
was specified as Windows. These values are inconsistent as SUNOS is relevant 
only for a UNIX platform. The value SUNOS was replaced with NT.

➤ No machine name was specified for the third machine listed in the Excel file. 
This machine was not imported. It should be added manually.

➤ Required but non-mandatory values were automatically provided by the system 
during the import process.
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Reference

AUT Resource Modules User Interface 

This section includes:

 ➤ AUT Hosts Module on page 870

 ➤ AUT Host Fields on page 871

 ➤ New AUT Host Dialog Box on page 873

 ➤ AUT Host Details Dialog Box on page 875

 ➤ AUT Host Pools Module on page 877

 ➤ Linked Hosts Page on page 879

 ➤ Add AUT Hosts to Pool Dialog Box on page 882

 ➤ AUT Host Pool Fields on page 884

 ➤ New AUT Host Pool Dialog Box on page 885

 ➤ AUT Host Pool Details Dialog Box on page 887

 ➤ AUT Resource Module Menus and Buttons on page 889
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AUT Hosts Module

This module enables you to view and manage AUT hosts.

 

To access Use one of the following:

➤ On the Lab Management sidebar, under AUT 
Resources, select AUT Hosts.

➤ On the ALM sidebar, under Lab Resources, select AUT 
Hosts.

Important 
information

The AUT Host module is available both in Lab 
Management and in ALM.

Relevant tasks "How to Design Topologies" on page 47

See also ➤ "AUT Resources Overview" on page 862

➤ "Topologies Overview" on page 46
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

AUT Host Fields

The following table describes the AUT host fields:

UI Elements Description

<Common Menus 
and Toolbars>

For details on AUT Resource modules menus and 
toolbars, see "AUT Resource Module Menus and Buttons" 
on page 889. 

<AUT Hosts grid> Displays a list of AUT hosts defined in ALM. 

Description tab Displays the main details and a description about the 
AUT host. 

Tip: Right-click the Description area for edit and format 
options. 

History tab Lists changes made to the selected AUT host. For more 
details, see the HP Application Lifecycle Management User 
Guide.

Field Description

Belongs to Pools The host pools to which the AUT host belongs. 

Available in: Lab Management only

Description A description of the AUT host.

Logical Name The logical name given to the AUT host.

Machine Name/IP The name or IP address of the AUT host machine.

Modified The date on which the AUT host details were last 
modified.

OS Type The operating system of the AUT host machine.

Available for: AUT hosts in UNIX only.

Password The password for logging in to the AUT host machine.
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Platform The base operating system of the AUT host machine: 
Window or UNIX.

Protocol The network protocol used for communication with the 
AUT host (for monitoring purposes).

Default value: Windows: NetBIOS; UNIX: SSH

UNIX Prompt The prompt used by the operating system. Also used for 
communication with the AUT host (for monitoring 
purposes).

Available for: UNIX AUT hosts only.

Username The user name for logging in to the AUT host machine.

Field Description
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New AUT Host Dialog Box

This dialog box enables you to create a new AUT host.

 

To access Use one of the following:

➤ On the Lab Management sidebar, under AUT 
Resources, select AUT Hosts. Click New AUT Host . 

➤ On the ALM sidebar, under Lab Resources, select AUT 
Hosts. Click New AUT Host .

Important 
information

When creating an AUT host in ALM, the AUT host is 
automatically added to the project’s AUT host pool.

Tip: If you have a list of AUT hosts set up in an Excel file, 
you can import this list instead of adding the hosts one 
by one. For details, see "How to Import AUT Host Data 
from Excel" on page 863.

Relevant tasks "How to Design Topologies" on page 47

See also ➤ "Topologies Overview" on page 46

➤ "AUT Resources Overview" on page 862
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Machine Name/IP The name or IP of the AUT host machine.

Details Enables you to enter the details of the new AUT host. For 
more details, see "AUT Host Fields" on page 871.
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AUT Host Details Dialog Box

This dialog box enables you to view and modify AUT host details.

 

To access Use one of the following:

➤ On the Lab Management sidebar, under AUT 
Resources, select AUT Hosts. Right-click an AUT host 
in the grid and select AUT Host Details. 

➤ On the ALM sidebar, under Lab Resources, select AUT 
Hosts. Right-click an AUT host in the grid and select 
AUT Host Details. 

Relevant tasks "How to Design Topologies" on page 47

See also ➤ "AUT Resources Overview" on page 862

➤ "Topologies Overview" on page 46
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of AUT hosts. 

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Machine Name/IP The name or IP of the AUT host machine.

Details Displays the details of the selected AUT host. For more 
details, see "AUT Host Fields" on page 871.

History Lists changes made to the selected AUT host. For more 
details, see the HP Application Lifecycle Management User 
Guide.
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AUT Host Pools Module

This module enables you to view and manage AUT host pools.

 

To access On the Lab Management sidebar, under AUT Resources, 
select AUT Host Pools

Relevant tasks The AUT Host Pools module is available only in Lab 
Management.

See also "AUT Resources Overview" on page 862
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Common Menus 
and Toolbars>

For details on AUT Host Pools module menus and 
toolbars, see "AUT Resource Module Menus and Buttons" 
on page 889. 

<AUT Host Pools 
grid>

Displays the AUT host pools defined in the system. 

Description tab Displays the main details and a description about the 
AUT host pool.

Tip: Right-click the Description area for edit and format 
options. 

Linked Hosts tab Enables you to add AUT hosts to the selected pool and 
remove hosts from the pool. For details, see "Linked 
Hosts Page" on page 879.

History tab Lists changes made to the selected AUT host pool. For 
more details, see the HP Application Lifecycle Management 
User Guide.
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Linked Hosts Page 

This page enables you to add AUT hosts to an AUT host pool, and remove 
AUT hosts from an AUT host pool.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access ➤ From the AUT Host Pools module: 

On the Lab Management sidebar, under AUT 
Resources, select AUT Host Pools. In the information 
panel, select Linked Hosts.

➤ From the AUT Host Pool Details dialog box: 

On the Lab Management sidebar, under AUT 
Resources, select AUT Host Pools. Right-click an AUT 
host pool and select AUT Host Pool Details. In the AUT 
Host Pool Details dialog box, select Linked Hosts.

Note: Available in Lab Management only.

Important 
information

The Linked Hosts page enables you to link multiple AUT 
hosts to an AUT host pool.

Alternatively, you can link a single AUT host to multiple 
AUT host pools from the Belongs To Pools field in the 
AUT host’s details. For details, see "AUT Host Fields" on 
page 871.

See also "AUT Resources Overview" on page 862

UI Elements Description

Add Hosts to Pool. Opens the Add AUT Hosts to Pool 
dialog box, enabling you to select AUT hosts to add to 
the AUT host pool.

Remove Host. Removes the selected AUT hosts from the 
AUT host pool. 

Go to Host. Displays the selected linked AUT host in the 
AUT Hosts module.

AUT Host Details. Opens the AUT Host Details dialog 
box, enabling you to view details about the selected 
linked AUT host. For details, see "AUT Host Fields" on 
page 871. 

Refresh All. Refreshes the grid so it displays the most 
up-to-date information.
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Set Filter/Sort. Enables you to filter and sort the grid. 
Any currently applied filters or sorting orders are 
displayed below the toolbar. For details, see the 
HP Application Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For details, see the HP Application 
Lifecycle Management User Guide.

Find. Opens the Find dialog box, enabling you to search 
for an AUT host. For details, see the HP Application 
Lifecycle Management User Guide.

<Linked Hosts grid> Lists the AUT hosts that belong to the AUT host pool. For 
details about the host fields, see "AUT Host Fields" on 
page 871.

UI Elements Description
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Add AUT Hosts to Pool Dialog Box

This page enables you to select AUT hosts to add to an AUT host pool.

 

To access ➤ From the AUT Host Pools module: 

On the Lab Management sidebar, under AUT 
Resources, select AUT Host Pools. In the information 
panel, select Linked Hosts and click the Add Hosts to 
Pool  button.

➤ From the AUT Host Pool Details dialog box: 

On the Lab Management sidebar, under AUT 
Resources, select AUT Host Pools. Right-click an AUT 
host pool and select AUT Host Pool Details. In the AUT 
Host Pool Details dialog box, select Linked Hosts and 
click the Add Hosts to Pool  button.

Note: Available in Lab Management only.



Chapter 41 • AUT Host Management

883

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

Alternatively, you can link a single AUT host to multiple 
AUT host pools from the Belongs To Pools field in the 
AUT host’s details. For details, see "AUT Host Fields" on 
page 871.

See also "AUT Resources Overview" on page 862

UI Elements Description

Refresh All. Refreshes the grid so it displays the most 
up-to-date information.

Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields to display in the 
grid and their order. For details, see the HP Application 
Lifecycle Management User Guide.

Set Filter/Sort. Enables you to filter and sort the grid. 
Any currently applied filters or sorting orders are 
displayed below the toolbar. For details, see the 
HP Application Lifecycle Management User Guide.

Adds the selected AUT hosts to the AUT host pool.

<AUT Hosts grid> Lists the AUT hosts available to add to the AUT host 
pool. 

Selected Displays the AUT hosts selected to add to the pool.
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AUT Host Pool Fields

The following fields are available for AUT host pools:

Field Description

Description A description of the AUT host pool.

Modified The date on which the AUT host pool details were last 
modified.

Pool ID The ID of the AUT host pool.

Pool Name The name of the AUT host pool.

Note: The name may contain up to 128 characters, 
excluding spaces, periods, and any of the following 
characters: 

 : ; * \ / ” ~ & ? { } $ % | < > + = ^ [ ] ( ) 

Total Hosts The total number of AUT hosts in the host pool.
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New AUT Host Pool Dialog Box

This dialog box enables you to create a new AUT host pool.

 

To access On the Lab Management sidebar, under AUT Resources, 
select AUT Host Pools. Click New AUT Host Pool . 

See also "AUT Resources Overview" on page 862



Chapter 41 • AUT Host Management

886

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Pool Name The name of the AUT host pool.

Details Enables you to enter the details of the new AUT host 
pool. For more details, see "AUT Host Pool Fields" on 
page 884.
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AUT Host Pool Details Dialog Box

This dialog box enables you to view and modify AUT host pool details.

 

To access On the Lab Management sidebar, under AUT Resources, 
select AUT Hosts. Right-click an AUT host in the grid and 
select AUT Host Details. 

See also "AUT Resources Overview" on page 862
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse 
through the list of AUT host pools. 

Spell Check. Checks the spelling for the selected word or 
text box. 

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Enables you to configure how to check 
the spelling.

Pool Name The name of the AUT host pool.

Details Displays the details of the selected AUT host pool. For 
more details, see "AUT Host Fields" on page 871.

Linked Hosts Enables you to add AUT hosts to the selected pool and 
remove hosts from the pool. For details, see "Linked 
Hosts Page" on page 879.

History Lists changes made to the selected AUT host pool. For 
more details, see the HP Application Lifecycle Management 
User Guide.
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AUT Resource Module Menus and Buttons

These modules enable you to manage the AUT resources which host 
applications under test.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Use one of the following:

➤ In Lab Management: On the Lab Management sidebar, 
under AUT Resources, select <AUT Resource>

➤ In ALM: on the ALM sidebar, under Lab Resources, 
select AUT Hosts.

Note: In Lab Management, you can define both AUT 
hosts and AUT host pools. In ALM, you can define only 
AUT hosts.

Important 
Information

➤ AUT hosts can be managed both in Lab Management 
and in ALM. 

➤ Only a user with administrator privileges can manage 
AUT host pools (in Lab Management).

Relevant tasks "How to Design Topologies" on page 47

See also ➤ "AUT Resources Overview" on page 862

➤ "Topologies Overview" on page 46

UI Elements (A-Z) Where Description

<AUT resource> 
Details

<AUT 
resource> and 
right-click 
menu

Opens the <AUT resource> Details 
dialog box, enabling you to view 
details of the selected AUT resource. 

Add to Favorites Favorites Opens the Add Favorite dialog box, 
enabling you to add a favorite view 
to your private or the public folder. 
For details, see the HP Application 
Lifecycle Management User Guide.
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Copy URL <AUT 
resource> and 
<right-click 
menu>

Copies a selected AUT resource URL 
and pastes it as a link. You can paste 
the URL into another location, such 
as an email or a document. Clicking 
the link opens up ALM and takes 
you to the resource file or folder. If 
you are not already logged in, ALM 
first prompts for login details.

Delete Edit and 
<right-click 
menu>

Deletes the AUT resource selected in 
the grid.

Export <AUT 
Resource> 
and 
<right-click 
menu>

Opens the Export All Grid Data 
dialog box, enabling you to export 
the AUT resources in the grid as a 
text file, Microsoft Excel worksheet, 
Microsoft Word document, or HTML 
document. 

Choose one of the following 
options: 

➤ All. Exports all resources in the 
grid. 

➤ Selected. Exports selected 
resources in the grid.

Find View Opens the Find dialog box, enabling 
you to search for a resource in the 
module. For details about search 
options, see the HP Application 
Lifecycle Management User Guide.

Go to <AUT 
Resource>

<AUT 
Resource>

Opens the Go To <AUT Resource> 
dialog box, enabling you to find a 
specific resource by its ID number. 
You can only go to resources that are 
in the current filter.

UI Elements (A-Z) Where Description
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Grid Filters View and 
<right-click 
menu>

Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Import AUT Hosts Enables you to import a list of 
AUT hosts from an Excel file (.xls or 
.csv) into ALM. For details, see "How 
to Import AUT Host Data from 
Excel" on page 863.

Information Panel View and 
<right-click 
menu>

Shows/Hides the Information Panel 
in the lower area of the module. 

New <AUT 
Resource>

<AUT 
Resource>

Enables you to add an AUT resource.

Note: For AUT host pools, this is 
available in Lab Management only

Organize Favorites Favorites Opens the Organize Favorites dialog 
box, enabling you to organize the 
list of favorite views by changing 
properties or deleting views. For 
details, see the HP Application 
Lifecycle Management User Guide.

Private Favorites Lists the favorite views that are 
accessible only to the user who 
created them.

Public Favorites Lists the favorite views that are 
accessible to all users.

Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

Replace Edit and 
<right-click 
menu>

Opens the Replace dialog box in the 
<AUT Resource> grid, enabling you 
to replace a resource field value in 
the grid. For more details, see the 
HP Application Lifecycle Management 
User Guide. 

UI Elements (A-Z) Where Description
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Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For details, see the 
HP Application Lifecycle Management 
User Guide.

For details about the resource fields, 
see:

➤ "AUT Host Fields" on page 871

➤ "AUT Host Pool Fields" on 
page 884

Set Filter/Sort View Enables you to filter and sort the 
resources in the grid. Any currently 
applied filters or sorting orders are 
displayed below the toolbar. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Updated Selected Edit and 
<right-click 
menu>

Opens the Update Selected dialog 
box, enabling you to update a field 
value for a multiple selection in the 
<AUT resource> grid. For more 
details, see the HP Application 
Lifecycle Management User Guide.

UI Elements (A-Z) Where Description
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42
Performance Center System 
Administration 

This chapter includes:

Concepts

➤ ALM-Performance Center Communication Security on page 894

➤ Performance Center System User on page 894

Tasks

➤ How to Update the Communication Security Passphrase on page 896

➤ How to Change the System User on page 898

➤ How to Configure the System User Manually on page 901

Reference

➤ Required Policies for the Performance Center System User on page 908

➤ System Identity Utility Window on page 909

Troubleshooting and Limitations on page 915
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Concepts

ALM-Performance Center Communication Security

During installation ALM and the Performance Center Server and hosts, a 
passphrase, known as the Communication Security passphrase, is defined. 
This passphrase enables secure communication between the 
Performance Center components and the ALM Platform. This passphrase 
must be identical on all of the components of the system.

The Communication Security passphrase can be updated from time to time. 
For information about updating the Communication Security passphrase, 
see "How to Update the Communication Security Passphrase" on page 896.

Performance Center System User 

During installation of the Performance Center Server and hosts, a default 
Performance Center system user, IUSR_METRO (default password 
P3rfoRm@1nce), is created in the Administrators user group of the server/
host machines.

To prevent security breaches, you can replace Performance Center’s default 
system user by creating a different local system user, or by using a domain 
user. 

For stronger security, you can create a non-administrator 
Performance Center system user in a local group under the Users group. This 
system user has the permissions granted to any user in the Users group with 
extended rights to Web services and the HP file system and registry. 

With these limited permissions, such a system user cannot perform all 
administrative system tasks. You need to specify a configuration user (a user 
with administrative privileges that is defined on the Performance Center 
Server and hosts) that Performance Center uses when administrative tasks 
are required on the system. After the tasks are complete, the system user 
reverts back to itself, with its limited Performance Center user permissions.
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Note: The configuration user is saved in the database so that whenever an 
administrative-level system user is required to perform a task, the system 
automatically uses the configuration user, without asking for its credentials.

The Performance Center Server is installed with the System Identity Utility 
that enables you to manage the Performance Center system user on the 
Performance Center Server and hosts from one centralized location.

Using this utility, you can periodically update the Performance Center 
system user name and password. For more information, see "How to Change 
the System User" on page 898.

Remote Performance Center Server and Host Administration

To perform administrative tasks on the Performance Center Server or hosts 
(such as adding, configuring, or resetting a Performance Center Server/host), 
Performance Center must use a user with administrative privileges. This 
must be the Performance Center system user with administrative privileges 
or, if the Performance Center system user is non-administrative, a 
configuration user.

When the Performance Center system user has administrative privileges and 
is defined on the remote machine, tasks are performed upon request. After 
validating the Performance Center system user or configuration user, 
Performance Center can perform required tasks.
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Tasks

How to Update the Communication Security Passphrase

This task describes how to update the Communication Security passphrase 
on the ALM-Performance Center system components. 

To learn more about ALM-Performance Center communication security, see 
"ALM-Performance Center Communication Security" on page 894.

This task includes the following steps:

➤ "Update the Communication Security passphrase on the ALM Platform" 
on page 896

➤ "Update the Communication Security passphrase on the 
Performance Center components" on page 897

 1 Update the Communication Security passphrase on the 
ALM Platform

 a In Site Administration, update the 
COMMUNICATION_SECURITY_PASSPHRASE default parameter. For 
details, see HP Application Lifecycle Management Administrator Guide. 

 b Restart the HP Application Lifecycle Management service on the 
ALM Platform server.
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 2 Update the Communication Security passphrase on the 
Performance Center components

The System Identity Utility is installed on the Performance Center Server. 
You use this utility to update the Communication Security passphrase on 
the Performance Center Server and hosts from one centralized location.

 a From the Performance Center Server installation’s bin directory, open 
the System Identity Utility (<Performance Center Server Installation 
directory>/bin/IdentityChangerUtil.exe).

Note: You can run this utility from any one of the Performance Center 
Servers in the system.

 b Enter the ALM Platform details to connect to ALM.

 c The System Identity Utility opens. For user interface details, see 
"System Identity Utility Window" on page 909. 

In the Communication Security Passphrase section, select Change, and 
enter the new Communication Security passphrase.

 d Click Apply.
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How to Change the System User 

You use the System Identity Utility, installed on the Performance Center 
Server, to change the system user on the Performance Center Server and 
hosts.

When you change the system user, or a user’s password, the System Identity 
Utility updates the Performance Center Server and hosts. 

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

To learn more about the Performance Center system user, see 
"Performance Center System User" on page 894.

This task includes the following steps:

➤ "Prerequisites" on page 899

➤ "Launch the System Identity Utility on the Performance Center Server" on 
page 899

➤ "Change the details of the Performance Center user" on page 899

➤ "Verify that the system user was changed on the Performance Center 
Server" on page 900
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 1 Prerequisites

➤ When changing the system user, Performance Center must be down. 
That is, all users must be logged off the system and no tests may be 
running.

➤ When changing the user password:

➤ Ensure that each host is listed in the Machines table under one alias 
only.

➤ In the case of a domain user, when the domain IT team notifies you 
that the password is to be changed, you need to temporarily change 
the Performance Center system user on the Performance Center 
Server and hosts to a different user. After the domain IT team has 
changed the password of the domain user and has notified you of 
this change, you need to change the Performance Center system 
user back to the domain user on the Performance Center Server and 
hosts.

 2 Launch the System Identity Utility on the 
Performance Center Server

 a In the Performance Center Server installation’s bin directory, open the 
System Identity Utility (<Performance Center Server Installation 
directory>/bin/IdentityChangerUtil.exe).

 b Enter the ALM Platform details to connect to ALM.

The System Identity Utility opens. For user interface details, see "System 
Identity Utility Window" on page 909.

 3 Change the details of the Performance Center user

Enter the relevant details to update and click Apply. The utility updates 
the Performance Center Server and hosts, starting with the 
Performance Center Server. 

In the lower part of the utility window, the Machines table displays the 
status of each machine during the configuration process. 
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If the utility is unable to change the user on the Performance Center 
Server, it stops the configuration, rolls back the change, and issues a 
message explaining why the change cannot be made. Correct the error 
and click Apply again.

When configuration completes successfully on the Performance Center 
Server, the utility proceeds with the configuration of the hosts. The utility 
attempts to configure all the hosts, even if the configuration on one or 
more hosts is unsuccessful. In this case, after the utility has attempted to 
configure all the hosts, correct the errors on the failed hosts, and click 
Reconfigure. The utility runs again on the whole system. 

Note: If the configuration continues to fail, you can configure the 
Performance Center Server and hosts manually. However, all attempts 
should be made to correct errors that cause the configuration to fail. 
Manual configuration should be left as a last resort. For details on 
configuring the Performance Center Server and hosts manually, see "How 
to Configure the System User Manually" on page 901.

 4 Verify that the system user was changed on the 
Performance Center Server

 a Open the IIS Manager and verify that the Performance Center user is 
defined in the LoadTest and PCS virtual directories.

 b Check in the PCQCWSAppPool and LoadTestAppPool application 
pools that the identity is the Performance Center user. 

Note: If the Performance Center user was not updated, see 
"Troubleshooting and Limitations" on page 915.
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How to Configure the System User Manually

This task describes how to manually configure the Performance Center 
system user on the Performance Center Server and hosts.

Note: 

➤ First try to configure the Performance Center user using the System 
Identity Utility (see "How to Change the System User" on page 898). Use 
these manual instructions as a last resort only.

➤ This section applies to an administrative or non-administrative 
Performance Center user on the Performance Center Server and hosts.

➤ Manual configuration of the Performance Center user on the 
Performance Center Server and hosts involves granting the required 
Performance Center policies, updating the Performance Center user, and, 
for a non-administrative Performance Center user, granting the required 
Performance Center permissions. 
Follow all the procedures carefully, noting which procedures are relevant 
for the Performance Center Server and which for the hosts.

This task includes the following steps:

➤ "Define the Performance Center user as an Admin or Non-Admin user" on 
page 902

➤ "Configure IIS settings (Performance Center Server only)" on page 902

➤ "Configure the COM object identity" on page 903

➤ "Reset services" on page 903

➤ "Admin user only: Verify Performance Center user policies" on page 904

➤ "Non-Admin user only: Configure Performance Center user policies and 
permissions" on page 905
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 1 Define the Performance Center user as an Admin or 
Non-Admin user

The Performance Center system user can have administrative or 
non-administrative permissions. You define what type of user it is by 
adding it to the relevant local user group on the Performance Center 
Server or host.

 a Open the Computer Management (Control Panel > Administrative 
Tools > Computer Management).

 b Add the user to the appropriate user group. In System Tools > Local 
Users and Groups > Users.

➤ For administrative system users: Double-click the 
Performance Center user, and click the Member of tab. If 
Administrators is not listed, click Add, select Administrators, and 
click OK.

➤ For non-administrative system users: Double-click the 
Performance Center user, and click the Member of tab. Change the 
Performance Center user to belong to the following groups:

- Users

- Distributed Com Users

- Performance Log Users

 2 Configure IIS settings (Performance Center Server only)

 a Open the IIS Manager on the Performance Center Server machine:

➤ Windows 2003: Change the system user in the LoadTest and PCS 
virtual directories.

➤ Windows 2008: For each of the LoadTest and PCS virtual directories, 
add the Performance Center system user and grant the user full 
control on the virtual directory. 

 b Change the PCQCWSAppPool and LoadTestAppPool application pool 
identity to the Performance Center system user. 
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 3 Configure the COM object identity

For the Performance Center Server and hosts, change the identity of the 
COM objects to the Performance Center user.

For all the COM objects listed in the 
<Performance Center component installation>\bin\MiDCOM.ini file, 
configure the identity to be the Performance Center user as follows:

 a Run dcomcnfg.

 b For each COM object, under Properties > Identity, select This user and 
enter the Performance Center user details.

 4 Reset services

For the Performance Center Server and hosts, reset the services as follows:

➤ Performance Center Servers and hosts: Reset the RemoteManagement 
Agent service using the following commands:

where username and password are those of the Performance Center 
user.

➤ Performance Center hosts only: 

➤ Reset the Performance Center Agent service using the following 
commands:

where username and password are those of the Performance Center 
user.

➤ Open the Services console, and restart the Performance Center Load 
Testing Service.

%installation folder%\al_agent\bin\alagentservice.exe -remove 

%installation folder%\al_agent\bin\alagentservice.exe -install <username> 
<password> 

%installation folder%\launch_service\bin\magentservice.exe -remove 

%installation folder%\launch_service\bin\magentservice.exe -install 
<username> <password>
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 5 Admin user only: Verify Performance Center user policies

Note: This section is relevant when configuring an administrative 
Performance Center user only.

On the Performance Center Server and hosts, verify that the 
Performance Center user has the necessary policies. For details, see 
"Required Policies for the Performance Center System User" on page 908.

If any of these policies is missing, grant the Performance Center user the 
missing policies.
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 6 Non-Admin user only: Configure Performance Center user 
policies and permissions

Note: This section is relevant when configuring a non-administrative 
Performance Center user only.

On the Performance Center Server and hosts:

 a Grant the Performance Center user the required policies. For details, 
see "Required Policies for the Performance Center System User" on 
page 908.

 b Change registry permissions: Open the Registry Editor (regedt32) and 
give the Performance Center user full access to:

In addition, on hosts only:

- HKEY_LOCAL_MACHINE\Software\Mercury Interactive
- HKEY_CLASSES_ROOT\interface
- HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 
- HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 
- HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

- HKLM\SOFTWARE\Microsoft\Jet\4.0\Engines\Text (used by Analysis)
- HKEY_CLASSES_ROOT\CLSID\{67489277-9AB8-4AF6-91B4-94ED62303BE5}
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 c Add full control permissions to directories and files: 

➤ In the File System folder grant the Performance Center user full 
control of:

In addition, on hosts only:

If a file does not exist, create it and give the user full access.

➤ In the File System folder, after installing Web services, grant the 
IWAM_Machine user Read permissions in the following directory:

- The Performance Center directory 
(C:\Program Files\HP\Performance Center) and all sub-directories

- %CommonProgramFiles%

- %windir%\TEMP

- If the systemroot is on an NTFS partition, grant at least Read access to
- %SystemRoot%\System32\Perfc009.dat
- %SystemRoot%\System32\Perfh009.dat

- C:\Documents and Settings\Default User\Local Settings\Temp

- %windir%\wlrun7.ini

- %windir%\wlrun5.ini

- %windir%\mercury.ini

- %windir%\collate.txt

- %windir%\OnlineSet.ini

windir%\TEMP
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 d Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all 
folders needed to run .NET applications (Web services, and so on).

In a command line, go to

and run 

 e Change permissions of the Crypto key:

Open C:\Documents and Settings\All Users\Application 
Data\Microsoft\Crypto\RSA\MachineKeys. 

Right-click the f9416f003254e6f10da1f9bad8e4c383 file and select 
Properties. 

In the Security tab, add the Users Group and grant it full control.

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Reference

Required Policies for the Performance Center System 
User 

This section describes the policies required for the Performance Center 
system user.

Note: This section applies to:

➤ An administrative or non-administrative Performance Center user

➤ All Performance Center servers and hosts

The Performance Center user must be granted all of the following policies:

 Policy Reason

Create global object For Autolab running Vusers on the Controller.

Batch logon rights The minimum policies required to run Web 
applications.

Service logon rights The minimum policies required to run Web 
applications.

Access this computer 
from the network 

The minimum policies required to run Web 
applications.

Log on locally Required by infra services, For example, after reboot, 
the system logs in with the Performance Center system 
user.
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System Identity Utility Window 

This utility enables you update the ALM-Performance Center 
Communication Security passphrase, as well as the Performance Center 
system user (by default, IUSR_METRO) and/or password on the 
Performance Center Server and hosts from one centralized location.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access From the Performance Center Server installation’s bin 
directory, open the System Identity Utility 
(<Performance Center Server Installation directory>/bin/
IdentityChangerUtil.exe).

Important 
information

➤ This utility does not apply changes to UNIX machines, 
Standalone Load Generators, or machines that are 
located over the firewall.

➤ When updating the Communication Security 
passphrase, it is essential that it is updated on the 
ALM Platform as well.

➤ When changing the system user, Performance Center 
must be down. That is, all users must be logged off the 
system and no tests may be running.

Relevant tasks ➤ "How to Change the System User" on page 898

➤ "How to Update the Communication Security 
Passphrase" on page 896

See also ➤ "Performance Center System User" on page 894

➤ "ALM-Performance Center Communication Security" 
on page 894

UI Elements Description

Applies the selected changed on the Performance Center 
Server and hosts, starting with the Performance Center 
Server. 

Hides/shows the legend.

If, when applying a change, there are errors on any of the 
Performance Center hosts, troubleshoot the problematic 
host machines, then click Reconfigure. The utility runs 
again on the Performance Center Server and hosts.
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Performance Center 
User

The Performance Center system user details.

➤ Change. Enables you to select which detail to change.

➤ None. Do not change the user’s name or password.

➤ Password Only. Enables you to change only the 
Performance Center system user’s password.
Note: When changing the password:
- Ensure that each host is listed in the Machines 
table under one alias only.
- In the case of a domain user, when the domain IT 
team notifies you that the password is to be 
changed, you need to temporarily change the 
Performance Center system user on the 
Performance Center Server and hosts to a different 
user. After the domain IT team has changed the 
password of the domain user and has notified you 
of this change, you need to change the 
Performance Center system user back to the 
domain user on the Performance Center Server and 
hosts.

➤ User. Enables you to change the 
Performance Center system user name and 
password.

➤ Domain\Username. The domain and user name of the 
Performance Center system user.

➤ Password/Confirm Password. The password of the 
Performance Center system user. 

➤ Delete Old User. If you are changing the user, this 
option enables you to delete the previous user from 
the machine. 

Note: You cannot delete a domain user.

UI Elements Description
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User Group The details of the user group to which the 
Performance Center system user belongs.

➤ Group type. The type of user group. 

➤ Administrator Group. Creates a user in the 
Administrators group with full administrator 
policies and permissions.

➤ Other. Creates a local group under the Users group, 
granting policies and permissions as well as other 
Performance Center permissions.

Configuration User If you are creating a non-administrative 
Performance Center system user, that is, if you selected 
Other under User Group, you need to configure a 
configuration user (a system user with administrative 
privileges) that the non-administrative 
Performance Center system user can impersonate when it 
needs to perform administrative tasks. For more details, 
see "Performance Center System User" on page 894. 

If you selected Delete Old User in the 
Performance Center User area, ensure that the 
configuration user you are configuring is not the same as 
the system user you are deleting. Alternatively, do not 
delete the old user.

➤ Domain\Username. The domain and user name of a 
system user that has administrator privileges on the 
Performance Center Server and hosts.

➤ Password/Confirm Password. The password of a 
system user that has administrator privileges on the 
Performance Center Server and hosts. 

UI Elements Description
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Communication 
Security Passphrase

The Communication Security passphrase that enables the 
Performance Center Server and hosts to communicate 
securely with the ALM Platform. 

➤ Change. Enables you to change the passphrase.

➤ New passphrase. The new Communication Security 
passphrase.

Note: This passphrase must be identical to the 
Communication Security passphrase defined on the 
ALM Platform. For details, see "How to Update the 
Communication Security Passphrase" on page 896.

UI Elements Description
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Machines grid Displays the configuration status on each of the 
Performance Center components. 

➤ Configuration complete. The system user 
configuration was completed.

➤ Needs to be configured. The Performance Center 
server/host is pending configuration. Displayed only 
after the Performance Center Server configuration is 
complete.

➤ Configuring..... The Performance Center Server/host in 
being configured.

➤ Configuration failed. The Performance Center Server/
host configuration failed. The utility displays the 
reason for failure together with this status.

Notes: 

➤ If the utility is unable to apply the change on the 
Performance Center Server, the utility stops the 
configuration, rolls back the change, and issues a 
message explaining why the change cannot be 
applied. Correct the error and click Apply again.

When configuration completes successfully on the 
Performance Center Server, the utility proceeds with 
the configuration of the hosts. The utility attempts to 
configure all the hosts, even if the configuration on 
one or more hosts is unsuccessful. In this case, after 
the utility has attempted to configure all the hosts, 
correct the errors on the failed hosts, and click 
Reconfigure. The utility runs again on the whole 
system. 

➤ When changing system user details, if the 
configuration continues to fail, you can perform the 
change on the Performance Center Server and hosts 
manually. However, this is not recommended—all 
attempts should be made to correct errors that cause 
the configuration to fail. Changing the system user 
manually should be left as a last resort. For details on 
changing the system user manually, 
Performance Center see "How to Configure the System 
User Manually" on page 901.

UI Elements Description
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Troubleshooting and Limitations 

This section describes troubleshooting and limitations for 
Performance Center system user.

Windows 2003: The Performance Center user was not defined in the IIS 
virtual directories, and the application pool identity is not the 
Performance Center user. 

Troubleshooting: If the Windows Remote Management (WS-Management) 
(WinRM) service is running, disable the service, and configure the system 
user manually. For details, see "How to Configure the System User Manually" 
> "Configure IIS settings (Performance Center Server only)" on page 902.
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43
System Health

This chapter includes:

Concepts

➤ System Health Overview on page 918

Reference

➤ System Health User Interface on page 920
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Concepts

System Health Overview 

To design and run performance tests in ALM Performance Center, the 
system must be up and running. Verifying the health of the system includes 
validating that the components of the system are indeed up and running 
and communicating with each other, as well as maintaining the system in a 
healthy state. Periodic automated tasks locate and repair any failures, 
thereby ensuring constant monitoring of the system’s key components.

For System Health user interface details, see "System Health User Interface" 
on page 920.
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Reference

System Health Maintenance Tasks

The following table describes the system health maintenance tasks:

UI Elements (A-Z) Description

Check Host Task Verifies the host installation, and updates its status to 
either Operational or Non-Operational.

Default frequency. Every 24 hours

Data Processor Task Sets and updates a data processing queue for the 
following actions: Analyzing a test run, recalculating the 
SLA, or adding test runs to a trend report.

Default frequency. Every minute

OFW Status Update 
Task

Updates the real status (Operational or Non-Operational) 
of a host that is located over a firewall.

Default frequency. Every 15 minutes

Orphan Run Task Identifies orphan test runs during and outside of the 
active timeslot.

Default frequency. Every 15 minutes
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System Health User Interface 

This section includes:

 ➤ System Health Module Window on page 921

 ➤ Configure System Check Dialog Box on page 924

 ➤ Maintenance Task Fields on page 926

 ➤ Maintenance Task Menus and Buttons on page 927

Resource Recovery 
Task

Performs predefined validation tests on Controllers and 
load generators that are in the Non-Operational state. If 
the host passes the test, its status changes to Operational.

➤ Controller validation tests. OTA connection, ability to 
run, and available disk space.

➤ Load Generator validation tests. Connection to Agent

The task parameters should be within the following 
guidelines:

➤ MIN_APPLICATION_DIR_DISK_SPACE. Between 10 and 
1000

➤ CHECK_LG_TIMEOUT. Between 1 and 15

➤ MAX_RETRIES. Between 1 and 1000

➤ RESULT_EXPIRY_DAYS. Between 1 and 1000

Default frequency. Every 15 minutes

Note: For load generators over a firewall, this is 
performed by the OFW Status Update task (see above).

Result Cleaning Task Cleans test run results from Controllers or load 
generators in the following instances:

➤ If the results have already been collated.

➤ There are old performance tests whose results were not 
collated.

➤ If the performance test was deleted.

Default frequency. Every 6 hours

UI Elements (A-Z) Description
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System Health Module Window

This module displays information about the ALM Performance Center 
system health maintenance tasks and overall system checks.

 

To access On the Lab Management sidebar, under Lab Settings, 
select System Health.
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System Check Tab

This tab enables you to run a full validation on your 
ALM-Performance Center system. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Opens the configure system check dialog box, enabling 
you to select servers and hosts in the 
ALM-Performance Center system to include in the 
system check. For details, see "Configure System Check 
Dialog Box" on page 924.

Refresh All. Refreshes the grid so that it displays the most 
up-to-date information.

If Auto Refresh is enabled, this button is disabled.

Set Auto Refresh On/Off. When enabled, automatically 
refreshes the grid every 5 seconds so that it displays the 
most up-to-date task information.

Displays the system check results that have a failed status 
only.

Opens the Export Grid Data dialog box, enabling you to 
export the results of the system check as a Microsoft 
Excel worksheet. 

Choose one of the following options: 

➤ All. Exports all tasks in the grid. 

➤ Selected. Exports selected tasks in the grid.

<Results grid> Displays the progress and results of the system check.
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Maintenance Tasks Tab

This tab displays information about maintenance tasks performed by the 
system.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Maintenance Task 
tab UI elements>

➤ Maintenance Task fields. For field definitions, see 
"Maintenance Task Fields" on page 926.

➤ Maintenance Task menus and buttons. For command 
and button descriptions, see "Maintenance Task 
Menus and Buttons" on page 927.

➤ ALM main menu and sidebar. For details on the Tools 
menu, Help menu and sidebar, see "ALM Common 
Areas" on page 41.

<Maintenance tasks 
grid>

Displays a list of maintenance tasks. For details, see 
"System Health Maintenance Tasks" on page 919.

Parameters tab Displays a description of the selected maintenance task. 

Description tab Displays parameter information for the selected 
maintenance task. 

Right-click the text box to display a toolbar for 
formatting and spell checking the text.
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Configure System Check Dialog Box

This dialog box enables you to select which ALM-Performance Center 
system components (servers and hosts) to include when doing a system 
check.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  On the Lab Management sidebar, under Lab Settings, 
select System Health.

2  Click the System Check tab, and click .

Important 
information

➤ The system check is performed on Performance Center 
Servers and hosts that are in an operational state only.

➤ The system check is performed on hosts with the 
Controller purpose only.

See also "System Health Overview" on page 918

UI Elements Description

Check ALM Server Includes the ALM Platform server in the system check.

Check 
Performance Center 
Servers

Includes operational Performance Center Servers in the 
system check.

➤ All. Includes all of the operational Performance Center 
Servers in the system check.

➤ Specific. Enables you to select operational 
Performance Center Servers to include in the system 
check.

Check Hosts Includes operational Performance Center hosts with the 
Controller purpose in the system check.

➤ All. Includes all of the operational Performance Center 
hosts with the Controller purpose in the system check.

➤ Specific. Enables you to select operational 
Performance Center hosts with the Controller purpose 
to include in the system check.

<Performance Center 
Server grid>

Lists the Performance Center Servers that you selected to 
include in the system check, and displays their details.

<Performance Center 
host grid>

Lists the Performance Center hosts that you selected to 
include in the system check, and displays their details.
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Maintenance Task Fields

The following fields are available in the Maintenance Tasks tab:

Field (A-Z) Description

Description A description of the maintenance task

ID The maintenance task ID.

Name The maintenance task name. For a list of the 
maintenance task types, see "System Health Maintenance 
Tasks" on page 919.

Recurrence (minutes) Displays the frequency of the maintenance task.
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Maintenance Task Menus and Buttons

User interface elements are described below (unlabeled elements are shown 
in angle brackets): 

UI Elements (A-Z) Where Description

Copy URL Maintenance 
Tasks and 
<right-click 
menu>

Copies a selected maintenance task 
and pastes its URL as a link. The task 
itself is not copied. Instead, you can 
paste the address into another 
location, such as an email or a 
document. Clicking the link opens 
up ALM and takes you to the task 
file or folder. If you are not already 
logged in, ALM first prompts for 
login details.

Export Maintenance 
Tasks and 
<right-click 
menu>

Opens the Export Grid Data dialog 
box, enabling you to export the 
tasks in the grid as a text file, 
Microsoft Excel worksheet, 
Microsoft Word document, or HTML 
document. 

Choose one of the following 
options: 

➤ All. Exports all tasks in the grid. 

➤ Selected. Exports selected tasks in 
the grid.

Find View Opens the Find dialog box, enabling 
you to search for tasks in the 
module. For details about search 
options, see the HP Application 
Lifecycle Management User Guide.

Go to 
Maintenance Task

Maintenance 
Tasks

Opens the Go To Maintenance Task 
dialog box, enabling you to find a 
specific task by its ID number. You 
can only go to tasks that are in the 
current filter.
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Grid Filters View and 
<right-click 
menu>

Enables you filter the data according 
to an entry in the filter box. For 
details about filtering options, see 
the HP Application Lifecycle 
Management User Guide.

Information Panel View and 
<right-click 
menu>

Shows/Hides the Information Panel 
in the lower area of the module. 

Maintenance Tasks 
Details

Maintenance 
Tasks and 
<right-click 
menu>

Opens the Maintenance Task Details 
dialog box, enabling you to view 
and edit details of the task. 

Refresh All View Refreshes the grid so that it displays 
the most up-to-date information. 

Replace Edit and 
<right-click 
menu>

In the grid, opens the Replace dialog 
box, enabling you to replace a field 
value in the grid. For more details, 
see the HP Application Lifecycle 
Management User Guide. 

Select Columns View Opens the Select Columns dialog 
box, enabling you to determine 
which fields to display in the grid 
and their order. For more details, see 
the HP Application Lifecycle 
Management User Guide.

For details about the System Health 
fields, see "Maintenance Task Fields" 
on page 926.

UI Elements (A-Z) Where Description
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Set Filter/Sort View Enables you to filter and sort the 
tasks in the grid. Any currently 
applied filters or sorting orders are 
displayed below the toolbar. For 
more details, see the HP Application 
Lifecycle Management User Guide.

Updated Selected Edit and 
<right-click 
menu>

Opens the Update Selected dialog 
box, enabling you to update a field 
value for a multiple selection in the 
grid. For more details, see the 
HP Application Lifecycle Management 
User Guide.

UI Elements (A-Z) Where Description
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44
Secure Host Communication

This chapter includes:

Concepts

➤ Secure Host Communication Overview on page 932

➤ Host Security Configuration on page 934

➤ Remote Security Configuration on page 934

➤ Host Security Best Practices on page 937

Tasks

➤ How to Configure Security Settings Locally on Hosts on page 938

➤ How to Update Host Security Settings Remotely on page 940

Reference

➤ Secure Host Communication User Interface on page 943

Troubleshooting and Limitations on page 952
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Concepts

Secure Host Communication Overview 

The need to secure communication channels from hackers attacking the 
corporate networks is critical. Securing communication channels ensures 
confidentiality, integrity, and the user's authenticity within the scope of the 
load testing application. 

Because load generators and Controllers serve so many projects, it is 
essential that the channels between Controllers and load generators remain 
opaque to all machines except for the Controllers and load generators 
participating in running performance tests or collating test data after a run.

Secure communication is established between the Controller and load 
generator hosts using a security key. Each host in the system must be set up 
with the identical security key. If security keys on the hosts do not match, 
secure communication cannot be established.



Chapter 44 • Secure Host Communication

933

A host is in secure mode when it has a security key and security is enforced.

A host is in non-secure mode: 

➤ if it has no security key

➤ if it has a security key but security is not enforced

When a host in secure mode tries to communicate with a host in non-secure 
mode, security is automatically enforced on the non-secure host—assuming 
their security keys match—allowing secure communication to be 
established.

Note: 

➤ When you run a performance test, if secure communication cannot be 
established between a secure host (Controller or load generator) and 
another host participating in the test, the test cannot run.

➤ By definition, non-secure hosts can communicate with each other and 
participate in test runs over non-secure channels.

This can be summarized in the following table: 

Both Hosts in 
Secure Mode 

Security Mode on 
Hosts Differ

Both Hosts in 
Non-Secure Mode 

Security keys 
match

Test runs over 
secure channel

Test runs over 
secure channel

Test runs over 
non-secure channel

Security keys 
do not match

Test does not run Test does not run Test runs over 
non-secure channel
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Host Security Configuration 

When you install the hosts (Controllers and load generators), by default no 
security settings are defined on them, and communication channels 
between the hosts are not secure. To enforce secure communication between 
the hosts, you must configure security settings on each host machine 
immediately after installing the hosts.

When configuring these settings for the first time, to avoid configuration 
over non-secure channels, you must set the security on each host locally 
using the Host Security Setup utility. For details, see "How to Configure 
Security Settings Locally on Hosts" on page 938. 

After initial security configuration, you can update security settings locally 
or simultaneously across all the Performance Center hosts from a remote 
location using the HP Host Security Manager utility. This utility is installed 
on the same Performance Center Server. For details, see "How to Update 
Host Security Settings Remotely" on page 940.

Remote Security Configuration 

You can align security settings across all the Performance Center hosts 
simultaneously from a remote location using the HP Host Security Manager 
utility.

The utility lists all the Performance Center hosts, as well as the MI Listeners 
required to connect to the hosts that are over a firewall, where applicable. 

Using Host Security Manager, you can update the security key on all the 
hosts, or update the security mode on selected hosts. For details, see "How to 
Update Host Security Settings Remotely" on page 940.



Chapter 44 • Secure Host Communication

935

This section also includes:

➤ "Master Security Key" on page 935

➤ "Considerations for Updating UNIX Load Generators" on page 936

Master Security Key 
To update security settings on the hosts, Host Security Manager uses a 
master key that matches the security keys on all the hosts. This enables 
secure communication between Host Security Manager and the hosts for the 
purpose of remotely updating the security settings.

If the master key and security key on a particular host do not match, 
Host Security Manager cannot update security settings on that host.
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When you open Host Security Manager for the first time, you are prompted 
for a key. Host Security Manager stores this key as a master key for secure 
communication with the hosts. If you do not enter the key at this point, 
you are prompted for it again when you try to update the security settings.

Considerations for Updating UNIX Load Generators

➤ UNIX load generators that use rsh (remote shell) to connect to the 
Controller host cannot be updated using Host Security Manager. To 
update security settings on such load generators, use the local Host 
Security Setup utility. See "How to Configure Security Settings Locally on 
Hosts" for UNIX load generators on page 938.

➤ To update security settings on a UNIX load generator using 
Host Security Manager, you must launch the load generator daemon for a 
user and manually grant write permissions to the user on <installation 
folder>/config.
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Host Security Best Practices 

➤ To avoid sending security settings over a non-secure channel, perform 
initial configuration of the security settings on each host locally (see "How 
to Configure Security Settings Locally on Hosts" on page 938).

➤ Security settings should be changed once a month.

➤ Security settings can be updated:

➤ manually on each host

➤ remotely on all hosts simultaneously using the Host Security Manager 
utility

If, when using the Host Security Manager utility, updating a host’s 
settings fails, update the settings manually.
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Tasks

How to Configure Security Settings Locally on Hosts

This task describes how to configure security settings locally on Controllers 
and load generators.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

The task describes how to configure security settings on:

➤ "Windows Hosts" on page 938

➤ "UNIX Hosts" on page 939

Windows Hosts

 1 On each host, launch the Host Security Setup utility (Start > Programs > 
HP Performance Center Host > Tools > Host Security Setup).

For user interface details, see "Host Security Setup Dialog Box" on 
page 947.

 2 Select a security mode for the host. 

 3 If you selected to enforce secure communication, enter a security key 
(6 - 16 characters). Enter the key a second time for confirmation.
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UNIX Hosts

 1 Log in as root user and change to tcsh.

 2 Go to the /opt/HP/HP_LoadGenerator directory and type:

 3 Run SecurityKeyConsole.exe, located in the <Installation_folder>/bin/ 
directory.

 4 In the Console window, enter an option as follows:

➤ To change the security mode, enter 1.

➤ To change the security key, enter 2.

 5 If you are changing the security mode:

➤ To turn the security on, enter 1.

➤ To turn the security on, enter 0.

 6 If you are changing the security key, enter the new key. A valid key is 
6 - 16 characters long.

>source ./env.csh
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How to Update Host Security Settings Remotely

This task describes how to use Host Security Manager to update security 
settings on the Performance Center hosts remotely, from the 
Performance Center Server.

Note: This task is part of a higher-level task. For details, see "How to Work 
with Performance Center Administration" on page 622.

This task includes the following steps:

➤ "Prerequisites" on page 940

➤ "Register Performance Center hosts in Host Security Manager" on 
page 941

➤ "Update the security settings" on page 941

➤ "Results" on page 942

 1 Prerequisites

➤ Each host must have a security key defined on it, and all of the hosts’ 
security keys must be identical.

➤ Host Security Manager must have a master security key that is 
identical to the security key on all of the hosts. For details, see "Master 
Security Key" on page 935.
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 2 Register Performance Center hosts in Host Security Manager

For Host Security Manager to communicate with the Performance Center 
hosts, you must first register the hosts in Host Security Manager. 

Note: Every time you use Host Security Manager to update security 
settings, make sure that the list of hosts in Host Security Manager is 
updated. 

 a Open Host Security Manager: On the Performance Center Server, select 
Start > Programs > HP Performance Center Server > Tools > 
Host Security Manager. For user interface details, see "Host Security 
Manager Window" on page 944.

 b Before opening, the tool prompts you for the ALM Platform login 
credentials. Enter the credentials.

 c In the Host Security Manager, click Get Performance Center Hosts. 
The list of hosts is updated as follows:

➤ The hosts—and, where relevant, their associated MI Listeners—are 
imported from ALM into the utility.

➤ If you are updating the list, hosts that are no longer in ALM are 
removed from the list.

 3 Update the security settings

 a Update the desired security setting:

➤ Security key. Click Update Security Key, enter the new key, and enter 
it again for confirmation.

➤ Security Mode. Select the hosts in the list that you want to update. 
To select multiple hosts, hold down the CTRL key on your keyboard 
while selecting the relevant hosts. Click Update Security Mode, and 
select a security mode. 
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 b Click Update. 

Host Security Manager attempts to update the security setting on the 
hosts listed under Update progress. As it attempts to update each host, 
it displays the update status, Updated or Failed, before attempting to 
update the next host.

If a host is not updated successfully, check for possible reasons. You 
can stop the update process by clicking Stop.

If there is a mismatch between Host Security Manager’s master security 
key and the host’s security key, the Update Error dialog box opens, 
prompting you for an appropriate action:

➤ Skip host. Skip updating this host.

➤ Establish a secure channel using this key. Use a different security key 
to communicate securely with the host.

➤ Communicate over non-secure channel. Update the security setting 
over a non-secure channel. This action is not recommended, 
especially when updating the host security to secure mode. You 
should rather update the security setting locally on the host (see 
"How to Configure Security Settings Locally on Hosts" on page 938).

To apply the selected error-handling action to all similar mismatches, 
select Use this solution with all similar mismatches.

Note: The security key update also updates Host Security Manager’s 
master security key. If the update fails on all of the hosts, 
Host Security Manager’s master key is not updated.

 4 Results

If the update was successful, Host Security Manager displays the time and 
status of the security key/mode update for each host.
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Reference

Secure Host Communication User Interface

This section includes:

 ➤ Host Security Manager Window on page 944

 ➤ Host Security Setup Dialog Box on page 947

 ➤ Update Security Key Dialog Box on page 949

 ➤ Update Security Mode Dialog Box on page 951



Chapter 44 • Secure Host Communication

944

Host Security Manager Window

This window enables you to update security settings remotely on all of the 
hosts in the performance testing system.

 

To access On the Performance Center host select Start > Programs 
> HP Performance Center Server > Tools > Host Security 
Manager.

Important 
information

➤ You must provide Host Security Manager with a 
master security key before you can update the security 
settings. 

➤ Every time you use Host Security Manager to update 
security settings, click Get Performance Center Hosts 
to make sure that the list of hosts is up to date. 

Relevant tasks "How to Update Host Security Settings Remotely" on 
page 940

See also "Secure Host Communication Overview" on page 932
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Imports all the hosts defined in ALM into 
Host Security Manager.

Opens the Update Security Key dialog box, enabling you 
to update the security key on all the hosts. For details, see 
"Update Security Key Dialog Box" on page 949.

Opens the Update Security Mode dialog box, enabling 
you to update the security mode on selected hosts. For 
details, see "Update Security Mode Dialog Box" on 
page 951.

Opens the Set Master Key dialog box where you update 
Host Security Manager’s master security key. 

Opens the History dialog box, enabling you to view the 
history of updates made to the hosts. The information 
displayed includes the date of the update, the operation 
(key/mode update), and the update status (Passed/Failed). 
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<Hosts table> Displays the following information:

➤ Host Name/IP. The name or IP address of the host.

➤ Host Type. The type of host: Controller/
Load Generator.

➤ MI Listener. When the host is over a firewall, the name 
of the MI Listener through which the host 
communicates with the other hosts.

➤ Last Key Update. The last time the security key was 
updated.

➤ Key Update Status. The status of the last security key 
update.

➤ Last Security Mode Update. The last time the security 
mode was updated.

➤ Security Mode Update Status. The status of the last 
security mode update.

Tip: You can sort the details on this page in ascending or 
descending order by clicking the heading of the column 
by which you want to sort. Click the column heading 
again to reverse the sort order.

UI Elements Description
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Host Security Setup Dialog Box 

This dialog box enables you to update a host’s security settings manually.

 

To access On the host machine, select Start > Programs > 
Performance Center Host > Tools > Host Security Setup

Important 
information

When configuring security settings on hosts for the first 
time, to avoid configuration over non-secure channels, it 
is recommended to configure security settings on each 
host locally using the Host Security Setup utility. 

After initial security configuration, you can update 
security settings locally, or simultaneously across all the 
hosts in the system using the HP Host Security Manager 
utility installed on the Performance Center Server. For 
details, see "Remote Security Configuration" on page 934.

Relevant tasks  "How to Configure Security Settings Locally on Hosts" on 
page 938

See also "Host Security Configuration" on page 934
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Select a security 
mode

Select one of the following security modes:

➤ Allow non-secure communication. Allows the host to 
communicate with other machines over a non-secure 
channel. (Default)

➤ Enforce secure communication. Enforces the host to 
communicate with other machines over a secure 
channel. If you select this option, you must provide 
the key (6 - 16 characters long) matching the security 
key on the other hosts with which it needs to 
communicate.
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Update Security Key Dialog Box 

This dialog box enables you to update the security key simultaneously on all 
the hosts. 

 

To access In Host Security Manager, click Update Security Key.

Important 
information

When you update the security key, the 
Host Security Manager’s master security key is also 
updated. 

If the update fails on all the hosts, the 
Host Security Manager’s master key is not updated.

Relevant tasks "How to Update Host Security Settings Remotely" on 
page 940
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Updates the security key on all of the hosts.

Stops updating the hosts.

Security Key/

Confirm Security Key

Enter the new security key to be updated on all the hosts, 
and a second time for confirmation.

Note: The key must be 6 - 16 characters long.

Update progress Displays the hosts and their status during and after the 
update.
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Update Security Mode Dialog Box 

This dialog box enables you to update the security mode simultaneously on 
selected hosts. 

 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In Host Security Manager, click Update Security Mode.

Relevant tasks "How to Update Host Security Settings Remotely" on 
page 940

UI Elements Description

Updates the security mode on the selected hosts.

Stops updating the hosts.

Security mode Select a security mode: 

➤ Non-secure. Allows non-secure communication.

➤ Secure. Enforces secure communication.

Update progress Displays the hosts, their previous status (if known), and 
their status during and after the update.
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Troubleshooting and Limitations 

This section describes troubleshooting and limitations for secure host 
communication.

This section includes:

➤ "Cannot Run Test Over Secure Channels" on page 952

➤ "Test Run Fails. Load Generator Status is Changed to Resource Failure" on 
page 952

➤ "When Opening Host Security Manager Get Unhandled Exception" on 
page 953

Cannot Run Test Over Secure Channels 
Problem description: When you try to run a test over secure channels, the 
test cannot initialize because it cannot connect to a Controller or load 
generator.

Troubleshooting:

Verify that the reason the test cannot run is because of a security key 
mismatch: try to run the same test with the same hosts from a local 
Controller. 

If a Security Key Mismatch error is displayed in the error log, the keys do not 
match. Align the security keys on all the host machines.

Test Run Fails. Load Generator Status is Changed to 
Resource Failure 
Problem description: When trying to run a test over secure channels, the 
test fails to run and the load generator status changes to Resource Failure.

Troubleshooting: To re-enable the load generators, manually reset the status 
on each affected load generator to Operational. 
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When Opening Host Security Manager Get Unhandled 
Exception 
Problem description: When you open Host Security Manager for the first 
time, a message displays the following exception: Unhandled exception has 
occurred....

Troubleshooting: Click Continue to close the message window.
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45
ALM Performance Center Permissions

This chapter includes:

*Concepts

➤ Performance Center Permissions Overview on page 956

Reference

➤ Performance Center Permission Levels on page 957
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Concepts

Performance Center Permissions Overview 

You can control user access to projects and modules by defining user groups 
that can enter them, and by determining the types of tasks each user group 
performs according to permission levels. 

The following section provides details about permission levels that are 
specific to HP ALM Performance Center. For information about how to view 
and define these user groups and permissions, see HP Application Lifecycle 
Management Administrator Guide.

For details about the specific ALM Performance Center permissions, see 
"Performance Center Permission Levels" on page 957.
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Reference

Performance Center Permission Levels 

The following permission levels are specific to HP ALM Performance Center:

This section includes:

➤ "Performance Center Administration Permission Levels" on page 957

➤ "Lab Settings Permission Levels" on page 958

➤ "Performance Center Lab Permission Levels" on page 960

➤ "Performance Center Test Lab Permission Levels" on page 964

➤ "Performance Center Test Plan" on page 965

Performance Center Administration Permission Levels
The following administrative tasks are specific to ALM Performance Center. 
For details about additional administrative tasks, see HP Application Lifecycle 
Management Administrator Guide.

 

Entity > Permission Level Description

Performance Center > 
Download Standalone 
Applications

User group can download the standalone 
applications needed for working with ALM 
Performance Center.

Performance Center > 
Update General Settings

User group can update the Performance Center 
General Settings. 

Note: Lab Management only

Performance Center > login 
to My Performance Center

User group can access My Performance Center.

Note: ALM project only.
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Lab Settings Permission Levels
The Lab Settings tab displays the Lab Settings entities available in Lab 
Management and their corresponding permission levels. The entities are 
listed below in alphabetical order.

 

Entity > Permission Level Description

Diagnostics Mediator > 
Create

User group can add ERP/CRM Diagnostics 
Mediators.

Diagnostics Mediator > 
Update

User group can update ERP/CRM Diagnostics 
Mediator information. This permission level enables 
you to specify the fields that the selected user group 
can modify.

Diagnostics Mediator > 
Delete

User group can delete ERP/CRM Diagnostics 
Mediators.

Diagnostics Mediator > Test 
Mediator

User group can test ERP/CRM Diagnostics 
Mediators.

Diagnostics Server > Create User group can add HP Diagnostics Servers

Diagnostics Server > Update User group can updateHP Diagnostics Server 
information. This permission level enables you to 
specify the fields that the selected user group can 
modify.

Diagnostics Server > Delete User group can delete HP Diagnostics Servers

Diagnostics Server > Test 
Server

User group can test HP Diagnostics Servers

License > Manage Licenses User group can manage Performance Center and 
host licenses.

Patch > Create User group can upload Performance Center patches 
to ALM.

Patch > Update User group can update Performance Center patch 
information. This permission level enables you to 
specify the fields that the selected user group can 
modify.

Patch > Delete User group can delete Performance Center patches.
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PC Server > Create User group can add Performance Center Servers to 
ALM.

PC Server > Update User group can update Performance Center Server 
information. This permission level enables you to 
specify the fields that the selected user group can 
modify.

PC Server > Delete User group can delete Performance Center Servers 
from ALM.

PC Server > Check Server User group can perform checks on 
Performance Center Servers.

PC Server > Install Patch User group can install patches on 
Performance Center servers.

PC Server > Reboot User group can reboot Performance Center Servers.

PC Server > Reconfigure 
Server

User group can reconfigure Performance Center 
Servers.

PC Server > Set ALM 
Connection

User group can define ALM Connection 
information in the Performance Center Servers 
module.

Project Settings > Update User group can update Performance Center project 
settings information. This permission level enables 
you to specify the fields that the selected user group 
can modify.

Project Settings > Manage 
Autostart Retries

User group can manage autostart retries 
information.

Project Settings > Manage 
Timeslot Alerts

User group can manage timeslot alert settings.

Project Settings > Manage 
Controller Options

User group can define global Controller options.

Note: ALM project only

Target IP > Create User group can add target IP addresses. 

Entity > Permission Level Description
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Performance Center Lab Permission Levels
The Performance Center Lab tab displays permissions related to 
Performance Center lab resources, Application Under Test (AUT) resources, 
test runs, and timeslots.

 

Target IP > Update User group can update target IP information. This 
permission level enables you to specify the fields 
that the selected user group can modify.

Target IP > Delete User group can delete target IP addresses. 

Entity > Permission Level Description

AUT Host > Create User group can add AUT hosts to ALM.

AUT Host > Update User group can update AUT host information. This 
permission level enables you to specify the fields 
that the selected user group can modify.

AUT Host > Delete User group can delete AUT hosts.

AUT Host Pool > Create User can add AUT host pools.

Note: Lab Management only

AUT Host Pool > Update User group can update AUT host pool information. 
This permission level enables you to specify the 
fields that the selected user group can modify.

Note: Lab Management only

AUT Host Pool > Delete User group can delete AUT Host Pools.

Note: Lab Management only

AUT Host Pool > Manage 
AUT host-to-pool 
association

User group can add and remove AUT hosts to and 
from an AUT host pool.

Note: Lab Management only

Host > Create User can add Performance Center hosts.

Note: Lab Management only

Entity > Permission Level Description
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Host > Update User group can update Performance Center host 
information. This permission level enables you to 
specify the fields that the selected user group can 
modify.

Note: Lab Management only

Host > Delete User group can delete Performance Center hosts.

Note: Lab Management only

Host > Change Status User group can change a Performance Center host’s 
status.

Host > Check Host User group can perform checks on a 
Performance Center host.

Host > Install Patch User group can install patches on 
Performance Center hosts.

Host > Kill Process User group can kill processes on Performance Center 
hosts.

Host > Manage DP Queue User group can view pending data processing 
requests.

Host > Reboot User group can reboot Performance Center hosts.

Host > Reconfigure Host User group can reconfigure Performance Center 
hosts.

Host Location > Create User group can add host locations.

Note: Lab Management only

Host Location > Update User group can update host location information. 
This permission level enables you to specify the 
fields that the selected user group can modify.

Note: Lab Management only

Host Location > Delete User group can delete host locations.

Note: Lab Management only

Host Pool > Create User group can add Performance Center host pools 
to ALM.

Note: Lab Management only

Entity > Permission Level Description
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Host Pool > Update User group can update Performance Center host 
pool information. This permission level enables you 
to specify the fields that the selected user group can 
modify.

Note: Lab Management only

Host Pool > Delete User group can delete Performance Center host 
pools from ALM.

Note: Lab Management only

Host Pool > Manage 
host-to-pool association

User group can add and remove Performance Center 
hosts to and from a host pool.

Note: Lab Management only

MI Listener > Create User group can add MI Listeners to ALM.

Note: Lab Management only

MI Listener > Update User group can update MI Listener information. 
This permission level enables you to specify the 
fields that the selected user group can modify.

Note: Lab Management only

MI Listener > Delete User group can delete MI Listeners from ALM.

Note: Lab Management only

Test Run > Delete User group can delete test runs from the Test Runs 
module.

Note: Lab Management only

Test Run > Abort Run User group can abort a test run.

Note: Lab Management only

Timeslot > Create and 
Update

➤ ALM project: User group can reserve and update 
performance testing timeslots.

➤ Lab Management: User group can reserve and 
update maintenance timeslots. 

Entity > Permission Level Description
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Timeslot > Delete ➤ ALM project: User group can delete performance 
testing timeslots.

➤ Lab Management: User group can delete 
maintenance timeslots. 

Timeslot > Abort and Free ➤ ALM project: User group can abort active 
performance testing and data processing 
timeslots in his project, and free resources.

➤ Lab Management: User group can abort active 
maintenance timeslots, and free resources. 

Timeslot > Manage 
Consume VUDs

User group can select to use VUDs Vusers for the 
timeslot.

Note: ALM project only

Timeslot (PC Project) > 
Abort and Free

User group can abort active performance testing and 
data processing timeslots, and free resources in any 
project from Lab Management.

Note: Lab Management only

Timeslot (PC Project) > 
Delete

User group can delete performance testing timeslots 
in any project from Lab Management.

Note: Lab Management only

Timeslot (PC Project) > 
Update 

User group can update performance testing 
timeslots in any project from Lab Management.

Note: Lab Management only

Topology > Create User group can design new topologies.

Note: ALM project only

Topology > Update User group can update topology information. This 
permission level enables you to specify the fields 
that the selected user group can modify.

Note: ALM project only

Topology > Delete User group can delete topologies.

Note: ALM project only

Entity > Permission Level Description
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Performance Center Test Lab Permission Levels
The following permissions are specific to ALM Performance Center. For 
details about additional Test Lab permissions, see HP Application Lifecycle 
Management Administrator Guide.

Note: Available in the ALM project only.

 

Topology Folder > Create User group can add topology folders.

Note: ALM project only

Topology Folder > Update User group can update topology folder information. 
This permission level enables you to specify the 
fields that the selected user group can modify.

Note: ALM project only

Topology Folder > Delete User group can delete topology folders.

Note: ALM project only

Entity > Permission Level Description

Result > Analyze User group can analyze performance test results.

Result > Collate User group can collate performance test results.

Result > Delete Files User group delete performance test result files.

Result > Upload Files User group can upload performance test result files.

Run > Abort Run User group can abort a performance test run.

Run > Operations During 
Performance Run

User group can perform operations during a 
performance test run.

Run > Recalculate 
Performance SLA

User group can recalculate Service Level Agreements 
(SLAs).

Run > Start PC Run User group can start performance tests.

Entity > Permission Level Description



Chapter 45 • ALM Performance Center Permissions

965

Performance Center Test Plan
The following permission is specific to ALM Performance Center. For details 
about more Test Plan permissions, see HP Application Lifecycle Management 
Administrator Guide.

Note: Available in the ALM project only.

 

Performance Trend Report > 
Create

User group can create trend reports.

Performance Trend Report > 
Delete

User group can delete trend reports.

Performance Trend Report > 
Update

User group can update trend reports.

Entity > Permission Level Description

Test > Download VuGen 
Script

User group can download VuGen scripts.

Entity > Permission Level Description
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46
Managing ALM Performance Center 
Projects

This chapter includes:

Concepts

➤ Managing ALM Performance Center Projects Overview on page 968

Tasks

➤ How to Migrate from HP ALM Performance Center to HP ALM 
on page 970

➤ How to Migrate an ALM Performance Center System from a Staging to a 
Production Environment on page 973
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Concepts

Managing ALM Performance Center Projects Overview 

After you create an ALM Performance Center project, you manage it in the 
same way as a regular project in ALM, that is, from Site Administration. For 
information about managing projects in ALM, see the HP Application 
Lifecycle Management Administrator Guide.

There are, however, specific use-cases where you must be aware of detailed 
procedures to successfully perform tasks related to ALM Performance Center 
projects. These use-cases are:

Migrating from an HP ALM Performance Center 
environment to HP ALM environment
For more information, see "How to Migrate from HP ALM 
Performance Center to HP ALM" on page 970.

Migrating an ALM Performance Center system from a 
staging to a production environment
For more information, see "How to Migrate an ALM Performance Center 
System from a Staging to a Production Environment" on page 973.

Creating a copy of an ALM Performance Center project
For information about how to create a copy of a project, see HP Application 
Lifecycle Management Administrator Guide.

When creating a copy of an ALM Performance Center project, you must be 
aware of the following:

➤ The new project must also have the Performance Center extension 
enabled.

➤ Details about test runs will not be included in the ALM 
Performance Center Usage Reports.
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➤ Timeslot and project settings are not copied.

➤ Result files associated with the original project are not copied.

Archiving an ALM Performance Center project 
Archiving an ALM Performance Center project means exporting or 
removing the project from the server on which it is located, and in the 
future importing the project back onto that same server.

For information about exporting, importing, and restoring access to 
projects, see HP Application Lifecycle Management Administrator Guide.

When archiving an ALM Performance Center project, you must be aware of 
the following:

➤ You cannot import a project onto the original server, if a project with the 
same PUID exists on that server.

➤ If the project was not part of Lab Management, when restoring access to 
the project:

➤ Details about test runs will not be included in the ALM 
Performance Center Usage Reports.

➤ Timeslot and project settings information is lost.
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Tasks

How to Migrate from HP ALM Performance Center to 
HP ALM

This task describes how to successfully migrate your system from HP ALM 
Performance Center (the source) to HP ALM (the target). 

Note: As a result of migrating the system, all information contained in Lab 
Management originally created on the target will be lost.

To learn more about managing ALM Performance Center projects, see 
"Managing ALM Performance Center Projects Overview" on page 968.

 1 Open Site Administration

For details, see HP Application Lifecycle Management Administrator Guide.

 2 Move Lab Management from the source to the target 
environment

 a In the source environment, In Site Administration, select the Lab 
Management tab.

 b Remove Lab Management from the source and restore it in the target 
environment. For details about removing and restoring Lab 
Management, see "Lab Management Tab" on page 627.

 3 Activate Lab Management in the target environment

For details about activating Lab Management, see "Lab Management Tab" 
on page 627.
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 4 Update the Performance Center license

In the target environment, in Lab Management, update the 
Performance Center license. For details, see "Performance Center 
Licensing User Interface" on page 826.

 5 Update the hosts and the Performance Center server in the 
target environment (if required)

Note: Perform this step if the servers and hosts in the target environment 
are different than those in the source. 

In Lab Management, remove the existing Performance Center Server and 
hosts and replace with the new server and hosts.

➤ For details about how to add a Performance Center server, see "How to 
Manage Performance Center Servers" on page 799.

➤ For details about how to add Performance Center hosts, see "How to 
Manage Lab Resources" on page 674.

 6 Move the Performance Center projects from the source to 
the target

Remove the Performance Center projects from the source and restore the 
in the target environment. For details about removing and restoring 
projects, see HP Application Lifecycle Management Administrator Guide.

 7 Activate the Performance Center projects that were moved 
to the target environment

For details about activating projects, see HP Application Lifecycle 
Management Administrator Guide.
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 8 In the target, redefine the project settings in Lab 
Management

Perform this step for each Performance Center project you moved to the 
target environment. For details about configuring project settings, see 
"Performance Center Project Settings" on page 637.

 9 Activate the Performance Center projects that were restored 
in the target

For details about activating projects, see HP Application Lifecycle 
Management Administrator Guide.

Note: Test runs information, as well as details about past and future 
timeslots from migrated projects will not be included in the ALM 
Performance Center Usage Reports.

 10 Clean the target of unused timeslot information

In the target environment, in Lab Management, delete future timeslots 
for projects that were not migrated and which will not be migrated in the 
future.

To delete timeslots:

 a On the Lab Management sidebar, select Lab Usage > Timeslots.

 b Select View > Grid View. 

 c Select the timeslots to delete, and click the Delete button. 
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How to Migrate an ALM Performance Center System 
from a Staging to a Production Environment 

This task describes how to successfully move an ALM Performance Center 
system from a staging to a production environment. 

Note: As a result of migrating the system, all information contained in Lab 
Management originally created in the production environment will be lost.

To learn more about managing ALM Performance Center projects, see 
"Managing ALM Performance Center Projects Overview" on page 968.

 1 Open Site Administration

For details, see the HP Application Lifecycle Management Administrator 
Guide.

 2 Move Lab Management from the staging to the production 
environment

 a In the staging environment, in Site Administration, select the Lab 
Management tab.

 b Remove the Lab Management project from the staging and restore it in 
the production environment. For details about removing and restoring 
Lab Management, see "Lab Management Tab" on page 627.

 3 Activate Lab Management in the production environment

For details about activating Lab Management, see "Lab Management Tab" 
on page 627.
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 4 Update the Performance Center license

In the production environment, in Lab Management, update the 
Performance Center license. For details, see "Performance Center 
Licensing User Interface" on page 826.

 5 Update the hosts and the Performance Center server (if 
required)

Note: Perform this step if the servers and hosts in the production 
environment are different than those in the staging environment. 

In Lab Management, remove the existing Performance Center servers and 
hosts and replace them with new servers and hosts.

➤ For details about how to add Performance Center Server, see "How to 
Manage Performance Center Servers" on page 799.

➤ For details about how to add hosts, see "How to Manage Lab Resources" 
on page 674.

 6 Move the Performance Center projects from the staging 
environment to the production environment

Remove each Performance Center project from the staging environment 
and restore it in the production environment. For details about removing 
and restoring projects, see HP Application Lifecycle Management 
Administrator Guide.

 7 Activate the Performance Center projects in the production 
environment

For details about activating projects, see HP Application Lifecycle 
Management Administrator Guide.



Chapter 46 • Managing ALM Performance Center Projects

975

 8 In the production environment, configure the project 
settings in Lab Management 

Perform this step for each Performance Center project you moved to the 
production environment. For details about configuring project settings, 
see "Performance Center Project Settings" on page 637.
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